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Надлежащее уведомление

Гарантийные обязательства

Единственные гарантийные обязательства в отношении продуктов и услуг компании НР изложены в
заявлении о прямых гарантийных обязательствах, прилагаемом к таким продуктам и услугам. Ничего из
приведенного в данном документе не может быть истолковано в качестве дополнительных гарантийных
обязательств. Компания НР не несет ответственность за технические или редакторские ошибки и
опущения, содержащиеся в данном документе.
Содержащаяся в данном документе информация может быть изменена без уведомления.

Пояснения к ограниченным правам

Конфиденциальное компьютерное программное обеспечение. Для владения, использования или копирования
необходима действительная лицензия компании НР. В соответствии с положениями FAR 12.211 и 12.212
коммерческое компьютерное программное обеспечение, документация на компьютерное программное
обеспечение и технические данные на коммерческие продукты лицензируются государственным учреждениям
США на условиях стандартной коммерческой лицензии поставщика.

Независимые веб-узлы

Компания НР предоставляет ссылки на внешние независимые веб-узлы с тем, чтобы вы могли найти
дополнительную информацию  Содержимое и доступность таких веб-узлов могут быть изменены без
уведомления.  Компания НР не делает каких бы то ни было заявлений и не дает каких бы то ни было гарантий
в отношении содержимого или доступности таких веб-узлов.

Уведомление об авторских правах

©  1993 - 2007 Mercury Interactive Corporation. Все права защищены.

Уведомление о товарных знаках

Adobe® является товарным знаком компании Adobe Systems Incorporated.
JavaTM является товарным знаком компании Sun Microsystems, Inc. в США.
Microsoft® и Windows® являются зарегистрированными в США товарными знаками корпорации Майкрософт.
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Обновления документации

На титульном листе настоящего документа приведена следующая идентифицирующая информация:

• номер версии программного обеспечения;

• дата опубликования документа, которая изменяется при каждом обновлении документации;

• дата выпуска программного обеспечения, обозначающая дату выпуска текущей версии программного 
обеспечения.

Чтобы проверить последние обновления или убедиться в том, что вы пользуетесь самой последней
редакцией документа, перейдите на

http://ovweb.external.hp.com/lpe/doc_serv/ 
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Поддержка

Поддержка продуктов Mercury

Сведения о поддержке продуктов, ранее выпускавшихся компанией Mercury, можно получить одним из
следующих способов.

• Если вы работаете с партнером HP в рамках программы Software Services Integrator (SVI) (www.hp.com/
managementsoftware/svi_partner_list), то свяжитесь со своим агентом SVI.

• Если у вас есть действующий контракт на оказание поддержки программного обеспечения компании НР, 
зайдите на веб-узел поддержки программного обеспечения компании НР и найдите ответы на интересующие 
вас вопросы с помощью функции поиска Self-Solve Knowledge Search.

• Последние на данный момент данные относительно процессов и инструментов поддержки, доступных для 
продуктов, ранее выпускавшихся компанией Mercury, приведены на веб-узле поддержки клиентов Mercury по 
адресу: http://support.mercury.com.

• Если у вас есть дополнительные вопросы, свяжитесь с торговым представителем компании НР.

Поддержка программного обеспечения НР

Посетите веб-узел поддержки программного обеспечения НР по адресу:

www.hp.com/managementsoftware/services 

Служба Интернет-поддержки программного обеспечения НР предоставляет эффективный доступ к
интерактивным инструментам технической поддержки. Наши клиенты, имеющие право на техническую
поддержку, могут использовать данный веб-узел для:

• поиска интересующих их документов в базе знаний;

• подачи и отслеживания заявок на техническое обслуживание и расширение функциональных возможностей;

• загрузки исправлений программного обеспечения;

• управления контрактами на оказание поддержки;

• поиска контактов в компании НР в связи с технической поддержкой;

• просмотра сведений о доступных услугах;

• участия в обсуждениях с другими покупателями программного обеспечения;

• поиска курсов обучения по программному обеспечению и регистрации для участия них.

Для получения доступа к большинству разделов поддержки сначала необходимо зарегистрироваться в
качестве пользователя службы НР Passport, а затем войти в систему. Для ряда разделов поддержки также
необходим контракт на оказание поддержки. Получить более подробные сведения об уровнях доступа можно
по адресу: www.hp.com/managementsoftware/access_level 
Чтобы зарегистрироваться на получение идентификатора пользователя службы НР Passport, перейдите на
страницу: 
www.managementsoftware.hp.com/passport-registration.html
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Руководство Quality Center

Вас приветствует центр качества HP Quality Center – средство управления 
тестированием на основе веб-технологий. С помощью Quality Center можно 
эффективно упорядочить все фазы процесса тестирования приложений и 
управлять ими, включая определение требований к тестированию 
приложений, планирование и выполнение тестов и отслеживание 
дефектов.

Структура руководства
В руководстве пользователя по центру качества Quality Center описано, как 
с помощью Quality Center управлять процессом тестирования приложений. 

состоит из следующих частей:

 Часть I Основы Quality Center

Общий обзор функциональных возможностей и методологии Quality Center.

 Часть II Управление релизами

Определение релизов и циклов для управления процессами разработки и 
тестирования приложений.

 Часть III Детализация требований
Определение требований к тестированию приложений путем построения 
дерева требований.
15



Добро пожаловать!
 Часть IV Планирование проведения тестирования
Планирование процесса тестирования, начиная с построения дерева плана 
тестирования и заканчивая разработкой тестов.

 Часть V Выполнение тестов
Создание наборов тестов, выполнение тестов вручную и в автоматическом 
режиме и анализ результатов тестирования.

 Часть VI Отслеживание дефектов
Направление отчетов о дефектах приложений в проект Quality Center и 
отслеживания процесса устранения дефектов с самого начала и до конца.

 Часть VII Анализ в Quality Center
Контроль процесса тестирования приложений и отслеживания дефектов 
путем создания отчетов, отчетов в Excel, диаграмм и документации по 
проекту. 

 Часть VIIIПриложения
Работа со средством тестирования VAPI-XP и список сочетаний клавиш 
Quality Center.

Библиотека документации
Библиотека документации представляет собой интерактивную справку, в 
которой описано, как использовать Quality Center. Получить доступ к 
Библиотека документации можно следующими способами:

➤ Щелкните Библиотека документации в меню Help центра качества 
Quality Center, чтобы открыть домашнюю страницу Библиотека 
документации. Домашняя страница содержит быстрые ссылки на 
основные разделы справки.

➤ Щелкните Help on this page в меню Help Quality Center, чтобы открыть 
раздел Библиотека документации, содержащий данную страницу.
16
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Руководства комплекта документации
Комплект документации состоит из следующих руководств и справочных 
материалов, доступных в интерактивном режиме и/или в формате PDF. С 
документами в формате PDF можно ознакомиться и распечатать их с 
помощью программы Adobe Reader, которую можно загрузить с веб-сайта 
компании Adobe (http://www.adobe.com).

В документе Getting Started описано, как пользоваться комплектом 
документации, а также приведена его структура (доступны в интерактивном 
режиме).

В документе What’s New? описаны новейшие функциональные 
возможности последних версий Quality Center (доступны в интерактивном 
режиме и в формате PDF).

Можно также получить доступ к документу What’s New? с помощью меню 
Help центра качества Quality Center. Кроме того, чтобы просмотреть 
видеоролики, в которых демонстрируются основные возможности 
продукта, выберите Help > Product Feature Movies. 

Документ Readme содержит самые последние новости и сведения о 
Quality Center. 

Руководства по центру качества Quality Center:
В руководстве пользователя по центру качества HP Quality Center 
описано, как с помощью Quality Center можно упорядочить и выполнить все 
этапы процесса тестирования приложений. В нем описаны такие этапы 
тестирования, как определение требований, планирование и выполнение 
тестов и отслеживание дефектов приложений (доступны в интерактивном 
режиме и в формате PDF).

В руководстве администратора HP Quality CenterAdministrator’s Guide 
описано, как создавать и поддерживать проекты с помощью Site 
Administration, а также как настраивать их в окне Project Customization 
(доступны в интерактивном режиме и в формате PDF).
17
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Добро пожаловать!
Руководство HP Quality Center Tutorial представляет собой материалы 
для самостоятельного изучения, помогающие пользователю понять, как с 
помощью центра качества Quality Center управлять процессом 
тестирования программного обеспечения (Доступно в формате PDF).

В руководстве по установке HP Quality Center Installation Guide 
описано, как установить Quality Center на сервере кластерной среды или в 
автономном режиме (доступно в формате PDF).

Руководства по тестированию бизнес-процессов:
В руководстве HP Business Process Testing User’s Guide описано, как 
разрабатывать тесты для бизнес-процессов (доступны в интерактивном 
режиме и в формате PDF). 

Руководство HP Business Process Testing Tutorial представляет собой 
материалы для самостоятельного изучения, содержащие основные 
сведения о приложении Business Process Testing, используемом в центре 
качества Quality Center (доступно в формате PDF).

Справочные материалы по интерфейсу прикладного 
программирования (API):
HP Quality Center Database Reference  – это полный комплект 
интерактивной документации по таблицам и полям базы данных проекта 
(доступен в интерактивном режиме).

HP Quality Center Open Test Architecture API Reference – это полный 
комплект интерактивной документации по API на основе COM центра 
качества Quality Center.   Можно использовать программу тестирования с 
открытой архитектурой центра качества Quality Center для интеграции 
средств управления конфигурацией приложений пользователя, 
инструментов отслеживания дефектов и средств тестирования 
собственной разработки в проекте Quality Center (доступен в 
интерактивном режиме). 

HP Quality Center Site Administration API Reference – это полный 
комплект интерактивной документации по интерфейсу Site Administration 
API на основе COM.  Можно использовать интерфейс Site Administration 
API, чтобы разрешить тестируемому приложению упорядочивать и 
обслуживать в центре качества Quality Center пользователей, проекты, 
домены, подключения и параметры конфигурации сайта, а также управлять 
ими (доступен в интерактивном режиме).
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Руководство HP Quality Center Custom Test Type Guide – это полный 
комплект интерактивной документации по созданию пользовательского 
средства тестирования и его интеграции в центр качества Quality Center 
(доступно в интерактивном режиме).

Дополнительные ресурсы в Интернете
Доступ к дополнительным веб-ресурсам можно получить с помощью 
следующих пунктов меню Help центра качестваQuality Center:

 Knowledge Base  используется для открытия в веб-обозревателе по 
умолчанию целевой страницы «База знаний» сайта центра технической 
поддержки Mercury.

Customer Support Web Site используется для открытия в веб-
обозревателе по умолчанию сайта центра технической поддержки Mercury. 
На этом сайте пользователи могут просматривать базу знаний Mercury 
Support Knowledge Base и добавлять в нее собственные статьи. Кроме того, 
пользователи могут просматривать форумы и публиковать на них свои 
сообщения, подавать заявки на предоставление поддержки, загружать 
пакеты исправлений и обновленную документацию, а также выполнять 
другие действия. URL -адрес этого сайта: http://support.mercury.com 

HP Software Web site используется для доступа с помощью веб-
обозревателя по умолчанию к странице сайта НР, посвященной 
программным продуктам. На этой веб-странице можно ознакомиться с 
самыми последними сведениями о программных решениях НР, а именно: 
сведениями о новых выпусках программного обеспечения, семинарах и 
выставках, технической поддержке клиентов и другой полезной 
информацией. URL-адрес этого сайта: 
http://www.hp.com/managementsoftware 

Add-ins Page открывает страницу надстроекHP Quality Center, которая 
позволяет интегрировать эти надстройки в средства тестирования 
(созданные как компанией HP, так и сторонними производителями), 
инструменты синхронизации и средства управления версиями приложений. 
Для получения дополнительных сведений см. руководство Руководство по 
установке HP Quality Center.
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Добро пожаловать!
Соглашения о типографских обозначениях 
В данном руководстве используются следующие типографские 
обозначения:

Элементы 
пользовательского 
интерфейса и 
имена функций

Этот стиль применяется для названий элементов 
интерфейса, используемых для выполнения 
пользователями определенных действий, имен 
файлов и путей к ним, а также для других элементов, 
которые необходимо выделить. Например, "Нажмите 
кнопку Save". Он также применяется к именам 
методов и функций. Например, "Оператор 
wait_window имеет следующие параметры:".

Аргументы Этот стиль применяется к аргументам методов, 
свойств или функций, а также к названиям руководств. 
Например, "Смотрите Руководство пользователя HP 
User’s Guide".

<Замените 
значение>

Угловыми скобками выделяют часть пути к файлу или 
URL-адрес, которую необходимо заменить реальным 
значением. Например, <Папка установки 
MyProduct>\bin.

Пример Этот стиль применяется для примеров и выделения 
текста, который необходимо ввести дословно. 
Например, "Введите в поле текст Hello".

CTRL+C Этот стиль применяется для клавиш на клавиатуре. 
Например, "Нажмите клавишу ENTER".

[ ] В квадратные скобки заключаются необязательные 
аргументы.

{ } Фигурные скобки указывают на то, что одно из 
заключенных в них значений должно быть назначено 
текущему аргументу. 
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Добро пожаловать!
... В строке синтаксической структуры многоточие 
указывает на то, что в строку можно добавить 
большее количество элементов в том же формате. 
Например в программировании многоточие 
используется, чтобы указать строки программного 
кода, которые были специально пропущены.

| Вертикальная черта указывает на то, что необходимо 
выбрать один из вариантов, разделенных чертой.
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Часть I
Основы Quality Center





1
Введение

Вас приветствует центр качества HP Quality Center – средство управления 
тестированием на основе веб-технологий! Получить доступ к нему можно с 
помощью веб-обозревателя через Интернет или корпоративную интрасеть.

Тестирование приложений представляет собой сложный процесс, 
включающий в себя разработку и выполнение тысяч тестов. Часто 
необходимо выполнять тесты на различных аппаратных платформах с 
использованием разных конфигураций (компьютеров, операционных 
систем и веб-обозревателей) и различных версий приложений. Управление 
всеми аспектами процесса тестирования может потребовать много 
времени и быть сложным.

Quality Center упрощает и упорядочивает процесс управления 
тестированием благодаря систематическому контролю процесса 
тестирования  и помогает создавать структуру и основу процесса 
тестирования.

Quality Center облегчает ведение базы данных проекта, содержащей тесты, 
которые охватывают все аспекты функциональности приложения. Каждый 
тест проекта предназначен для проверки определенного требования 
приложения. Чтобы обеспечить соответствие различным целям проекта, 
необходимо упорядочить тесты, содержащиеся в проекте, с помощью 
уникальных групп. Quality Center предоставляет эффективный интуитивный 
метод планирования и выполнения наборов тестов, сбора результатов 
тестирования и анализа данных.
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Глава 1 • Введение
Quality Center также использует сложную систему отслеживания дефектов 
приложения, обеспечивающую полный текущий контроль дефектов, 
начиная с их обнаружения и до устранения. Благодаря взаимодействию 
центра качестваQuality Center с электронной почтой можно обеспечить 
совместное использование данных о дефектах всеми сотрудниками групп 
разработки, контроля качества, технической поддержки клиентов и 
информационных систем.

Quality Center обеспечивает интеграции с инструментами тестирования HP 
(WinRunner, QuickTest Professional, LoadRunner и Visual API-XP), 
средствами тестирования сторонних производителей и специальными 
средствами тестирования, а также средствами управления требованиями и 
конфигурациями. Quality Center эффективно обменивается данными с 
выбранным пользователем средством тестирования, что предоставляет 
пользователю полное решение для полностью автоматизированного 
тестирования приложений.

Quality Center знакомит пользователей с такими этапами процесса 
тестирования как определение спецификаций релизов приложения, 
определение спецификации требований, планирование тестов, 
проведение тестов и отслеживание дефектов приложений. Благодаря 
интеграции всех задач, входящих в процесс тестирования приложений, 
центр качества Quality Center гарантирует предоставление клиентам 
высококачественных приложений.
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Глава 1 • Введение
Процесс управления тестированием
Управление тестированием с помощью Quality Center состоит из пяти 
этапов:  

Определение релизов. Разработка плана управления циклами релизов.

Определениетребований. Анализ приложения и определение 
требований.

Планирование тестов. Разработка плана тестирования на основе 
требований пользователя.

Проведение тестирования. Создание наборов тестов и их выполнение.

Отслеживание дефектов приложений Создание отчетов о дефектах, 
обнаруженных в приложениях, и отслеживание процесса их устранения.
27
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На каждом этапе можно анализировать данные с помощью подробных 
отчетов и диаграмм.

Определение релизов 
Разработайте план управления релизами-циклами. 

Определение релизов и циклов. Создайте дерево релизов для 
определения релизов и циклов и временной шкалы проекта. Релиз 
представляет собой группу изменений, внесенных в одно или несколько 
приложений, которые доступны для одновременного распространения. 
Цикл представляет собой этап разработки и контроля качества на основе 
временных рамок проекта.

Назначение требований. Определите требования в модуле Requirements 
и назначьте их релизам и циклам дерева релизов.  
28
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Назначение и выполнение наборов тестов. Создайте папки наборов 
тестов в модуле Test Lab и назначьте их циклам дерева релизов. Набор 
тестов – это группа в проекте Quality Center, предназначенном для 
тестирования. После назначения папок наборов тестов циклу, выполните 
наборы тестов, расположенных в соответствующих папках. 

Назначение дефектов. Задокументируйте новые дефекты, обнаруженные 
в приложении, в проекте Quality Center. Назначьте дефекты 
соответствующим релизам и циклам дерева выпусков.

Анализ выпусков и циклов. Создайте отчеты и диаграммы, с помощью 
которых можно проанализировать процесс создания релиза. 
Проанализируйте дерево релизов, чтобы обеспечить его соответствие 
целям релиза.
29
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Определение требований 
Анализ приложения и определение требований. 

Определение рамок тестирования. Ознакомьтесь с документацией по 
приложению, чтобы определить рамки тестирования, т.е. цели, задачи и 
стратегии тестирования.

Создание требований. Создайте дерево требований, чтобы определить 
общие требования.
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Детализация требований. Для каждого раздела дерева требований 
создайте перечень подробных требований. Составьте описание каждого 
требования, назначьте ему уровень приоритета и, если необходимо, 
добавьте к нему вложения.

Назначение релизов требованиям. Назначьте каждому требованию 
релизы и циклы дерева релизов  в модуле Releases. Дерево релизов 
отображает выпуски продукта в виде иерархической структуры. 

Анализ требований. Создайте отчеты и диаграммы, с помощью которых 
можно проанализировать требования. Проанализируйте требования, 
чтобы обеспечить их соответствие рамкам тестирования.
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Планирование тестов 
Составление плана тестирования на основе требований. 

Определение стратегии тестирования. Ознакомьтесь с приложением, 
системной средой и тестируемыми ресурсами, чтобы определить цели 
тестирования.

Определение объектов тестирования. Разбейте приложение на 
подлежащие тестированию функциональные возможности. Создайте 
дерево плана тестирования, чтобы иерархически разделить приложение 
на блоки или объекты тестирования.

Определение тестов. Определите необходимые типы тестов для каждого 
объекта тестирования. Добавьте базовое определение каждого теста в 
дерево плана тестирования.
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Создание покрытия требований тестами. Свяжите каждый тест с одним 
или несколькими требованиями.

Разработка этапов тестирования. Разработайте тесты, выполняемые 
вручную, путем добавления этапов тестирования в дерево планов 
тестирования.  Каждый шаг тестаописывает выполняемые действия и 
ожидаемый результат Определите, какие тесты следует автоматизировать.

Автоматизация тестов. Для тестов, которые необходимо 
автоматизировать, разработайте сценарии тестов с помощью средств 
тестирования HP, инструментов тестирования сторонних производителей 
или специальных средств тестирования.

Анализ плана тестирования. Создайте отчеты и диаграммы, с помощью 
которых можно проанализировать планы тестов. Проанализируйте тесты, 
чтобы обеспечить их соответствие целям тестирования.
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Выполнение тестов 
Создание наборов тестов и их выполнение  

Создание наборов тестов. В проекте определите группы тестов, 
соответствующие различным целям тестирования. Такие группы могут 
включать в себя, например, тестирование новой версии или отдельных 
функций приложения. Определите, какие тесты следует включить в каждый 
набор тестов. Назначьте папки наборов тестов циклам, определенным в 
дереве релизов модуля Releases. 

Составление графика тестов. Составьте график выполнения тестов и 
поставьте задачи перед тестерами приложений. 

Выполнение тестов. Выполните тесты из набора в автоматическом 
режиме или вручную.

Анализ результатов тестов. Просмотрите результаты выполненных 
тестов, чтобы определить, были ли обнаружены дефекты в приложении 
или нет. Создайте отчеты и диаграммы, с помощью которых можно 
проанализировать эти результаты.

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements
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Отслеживание дефектов 
Документирование дефектов, обнаруженных в приложении,в проекте и 
отслеживание процесса их устранения.  

Добавление дефектов. Создайте отчет о новых дефектах, обнаруженных 
в приложении. Специалисты по контролю качества, разработчики, 
руководители проектов и конечные пользователи могут добавлять дефекты 
на любом этапе процесса тестирования.

Анализ новых дефектов. Проанализируйте новые дефекты и определите, 
какие из них следует устранить.

Устранение открытых дефектов. Исправьте те дефекты, которые 
необходимо устранить.

Тестирование новой сборки. Протестируйте новую сборку приложения. 
Продолжайте процесс пока дефекты не буду устранены.
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Анализ данных о дефектах. Создайте отчеты и диаграммы, с помощью 
которых можно провести анализ процесса устранения дефектов и 
определить дату выпуска приложения.

Работа с базами данных проекта 
При создании проекта Quality Center необходимо сохранять данные, 
созданные и собранные с помощью центра качества Quality Center, и 
управлять ими. Каждый проект использует базу данных, в которой хранятся 
сведения о проекте.

Проекты – это репозитории, в которых хранятся релизы, циклы, 
требования, тесты, наборы тестов, результаты выполнения тестов, 
дефекты, документация по проекту и сведения о настройках приложений.  
Для работы с проектом тестирования приложения, пользователю 
Quality Center необходим постоянный доступ к этим данным. 

Дополнительные сведения о поддерживаемых серверах баз данных см. в 
Руководство по установке HP Quality Center.

Дополнительные сведения о создании проектов и управлении ими 
Quality Center см. в документе Руководство администратора 
HP Quality Center.

Привилегии пользователей 
Quality Center позволяет управлять доступом пользователей к проекту. 
Путем создания списка авторизованых пользователей, назначения 
каждому из них пароля и включения пользователей в группы можно 
управлять типами дополнений и изменений, вносимых каждым 
пользователем в проект. Группа пользователей определяет привилегии 
пользователя в проекте. Quality Center включает в себя механизм 
привилегий и разрешений, который позволяет создавать правила для 
определенных полей проекта.

Подробные сведения о существующих в Quality Center группах 
пользователей и назначении паролей и привилегий см. в документе 
Руководство администратора HP Quality Center.
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Импорт из приложений Microsoft Word и Microsoft Excel
Можно импортировать данные из приложений Word или Excel в проект 
Quality Center.

Импорт из приложения Word
Quality Center предоставляет возможность импортировать требование или 
план тестирования из документа Word в проект. Для импорта из 
приложения Word необходимо установить на клиентский компьютер 
надстройки Microsoft Word и HP Quality Center Connectivity. Для установки 
надстройки выберите Help > Add-ins Page, чтобы открыть страницу 
надстроек центра качества HP Quality Center, и щелкните ссылку на 
соответствующую надстройку.

Дополнительные сведения см. на странице надстроек Microsoft Word 
руководства Руководство по дополнительному средству Microsoft Word 
Add-in HP Quality Center.

Импорт из приложения Excel
Quality Center предоставляет возможность импортировать требование, 
план тестирования или сведения о дефекте из таблицы Excel в проект. Для 
импорта из приложения Excel необходимо установить на клиентском 
компьютере надстройки Microsoft Excel и HP Quality Center Connectivity. Для 
установки надстройки выберите Help > Add-ins Page, чтобы открыть 
страницу надстроек центра качества HP Quality Center, и щелкните ссылку 
на соответствующуб надстройку.

Дополнительные сведения см. на странице надстроек Microsoft Excel 
руководства Руководство по дополнительному средству Microsoft Word 
Excel HP Quality Center.
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Приступая к работе

В этом разделе приведены порядок запуска приложения Quality Center и 
описание окна Quality Center.

Запуск Quality Center
Запустите Quality Center с помощью веб-обозревателя.

Для запуска Quality Center:

 1 Откройте веб-обозреватель и введите URL-адрес сервера Quality Center 
http://<Quality Center имя сервера>[<:номер порта>]/qcbin. Если правильный 
путь к серверу не известен, обратитесь к системному администратору.

Глава содержит следующие разделы: На стр.

Запуск Quality Center 39

Окно Quality Center 44

Общая панель инструментов Quality Center 46

Изменение свойств и пароля пользователя 48

Удаление истории изменения 50

Просмотр сообщений администратора сайта 51
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Откроется окно ссылок HP Quality Center.

 2 Щелкните ссылку Quality Center.

При первом запуске Quality Center файлы загружаются на компьютер, и 
выполняется программа установки приложения Microsoft .NET Framework 
2.0 (если оно еще не установлено на компьютере).  После этого 
Quality Center выполнет проверку версии. Если на сервере установлена 
более новая версия, на компьютер будут загружены обновленные файлы. 
Дополнительные сведения о загружаемых файлах см. в руководстве 
Руководство по установке HP Quality Center. 
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Примечание. 

➤ Чтобы загрузить файлы на компьютер, необходимо войти в систему с 
правами администратора. Вход с правами администратора необходим 
при первом запуске Quality Center, его обновлении до новой версии или 
установке пакета обновлений. 

➤ Если в веб-обозревателе загрузка файлов запрещена, их можно 
установить с помощью надстройки HP Quality Center Client Side Setup на 
веб-странице надстроекHP Quality Center. Дополнительные сведения по 
установке надстроек см. в руководстве Руководство по установке 
HP Quality Center. 

➤ Quality Center предлагает установить приложение Microsoft .NET 
Framework 2.0, если оно еще не установлено на компьютере. Для его 
установки следуйте инструкциям мастера Software Update Installation 
Wizard (если не установлен Windows Installer 3.1) и программы 
установки Microsoft .NET Framework 2.0.
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После проверки версии и обновления файлов (если это необходимо) 
Quality Center откроется окно  для входа в систему.

 3 В поле Login Name введите имя пользователя. 

 4 В поле Password введите свой пароль, выданный администратором сайта.

Чтобы изменить этот пароль, см. главу“Изменение свойств и пароля 
пользователя" на стр. 48.

 5 Установите флажок Automatically log in to my last domain and project on 
this machine, если необходимо, чтобы Quality Center автоматически 
входил в последний проект, с которым работал пользователь.
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 6 Нажмите кнопку Authenticate. Quality Center проверит имя и пароль 
пользователя, чтобы определить, к каким доменам и проектам он имеет 
доступ. Если был установлен автоматический вход в систему, откроется 
окно Quality Center.

Если аутентификация прошла неуспешно, проверьте, что имя и пароль 
пользователя введены правильно, в противном случае введите их еще раз.

 7 В списке Domain выберите нужный домен. По умолчанию отображается 
последний домен, который использовал пользователь.

 8 В списке Project выберите нужный проект. По умолчанию отображается 
последний проект, с которым работал пользователь.

Если на сервере Quality Center установлен демонстрационный проект, 
выберите проект QualityCenter_Demo (убедитесь в том, что в списке 
Domain выбран параметр DEFAULT). Демонстрационный проект 
позволяет получить представление о Quality Center и включает в себя 
примеры требований, тестов, наборов тестов, их выполнения и дефектов. 
Для получения дополнительных сведений см. руководство Учебное 
руководство по HP Quality Center.

 9 Нажмите кнопку Login. Открывается окно Quality Center, содержащее 
модуль (Releases, Requirements, Test Plan, Test Lab или Defects), в котором 
пользователь работал в последнем сеансе.

При первом запуске Quality Center открывается начальная страница. На 
этой веб-странице можно получить доступ к руководству пользователя по 
центру качества Quality Center и другой документации по Quality Center. 
Чтобы отключить отображение начальной страницы при каждом входе в 
Quality Center, выберите Don’t show this again. В любой момент, когда 
необходимо открыть начальную страницу, выберите Help > Welcome Page.

 10 Чтобы перейти с начальной страницы в окно входа в HP Quality Center, 
нажмите кнопку Logout в верхней правой части окна. 

Альтернативный вариант — выберите Tools > Change Project, чтобы войти 
в другой проект.
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Окно Quality Center
При подключении к проекту открывается главное окно Quality Center , 
содержащее модуль, в котором пользователь работал в последний раз. В 
верхней правой части окна отображаются домен, проект и имя 
пользователя. 

Окно Quality Center содержит следующие основные элементы:

➤ Quality Center боковая панель. Предоставляет доступ к модулям 
Quality Center. Дополнительные сведения см. в разделе “Модули 
Quality Center" на стр. 45.

➤ Quality Center Панель основных инструментов.Содержит кнопки 
переходов и предоставляет доступ к основным инструментам, 
документации и дополнительным ресурсам. Эта панель инструментов 
расположена в верхней правой части окна. Дополнительные сведения см. в 
разделе “Общая панель инструментов Quality Center" на стр. 46.

Общая панель 
инструментов

Строка меню

Панель 
инструментов

Боковая 
панель 

QualityCenter
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➤ Строка меню модуля. Отображает имена меню, содержащих команды 
текущего модуля Quality Center.

➤ Панель инструментов модуля. Содержит кнопки вызова команд, часто 
используемых текущим модулем Quality Center.

Модули Quality Center
Quality Center включает в себя следующие модули, доступ к которым 
можно получить в боковой панели:

➤ Модуль Releases. Позволяет определять релизы и циклы для управления 
процессом тестирования.

➤ Модуль Requirements. Позволяет задавать требования к тестированию. С 
помощью этого модуля можно определять объекты тестирования, разделы 
и элементы требований, связывать требования с тестами и дефектами, а 
также анализировать требования. 

➤ Модуль Test Plan. Позволяет разрабатывать план тестирования на основе 
требований к тестированию. С помощью этого модуля можно разбивать 
план тестирования на категории, разрабатывать тесты и автоматизировать 
их в тех случаях, когда это целесообразно, связывать тесты с 
требованиями и дефектами, а также анализировать план.

➤ Модуль Test Lab. Позволяет тестировать приложения и анализировать 
результаты тестирования.

➤ Модуль Defects. Позволяет добавлять в отчет дефекты, определять 
приоритеты их устранения, устранять открытые дефекты и анализировать 
данные о дефектах.

В зависимости от имеющихся лицензий на Quality Center можно также 
получить доступ к модулю Business Components, Этот модуль позволяет 
экспертам в данной области управлять процессом оптимизации качества с 
помощью решения HP по автоматизации тестирования бизнес-процессов 
Business Process Testing. Дополнительные сведения см. в руководстве 
пользователя HP Тестирование бизнес-процессов.

Для получения сведений о настройке имен модулей, см. Руководство по 
установке HP Quality Center.
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Совет. Переходить от одного модуля к другому можно с помощью 
комбинаций клавиш. Чтобы перейти к модулю Requirements , используйте 
CTRL+SHIFT+1; чтобы перейти к модулю Test Plan — CTRL+SHIFT+2 и т.д. 
Кроме того, с помощью комбинаций клавиш можно выполнять много других 
операций в Quality Center. Перечень комбинаций клавиш приведен в 
Приложение B, "Quality Center - Комбинации клавиш".

Общая панель инструментов Quality Center
Перейти к панели основных инструментов Quality Center, расположенной в 
верхней правой части окна Quality Center, можно из любого модуля. Эта 
панель содержит следующие кнопки:

Кнопки перехода
Back. Переход к предыдущей веб-странице Quality Center.

Forward. Переход к следующей веб-странице Quality Center.

Кнопка Tools
Change Project. Выход из текущего проекта и при необходимости выбор 
одного из пяти проектов, недавно открывавшихся на этом компьютере, или 
выбор другого проекта из окна входа в систему.

Customize. Открытие окна Project Customization для настройки проекта. 
Дополнительные сведения см. в руководстве Руководство 
администратора HP Quality Center.

New Defect. Открытие окна New Defect, в котором можно добавлять новые 
дефекты. Дополнительные сведения см. в главеГлава 31, "Добавление и 
отслеживание дефектов".
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Spelling and Grammar: 

➤ Check Spelling. Проверка орфографии выделенного слова или 
фрагмента текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене. 

➤ Spelling Options. Открытие диалогового окна Spelling Options, в котором 
можно настроить параметры проверки орфографии Quality Center. 

➤ Thesaurus. Открытие диалогового окна тезауруса, содержащего 
синонимы, антонимы или связанные слова для выделенного слова. 
Можно заменять выделенное слово или искать новые слова.

Clear History. Открытие диалогового окна удаления истории изменения, в 
котором можно удалять исторические данные из проекта. Эту команду 
могут использовать только пользователи с правами администратора 
проекта. Дополнительные сведения см. в разделе “Удаление истории 
изменения" на стр. 50.

Document Generator. Открытие генератора документов. Дополнительные 
сведения см. в главеГлава 36, "Создание документов в проекте".

Excel Report Generator. Открывает генератора отчетов Excel. 
Дополнительные сведения см. в главе Глава 37, "Создание отчетов Excel".

Модуль Dashboard. Запуск модуля HP Quality Center Dashboard— 
платформы HP,с помощью которой специалисты по ИТ могут отслеживать 
готовность приложения в реальном времени и управлять рисками проекта. 
Дополнительные сведения см. в комплекте документации  HP 
Quality CenterDashboard.

Чтобы настроить меню Tools, см. руководство Руководство по установке 
HP Quality Center.
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Кнопка Help
Кнопка Help позволяет открывать комплект документации поQuality Center 
и другие интерактивные ресурсы. С помощью этой кнопки можно также 
отобразить сведения о версии для каждого клиентского компонента 
приложения Quality Center. Дополнительные сведения см. в “Библиотека 
документации" на стр. 16 и “Дополнительные ресурсы в Интернете" на 
стр. 19.

Чтобы настроить меню Help, см. руководство Руководство по установке 
HP Quality Center.

Кнопка Logout
С помощью кнопки Logout можно перейти из текущего проекта в окно 
входа в HP Quality Center.

Изменение свойств и пароля пользователя
Можно изменять свойства пользователя (полное имя, адрес электронной 
почты, номер телефона и описание). Необходимо указать данные 
электронной почты, поскольку они позволяют пользователю получать 
уведомления о дефектах, требованиях, тестах и наборах тестов в своем 
почтовом ящике. Пользователь может также изменять свой пароль для 
доступа к проектам Quality Center.

Администратор сайта может изменять или переопределять свойства или 
пароль пользователя. Дополнительные сведения см. в руководстве 
Руководство администратора HP Quality Center.

Для изменения свойств и пароля пользователя:

 1 В верхней правой части окна нажмите кнопку Tools и выберите Customize. 
Откроется окно Project Customization. 
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 2 Щелкните ссылку User Properties. Откроется окно свойств пользователя.

 3 Измените следующие свойства пользователя: Full Name, E-mail, Phone 
Number, Description.

 4 Нажмите кнопку Save для сохранения изменений.

 5 Нажмите кнопку Change Password. Откроется диалоговое окно изменения 
пароля.
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 6 В поле Old Password введите старый пароль.

 7 В поле New Password введите новый пароль.

 8 В поле Retype New Password введите новый пароль еще раз.

 9 Нажмите кнопку OK для сохранения изменений. Окно изменения пароля 
закроется.

 10 В верхней правой части окна нажмите кнопку Return, чтобы выйти из окна 
Project Customization и вернуться в проект.

Удаление истории изменения 
При настройке своего проекта можно указать Quality Center , что 
необходимо сохранять журнал значений системы и пользовательских 
полей в объектах Requirement, Test, Test Set, Test Instance и Defect. 
Создаваемые исторические данные отображаются на вкладках History 
модулей Requirements, Test Plan, Test Lab и Defects. Дополнительные 
сведения о сохранении истории изменения поля см. в Руководство 
администратора HP Quality Center.

Если исторические данные больше не нужны, их можно удалить из проекта 
Quality Center. Например, если наборы тестов пройдены успешно, можно 
удалить историю выполнения тестов их проекта.

Можно удалить либо все историчесике данные, либо выбрать отдельный 
объект или поле и удалить историю его изменения. Кроме того, можно 
удалять исторические данные до определенной даты включительно. 
Quality Center удаляет данные, отображаемые на вкладке History 
соответствующих модулей.

Примечание. Для удаления исторических данных необходимо иметь права 
администратора проекта. 
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Для удаления исторических данных:

 1 В верхней правой части окна нажмите кнопку Tools и выберите Clear 
History. Откроется диалоговое окно удаления исторических данных.

 2 В поле Entity выберите объект, историю изменения которого необходимо 
удалить. Чтобы удалить исторические данные об изменении всех объектов, 
выберите All.

 3 В поле Field выберите поле, историю изменения которого необходимо 
удалить. Чтобы удалить исторические данные об изменении всех полей, 
выберите All.

 4 В поле Until Date выберите дату. Все данные до выбранной даты 
включительно будут удалены. 

 5 Нажмите кнопку OK.

Просмотр сообщений администратора сайта
Администратор сайта может отправлять сообщения пользователям, 
подключенным к проектам Quality Center, информируя их о важных 
вопросах, связанных с обслуживанием сайта, и других вопросах. 
Например, администратор сайта может направить предупреждение о том, 
что проект, к которому подключены пользователи, будет отключен или о 
перезагрузке сервера Quality Center.

Дополнительные сведения о отправке сообщений администратором сайта 
см. в Руководство администратора HP Quality Center.
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Для просмотра сообщений администратора сайта:

 1 После отправки сообщения администратором сайта на компьютере 
пользователя автоматически открывается всплывающее окно с текстом 
сообщения.

 2 При приеме более одного сообщения для их просмотра используйте кнопки 
Previous Message и Next Message.

 3 Чтобы закрыть окно сообщения, нажмите кнопку Close.
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Можно просматривать и изменять данные проекта с помощью таблиц и 
деревьев.Quality Center. 
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О порядке работы с данными Quality Center
Quality Center упорядочивает и отображает данные в виде таблиц или 
деревьев.

Дерево/
Таблица Описание

Дерево релизов Расположено в модуле Releases. Отображает релизы и 
циклы проекта Quality Center. Дополнительные сведения см. 
в главе Глава 9, "Создание дерева релизов".

Дерево/таблица 
требований 

Расположены в модуле Requirements. Отображает 
требования к тестированию, содержащиеся в проекте 
Quality Center. Дополнительные сведения см. в 
главеГлава 12, "Разработка дерева требований".

Дерево плана 
тестирования

Расположено в модуле Test Plan. Отображает тесты проекта 
Quality Center, сгруппированные по объектам. 
Дополнительные сведения см. в главеГлава 17, "Создание 
дерева плана тестирования". 

Таблица тестов Расположена в модуле Test Plan. Отображает все тесты 
проекта Quality Center. Дополнительные сведения см. в 
главе Глава 16, "Краткий обзор модуля Test Plan".

Таблица шагов 
теста

Расположена в модуле Test Plan. Отображает шаги теста. 
Дополнительные сведения см. в главеГлава 19, "Разработка 
тестов".

Дерево/таблица 
наборов тестов

Расположены в модуле Test Lab. Отображает наборы тестов 
(группу тестов, выполняемых для достижения определенной 
цели тестирования) проекта Quality Center. Дополнительные 
сведения см. в разделе Глава 24, "Создание набора тестов".

Таблица 
выполнения 
набора тестов

Расположена в модуле Test Lab. Отображает все тесты из 
набора. Дополнительные сведения см. в разделе Глава 23, 
"Краткий обзор модуля Test Lab".

Таблица 
дефектов

Расположена в модуле Defects. Отображает дефекты 
приложений проекта Quality Center. Дополнительные 
сведения см. в главе Глава 31, "Добавление и отслеживание 
дефектов".
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Следует учитывать, что таблицы и деревья Quality Center различаются по 
типам отображаемого в них содержимого, и действия, описанные в этом 
главы, не всегда применимы ко всем таблицам и деревьям.

Совет. Можно сохранять такие параметры деревьев и таблиц, как поля 
сортировки и фильтры, в виде избранного представления. Дополнительные 
сведения см. в главе Глава 6, "Работа с избранными представлениями".

Упорядочивание столбцов 
Можно изменять параметры данных,  задавая порядок отображения 
столбцов, и изменяя размеры столбцов. При следующем открытии 
проекта Quality Center отобразит столбцы с измененными параметрами.

Совет.  Можно также перегруппировать столбцы путем перетаскивания 
заголовков столбцов.

Определение порядка отображения столбцов
Можно определить, какие столбцы и в каком порядке должны отображаться 
в окне Quality Center с помощью диалогового окна выбора столбцов. 
Например, в качестве первого столбца таблицы тестов можно задать 
столбец Subject.
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Для определения размеров и порядка отображения столбцов:

 1 Нажмите кнопку Select Columns. Откроется диалоговое окно выбора 
столбцов.

Список Available Columns содержит столбцы, которые в настоящее время 
не отображаются. В списке 
Visible Columns содержит столбцы, которые в настоящее время 
отображаются.

Примечание. При открытии окна выбора столбцов в модуле Requirements 
в нем также отображаются поле Requirement Type и флажок Hide Risk-
Based Quality Management Columns.

 2 При работе в модуле Requirements выберите тип требования из списка 
Requirement Type. Отображаются столбцы, соответствующие данному 
типу требования.
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 3 При работе в модуле Requirements можно установить флажок Hide Risk-
Based Quality Management Columns, чтобы скрыть поля требования, 
относящиеся к управлению качеством на основе риска, в списке Available 
Columns. Чтобы поля стали видимы, снимите этот флажок.

 4 Выберите имена столбцов и с помощью кнопок со стрелками (> и <) 
перемещайте их между списками Available Columns и Visible Columns. 
Чтобы переместить все столбцы из одного списка в другой, используйте 
кнопки с двумя стрелками (>> и <<).  Обратите внимание, что перемещать 
имена столбцов между списками можно либо перетаскиванием, либо 
сначала дважды щелкнув имя столбца , а затем переместив его.

Примечание. Столбцы, помеченные значком , нельзя удалить из списка 
Visible Columns.

 5  В списке Visible Columns задайте порядок столбцов кнопками вверх и 
вниз. Также можно перетаскивать имена столбцов вверх или вниз.

 6 Чтобы использовать столбцы без прокрутки, определите число таких 
столбцов и добавьте их в список Fixed Columns. Количество столбцов, 
заданных как фиксированные, будет установлено как количество столбцов 
без прокрутки, начиная с крайнего левого столбца. При горизонтальной 
прокрутке столбцы без прокрутки, остаются на месте. Такие столбцы 
затемнены.

 7 Нажмите кнопку OK, чтобы закрыть диалоговое окно и примените новый 
порядок отображения столбцов. 

Изменение размеров столбцов
Изменить размеры столбцов можно с помощью мыши. Щелкните правый 
край заголовка столбца и перетащите его, чтобы установить нужную 
ширину столбца. Обратите внимание, что можно изменять размеры только 
нефиксированных столбцов (столбцов без прокрутки).
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Выбор пользователей
При выборе столбца в таблице или дереве Quality Center, содержащего 
имя пользователя, Quality Center отображает список пользователей с этим 
именем пользователя и их полные имена. Можно сортировать список 
пользователей, выполнять поиск пользователей, упорядочивать 
пользователей по группам и выбирать пользователей из списка или дерева 
групп. 

Для выбора пользователей:

 1 Выберите поле пользователя и щелкните стрелку раскрывающегося 
списка. Откроется диалоговое окно списка пользователей.

Чтобы выполнить сортировку списка пользователей по имени или полному 
имени пользователя (по возрастанию или убыванию), щелкните заголовок 
столбца Name или Full Name. Чтобы изменить порядок сортировки, 
щелкните заголовок столбца еще раз. 

 2 Поиск пользователей можно выполнять следующими способами:

➤ Пошаговый поиск путем ввода первого символа имени пользователя. 
Для сужения поиска можно вводить дополнительные символы. 
Quality Center начинает поиск после ввода первого символа строки 
поиска и выделяет записи с первым вхождением всей искомой 
последовательности символов.
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➤ Поиск пользователей по имени пользователя или по его полному имени. 
Введите имя пользователя (или часть имени) в поле Find. Нажмите 
кнопку Find. Quality Center выделит запись с первым вхождением имени 
пользователя, совпадающим со строкой поиска. 

 3 Для отображения пользователей по группам, установите флажок View by 
Group. Пользователи будут отображаться по группам.

Чтобы развернуть ветвь дерева, щелкните знак  («Развернуть») слева от 
имени группы пользователей. Чтобы свернуть ветвь дерева, щелкните знак 

 («Свернуть» ) слева от имени группы пользователей.

 4 Выберите пользователя и нажмите кнопку OK. Диалоговое окно Users List 
закроется, и в поле данных отобразятся данные пользователя.

Фильтрация записей 
Можно фильтровать данные Quality Center , чтобы отображать только те 
данные, которые соответствуют определенному критерию. Фильтровать 
можно по одному элементу (например, Failed) или по логическому 
выражению (например, Passed or Failed). В таблице или дереве будут 
отображаться только записи, соответствующие всем условиям при 
использовании фильтра. 

Кроме того, можно задавать несколько фильтров. Например, можно задать 
фильтр Status с критерием ‘Failed’, а фильтр Tester с критерием ‘David Or 
Mark’. После фильтрации отобразятся только тесты, выполненные 
Дэвидом или Марком с отрицательным результатом.
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Совет. Можно сохранить фильтр в виде избранного представления, 
отсортировать информацию в нем, а затем загрузить его, когда это 
необходимо. Чтобы сохранить этих параметров в качестве избранного 
представления, выберите Favorites > Add to Favorites. Дополнительные 
сведения см. в главеГлава 6, "Работа с избранными представлениями".

Для задания фильтра:

 1 Нажмите соответствующую кнопку Set Filter/Sort. Откроется диалоговое 
окно Filter и отобразится вкладка Filter Condition.

Примечание. При открытии диалогового окна Filter в модуле Requirements 
в нем также отображается поле Requirement Type и флажок Hide Risk-
Based Quality Management Columns.
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 2 Чтобы задать фильтр по типу требования, в поле Requirement Type 
нажмите кнопку обзора. Откроется диалоговое окно Select Filter Condition. 
Выберите тип требования. Нажмите кнопку OK, чтобы закрыть диалоговое 
окно Select Filter Condition. На вкладке Filter Condition отобразятся 
соответствующие имена полей.

 3 При работе в модуле Requirements можно установить флажок Hide Risk-
Based Quality Management Columns, чтобы скрыть поля требования, 
относящиеся к управлению качеством на основе риска. Будут скрыты 
только те поля, для которых не задан условие фильтра. Чтобы поля стали 
видимы, снимите этот флажок.

 4 Чтобы перейти к полю на вкладке Filter Condition, щелкните поле в столбце 
Field Name и введите первые символы имени поля. Quality Center выделит 
первое совпадение.

 5 Чтобы задать условие фильтра для поля, щелкните соответствующее поле 
Filter Condition. Нажмите кнопку обзора. Откроется диалоговое окно Select 
Filter Condition.
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Примечания. 

➤ При выборе поля с именем пользователя в диалоговом окне Select Filter 
Condition отображается список пользователей, в котором можно 
сортировать пользователей, выполнять поиск пользователей, 
упорядочивать пользователей по группам и выбирать пользователей из 
списка или дерева групп. Дополнительные сведения см. в разделе 
“Выбор пользователей" на стр. 58.

➤ Если в модуле Requirements выбрать поле Req Parent, откроется 
диалоговое окно Select Filter Condition с деревом требований, 
отсортированных по имени требования. При выборе требования из 
дерева в поле Condition отображается полный путь к нему. При 
применении фильтра отображаются только требования, являющиеся 
дочерними для выбранного требования.

 6 Задайте условие фильтра. Если применимо, выберите элементы из списка. 
Можно добавить операторы, чтобы создать логическое выражение. 
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Примечание. При задании условия фильтра необходимо учитывать 
следующее:

➤ Некоторые элементы, отображающиеся в иерархических списках, 
содержат подчиненные списки. Перед такими элементами стоит значок 
папки. Чтобы выбрать элемент из подчиненного списка, дважды 
щелкните папку и выберите элемент.

➤ При определении условия фильтра для поиска пользователя можно 
задать имя текущего пользователя (выберите [CurrentUser]) или имя 
группу пользователей (например, [Developer]).

➤ При вводе условия фильтра из нескольких слов его необходимо 
заключить в кавычки. Например, для поиска теста Login Boundary в поле 
Condition введите: "login boundary".

➤ При вводе только части условия фильтра используйте ‘звездочку’ (*). 
Например, для поиска всех тестов со словом Login в поле Condition 
введите: *login*. Для поиска всех тестов со словами Insert New в поле 
Condition введите: "insert new*".

➤ Для задания пустого поля введите: ""

➤ Для задания непустого поля введите: not "".

 7 Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

 8 Для добавления перекрестных фильтров щелкните значок стрелки Show 
Advanced Filter. Дополнительные сведения см. в разделе “Применение 
расширенных/перекрестных фильтров для записей" на стр. 65.

 9 Для копирования параметров фильтра нажмите кнопку Copy Filter 
Settings. Дополнительные сведения см. в разделе “Копирование 
параметров" на стр. 74.

 10 Для удаления параметров фильтра нажмите кнопку Clear Filter.

 11 Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter. 
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После этого применяются все заданные фильтры и отображается их 
описание. Для таблицы Quality Center также отображает условие фильтра в 
поле фильтра таблицы под именем каждого столбца. 

Совет. Для таблицы также можно задать фильтр с помощью поля фильтра 
таблицы. Чтобы отобразить поля фильтров таблицы, выберите View > Grid 
Filters. Если поле фильтра пустое, к столбцу фильтр не применен. Введите 
условие фильтра непосредственно в поле или щелкните это поле для 
отображения кнопки Browse, нажмите на эту кнопку и в открывшемся 
диалоговом окне Select Filter Condition введите условие фильтра. 

Примечание. При применении фильтра для дерева требований 
родительские требования фильтруемых объектов, которые не 
соответствуют фильтру, отображаются со значком .

Общая панель 
инструментов
Поле фильтра 
для столбца 

Designer
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Применение расширенных/перекрестных фильтров для 
записей 

При задании фильтра также можно применять перекрестный фильтр. Он 
представляет собой расширенный второй фильтр для связанного 
элемента, такого как требование, тест, набор тестов или дефект. 
Например, в дереве плана тестирования можно задать перекрестный 
фильтр ‘Open’ для связанных наборов тестов. При применении такого 
фильтра будут отображаться только тесты, принадлежащие к набору 
тестов со статусом "Open". Альтернативный вариант — можно задать 
фильтр для связанных наборов тестов, чтобы найти тесты, которые не 
содержит ни один набор тестов.

В таблице ниже для каждого модуля Quality Center приведен список 
перекрестных фильтров, содержащихся в нем :

Модуль Перекрестный фильтр

Requirements ➤ Tests. Фильтрация требований по тестам, покрывающим 
их.

➤ Defects. Фильтрация требований по дефектам, 
непосредственно или косвенно связанным с требованиями.

➤ Requirements: Trace from. Фильтрация требований, от 
которых выполняется отслеживание.

➤ Requirements: Trace to. Фильтрация требований, к 
которым выполняется отслеживание. 

➤ Show requirements with alerts. Фильтрация требований по 
инициированным оповещениям. 

Test Plan ➤ Requirements. Фильтрация тестов по требованиям, 
покрытым тестами.

➤ Test Sets. Фильтрация тестов по наборам, содержащим эти 
тесты.

➤ Defects. Фильтрация тестов по дефектам, 
непосредственно или косвенно связанным с тестами.

➤ Show tests with alerts. Фильтрация тестов по 
инициированным оповещениям.
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Для задания перекрестного фильтра:

 1 Нажмите соответствующую кнопку Set Filter/Sort. Откроется диалоговое 
окно Filter с вкладкой Filter. 

Дополнительные сведения о задании фильтра см. в разделе “Фильтрация 
записей" на стр. 59.

Test Lab - Test 
Sets list

➤ Tests. Фильтрация наборов тестов по содержащимся в них 
тестам. 

➤ Defects. Фильтрация наборов тестов по дефектам, 
непосредственно или косвенно связанным с тестами.

Test Lab - 
Execution Grid

➤ Requirements. Фильтрация экземпляров тестов по тестам, 
покрывающим выбранные требования.

➤ Defects.  Фильтрация тестов по дефектам, 
непосредственно или косвенно связанным с тестами.

➤ Show test instances with alerts. Фильтрация экземпляров 
тестов по инициированным оповещениям. 

Defects ➤ Requirements.  Фильтрация дефектов по связанным 
требованиям.

➤ Test Sets. Фильтрация дефектов по связанным наборам 
тестов.

➤ Tests. Фильтрация дефектов по связанным тестам.
➤ Show defects with alerts. Фильтрация дефектов по 

инициированным оповещениям. 

Модуль Перекрестный фильтр
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 2 Чтобы отобразить параметры перекрестного фильтра, щелкните значок 
стрелки Show Advanced Filter.
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 3 Установите флажок фильтра в Cross filter by. Например, выберите ‘Test 
Sets’. Откроется диалоговое окно Cross Filter.

В модуле Test Plan можно выбрать следующие параметры:

➤ Filter tests not in any test set. Фильтрация тестов, которые не входят ни 
в один набор тестов. Этот параметр помогает найти, например, те 
тесты, которые еще не выполнялись. Его можно выбрать только в 
диалоговом окне Cross Filter: Test Sets. 

➤ Filter tests with no requirement coverage. Фильтрация тестов, которые 
не покрывают ни одно требование. Этот параметр помогает найти, 
например, избыточные тесты или тесты, не содержащие связи с 
покрытием требований. Его можно выбрать только в диалоговом окне 
Cross Filter: Requirements

 4 Задайте перекрестный фильтр с помощью правил задания фильтра. 
Дополнительные сведения см. в разделе “Фильтрация записей" на стр. 59.
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 5 Для копирования параметров фильтра нажмите кнопку Copy Filter 
Settings. Дополнительные сведения см. в разделе “Копирование 
параметров" на стр. 74.

 6 Для удаления параметров фильтра нажмите кнопку Clear Filter.

 7 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно Cross Filter. Заданные перекрестные фильтры отображаются  в Cross 
filter by диалогового окна Filter.

 8 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно Filter.

Сортировка записей 
По умолчанию записи отображаются в окне Quality Center в порядке их 
добавления. При задании приоритетов сортировки записи отображаются в 
соответствии с порядком сортировки ASCII. При сортировке ASCII сначала 
рассматриваются записи, начинающиеся с пробела или символа, а затем 
— записи, начинающиеся с цифр. Далее выполняется сортировка по 
заглавным буквам и, наконец, по строчным буквам.

Например, если столбцу Designer таблицы Test присвоен высший 
приоритет сортировки, записи сортируются в порядке сортировки ASCII в 
соответствии с именами, отображающимися в столбце Designer. Если 
столбцу Test Name присвоен следующий по важности приоритет, то затем 
в порядке ASCII и в соответствии с их именами будут сортироваться записи 
тестов, которым назначены те же имена в столбце Designer.

Примечание.  Можно сохранить фильтр в виде избранного представления, 
отсортировать информацию в нем, а затем загрузить его при 
необходимости. Чтобы сохранить в виде избранного представления, 
выберите Favorites > Add to Favorites. Дополнительные сведения см. в 
разделе Глава 6, "Работа с избранными представлениями".
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Для сортировки записей:

 1 Нажмите соответствующую кнопку Set Filter/Sort. Откроется диалоговое 
окно Filter.

Примечание. При открытии диалогового окна Filter в модуле Requirements 
в нем также отображаются поле Requirement Type и флажок Hide Risk-
Based Quality Management Columns. 

 2 Выберите вкладку View Order.

Список Available Fields содержит имена всех полей, которые можно 
отображать. Список 
Sorted Fields содержит имена полей, которым в текущий момент присвоен 
приоритет сортировки.
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 3 При работе в модуле Requirements выберите тип требования из списка 
Requirement Type. На вкладке View Order отобразятся соответствующие 
имена полей.

 4 При работе в модуле Requirements можно установить флажок Hide Risk-
Based Quality Management Columns, чтобы скрыть поля требования, 
относящиеся к управлению качеством на основе риска, в списке Available 
Fields. Чтобы поля стали видимы, снимите флажок. 

 5 Выберите имена полей и с помощью кнопок со стрелками (> и <) 
перемещайте их между списками Available Fields и Sorted Fields. Чтобы 
переместить все имена из одного списка в другой, используйте кнопки с 
двумя стрелками (>> и <<). Для перемещения столбца между списками 
можно также перетаскивать имена полей между списками или щелкать 
дважды имя столбца.

 6 В списке Sorted Fields выберите поле и с помощью кнопок Sort Ascending 
и Sort Descending выполните сортировку полей по возрастанию или 
убыванию.

 7 В списке Sorted Fields выберите поле и присвойте ему приоритет 
сортировки с помощью кнопок Move Field Up и Move Field Down. Также 
можно перетаскивать имена полей вверх или вниз.

 8 Для копирования параметров сортировки нажмите кнопку Copy Filter 
Settings. Дополнительные сведения см. в разделе “Копирование 
параметров" на стр. 74.

 9 Для удаления параметров сортировки нажмите кнопку Clear Filter.

 10 Чтобы применить порядок сортировки, нажмите кнопку OK.
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Группирование записей таблицы
При работе с таблицами Quality Center можно упорядочивать данные по 
группам в соответствии с заданными условиями. Можно определить 
данные, по которым Quality Center будет группировать записи, и задать 
иерархический порядок их отображения (до трех уровней), что упростит 
перемещение по большим наборам данных.

Например, если столбцу Assigned To таблицы Defects присвоить высший 
приоритет группирования, записи будут группироваться в соответствии с 
именами, отображающимися в столбце Assigned To. Если столбцам 
Status и Severity присвоить следующие по важности приоритеты 
соответственно, то дефекты тестов, которым присвоены те же имена, что и 
в столбце Assigned To, будут группироваться в соответствии с их статусом 
и уровнем серьезности.

Примечания.

➤ Нельзя выполнять операции Quality Center для всей группы, выбрав 
заголовок группы. Чтобы выполнять операции с несколькими записями, 
используйте клавиши Ctrl или Shift для выбора записей.

➤ При группировании записей по полю, содержащему несколько значений, 
сведения в каждом значении группируются в качестве единого значения. 
Это значение является категорией группирования. Например, значение, 
содержащее English и French, будет сгруппировано как English;French, а 
не как части отдельных категорий English и French. Дополнительные 
сведения об использовании нескольких значений см. в руководстве 
Руководство администратора HP Quality Center. 

➤ При группировании по списку отображаются только системные и 
заданные пользователем поля, связанные с полем типа User List или 
Lookup List. Дополнительные сведения о типах полей см. в руководстве 
Руководство администратора HP Quality Center.
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Для группирования записей таблицы:

 1 Нажмите соответствующую кнопку Set Filter/Sort. Откроется диалоговое 
окно Filter.

Примечание. При открытии диалогового окна Filter в модуле Requirements 
в нем также отображаются поле Requirement Type и флажок Hide Risk-
Based Quality Management Columns.

 2 Выберите вкладку Group.

 3 При работе в модуле Requirements выберите тип требования из списка 
Requirement Type. На вкладке Group отобразятся соответствующие имена 
полей.

 4 При работе в модуле Requirements можно установить флажок Hide Risk-
Based Quality Management Columns, чтобы скрыть поля требования, 
относящиеся к управлению качеством на основе риска. Чтобы поля стали 
видимы, снимите флажок.
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 5 Щелкните значок стрелки Group items by. Выберите поле, по которому 
необходимо сгруппировать записи. 

 6 Чтобы сгруппировать записи по дополнительным полям, щелкните значок 
стрелки Then by и выберите поле, по которому необходимо сгруппировать 
записи. При группировании записей по нескольким полям выберите поля в 
том иерархическом порядке, в котором они должны отображаться. 
Обратите внимание, что уже выделенное поле больше не выбирается.

 7 Чтобы удалить уровень группирования, задайте значение уровня (none). 
При изменении родительского уровня группирования на (none) дочерние 
уровни группирования автоматически изменятся на (none).

 8 Для копирования параметров группирования нажмите кнопку Copy Filter 
Settings. Дополнительные сведения см. в разделе “Копирование 
параметров" на стр. 74.

 9 Для удаления параметров группирования нажмите кнопку Clear Filter.

 10 Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter. 

Группирование записей таблицы выполняется в соответствии с 
параметрами.

Копирование параметров
Можно копировать параметры фильтра, сортировки или группирования в 
буфер обмена и вставлять их из него.  Можно копировать эти параметры и 
вставлять их в другой проект. Также можно обмениваться параметрами с 
другим пользователем, вставив их в сообщение электронной почты или 
текстовый файл. 
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Для копирования параметров:

 1 Нажмите соответствующую кнопку Set Filter/Sort. Откроется диалоговое 
окно Filter.

 2 Нажмите кнопку Copy Filter Settings. Параметры фильтра копируются в 
буфер обмена.

 3 Чтобы вставить параметры фильтра в другой проект, откройте проект, в 
который необходимо их вставить, перейдите к соответствующему модулю 
и откройте диалоговое окно Filter. Нажмите кнопку Paste Filter Settings. 
Нажмите кнопку OK.

Чтобы вставить параметры фильтра в сообщение электронной почты или 
текстовый файл, нажмите кнопку ‘Вставить’. 

Обновление и удаление параметров 
Можно обновлять и удалять параметры фильтра, сортировки и 
группирования, примененные к данным Quality Center.

➤ Чтобы обновить данные в таблице или дереве, нажмите кнопку Refresh All. 

➤ Чтобы удалить все фильтры и приоритеты сортировки в таблице или 
дереве, щелкните значок стрелки Set Filter/Sort и выберите Clear 
Filter/Sort.
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Поиск записей
С помощью текстового поиска можно искать записи в предопределенных 
полях модулей Requirements, Test Plan и Defects. Доступные для поиска 
текстовые поля предварительно определяются администратором проекта 
в окне Project Customization. Дополнительные сведения об определении 
доступных для поиска полей см. в Руководство администратора 
HP Quality Center.

При вводе ключевого слова Quality Center выполняет поиск этого слова или 
его вариаций в предопределенных полях. Например, при вводе ключевого 
слова log будут найдены поля, содержащие слова log, logs, logging и logged. 
Слова login или logical найдены не будут, поскольку они не являются 
вариациями ключевого слова  Дополнительные сведения о функции поиска 
см. в разделе“Что необходимо учитывать при поиске" на стр. 77.

Если были определены условия фильтра модуля, можно выполнять поиск 
только в отфильтрованных записях или во всех записях модуля (при этом 
не потребуется удалять текущий фильтр и задавать фильтр еще раз). Если 
в модуле выбрана папка, поиск все равно выполняется во всех записях 
модуля в соответствии с выбранными параметрами фильтра. 

Quality Center отображает результаты поиска в виде списка, 
отсортированного в порядке релевантности. Можно просмотреть 
результаты поиска и отобразить сведения о записях. Можно настроить 
данные, указав, какие столбцы должны отображаться и порядок их 
отображения. 

Примечание. Функцию текстового поиска можно использовать только в том 
случае, если она включена в проекте. Если функция поиска не доступна, 
обратитесь к администратору сайта Quality Center.
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Что необходимо учитывать при поиске
При использовании функции текстового поиска необходимо учитывать 
следующее:

➤ При поиске пропускаются: артикли (a, an, the); 
соединительные/сочинительные союзы (and, but, for, nor, or); знаки 
логических операций (and, or, not, if, or, then).

➤ При вводе нескольких слов результаты поиска будут включать в себя 
все записи, содержащие хотя бы одно искомое слово.

➤ Поиск выполняется без учета регистра.

➤ Поиск ранжирует результаты и отображает их в порядке релевантности.

Для поиска в записях:

 1 Нажмите кнопку Text Search или выберите Edit > Text Search. В нижней 
части окна откроется панель поиска. 

 2 В поле Search for введите искомое слово. В модуле Test Plan укажите, где 
следует выполнять поиск: в Tests или в Design Steps.

 3 Чтобы выполнить поиск во всех записях модуля, снимите флажок Restrict 
to current filter. 

 4 Щелкните Search. Quality Center выполнит текстовый поиск в 
предопределенных полях и отобразит результаты в порядке 
релевантности. Дополнительные сведения о функции поиска см. в “Что 
необходимо учитывать при поиске" на стр. 77.

 5 Чтобы изменить размеры и порядок отображения столбцов, нажмите 
кнопку Select Columns. Откроется диалоговое окно Select Columns. 
Дополнительные сведения см. в разделе “Упорядочивание столбцов" на 
стр. 55.
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 6 Чтобы просмотреть список предопределенных полей поиска, заданных в 
окне Project Customization, нажмите кнопку Searchable Fields Information. 
Отобразится список предопределенных полей поиска. Нажмите кнопку OK, 
чтобы закрыть список доступных для поиска полей. 

 7 Чтобы отобразить сведения о записи, выберите запись и щелкните ссылку 
ID или Name. Альтернативный вариант — выберите запись и нажмите 
кнопку Go to Entity.

Примечание. В представлениях дерева Quality Center сведения о записях 
отображаются только в том случае, если запись соответствует текущему 
фильтру. Чтобы отобразить сведения о тех записях, которые не 
соответствуют текущему фильтру, очистите фильтр или выберите другой 
фильтр.

Экспорт данных в файл 
 Также можно экспортировать данные из таблицы в текстовый файл, лист 
Microsoft Excel, документ Microsoft Word или HTML.

Для экспорта данных в файл:

 1 Можно экспортировать все данные таблицы или только отдельные записи:

➤ Чтобы экспортировать все данные таблицы, щелкните таблицу правой 
кнопкой мыши и выберите Export > All. Откроется диалоговое окно 
Export All Grid Data.

➤ Чтобы экспортировать отдельные записи таблицы, выберите их с 
помощью клавиш Ctrl или Shift. Щелкните таблицу правой кнопкой 
мыши и выберите Export > Selected. Откроется диалоговое окно Export 
Selected Grid Data.

 2 В поле Save in выберите папку для сохранения файла.

 3 В поле File name введите имя файла.

 4 В поле Save as type выберите тип файла. 

 5 Нажмите кнопку Save.
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Оповещение об изменениях

Можно указать Quality Center автоматически создавать оповещения и 
отправлять сообщения по электронной почте, чтобы уведомлять лиц, 
ответственных за внесение изменений в проект, которые могут повлиять на 
процесс тестирования. Пользователь также может добавлять собственные 
оповещения отслеживания.

Глава содержит следующие разделы: На стр.

Оповещение об изменении объектов 80

Описание оповещений 80

Просмотр оповещений 85

Удаление оповещений 87

Установка флажков для отслеживания 88
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Оповещение об изменении объектов
В процессе тестирования приложений можно отслеживать изменения 
требований, тестов и дефектов. В Quality Center применяются две функции 
оповещения:

➤ Automatic notification alerts. Используется для активации правил 
оповещений администратором проекта Quality Center. Правила 
основываются на связях  между требованиями, тестами и дефектами 
Quality Center. При изменении объекта проекта Quality Center оповещает  
все связанные объекты, на которые может повлять изменение этого 
объекта. Такие оповещения могут видеть все пользователи. Quality Center 
также уведомляет лиц, ответственных за определенные объекты, при 
изменений любых связанных объектов, на которые могут повлиять такие 
изменения. Дополнительные сведения см. в разделе “Описание 
оповещений" на стр. 80 и “Просмотр оповещений" на стр. 85.

➤ Follow up alerts. Можно установить флажок отслеживания  для 
конкретного требования, теста, экземпляра теста или дефекта. Такой 
флажок будет напоминать о необходимости отслеживания события. При 
наступлении даты начала отслеживанияQuality Center направлет 
сообщение по электронной почте. Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 88.

Описание оповещений
При изменении требования, теста или дефекта Quality Center оповещает 
связанные объекты и может уведомлять лиц, ответственных за связанные 
объекты. В Quality Center правила оповещений основываются на 
следующих создаваемых пользователем связях:

➤ Связь теста дерева плана тестирования с требованием. Эта связь 
устанавливается путем создания покрытия требований тестами в 
модуле Test Plan или покрытия тестов  в модуле Requirements. 
Дополнительные сведения см. в главе Глава 18, "Связывание тестов с 
требованиями".
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➤ Связь экземпляра теста с дефектом. Эта связь устанавливается путем 
создания связанных дефектов в модуле Test Plan или добавления 
дефекта во время выполнения ручного теста. Дополнительные сведения 
см. в главе Глава 32, "Связывание дефектов".

➤ В модуле Requirements можно создавать связи прослеживаемости между 
требованиями. Дополнительные сведения см. в главеГлава 13, 
"Отслеживание требований".

После установления связей в проекте с их помощью можно отслеживать 
изменения. При изменении объекта в проекте Quality Center оповещает все 
связанные объекты, на которые может оказать влияние данное изменение. 
Эти оповещения могут видеть все пользователи. Quality Center также 
уведомляет лиц, ответственных за определенные объекты, при изменении 
связанных объектов, на которые могут оказать влияние такие изменения.
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Администратор проекта Quality Center может активировать четыре правила 
оповещений:

Правило Описание
Объекты, 
помеченные 
флажком

Пользователь, 
уведомляемый 
по электронной 
почте

1 При изменении 
требования 
необходимо оповестить 
связанные тесты.

Примечание. 
Изменение требования 
— любая его 
модификация, за 
исключением 
изменений в поле 
Direct Cover Status и 
полях управления 
качеством на основе 
риска.

Тесты, 
покрывающие 
требование

Разработчик 
тестов. 

2 При изменении статуса 
дефекта на ‘Fixed’ 
необходимо оповещать 
связанные экземпляры 
теста.

Экземпляры теста, 
связанные с 
дефектом

Тестировщик 
экземпляров 
теста.

3 При успешном 
выполнении теста 
(статус изменился на 
«Passed») необходимо 
оповещать связанные 
дефекты.

Дефекты, 
связанные с 
выполнением 
теста

Пользователь, 
задающий данный 
дефект

4 При изменении или 
удалении требования 
необходимо оповещать 
требования, к которым 
выполняется 
отслеживание, и 
дочерние требования. 

Дочерние 
требования и 
требования, к 
которым 
выполняется 
отслеживание. 

Автор требования.
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Дополнительные сведения об активации правил оповещения в окне Project 
Customization см. в Руководство администратора HP Quality Center.

Пример оповещения
Предположим, используется проект QualityCenter_Demo, основанный на 
приложении Mercury Tours.  В окне Project Customization администратор 
проекта активирует первое правило: При изменении требования 
необходимо оповестить связанные тесты. Администратор проекта также 
указывает, что уведомления должны отправляться по электронной почте.

В модуле Requirements менеджер по контролю качества определяет 
требование Page Download Time (под Application Performance). 

Затем в модуле Test Plan менеджер по контролю качества определяет 
новый тест Connect_Site_Stress для этого требования (на Mercury Tours 
Site > Welcome Page). На вкладке Details администратор проекта 
назначает новый тест разработчику Сесил.
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На вкладке Req Coverage менеджер по контролю качества связывает тест 
Connect_Site_Stress с требованием Page Download Time. 

Тестировщик по контролю качества Майк анализирует требование Page 
Download Time и решает, что 10 секунд на загрузку страницы — это 
слишком много. Он изменяет в описании требования 10 секунд на 7 секунд. 
В результате теперь Сесил должен внести изменения в свой тест 
Connect_Site_Stress таким образом, чтобы он отвечал измененным 
требованиям. 
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После активации правила, поскольку Майк внес изменения в требование, 
Quality Center должен установить флажок для связанного теста. Этот 
флажок видит разработчик теста Сесил, и все остальные пользователи 
проекта.  

Если щелкнуть флажок оповещения, открывается диалоговое окно Alerts, 
содержащее сведения об изменении. Дополнительные сведения см. в 
разделе “Просмотр оповещений" на стр. 85. 

Кроме того, разработчик тестов Сесил получает по электронной почте 
автоматическое уведомление Quality Center с описанием изменения, 
внесенного в требование Page Download Time Майком, и рекомендацией 
проверить связанный тест Connect_Site_Stress. Сесил щелкает ссылку, 
чтобы открыть окно Quality Center , содержащее заданное требование или 
тест.

Просмотр оповещений
Можно просматривать список оповещений для выбранного объекта. 
Допускаются следующие объекты:

➤ требование в модуле Requirements;

➤ тест в дереве плана тестирования или в таблице Test;

➤ экземпляр теста в таблице Execution;
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➤ дефект в диалоговом окне Defects Grid или Defect Details.

Примечание. Также можно просмотреть список всех оповещений для 
определенного модуля, выбрав в диалоговом окне Filter параметр Show 
<entity> with alerts. Дополнительные сведения см. в разделе “Применение 
расширенных/перекрестных фильтров для записей" на стр. 65.

Дополнительные сведения о создании оповещений с помощью 
Quality Center см. в разделе “Описание оповещений" на стр. 80.

Для просмотра оповещений:

 1 Выберите объект с оповещением следующим образом:

➤ В главном модуле щелкните флажок Alerts  в столбце Alerts дерева 
или таблицы. Если этот столбец не отображается, выберите View > 
Indicator Columns. Альтернативный вариант — выберите Edit > Alerts. 

➤ В диалоговых окнах Defect Details нажмите кнопку Alerts.

Красный флажок указывает на то, что это новое оповещение. Серый 
флажок указывает на то, что это оповещение уже прочитано.

Откроется диалоговое окно Alerts.

Quality Center отображает выбранный объект и список оповещений. Чтобы 
выделить элемент в Quality Center, щелкните ссылку в диалоговом окне.
86



Глава 4 • Оповещение об изменениях
 2 Чтобы удалить отдельное оповещение, нажмите кнопку Delete Alert или 
нажмите кнопку Clear All, чтобы удалить все оповещения для объекта. Для 
подтверждения нажмите кнопку Yes. Учтите, что пользователь может 
удалять только те оповещения, которые предназначено только ему.  
Пользователь, которому предназначено оповещение, — пользователь, 
которому при инициации оповещения посылается уведомление по 
электронной почте. Список оповещений и пользователей, которым 
направляются уведомления по электронной почте, см. в разделе 
“Описание оповещений" на стр. 80.

 3 Закройте диалоговое окно Alerts.

Удаление оповещений
В диалоговом окне Alerts можно удалять либо отдельное, либо все 
оповещения для выбранного объекта. Дополнительные сведения о 
диалоговом окне Alerts см. в разделе “Просмотр оповещений" на стр. 85.

Кроме того, можно удалять все оповещения, связанные со всеми 
объектами в модуле Quality Center. При выборе этого параметра будут 
удалены только те оповещения, которые связаны с объектами, 
соответствующими текущему фильтру. Кроме того, пользователь может 
удалять только те оповещения, которые предназначены только ему. 
Пользователь, которому предназначено оповещение, — это пользователь, 
которому при инициации оповещения посылается уведомление по 
электронной почте. Такой пользователь указывается в списке оповещений 
в диалоговом окне Alerts. Список оповещений и пользователей, которым 
направляются уведомления по электронной почте, см. в разделе 
“Описание оповещений" на стр. 80.

Для удаления всех оповещений в модуле:

 1 При работе в модуле Requirement, Test Plan или Defects выберите Edit > 
Clear Alerts. При работе в модуле Test Lab выберите Tests > Clear Alerts.

 2 Для подтверждения нажмите кнопку Yes. Оповещения будут удалены.
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Установка флажков для отслеживания
Quality Center позволяет пользователям добавлять к автоматическим 
уведомлениям об отслеживании собственные оповещения. Флажки для 
отслеживания можно использовать для напоминания о необходимости 
отследить определенное событие. Например, можно установить флажок 
отслеживания для дефекта, чтобы он напоминал о необходимости 
проверить его через неделю. 

Можно устанавливать флажки отслеживания для:

➤ требования в модуле Requirements;

➤ теста в дереве плана тестирования или в таблице Test;

➤ экземпляра теста в таблице Execution;

➤ дефекта в диалоговом окне Defects Grid или Defect Details.

При добавлении флажка Quality Center добавляет к записи значок серого 
флажка . В любой момент можно открыть оповещение об отслеживании, 
чтобы просмотреть нужные сведения.  При наступлении даты начала 
отслеживания Quality Center направляетсообщение по электронной почте и 
меняет цвет значка флажка на красный. 

 Для оповещение об отслеживании Quality Center также отображает 
информационную панель. Эта панель отображается в правой области 
дерева плана тестирования для отслеживания теста, в диалоговом окне 
Test Instance Properties для отслеживания экземпляра теста и в диалоговом 
окне Defect Details для отслеживания дефекта. 

Примечание. Флажок отслеживания связан с конкретным именем 
пользователя. Другие пользователи, просматривающие данную запись, не 
могут видеть флажок отслеживания для этого пользователя.

Можно либо создавать новые оповещения об отслеживании, либо 
просматривать и изменять существующее оповещения.
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Создание оповещений об отслеживании
Можно создавать оповещение об отслеживании для требования, теста, 
экземпляра теста или дефекта. 

Для создания оповещения об отслеживании:

 1 Выберите запись, для которой необходимо установить флажок 
отслеживания. Нажмите кнопку Flag for Follow Up или щелкните запись 
правой кнопкой мыши и выберите Flag for Follow Up. Откроется 
диалоговое окно Flag For Follow Up. 

 2 В поле Follow up by выберите дату, когда Quality Center должен отправить 
сообщение об отслеживании по электронной почте.

 3 В поле Description введите напоминание, которое необходимо отобразить.

 4 Нажмите кнопку OK. Quality Center сохранит оповещение об отслеживании 
и добавит к записи значок флажка .

Изменение флажков отслеживания
Можно открыть оповещение об отслеживании, созданное для записи. 
Можно просматривать и изменять сведения о нем или удалить его. 
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Для изменения оповещение об отслеживании:

 1 В дереве или таблице щелкните значок флажка  записи в столбце Follow 
Up Flag. Если этот столбец не отображается, выберите View > Indicator 
Columns. Откроется диалоговое окно Flag For Follow Up. 

 2 Чтобы изменить оповещение, измените поле Follow up by date или 
Description. Нажмите кнопку OK, чтобы закрыть диалоговое окно.

 3 Чтобы удалить флажок отслеживания, нажмите кнопку Clear Flag. Нажмите 
кнопку Yesдля подтверждения и закройте диалоговое окно.
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Добавление вложений

Можно добавлять вложения в запись Quality Center.

Глава содержит следующие разделы: На стр.

Сведения о вложениях 92

Вложение файла 93

Вложение URL-адреса 93

Вложение снимка 94

Вложение сведений о системе 96

Вложение элементов буфера обмена 97

Управление вложениями 97
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Сведения о вложениях
Чтобы проиллюстрировать ход работ во время процесса тестирования 
можно добавлять вложения. Можно добавлять файлы, URL-адреса, снимки 
приложения, элементы буфера обмена или сведения о системе. При 
добавлении вложения к записи Quality Center добавляет к ней значок . 

Для управления вложениями используется окно Attachments. 

Управлять вложениями также можно на вкладке Attachments и в 
диалоговых окнах New Defect, Defect Details и Requirement Details.
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Вложение файла 
В запись Quality Center можно вложить файл.

Вложение файла

 1 В диалоговом окне Attachments нажмите кнопку File. Откроется диалоговое 
окно Open.

 2 Выберите имя файла и нажмите кнопку Open. Альтернативный вариант — 
дважды щелкните имя файла. 

Имя файла появится в списке Attachments вместе с размером файла и 
датой его изменения. Рядом с именем файла появится значок приложения, 
связанного с этим файлом.

 3 В поле Description можно ввести комментарии к вложенному файлу.

Вложение URL-адреса 
В запись Quality Center можно добавлять вложения URL-адресов. Он 
представляет собой любую допустимую схему URL-адресов, например 
HTTP, FTP, Gopher, News, Mailto и File.

Вложение URL-адреса:

 1 В диалоговом окне Attachments нажмите кнопку URL. Откроется 
диалоговое окно Attach Uniform Resource Locator (URL).

 2 В поле URL введите допустимый URL-адрес и нажмите кнопку OK. 

URL-адрес появится в списке Attachments. Рядом с URL-адресом появится 
значок веб-обозревателя по умолчанию.

 3 В поле Description можно ввести любые комментарии к вложенному URL-
адресу.
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Вложение  снимка 
В запись Quality Center можно добавлять вложения снимков приложения.

Вложение снимка

 1 В диалоговом окне Attachments нажмите кнопку Snapshot. Откроется 
диалоговое окно Snapshot.

 2 Перетащите значок camera на объект, снимок которого необходимо 
сделать. Снимок этого объекта отобразится в диалоговом окне Snapshot.

 3 Изменение размера снимка 

➤ Для выбора нужного размера изображения нажмите кнопку Zoom Out 
или кнопку Zoom In. 

➤ Чтобы вернуться к стандартному размеру изображения, нажмите кнопку 
Normal.

 4 Нажмите кнопку Attach. 
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Quality Center присвоит изображению уникальное имя файла с 
расширением .jpg. В списке Attachments появится это имя файла со 
значком изображения. Также отобразятся размер файла и дата его 
изменения.

 5 В поле Description можно ввести комментарии к вложенному снимку.
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Вложение сведений о системе
В запись Quality Center можно добавлять сведения о компьютере.

Вложение сведений о системе

 1 В диалоговом окне Attachments нажмите кнопку System Info. Откроется 
диалоговое окно System Information.

 2 Для вложения сведений из одной вкладки, выберите вкладку и нажмите 
кнопку Current Topic. 
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 3 Для вложения сведений со всех вкладок, нажмите кнопку All Topics.

Сведениям присваивается уникальное имя файла с расширением .tsi. В 
списке Attachments появляется имя файла со значком. Также 
отображаются размер файла и дата его изменения.

 4 В поле Description можно ввести комментарии к вложенному текстовому 
файлу.

Вложение элементов буфера обмена 
В запись Quality Center можно добавлять вложения текста и изображений, 
скопированные в буфер обмена.

Для вложения элемента буфера обмена:

 1 Скопируйте текст или изображение в буфер обмена.

 2 В диалоговом окне Attachments нажмите кнопку Clipboard.

Тексту будет присвоено уникальное имя файла с расширением .txt. 
Изображению будет присвоено уникальное имя файла с расширением .jpg. 
Вложенный файл со значком появится в списке Attachments. Также 
отобразятся размер файла и дата его изменения.

Управление вложениями
Просматривать, изменять, сохранять и удалять вложения можно либо в 
диалоговом окне Attachments, либо на вкладке Attachments.

Просмотр вложений
Просматриваать вложения можно в списке Attachments.

Для просмотра вложения:

 1 В списке Attachments выберите вложение. Соответствующее описание 
отобразится ниже в поле Description.
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 2 Дважды щелкните вложение или нажмите кнопку Download and Open. 
Вложение откроется в соответствующем приложении. Например, URL-
адрес открывается в веб-обозревателе по умолчанию.

Изменение вложений
Изменять вложения можно в списке Attachments. При открытии вложения в 
связаном с ним приложении Quality Center загружает вложение в 
локальный каталог на клиентском компьютере. После внесения изменений 
во вложение его необходимо сохранить дважды. Сначала необходимо 
сохранить вложение на локальном диске в том приложении, с помощью 
которого оно было открыто. Затем в Quality Center нажмите кнопку Upload 
Selected, чтобы сохранить локальную копию вложения в проекте 
Quality Center. 

Для изменения вложения:

 1 Дважды щелкните вложение в списке Attachments. Локальная копия 
вложения откроется в связанном с ним приложении. 

 2 Внесите изменения во вложение.

 3 Сохраните вложение в приложении —   сохранится локальная копия 
вложения.

 4 Закройте вложение.

 5 В Quality Center нажмите кнопку Upload Selected в диалоговом окне 
Attachments –   сохранится локальная копия вложения в проекте 
Quality Center.

Сохранение вложений
Можно сохранять вложения в локальном каталоге на клиентском 
компьютере.

Для сохранения вложения: 

 1 В списке Attachments выберите вложение и нажмите кнопку Save As. 
Откроется диалоговое окно Save Attachment.

 2 В поле Save in выберите папку для сохранения файла.

 3 В поле File name введите имя файла.
98



Глава 5 • Добавление вложений
 4 Нажмите кнопку Save. Вложение загружается и сохраняется в локальном 
каталоге на клиентском компьютере.

Удаление вложений
Можно удалять вложения из списка Attachments.

Для удаления вложения:

 1 В списке Attachments выберите вложение, которое необходимо удалить. 
Чтобы выбрать несколько вложений, используйте клавишу CTRL.

 2 Нажмите кнопку Delete Selected, а затем — кнопку Yes для подтверждения 
операции.
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6
Работа с избранными представлениями 

 Избранное представление — это представление окна Quality Center с 
выбранными пользователем настройками. Можно сохранять избранные 
представления для последующей их загрузки. 

Сведения об избранных представлениях
 При помощи настроек можно установить желаемый вид окна 
Quality Center, необходимо выбрать для него определенные настройки. Эти 
настройки включают в себя, например, применение фильтра для столбцов 
таблицы, сортировку полей в отчете или определение вида диаграммы. 
Можно сохранить избранное представление для его последующего 
использования и загрузки (при необходимости).

Можно сохранять избранные представления либо в папке public, либо в 
папке private. Представления из папки public доступны всем 
пользователям. Представления из папки private доступны только 
пользователям, создавшим их. 

Глава содержит следующие разделы: На стр.

Сведения об избранных представлениях 101

Добавление избранных представлений 103

Загрузка избранных представлений 104

Обновление представлений 104

Упорядочивание избранных представлений 105
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Некоторые команды, связанные с избранными представлениями, доступны 
только определенным группам пользователей. Дополнительные сведения 
о привилегиях групп пользователей см. в Руководство администратора 
HP Quality Center.

Примечание. Порядок работы с избранными представлениями, 
приведенный в этой главе, может отличаться от того, который 
используется в модуле Test Lab, отчетах, диаграммах и Генераторе 
документов Quality Center. 

➤ В модуле Test Lab выберите Tests > Favorites, чтобы отобразить 
команды, связанные с избранными представлениями. Чтобы загрузить 
существующее представление, выберите View. Выберите Add, чтобы 
добавить новое представление. Чтобы упорядочить представления, 
выберите Organize. 

➤ В отчетах и диаграммах Quality Center нажмите кнопку Add to Favorites, 
чтобы добавить новое представление, или кнопку Edit Favorites, чтобы 
упорядочить представления.

➤  В Генераторе документов нажмите кнопку Add to Favorites, чтобы 
добавить новое представление, или кнопку Favorites, чтобы 
упорядочить представления.
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Добавление избранных представлений 
Можно добавлять представления в папку private или в папку public.

Для добавления избранных представлений:

 1 Выберите Favorites > Add to Favorites. Откроется диалоговое окно Add 
Favorite.

 2 В поле Name введите имя представления.

 3 В Location: 

➤ Выберите Private, чтобы добавить представление в папку private. 
Избранные представления из этой папки доступны только для 
пользователя, создавшего их. 

➤ Выберите Public, чтобы добавить представление в общую папку. 
Избранные представления из этой папки доступны для всех 
пользователей проекта.

Избранные представления, содержащиеся в выбранной папке, 
отображаются в списке Existing Favorites.

 4 Нажмите кнопку OK. Новое представление добавляется в папку ‘private 
’или в папку ‘public’.
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Загрузка избранных представлений
Можно загрузить существующее представление в окне Quality Center.

Загрузка избранных представлений:

➤ Для загрузки недавно использовавшегося представления откройте меню 
Favorites и выберите нужное представление.

Примечание. По умолчанию в меню Favorites приложения Quality Center 
отображаются четыре недавно использовавшихся представления. Задать 
количество отображаемых в меню представлений можно с помощью 
параметра FAVORITES_DEPTH вкладки Site Configuration в Site 
Administration. Дополнительные сведения см. в Руководство 
администратора HP Quality Center.

➤ Чтобы загрузить избранное представление , выберите Favorites > Private 
или Favorites > Public и щелкните нужное представление.

Альтернативный вариант — на панели инструментов модуля выберите 
представление из панели Favorite. По умолчанию панель Favorite не 
отображается. Чтобы ее на отобразить, выберите View > Favorite Bar. 
Панель Favorite доступна только из таблицы Quality Center.

Обновление представлений
Можно обновить настройки существующего представления.

Для обновления представления:

 1 Загрузите избранное представление из меню Favorites. Дополнительные 
сведения см. в разделе “Загрузка избранных представлений" на стр. 104.

 2 Внесите изменения в представление.

 3 Выберите Favorites > Add to Favorites. Откроется диалоговое окно Add 
Favorite.
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 4 В списке Existing Favorites выберите имя нужного представления и 
нажмите кнопку OK.

 5 Нажмите кнопку Yes, чтобы заменить предыдущие настройки.

Упорядочивание избранных представлений
Упорядочить список избранных представлений в папках private и public 
можно, изменяя свойства представлений или удаляя представления.

Для упорядочивания избранных представлений:

 1 Выберите Favorites > Organize Favorites. Откроется диалоговое окно 
Organize Favorites.

 2 Чтобы изменить свойства представления, выберите представление из 
списка и нажмите кнопку Properties. Откроется диалоговое окно Properties.

 3 В поле Name введите новое имя представления. 
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 4 Выберите Location:

➤ Выберите Private, чтобы добавить имя представления в папку private. 
Доступ к этой папке имеет только создавший ее пользователь.

➤ Выберите Public, чтобы добавить имя представления в общую папку. 
Доступ к этой папке имеют все пользователи.

 5 Нажмите кнопку OK, чтобы сохранить свойства представления. Для 
подтверждения нажмите кнопку Yes.

 6 Чтобы удалить избранное представление, выберите его из списка и 
нажмите кнопку Delete. Для подтверждения нажмите кнопку OK.

 7 Нажмите кнопку Close, чтобы закрыть диалоговое окно Organize Favorites.
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7
Процесс управления релизами

Процесс тестирования приложения начинается с определения дерева 
релизов в модуле Releases. 

В главе описано, как использовать Quality Center для управления 
жизненным циклом релиза. Процесс управления релизами включает в себя 

следующие этапы.
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Перед началом использования Quality Center пользователь должен 
убедиться, что существует проект, в который он должен ввести данные. 
Сведения о создании проектов приведены в Руководство 
администратора HP Quality Center.

Определение релизов и циклов
Основным компонентом модуля Releases является дерево релизов. Оно 
позволяет моделировать следующие релизы в иерархической структуре 
дерева. 

Руководитель проекта начинает работу с определения папки релизов 
вместе с ее релизами. Релиз представляет собой группу изменений, 
внесенных в одно или несколько приложений, которые доступны для 
одновременного распространения После определения релиза менеджер по 
контролю качества определяет циклы. Цикл представляет собой 
последовательность действий по разработке и контролю качества для 
достижения общей цели на основе временных рамок релиза.

Предположим, необходимо определить следующие релизы примера 
приложения Mercury Tours. Папка Mercury Tours Application содержит 
релиз Release 10.5. Этот релиз включает в себя четыре цикла. Можно 
определять релизы и циклы в дереве релизов следующим образом:

Дополнительные сведения об определении релизов см. в главеГлава 9, 
"Создание дерева релизов".
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Назначение требований
После определения дерева релизов менеджер по контролю качества 
определяет и анализирует требования в модуле Requirements и назначает 
их релизам и циклам. Требования содержат подробное описание того, что 
необходимо протестировать в приложении. 

Например, в дереве требований в папке Mercury Tours Application можно 
назначить требования Booking System и Application Security  циклу Cycle 
1 - New Features релиза Release 10.5.

На основе требований составляется план тестирования в модуле Test Plan. 
Тесты, созданные на этапе разработки плана тестирования, должны 
покрывать эти требования. 

Дополнительные сведения о требованиях приведены в главе Глава 12, 
"Разработка дерева требований".

Дополнительные сведения о разработке плана тестирования приведены в 
главеГлава 17, "Создание дерева плана тестирования". Дополнительные 
сведения о покрытии требований тестами приведены в главе Глава 18, 
"Связывание тестов с требованиями".
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Назначение и выполнение наборов тестов
После назначения требований менеджером по контролю качества 
руководитель группы контроля качества назначает каждую папку test set 
циклу в модуле Test Lab. Набор тестов представляет собой группу 
экземпляров тестов в проекте Quality Center, предназначенных для 
достижения конкретных целей тестирования. 

Например, в дереве наборов тестов релиза Release 10.5 можно назначить 
следующие папки наборов тестов.

Каждая папка наборов тестов назначается циклу. Например, папка набора 
тестов Cycle 1 назначена циклу Cycle 1 - New Features. 

После того, как руководитель группы контроля качеств назначит папки 
наборов тестов циклу, инженер по контролю качества выполняет наборы 
тестов, расположенные в соответствующих папках. 

Дополнительные сведения о наборах тестов см. в главеГлава 24, 
"Создание набора тестов". Дополнительные сведения о выполнении тестов 
см. в главахГлава 26, "Выполнение тестов вручную" и Глава 27, 
"Автоматическое выполнение тестов".
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Назначение дефектов
Если во время выполнения набора тестов был обнаружен дефект 
приложения, инженер по контролю качества документирует его в проекте. 
Quality Center автоматически создает связь между выполняемым тестом, 
связанным с релизом и циклом, и новым дефектом. 

Предположим, дефект был обнаружен во время выполнения экземпляра 
теста из набора в папке Cycle 1. Если дефект документируется в проекте 
впервые, релизу Release 10.5 назначается поле Detected in Release , а 
циклу Cycle 1 - New Features — поле Detected in Cycle. 

В процессе анализа и определения того, какие дефекты необходимо 
устранить, менеджер по контролю качества назначает их 
соответствующему релизу и циклу. 

Предположим, что устранение дефекта запланировано в следующем 
цикле. Назначьте поле Target Release релизу Release 10.5, а поле Target 
Cycle – циклу Cycle 2 - New Features + Regression. 

Дефект можно задокументировать в проекте Quality Center из любого 
модуля на любом этапе процесса тестирования.

Дополнительные сведения о документировании дефектов см. в главе 
Глава 31, "Добавление и отслеживание дефектов".

Анализ релизов и циклов
После заврешения выполнения тестов менеджер по контролю качества 
анализирует процесс тестирования, чтобы определить его соответствие 
целям релиза. Менеджер по контролю качества также определяет, сколько 
дефектов было устранено, а сколько еще осталось открытыми. Результаты 
можно проанализировать на уровне релиза или цикла. 

Менеджер по контролю качества может отслеживать ход выполнения 
процесса тестирования в реальном времени путем анализа дерева 
релизов и обеспечения его соответствия целям релиза. Дополнительные 
сведения об анализе результатов тестирования на уровне релиза или на 
уровне цикла см. в главеГлава 9, "Создание дерева релизов".
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Краткий обзор модуля Releases

В главе содержится краткое описание основных элементов модуля 
Releases.

Глава содержит следующие разделы: На стр.

Модуль Releases 116

Строка меню модуля Releases 117

Панель инструментов модуля Releases 117

Поля релизов и циклов 118
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Модуль Releases
Определение релизов и циклов в Quality Center выполняется в модуле 
Releases. Для открытия окна этого модуля необходимо нажать кнопку 
Releases в доковой панели. 

Модуль Releases содержит следующие основные элементы:

➤ Строка меню модуля Releases. Содержит раскрывающиеся меню с 
командами модуля Releases. 

➤ Панель инструментов модуля Releases. Содержит кнопки вызова команд 
модуля Releases. 

➤ Вкладка Details. Описывает папку релизов, релиз или цикл, выбранный в 
настоящий момент в дереве релизов. Также указывает диапазон дат 
создания релизов и циклов. Область Statistics содержит требования и 
папки наборов тестов, связанные с релизом или циклом.

➤ Вкладка Attachments. Содержит перечень вложений, содержащих 
дополнительные сведения о папке релизов, релизе или цикле, выбранной в 
настоящее время. Дополнительные сведения см. в главеГлава 5, 
"Добавление вложений".
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➤ Вкладка Progress. Содержит краткий обзор процесса создания релиза или 
цикла. Дополнительные сведения см. в разделе “Просмотр хода 
выполнения покрытия для релизов и циклов" на стр. 130.

➤ Вкладка Quality. Отображает количество дефектов, обнаруженных в 
процессе создания релиза или цикла. Также показывает количество 
неустраненных дефектов. Дополнительные сведения см. в разделе 
“Просмотр дефектов для релизов и циклов" на стр. 134.

Строка меню модуля Releases 
Строка меню Releases включает в себя следующие меню:

➤ Меню Releases содержит команды, позволяющие добавлять папки 
релизов, релизы и циклы. 

➤ Меню Edit содержит команды, позволяющие вырезать, вставлять, удалять 
и переименовывать папки релизов, релизы и циклы. Также содержит 
команду для создания копии цикла.

➤ Меню View содержит команды, позволяющие раскрывать и свертывать 
дерево релизов. Также содержит команду обновления дерева релизов.

Панель инструментов модуля Releases 
Панель инструментов модуля Releases содержит следующие кнопки:

Папка New Release. Добавление новой папки релиза в дерево релизов. 

New Release. Добавление нового релиза в дерево релизов. 

New Cycle. Добавление нового цикла в дерево релизов.

Cut. Вырезает папку релизов или релиз из дерева релизов для 
перемещения в другое место в дереве.

Paste. Вставляет вырезанную папку релизов или релиз в указанное место в 
дереве.

Duplicate Cycle. Создание копии цикла в том же релизе.
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Delete. Удаление выбранного элемента. При удалении папки релиза также 
удаляются релизы и циклы. При удалении релиза также удаляются его 
циклы.

Refresh All. Обновление дерева и вкладок релизов для отображения 
самых последних данных.

Поля релизов и циклов 
На вкладке Details модуля Releases отображаются следующие поля:

Примечания. 

➤ Диапазон дат создания циклов должен быть в пределах диапазона дат 
создания релизов.

➤ В модуле Releases можно добавлять поля, определенные 
пользователем, и изменять метки любых полей. Дополнительные 
сведения см. в Руководство администратора HP Quality Center.

Поле Описание

Name Имя папки релиза, релиза или цикла.

Start Date Дата начала создания релиза или цикла. Нажмите кнопку 
вниз, чтобы отобразить календарь и выбрать дату начала. 

End Date Дата завершения создания релиза или цикла. Нажмите кнопку 
вниз, чтобы отобразить календарь и выбрать дату 
завершения.

Statistics Статистические данные о требованиях и папках наборов 
тестов, назначенных релизам и циклам.

Description Описание папки релиза, релиза или цикла.
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9 
Создание дерева релизов

Зачастую процесс создания релизов приложения является весьма 
сложным. Требования, тесты и дефекты, содержащиеся в проекте, должны 
быть определены в соответствии с приоритетами бизнес-целей и 
требованиями к качеству приложения.  Большинство приложений требуют 
тестирования на различных аппаратных платформах с использованием 
разных конфигураций (компьютеров, операционных систем и 
веб-обозревателей) и различных версий приложений. Управление всеми 
аспектами создания релиза приложения может потребовать много времени 
и быть сложным. В модуле Releases можно упорядочивать и отслеживать 
следующие релизы путем определения дерева релизов.

Глава содержит следующие разделы: На стр.

Сведения о создании дерева релизов 120

Создание дерева релизов 126

Добавление релизов в папки 126

Добавление циклов в релизы 127

Просмотр назначенных требований и папок наборов тестов 128

Просмотр хода выполнения покрытия для релизов и циклов 130

Просмотр дефектов для релизов и циклов 134

Изменение дерева релизов 137
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Сведения о создании дерева релизов 
В модуле Releases можно упорядочивать и отслеживать следующие 
релизы путем определения иерархического дерева релизов, содержащего 
релизы и циклы. Релиз представляет собой группу изменений, внесенных в 
одно или несколько приложений, которые будут доступны одновременно 
для распространения. Каждый релиз может содержать несколько циклов. 
Цикл представляет собой этап разработки и контроля качества на основе 
временных рамок проекта. Как релизы, так и циклы имеют заданные даты 
начала и завершения их создания.

После определения дерева релизов составьте требования в модуле 
Requirements и назначьте их релизам и циклам (см. главу Глава 12, 
"Разработка дерева требований"). Требования подробно описывают, что 
необходимо протестировать в приложении.

Для покрытия требований тестами (чтобы убедиться, что все компоненты, 
разработанные в конкретном цикле полностью протестированы) создайте 
тесты в модуле Test Plan (см. Глава 17, "Создание дерева плана 
тестирования" и Глава 18, "Связывание тестов с требованиями"). 

Затем в модуле Test Lab создайте папку наборов тестов, в которой будут 
храниться наборы тестов. Затем назначьте ее циклу. Далее добавьте 
наборы тестов в созданную папку набора тестов. И, наконец, заврешите 
разработку плана тестового покрытия, добавив тесты в каждый набор (см. 
главу Глава 24, "Создание набора тестов").

После этого выполните наборы тестов (см. главы Глава 26, "Выполнение 
тестов вручную", и Глава 27, "Автоматическое выполнение тестов"). При 
обнаружении дефектов приложения можно документировать их в проекте 
путем их назначения конкретному релизу или циклу в дереве релизов (см. 
Глава 31, "Добавление и отслеживание дефектов"). Это позволит всем 
разработчикам и тестировщикам определить, какие дефекты необходимо 
устранить и срок их устранения. 

После выполнения заданных наборов тестов можно проанализировать ход 
выполнения процесса создания релиза в модуле Releases, чтобы 
убедиться, что он соответствует целям релиза. Также можно определить 
количество обнаруженных дефектов и количество неустраненных 
дефектов. Результаты тестирования можно проанализировать на уровне 
релиза или цикла.
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Пример управления релизами
Предположим, что выполняется разработка приложения бронирования 
авиабилетов. Запланировано разработать версию 10.5 за четыре месяца. 
Данный релиз включает в себя четыре цикла. Первый цикл заключается в 
тестировании новых функций. Второй цикл предназначен для 
регрессионного тестирования. В третьем цикле выполняется тестирование 
работоспособности релиза. В четвертом цикле проверяются все 
функциональные возможности приложения. Дерево релизов можно 
определить следующим образом:

В модуле Requirements следует определить, какие требования необходимо 
покрыть тестами в каждом цикле, и назначить их соответствующим циклам. 
Затем в модуле Test Plan необходимо создать тесты и связать их с 
назначенными требованиями, чтобы создать покрытие. 

В модуле Test Lab создайте папки наборов тестов и назначьте их 
конкретным циклам. В данном примере можно определить вложенные 
папки наборов тестов Cycle 1, Cycle 2, Cycle 3 и Cycle 4:

Учтите, что после назначения папки наборов тестов циклу значок  папки 
набора тестов заменяется значком  назначенной папки набора тестов.
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Затем для каждой назначенной папки набора тестов создайте наборы 
тестов и добавьте в них тесты, например: 
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После выполнения наборов тестов из назначенных папок можно 
проанализировать ход выполнения процесса создания релиза с помощью 
вкладки Progress, чтобы убедиться, что он соответствует целям создания 
релиза. На этой вкладке отображается краткий обзор хода выполнения 
процесса создания релиза. Ниже приведен пример создания релиза 
Release 10.5. 

В верхней области показано общее количество дней, необходимое для 
создания релиза и количество дней, оставшихся для завершения релиза, 
общее количество экземпляров тестов для создания релиза, количество 
выполненных и невыполнявшихся экземпляров тестов и многое другое. 

В нижней области приведена диаграмма хода выполнения покрытия. На 
диаграмме эти кривые отображаются аккумулятивно, т.е. каждая кривая 
рассчитывается на основе накапливающихся данных о релизе с начала 
процесса создания релиза. 
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Кривая Assigned requirements отображает распределение назначенных 
требований по циклам релиза. В этом примере кривая показывает, что цикл 
Cycle 4 - Full выполнен на 100%. 

Кривая Planned coverage, расположенная под кривой Assigned 
requirements, показывает количество покрытых требований (в процентах), 
для всех циклов релиза. В этом примере в цикле Cycle 4 - Full покрыто 
только 60% требований.

Кривая Executed coverage, расположенная под кривой Planned coverage, 
показывает количество тестов, выполненных в ходе выполнения процесса 
создания релиза. В этом примере кривая показывает, что в цикле Cycle 4 - 
Full выполнено только 40% назначенных тестов.

Кривая Passed Coverage располагается под кривой Executed coverage. 
Она показывает количество выполненных тестов, имеющих последний 
статус «Пройден». В этом примере кривая показывает, что цикл Cycle 4 - 
Full выполнен на 20%.
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Для каждого цикла на вкладке Quality можно просматривать количество 
задокументированных дефектов и их серьезность. Предположим, что во 
время выполнения наборов тестов Cycle 1 из папки набора тестов Release 
10.5  были обнаружены четыре дефекта приложения. В дереве релизов 
выберите цикл Cycle 1 - New Features и перейдите на вкладку Quality, 
чтобы просмотреть количество дефектов, обнаруженных во время 
выполнения цикла. Дефекты распределяются по уровням серьезности от 
1-Low до 5-Urgent.

На диаграмме Defect Opening Rate видно, что четыре дефекта были 
обнаружены во время тестирования в первом цикле. Двум дефектам был 
задан уровень серьезности 3-High, одному дефекту — 5-Urgent и еще 
одному дефекту — уровень серьезности 2-Medium.
125



Глава 9 • Создание дерева релизов
На диаграмме Outstanding Defects видно, что два из четырех дефектов пока 
не устранены. Одному дефекту задан уровень серьезности 2-Medium, а 
второму — 3-High.

Создание дерева релизов
Для построения иерархической структуры релизовм необходимо создать 
дерево релизов. В каждой папке релизов дерева определяются релизы, в 
которые добавляются циклы. Создание дерева релизов начинается с 
добавления папки в корневую папку Releases.

Для создания дерева релизов:

 1 В дереве релизов выберите папку Releases.

 2 Нажмите кнопку New Release Folder или выберите Releases > New 
Release Folder. Откроется диалоговое окно New Release Folder.

 3 Введите Release Folder Name и нажмите кнопку OK. Новая папка будет 
добавлена в дерево релизов в папку Releases.

 4 На вкладке Details введите описание папки релизов.

 5 При необходимости перейдите на вкладку Attachments, чтобы добавить 
вложение в папку. Вложение может представлять собой файл, URL-адрес, 
снимок приложения, элемент буфера обмена или сведения о системе. 
Дополнительные сведения см. в главеГлава 5, "Добавление вложений".

 6 Для создания дополнительных папок выберите папку и повторите шаги 2и 
5.

Добавление релизов в  папки
После создания дерева релизов можно добавлять релизы в папки релизов. 
Добавьте циклы для каждого определенного релиза.

Для добавления релиза в папку релизов:

 1 Выберите папку релизов в дереве.

 2 Нажмите кнопку New Release  или выберите Releases > New Release. 
Откроется диалоговое окно New Release. 
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 3 Введите Release Name и щелкните OK. Новый релиз появится под 
раскрытой папкой релизов.

 4 На вкладке Details введите следующие подробные сведения о релизе:

 5 При необходимости перейдите на вкладку Attachments, чтобы добавить 
вложение в релиз. Вложением может быть файл, URL-адрес, снимок 
приложения, элемент буфера обмена или сведения о системе. 
Дополнительные сведения см. в главеГлава 5, "Добавление вложений".

 6 Для создания дополнительных релизов выберите папку релизов и 
повторите шаги 2 — 5.

Добавление циклов  в релизы
После добавления релизов в папки, в каждый релиз можно добавлять 
циклы.

Для добавления цикла в релиз:

 1 Выберите релиз в дереве.

 2 Нажмите кнопку New Cycle или выберите Releases > New Cycle. Откроется 
диалоговое окно New Cycle. 

 3 Введите Cycle Name и щелкните OK. Новый цикл появится под раскрытым 
релизом.

Поле Описание

Start Date Дата начала создания релиза. Нажмите кнопку вниз, чтобы 
отобразить календарь и выбрать дату начала.

End Date Дата завершения создания релиза. Нажмите кнопку вниз, чтобы 
отобразить календарь и выбрать дату завершения.

Описание Введите описание релиза.
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 4 На вкладке Details введите следующие подробные сведения о цикле:

Учтите, что диапазон дат создания циклов должен входить в диапазон дат 
создания релизов.

 5 При необходимости перейжите на вкладку Attachments, чтобы добавить 
вложение в цикл. Вложение может представлять собой файл, URL-адрес, 
снимок приложения, элемент буфера обмена или сведения о системе. 
Дополнительные сведения см. в главе Глава 5, "Добавление вложений".

 6 Для создания дополнительных циклов выберите релиз и повторите шаги 2 
— 5.

Просмотр назначенных требований и папок наборов тестов
Можно просматривать статистические данные о требованиях и папках 
наборов тестов, назначенных релизам и циклам.

Для просмотра требований, назначенных релизу или циклу:

 1 В дереве релизов выберите релиз или цикл.

Поле Описание

Start Date Дата начала создания цикла. Нажмите кнопку вниз, чтобы 
отобразить календарь и выбрать дату начала.

End Date Дата завершения создания цикла. Нажмите кнопку вниз, чтобы 
отобразить календарь и выбрать дату завершения.

Описание Введите описание цикла.
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 2 Перейдите на вкладку Details. Отобразятся подробные сведения о релизе 
или цикле. 

 3 Если выбран релиз, в области Statistics можно просмотреть следующие 
статистические данные: 

Параметр Описание

Requirements assigned to 
release

Отображает количество требований, связанных с 
выбранным релизом. Для просмотра в модуле 
Requirements требований, назначенных релизу, 
щелкните ссылку, чтобы отобразить количество 
требований. Альтернативный вариант — в дереве 
релизов щелкните правой кнопкой мыши релиз и 
выберите Show Requirements.
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Если в области Statistics выбран цикл, можно просмотреть следующие 
статистические данные:

Просмотр хода выполнения покрытия для релизов и 
циклов

На вкладке Progress отображаются статистические данные и диаграммы, 
показывающие ход выполнения создания релиза или цикла в настоящее 
время. На этой вкладке отображаются такие данные, как количество 
прошедших и оставшихся дней, количество выполненных и 
невыполнявшихся экземпляров тестов, фактический и необходимый темп 
выполнения тестов. 

Для просмотра хода выполнения покрытия для релиза или цикла:

 1 Выберите релиз или цикл в дереве релизов.

Параметр Описание

Requirements assigned to 
cycle

Отображает количество требований, связанных с 
выбранным циклом. Для просмотра в модуле 
Requirements назначенных циклу требований 
щелкните ссылку, чтобы отобразить количество 
требований. Альтернативный вариант — в дереве 
релизов щелкните правой кнопкой цикл и 
выберите команду Show Requirements.

Test set folders assigned 
to cycle

Отображает количество папок наборов тестов, 
связанных с выбранным циклом. Для просмотра в 
модуле Test Lab назначенных циклу папок наборов 
тестов щелкните ссылку, чтобы отобразить 
количество папок наборов тестов. 
Альтернативный вариант — в дереве релизов 
щелкните правой кнопкой цикл и выберите 
команду Show Test Set Folders.
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 2 Перейдите на вкладку Progress.

Для каждого релиза в верхней области вкладки Progress можно 
просмотреть следующие сведения:

Параметр Описание

Total days in release Общее количество дней в выбранном релизе (дата 
завершения - дата начала). 

Remaining days in 
release

Общее количество дней, оставшихся до завершения 
выбранного релиза.

Total test instances for 
release

Общее количество экземпляров тестов, включенных в 
папки наборов тестов, назначенных выбранному 
релизу.

Remaining test 
instances to run

Общее количество экземпляров тестов, включенных в 
папки наборов тестов, назначенных выбранному 
релизу, который еще не выполнялся.

Required execution 
rate (test 
instances/day)

Среднее количество экземпляров тестов, которое 
необходимо выполнять в день в течение оставшихся 
до завершения выбранного релиза дней.
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Для каждого цикла в верхней области вкладки Progress можно просмотреть 
следующие сведения:

Actual execution rate 
(test instances/day)

Среднее количество выполнений экземпляров тестов 
в день в выбранном релизе до текущей даты.

Days (индикатор 
выполнения)

Количество дней (в процентах), прошедших с начала 
создания выбранного релиза.

Test Instance Runs 
(индикатор 
выполнения)

Количество экземпляров тестов (в процентах), 
выполненных в выбранном релизе.

Параметр Описание

Total days in cycle Общее количество дней для создания выбранного 
цикла (дата завершения - дата начала). 

Remaining days in 
cycle

Общее количество дней, оставшихся до завершения 
выбранного цикла. 

Total test instances for 
cycle

Общее количество экземпляров тестов, включенных в 
папки наборов тестов, назначенных выбранному 
циклу.

Remaining test 
instances to run

Общее количество экземпляров тестов, включенных в 
папки наборов тестов, назначенных выбранному 
циклу, который еще не выполнялся.

Required execution 
rate (test 
instances/day)

Среднее количество экземпляров тестов, которое 
необходимо выполнять в день, в течение дней, 
оставшихся до завершения выбранного цикла.

Actual execution rate 
(test instances/day)

Среднее количество экземпляров тестов, которое 
необходимо выполнять в день до текущей даты, в 
выбранном цикле.

Days (индикатор 
выполнения)

Количество дней (в процентах), прошедших с начала 
выбранного цикла. 

Test Instance Runs 
(индикатор 
выполнения)

Количество экземпляров тестов (в процентах) в 
выбранном цикле.

Параметр Описание
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 3 Для настройки диаграммы Coverage Progress для выбранного релиза 
установите или снимите следующие флажки:

 4 Для настройки диаграммы Coverage Progress для выбранного цикла 
установите или снимите следующие флажки для следюущих параметров:

 5 Для обновления данных, отображаемых на вкладке Progress, нажмите 
кнопку Refresh All. 

Параметр Описание

Assigned 
requirements

Совокупное количество требований (в процентах), 
назначенных всем циклам в релизе. 

Planned 
coverage

Совокупное количество тестов, запланированных для всех 
циклов в релизе. 

Executed 
coverage

Совокупное количество тестов, которых были выполнены во 
всех циклах в релизе. 

Passed coverage Совокупное количество тестов, которые были выполнены 
успешно во всех циклах в релизе. 

Параметр Описание

Planned coverage Количество тестов, запланированных для выполнения 
каждый день в цикле. 

Executed coverage Количество тестов (в процентах), которые 
выполнялись ежедневно в цикле.

Passed coverage Количество тестов, которые завершались успешно 
ежедневно в цикле.
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Просмотр дефектов для релизов и циклов
На вкладке Quality можно быстро определять и просматривать количество 
дефектов, задокументированных в процессе создания релиза или цикла. 
Дефекты распределяются по уровням их серьезности с точки зрения 
негативного воздействия на работоспособность системы. Уровни 
серьезности могут быть от Low-1 до Urgent-5. Можно просматривать 
диаграммы на любом этапе процесса тестирования и проверять ход 
выполнения процесса создания релиза.

Для каждого релиза на вкладке Quality можно просмотреть следующие 
диаграммы:

Диаграмма Описание

Defect Opening 
Rate

Отображает количество дефектов, обнаруженных в 
процессе создания релиза.  На диаграмме отображаются те 
дефекты, для которых значение Detected in Release 
соответствует выбранному релизу. Дефекты группируются в 
соответствии с их уровнем серьезности. По оси Х 
отображается количество дефектов для каждого цикла, 
обнаруженных за последний день, в соответствии с их 
уровнем серьезности. 

Outstanding 
Defects

Отображает количество неустраненных дефектов для 
выбранного релиза. На диаграмме отображаются дефекты, 
для которых значение Target Release соответствует 
выбранному релизу. Дефекты группируются в соответствии с 
их уровнем серьезности. По оси Х отображается 
количество неустраненных дефектов за последний день для 
каждого цикла в соответствии с их уровнем серьезности. По 
умолчанию неустраненными считаются дефекты со статусом 
New, Open и Reopened. 
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Для каждого цикла на вкладке Quality можно просмотреть следующие 
диаграммы:

Для просмотра дефектов для релиза или цикла:

 1 Выберите релиз или цикл в дереве релизов.

Диаграмма Описание

Defect Opening 
Rate

Отображает количество дефектов, обнаруженных в 
процессе создания цикла. На диаграмме отображаются 
дефекты, для которых значение Detected in Cycle 
соответствует выбранному циклу. Дефекты группируются в 
соответствии с их уровнем серьезности. По оси Х 
отображается количество существующих дефектов, для 
каждой даты.

Outstanding 
Defects

Отображает количество неустраненных дефектов для цикла. 
На диаграмме отображаются те дефекты, чье значение 
значение Detected in Cycle соответствует выбранному 
циклу. Дефекты группируются в соответствии с их уровнем 
серьезности. По оси Х отображается количество дефектов, 
которые не были устранены, для каждой даты. По 
умолчанию дефекты New, Open и Reopened считаются 
неустраненными.
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 2 Перейдите на вкладку Quality.

На этой вкладке отображены диаграммы Defect Opening Rate и Outstanding 
Defects для выбранного релиза или цикла.

 3 На диаграмме Defect Opening Rate  можно устанавливать или снимать 
флажки уровней серьезности дефектов.

 4 На диаграмме Outstanding Defects можно:

➤ Устанавливать или снимать флажки уровней серьезности дефектов.

➤ Определять, какие дефекты необходимо отображать на диаграмме 
путем фильтрации дефектов по статусу. Щелкните Configure 
Outstanding Defects. В диалоговом окне Configure Outstanding Defects 
выберите статус дефекта и с помощью кнопок со стрелками (> и <) 
перемещайте его между списками Available Defect Status и Visible 
Defect Status. Для перемещения всех типов из одного списка в другой 
используйте кнопки с двойными стрелками (>> и <<). Нажмите кнопку 
OK. 

 5 Для обновления данных, отображенных на вкладке Quality, нажмите кнопку 
Refresh All. 
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Изменение дерева релизов
Содержание раздела об изменении дерева релизов:

➤ Переименование папок релизов, релизов и циклов

➤ Перемещение папок релизов и релизов

➤ Дублирование циклов

➤ Удаление папок релизов, релизов и циклов

Переименование папок релизов, релизов и циклов
Можно переименовать папку релизов, релиз или цикл.

Для переименования папки релизов, релиза или цикла:

 1 Выберите элемент в дереве релизов.

 2 Выберите Edit > Rename.

 3 Измените имя элемента и нажмите ENTER. 

Перемещение папок релизов и релизов
Папку релизов или релиз можно переместить в другое место в дереве 
релизов. При перемещении папки релизов перемещаются также релизы и 
циклы. При перемещении релиза также перемещаются его циклы. 
Переместить корневой каталог Releases невозможно. 

Совет. Также можно переместить папку релизов или релиз в новое место в 
дереве путем перетаскивания.

Для перемещения папки релизов или релиза:

 1 Выберите папку релизов или релиз в дереве. Для перемещения более 
одного элемента нажмите клавишу CTRL и выберите элементы, которые 
необходимо переместить.

 2 Нажмите кнопкуCut. Альтернативный вариант — выберите Edit > Cut.
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 3 Выберите папку в дереве релизов.

 4 Нажмите кнопку Paste. Альтернативный вариант — выберите Edit > Paste.

Дублирование циклов
Можно создать копию цикла в том же релизе. 

Для дублирования цикла:

 1 Выберите цикл в дереве релизов. 

Для дублирования нескольких циклов нажмите клавишу CTRL и выберите 
циклы, которые необходимо дублировать. Можно выбрать несколько 
циклов только если они относятся к одному релизу.

 2 Нажмите кнопку Duplicate Cycle. Альтернативный вариант — выберите 
Edit > Duplicate Cycle. Копия цикла будет добавлена в релиз.

Удаление папок релизов, релизов и циклов
Можно удалить папку релизов, релиз или цикл. При удалении папки также 
удаляются входящие в нее релизы и циклы. При удалении релиза также 
удаляются входящие в него циклы.

Примечание. Удаление папки релизов, релиза или цикла также отменяет 
назначение связанных требований, папок наборов тестов и дефектов.

Для удаления папки релизов, релиза или цикла:

 1 Выберите элемент в дереве релизов. Для удаления более одного элемента 
нажмите клавишу Ctrl и выберите элементы, которые необходимо удалить.

 2 Нажмите кнопку Delete. Альтернативный вариант — выберите Edit > 
Delete. Отображается подтверждающее сообщение.

 3 Для подтверждения нажмите кнопку Yes. Элементы будут удалены.
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10
Описание требований

После определения дерева требований в модуле Releases для 
продолжения процесса тестирования приложения необходимо описать 
требования. Требования подробно описывают, что необходимо 
протестировать в приложении и предоставляют группе тестирования 
основные сведения для всего процесса тестирования. После описания 
требований их назначают релизам и циклам, определенным в модуле 
Releases. 
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В этойглаве объясняется, как использовать модуль Requirements для 
описания требований. Процесс описания требований включает в себя 
следующие : 
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Определение целей и задач тестирования
Группа тестирования начинает процесс тестирования со сбора всей 
доступной документации по тестируемому приложению, например 
документации по маркетинговым и бизнес-требованиям, спецификаций по 
системным требованиям и проектной документации. 

Эта документация используется для тщательного изучения тестируемого 
приложения и определения рамок тестирования: целей, задач и стратегий 
тестирования.

При определении целей и задач тестирования следует ответить на 
следующие вопросы:

➤ Какие цели приложения и его назначение?

➤ Какие основные функции приложения?

➤ Какова относительная важность каждого элемента функциональности 
приложения?

➤ Какие функции приложения являются наиболее критичными или 
функциями с наибольшей вероятностью отказа?

➤ Каковы приоритеты в процессе тестирования? 

➤ Согласны ли заказчики и конечные пользователи с приоритетами, 
определенными пользователем  в процессе тестирования?

➤ Каковы общие целевые показатели качества?

Для принятия решения о распределении доступных ресурсов тестирования 
можно использовать тестирования на основе риска. Дополнительные 
сведения см. в главеГлава 14, "Расчет рисков требований".
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Создание структуры требований
Менеджеры по контролю качества используют цели и задачи тестирования 
для того, чтобы определить общие требования к тестируемому 
приложению. Они определяют разделы требований и назначают их 
тестировщикам, входящим в состав группы тестирования. Каждый 
тестировщик использует Quality Center для записи тех разделов 
требований, за которые он несет ответственность.

Запись разделов требований в модуле Requirements выполняется путем 
создания дерева требований. Дерево требований — это графическое 
представление описания требований, отображающее иерархические связи 
между различными требованиями.

Рассмотрим в качестве примера приложение для бронирования 
авиабилетов, с помощью которого можно управлять расписанием полетов, 
заказами пассажиров на билеты и продажами билетов.  Менеджер по 
контролю качества может определить основные требования к этому 
приложению, например, так: Online Travel Booking Services, Online Travel 
Information Source, Profile Management, Reservation Management, Booking 
System, Application Security, Application Usability, Application Client System и 
Application Performance. Полностью этот пример описан в проекте 
QualityCenter_Demo.

Дополнительные сведения см. в главе Глава 12, "Разработка дерева 
требований".
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Определение требований
Для каждого раздела требований тестировщик создает в дереве 
требований перечень подробных требований. Например, раздел Profile 
Management может содержать следующие требования: 

Каждое требование дерева имеет подробное описание и может включать в 
себя вложения. Тестировщик назначает требованию уровень приоритета, 
который учитывается группой тестировщиков при создании плана 
тестирования. 

После определения требований можно добавлять прослеживаемость 
требований. При анализе воздействия, которое окажет предлагаемое 
изменение определенного требования, прослеживаемость указывает 
другие требования, на которые такое изменение также может оказать 
воздействие. Дополнительные сведения см. в главеГлава 13, 
"Отслеживание требований".
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Назначение требований релизам
Менеджеры по контролю качества назначают требования релизам и 
циклам в дереве релизов модуля Releases. Дерево релизов содержит 
предыдущие, текущие и следующие релизы продуктов в виде 
иерархической структуры. Релиз представляет собой группу изменений, 
внесенных в одно или несколько приложений, которые доступны для 
одновременного распространения. Цикл представляет собой 
последовательность действий по разработке и контролю качества для 
достижения общей цели на основе временных рамок релиза. 
Дополнительные сведения о назначении требований см. в 
разделе“Назначение требований релизам и циклам" на стр. 175.

Затем назначенные требования используются в качестве основных 
сведений для создания плана тестирования в модуле Test Plan. Далее, 
чтобы создать покрытие требований тестами, тесты, созданные на этапе 
разработки плана тестирования, связывают с требованиями. 
Дополнительные сведения о требованиях и покрытии требований тестами 
см. в главеГлава 18, "Связывание тестов с требованиями". 

Анализ описания требований
Менеджеры по контролю качества анализируют требования, чтобы 
убедиться, что они соответствуют целям и задачам, определенным ранее. 
После утверждения требования менеджеры изменяют его статус с Not 
Reviewed  на Reviewed. 

Чтобы облегчить анализ требований, можно создавать отчеты и графики. 
Дополнительные сведения см. в главах Глава 33, "Создание отчетов", и 
Глава 34, "Создание диаграмм".
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Краткий обзор модуля Requirements

В главе приведено краткое описание основных элементов модуля 
Requirements.

Модуль Requirements
Задание требований в Quality Center выполняется в модуле Requirements. 
Для открытия окна этого модуля нажмите кнопку Requirements в боковой 
панели. Требования можно отображать в следующих окнах: Requirements 
Tree, Requirement Details, Requirements Grid или Coverage Analysis.

Примечание. Также можно импортировать требования в проект 
Quality Center из Microsoft Word, Excel или средств управления 
требованиями сторонних производителей. Чтобы импортировать 
требования, сначала необходимо установить соответствующую надстройку 
HP Quality Center. Дополнительные сведения см. в руководстве 
Руководство по установке HP Quality Center. 

Глава содержит следующие разделы На стр.

Модуль Requirements 147

Строка меню Requirements 160

Панель инструментов Requirements 161

Поля требований 162
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Окно Requirements Tree
Окно Requirements Tree позволяет отображать дерево требований. 

Окно Requirements Tree содержит следующие основные элементы:

➤ Строка меню Requirements. Отображает раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 160.

➤ Панель инструментов Requirements. Содержит кнопки вызова команд, 
часто использующихся для создания и изменения требований. 
Дополнительные сведения см. в разделе “Панель инструментов 
Requirements" на стр. 161.
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➤ Indicator columns. Указывают, что требование содержит вложения, 
связанные дефекты, оповещения и флажки отслеживания. Выберите View 
> Indicator Columns, чтобы отобразить эти столбцы.

➤ Requirements tree. Отображает требования в виде дерева.

➤ Information Panel. Отображает следующие вкладки: Description, Comments, 
Attachments, History и Rich Text. Выберите View > Information Panel или 
щелкните значок стрелки Show , чтобы отобразить эти вкладки.
 

Столбец Описание

Attachments Чтобы просмотреть вложения в требования, 
щелкните значок . Дополнительные сведения см. 
в главеГлава 5, "Добавление вложений".

Linked Defects Чтобы просмотреть связанные дефекты для 
требования, щелкните значок . Дополнительные 
сведения см. в главеГлава 32, "Связывание 
дефектов".

Alerts Чтобы просмотреть оповещения для требования, 
щелкните значок . Дополнительные сведения см. 
в разделе “Просмотр оповещений" на стр. 85.

Follow Up Flags Чтобы просмотреть оповещения отслеживании для 
требования, щелкните значок . Дополнительные 
сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 88. 

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев о текущем требовании 

Attachments Содержит перечень вложений, содержащих 
дополнительные сведения о текущем требовании. 
Дополнительные сведения см. в разделе Глава 5, 
"Добавление вложений".
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Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
окне дерева Requirements, выберите Requirements > Go to Requirement и 
введите соответствующий идентификатор. Чтобы отобразить 
идентификатор требования, выберите столбец ReqID в диалоговом окне 
Select Columns. Можно переходить только к тем требованиям, которые 
соответствуют текущему фильтру.

History Отображение списка изменений, внесенных в 
текущее требование. Дополнительные сведения 
см. в разделе “Просмотр истории изменения 
требования" на стр. 186.

Rich Text Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft 
Word непосредственно в Quality Center. 
Дополнительные сведения см. в разделе 
“Добавление текста в формате RTF в требования" 
на стр. 176. 

Вкладка Описание
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Окно Requirement Details
Окно Requirement Details позволяет отображать тесты, с которыми связаны 
требования, требования, по которым отслеживаются эти тесты, и дефекты, 
с которыми эти тесты связаны. В нем также можно выполнять расчет и 
анализ рисков требований.

Окно Requirement Details содержит следующие основные элементы:

➤ Строка меню Requirements.Отображает раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 160.

➤ Панель инструментов Requirements. Содержит кнопки вызова команд, 
часто использующихся для создания и изменения требований. 
Дополнительные сведения см. в разделе “Панель инструментов 
Requirements" на стр. 161.
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➤ Indicator columns. Указывают, что конкретное требование содержит 
вложения, связанные дефекты, оповещения и флажки отслеживания. 
Выберите View > Indicator Columns, чтобы отобразить эти столбцы.
 

➤ Requirements tree. Отображает требования в виде дерева.

➤ Вкладка Details. Отображает сведения о текущем требовании. Она также 
включает в себя следующие вкладки:

Дополнительные сведения о полях, отображаемых на вкладке Details, см. в 
разделе “Поля требований" на стр. 162.

Столбец Описание

Attachments Чтобы просмотреть вложения для требования, 
щелкните значок . Дополнительные сведения см. 
в главе Глава 5, "Добавление вложений". 

Linked Defects Чтобы просмотреть связанные дефекты для 
требования, щелкните значок . Дополнительные 
сведения см. Глава 32, "Связывание дефектов".

Alerts Чтобы просмотреть оповещения для требования, 
щелкните значок у . Дополнительные сведения 
см. в разделе “Просмотр оповещений" на стр. 85.

Follow Up Flags Чтобы просмотреть оповещения об отслеживании 
для требования, щелкните значок . 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 88.

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев к текущему 
требованию. 

Rich Text Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft 
Word непосредственно в Quality Center. 
Дополнительные сведения см. в разделе 
“Добавление текста в формате RTF в требования" 
на стр. 176.
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➤ Вкладка Requirements Traceability.  Отображает требования, связанные с 
текущим требованием. Дополнительные сведения см. в главеГлава 13, 
"Отслеживание требований".

➤ Вкладка Test Coverage.  Отображает тесты, связанные с текущим 
требованием. Дополнительные сведения см. в главеГлава 18, "Связывание 
тестов с требованиями".

➤ Вкладка Linked Defects.  Отображает дефекты, связанные с текущим 
требованием. Дополнительные сведения см. в главе Глава 32, 
"Связывание дефектов". 

➤ Вкладка Risk. Расчет и анализ рисков требований. Дополнительные 
сведения см. Глава 14, "Расчет рисков требований".

➤ Вкладка Attachments. Отображает вложения, содержащие 
дополнительные сведения о текущем требовании. Дополнительные 
сведения см. в главеГлава 5, "Добавление вложений".

Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
окне Requirement Details, выберите Requirements > Go to Requirement и 
введите соответствующий идентификатор. Для отображения 
идентификатора требования выберите столбец ReqID в диалоговом окне 
Select Columns. Можно переходить только к требованиям, 
соответствующим текущему фильтру.
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Окно RequirementsGrid
Окно Requirements Grid позволяет отображать требования в виде таблицы, 
а не в иерархическом виде. В каждой строке таблицы отображается 
отдельное требование. 

Окно Requirements Grid содержит следующие основные элементы:

➤ Строка меню Requirements.Отображает раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 160.

➤ Панель инструментов Requirements. Содержит кнопки вызова команд, 
часто использующихся для создания и изменения требований. 
Дополнительные сведения см. в разделе “Панель инструментов 
Requirements" на стр. 161.
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➤ Indicator columns. Указывают, что конкретное требование содержит 
вложения, связанные дефекты, оповещения и флажки отслеживания. 
Выберите View > Indicator Columns, чтобы отобразить эти столбцы.

➤ Information Panel. Отображение следующих вкладок: Description, 
Comments, Attachments, History и Rich Text. Выберите View > Information 
Panel или щелкните значок стрелкиShow , чтобы отобразить эти вкладки.
 

Столбец Описание

Attachments Чтобы просмотреть вложения для требования, 
щелкните значок . Дополнительные сведения см. 
в главе Глава 5, "Добавление вложений".

Linked Defects Чтобы просмотреть дефекты, связанные с 
требованием, щелкните значок . Дополнительные 
сведения см. Глава 32, "Связывание дефектов".

Alerts Чтобы просмотреть оповещения для требования, 
щелкните значок . Дополнительные сведения см. 
в разделе “Просмотр оповещений" на стр. 85.

Follow Up Flags Чтобы просмотреть оповещения об отслеживании 
для требования, щелкните значок . 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 88.

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев к текущему 
требованию. 

Attachments Содержит вложения, предоставляющих 
дополнительные сведения о текущем требовании. 
Дополнительные сведения см. в главе Глава 5, 
"Добавление вложений".
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Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
окне Requirements Grid, выберите Requirements > Go to Requirement и 
введите соответствующий идентификатор. Для отображения 
идентификатора требования выберите столбец ReqID в диалоговом окне 
Select Columns.

History Отображает список изменений, внесенных в 
текущее требование. Дополнительные сведения 
см. в разделе “Просмотр истории изменения 
требования" на стр. 186.

Rich Text Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft 
Word непосредственно в Quality Center. 
Дополнительные сведения см. в разделе 
“Добавление текста в формате RTF в требования" 
на стр. 176.

Вкладка Описание
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Coverage Analysis
Окно Coverage Analysis позволяет анализировать классификацию дочерних 
требований в соответствии с статусом тестового покрытия. 

Окно Coverage Analysis содержит следующие основные элементы: 

➤ Строка меню Requirements.Отображает раскрывающиеся меню с 
командами модуля Requirements. Дополнительные сведения см. в разделе 
“Строка меню Requirements" на стр. 160.

➤ Панель инструментов Requirements. Содержит кнопки вызова команд, 
часто использующихся для создания и изменения требований. 
Дополнительные сведения см. в разделе “Панель инструментов 
Requirements" на стр. 161.
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➤ Indicator columns. Указывают, что конкретное требование содержит 
вложения, связанные дефекты, оповещения и флажки отслеживания. 
Выберите View > Indicator Columns, чтобы отобразить эти столбцы.

➤ Requirements tree. Отображает требования в виде дерева.

➤ Information Panel. Отображает следующие вкладки. Description, Comments, 
Attachments, History и Rich Text. Выберите View > Information Panel или 
щелкните значок стрелкиShow , чтобы отобразить эти вкладки.
 

Столбец Описание

Attachments Чтобы просмотреть вложения в требование, 
щелкните значок . Дополнительные сведения см. 
в главеГлава 5, "Добавление вложений".

Linked Defects Чтобы просмотреть связанные дефекты для 
требования, щелкните значок . Дополнительные 
сведения см. в главеГлава 32, "Связывание 
дефектов".

Alerts Чтобы просмотреть оповещения для требования, 
щелкните значок . Дополнительные сведения см. 
в разделе “Просмотр оповещений" на стр. 85.

Follow Up Flags Чтобы просмотреть оповещения об отслеживании 
для требования, щелкните значок . 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 88.

Вкладка Описание

Description Отображение описания текущего требования. 

Comments Отображение комментариев к текущему 
требованию. 

Attachments Содержит перечень вложений, предоставляющих 
дополнительные сведения о текущем требовании. 
Дополнительные сведения см. в главеГлава 5, 
"Добавление вложений".
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Совет. Чтобы найти конкретное требование по идентификатору ReqID в 
окне Requirement Details, выберите Requirements > Go to Requirement и 
введите соответствующий идентификатор. Для отображения 
идентификатора требования выберите столбец ReqID в диалоговом окне 
Select Columns. Можно переходить только к требованиям, 
соответствующим текущему фильтру.

History Отображает список изменений, внесенных в 
текущее требование. Дополнительные сведения 
см. в разделе “Просмотр истории изменения 
требования" на стр. 186.

Rich Text Позволяет добавлять, просматривать и изменять 
форматированный текст приложения Microsoft 
Word непосредственно в Quality Center. 
Дополнительные сведения см. в разделе 
“Добавление текста в формате RTF в требования" 
на стр. 176.

Вкладка Описание
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Строка меню Requirements 
Строка меню Requirements содержит следующие меню: Меню и команды, 
содержащиеся в строке меню, могут изменяться в зависимости от 
представления требований.

➤ Меню Requirements содержит команды, с помощью которых можно 
добавлять требования и определять их место в дереве, создавать тест на 
основании требования, отображать сведения о требованиях и отправлять 
требования по электронной почте.

➤ Меню Edit содержит команды, позволяющие вырезать, копировать, 
вставлять, переименовывать, удалять, искать или заменять требования. 
Также можно просматривать и удалять оповещения требований и 
устанавливать флажки отслеживания требований. Дополнительные 
сведения об оповещениях и флажках отслеживания см. в главеГлава 4, 
"Оповещение об изменениях"..

➤ Меню View содержит команды, с помощью которых можно задавать вид 
отображения требований: дерево или таблица, фильтровать и сортировать 
требования, настраивать отображаемые столбцы и выбирать вид 
представления требований.

➤ Меню Favorites содержит команды, позволяющие добавлять, 
упорядочивать и загружать избранные представления. Дополнительные 
сведения см. в разделе “Работа с избранными представлениями" на 
стр. 101.

➤ Меню Analysis содержит команды, позволяющие создавать отчеты о 
требованиях и их графики. Дополнительные сведения об отчетах о 
требованиях см. в главе Глава 33, "Создание отчетов". Дополнительные 
сведения о графиках требований см. в главе Глава 34, "Создание 
диаграмм".

Совет. Чтобы получить доступ к строке меню Requirements в модуле 
Requirements, нажмите клавишу F9. Кроме того, с помощью комбинаций 
клавиш можно выполнять много других операций в Quality Center. Таблица 
комбинаций клавиш приведена в Приложение B, "Quality Center - 
Комбинации клавиш".. 
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Панель инструментов Requirements 
Панель инструментов Requirements содержит следующие кнопки: Кнопки 
панели инструментов могут изменяться в зависимости от представления 
требований.

New Folder. Добавление новой папки в дерево требований. 

New Requirement. Добавление нового требования в дерево требований. 

Delete. Удаление выбранного требования. При удалении требования также 
удаляются его дочерние требования, покрытие тестами, связанные с ним 
дефекты и вложения.

Refresh All. Обновление дерева или таблицы требований для отображения 
самых последних требований.

Set Filter/Sort. Содержит следующие параметры: 

➤ Set Filter/Sort. Открытие диалогового окна Filter, в котором можно 
фильтровать и сортировать требования в дереве или таблице 
требований. 

➤ Clear Filter/Sort.  Очищает все фильтры или функции сортировки, 
примененные к дереву или таблице требований.

Select Columns. Открывает диалоговое окно Select Columns, в котором 
можно задавать поля, которые необходимо отображать в дереве или 
таблице требований и их порядок. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 55.

Requirement Details. Открывает диалоговое окно Requirement Details, 
отображающее сведения о выбранном требовании. Дополнительные 
сведения см. в разделе “Обновление требований" на стр. 178.

Attachments. Открывает диалоговое окно Requirement Details в окне 
Attachments, в котором можно добавлять вложение к выбранному 
требованию. Дополнительные сведения см. в главеГлава 5, "Добавление 
вложений".

Go To Requirement in Requirements Tree. Переход к окну Requirements 
Tree и выделение выбранного требования.
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Zoom In. Изменение детализации в дереве требований. Дополнительные 
сведения см. в разделе “Увеличение дерева" на стр. 184.

Send by E-mail. Открытие диалогового окна Send E-mail, с помощью 
которого можно отправить требование по электронной почте получателям, 
выбранным из списка, или автору требования. Дополнительные сведения 
см. в разделе “Отправка требований по электронной почте" на стр. 187.

Text Search. Открытие в нижней части окна области поиска, в которую 
можно вводить ключевые слова и выполнять поиск предварительно 
заданных полей. Дополнительные сведения см. в разделе “Поиск записей" 
на стр. 76.

Favorite. Щелкните значок стрелки Favorite , чтобы отобразить список 
избранных представлений. С помощью избранных представлений можно 
повторно открывать окно Quality Center , к которому применены нужные 
параметры. (Эта возможность доступна только в окне Requirements Grid). 
Чтобы отобразить панель Favorite, выберите View > Favorite Bar.) 
Дополнительные сведения об избранных представлениях см. в главе 
Глава 6, "Работа с избранными представлениями"..

Поля требований 
В модуле Requirements отображаются следующие поля:

Поле Описание

Author Имя пользователя, создавшего требование. По умолчанию — 
это имя пользователя, используемое для входа в систему. 

Comments Отображает комментарии к требованию.

Creation Date Дата создания требования. По умолчанию дата создания  
формируется в текущем сервере базы данных. Нажмите 
кнопку вниз, чтобы отобразить календарь и выбрать другую 
дату создания.

Creation Time Время создания требования. По умолчанию время создания 
формируется в текущем сервере баз данных.

Description Описание требования.
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Direct Cover 
Status

Текущий статус требования. По умолчанию требованию 
задается статус Not Covered. 

Допустимы следующие статусы требований:

➤ Not Covered. Требование не связано с тестом.
➤ Failed. Один или несколько тестов, покрытых 

требованием, имеют статус‘Failed’ («Не пройден»).
➤ Not Completed.  Один или несколько тестов, покрытых 

требованием, имеют статус ‘Not Completed’ («Не 
завершен»).

➤ Passed.  Все тесты, покрытые требованием, имеют статус 
‘Passed’ («Пройден»). 

➤ No Run. Все тесты, покрытые требованием, имеют статус 
«No Run» («Не выполнялся»).

➤ N/A. Текущий статус требований не применим.
➤ -----. Требование не имеет статуса прямого покрытия, 

поскольку оно относится к такому типу требований, которые 
не поддерживают покрытие.

Чтобы открыть диалоговое окно Tests Coverage для 
выбранного требования, щелкните статус. Такая возможность 
доступна только в дереве Requirements и Coverage Analysis. 
Дополнительные сведения о покрытии см. в главе Глава 18, 
"Связывание тестов с требованиями".

Modified Указывает дату последнего изменения требования.

Name Имя требования.

Old Type 
(obsolete)
(formerly – 
Type)

Тип требования (устаревшее). В предыдущих версиях 
Quality Center в качестве типа требования могло 
использоваться любое значение, заданное в проекте. 
Стандартные значения: Change, Functional, Guideline, 
Quality, Standard и System.

Учтите, что поле можно использовать только для требований 
неопределенного типа.

Priority Приоритет требования от низкого (уровень 1) до неотложного 
(уровень 5). 

Product Компонент приложения, к которому применяется требование.

Поле Описание
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RBQM 
Business 
Impact

Расчетная бизнес-критичность требования. Возможные 
значения: A (Critical), B (Important) и C (Nice to have). Это 
поле используется только для анализа требований.

RBQM 
Custom 
Business 
Impact

Определенная пользователем бизнес-критичность 
требования. Возможные значения: A (Critical), B 
(Important) и C (Nice to have). Это поле используется 
только для анализа требований.

RBQM 
Custom 
Failure 
Probability

Определенная пользователем вероятность отказа для 
требований. Возможные значения: 1 (High), 2 (Medium) и 
3 (Low). Это поле используется только для анализа 
требований.

RBQM 
Custom 
Testing Hours

Определенные пользователем ресурсы, необходимые для 
тестирования требования, измеряемые в единицах, 
определенных в окне Project Customization. Это поле 
используется только для анализа требований.

RBQM 
Custom 
Testing Level

Определенный пользователем уровень тестирования 
требования. Возможные значения: 1-Full, 2-Partial, 3-Sanity 
и 4-None. Это поле используется только для анализа 
требований.

RBQM Date of 
Last Analysis

Дата проведения последнего анализа тестирования 
требования на основе риска. Это поле используется только 
для анализа требований.

RBQM 
Effective 
Business 
Impact

Эффективная бизнес-критичность требования. Возможные 
значения: A (Critical), B (Important) и C (Nice to have). Это 
поле используется только для анализа требований.

RBQM 
Effective 
Failure 
Probability

 Эффективная вероятность отказа для требования. 
Возможные значения: 1 (Высокая), 2 (Средняя) и 
3(Низкая). Это поле используется только для анализа 
требований.

RBQM 
Estimated 
RnD Effort

 Определенная пользователем оценка ресурсов, 
необходимых для разработки требования. Это поле 
используется только для анализа требований.

Поле Описание
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RBQM 
Exclude from 
Analysis

Указывает на то, следует ли исключать требование из 
анализа рисков. Требование можно исключить из анализ 
рисков, если оно относится к тому типу, для которого анализ 
рисков невозможен, или если его необходимо исключить из 
анализа специально.

RBQM Failure 
Probability

Расчетная вероятность отказа для требования. Возможные 
значения: 1 (Высокая), 2 (Средняя) и 3(Низкая). Данное 
поле используется только для требований к оценке.

RBQM 
Testing Hours

Расчетные ресурсы, необходимые для тестирования 
требования, измеряемые в единицах, определенных в окне 
Project Customization. Данное поле используется только для 
требований к оценке.

RBQM 
Testing Level

Расчетный уровень теста при соответствующих требованиях. 
Возможные значения: 1-Full, 2-Partial, 3-Sanity и 4-None. 
Данное поле используется только для требований к оценке.

RBQM Use 
Custom 
Business 
Impact

Указывает, следует ли использовать определенную 
пользователем бизнес-критичность вместо бизнес-
критичности, рассчитанной Quality Center. Данное поле 
используется только для требований к оценке.

RBQM Use 
Custom 
Failure 
Probability

Указывает, следует ли использовать определенную 
пользователем вероятность отказа вместо вероятности 
отказа, рассчитанной Quality Center. Данное поле 
используется только для требований к оценке.

RBQM Use 
Custom 
Results

Указывает, следует ли использовать определенные 
пользователем ресурсы и уровень тестирования вместо 
ресурсов и уровня тестирования, рассчитанных Quality Center. 
Данное поле используется только для требований к оценке.

Req ID Уникальный буквенно-цифровой идентификатор требования, 
назначаемый автоматически. Учтите, что Req ID изменить 
невозможно.

Req Parent Имя родительского требования.

Поле Описание
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Reviewed Указывает на то, было ли требование проанализировано и 
одобрено ответственным лицом или нет.

Requirement 
Type

Указывает тип требования. По умолчанию используются 
следующие типы требований: 

➤  Business. Требование к бизнес-процессу. По 
умолчанию добавить покрытие к такому требованию 
невозможно.

➤  Folder. Папка для упорядочивания требований. По 
умолчанию добавить покрытие к такому требованию 
невозможно.

➤  Functional. Требование к реакции системы.
➤  Group. Комплект связанных требований.
➤  Testing. Требование к производительности системы.
➤  Undefined. Неопределенное требование.

Пользователь может настраивать типы требований по 
умолчанию и создавать собственные. Дополнительные 
сведения о настройке типов требований см. в Руководство 
администратора HP Quality Center.

Target Cycle Цикл, в котором было назначено требование. Чтобы выбрать 
другой цикл, щелкните кнопку со стрелкой вниз.

Target 
Release

Релиз, в котором было назначено требование. Чтобы выбрать 
другой релиз, щелкните кнопку со стрелкой вниз.

Поле Описание
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Примечания. 

➤ В модуле Requirements можно добавлять поля, определенные 
пользователем, и изменять метки полей. Также предусмотрена 
возможность настройки списков проектов. Дополнительные сведения 
см. в Руководство администратора HP Quality Center. 

➤ Для ограничения и динамического изменения полей и значений модуля 
Requirements можно использовать редактор Script Editor. 
Дополнительные сведения см. в Руководство администратора 
HP Quality Center. 

➤ При выборе столбца требований, содержащего имя пользователя 
(включая поля, определенные пользователем), Quality Center 
отображает список имен и полным имен всех пользователей. Можно 
выполнять поиск пользователей, сортировать и группировать их, а 
также выбирать пользователей из списка пользователей и в дереве 
групп. Дополнительные сведения см. в разделе “Выбор пользователей" 
на стр. 58.
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12 
Разработка дерева требований

Дерево требований упорядочивает и отображает требования в виде 
иерархической структуры.

Глава содержит следующие разделы: На стр.

Сведения о создании дерева требований 170

Создание дерева требований 171

Назначение требований релизам и циклам 175

Добавление текста в формате RTF в требования 176

Обновление требований 178

Поиск требований 180

Замена значений полей 182

Просмотр дерева требований 184

Просмотр истории изменения требования 186

Отправка требований по электронной почте 187

Изменение требований 190

Создание тестов из требований 193
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Сведения о создании дерева требований 
Процесс задания требований к тестированию приложений может быть 
трудоемким и длительным. Во многих случаях группа тестировщиков 
записывает требования в документ текстового редактора или в 
электронную таблицу. С таким документом неудобно работать, его трудно 
упорядочивать и сортировать, а также его невозможно связать с тестами и 
дефектами, созданными пользователем на основе этих или других 
требований. 

В модуле Requirements можно определять требования и управлять ими.  
Группа тестировщиков записывает требования в Quality Center путем 
создания дерева требований, которое является графическим 
представлением описания требований и отображает требования в виде 
иерархической структуры. 

После определения требований можно установить прослеживаемость для 
двух или более требований. Прослеживаемость требований определяет 
связи между требованиями. При анализе воздействия, которое окажет 
предлагаемое изменение в конкретном требовании, связи 
прослеживаемости указывают другие требования, на которые такое 
изменение также может оказать влияние. При изменении требования 
Quality Center оповещает те отслеживаемые требования, на которые 
данное изменение окажет непосредственное воздействие. 
Дополнительные сведения об установлении прослеживаемости 
требований см. в главе Глава 13, "Отслеживание требований".

На этапе описания требований пользователь назначает их релизу или 
циклу в дереве релизов. Требования можно назначить одному или 
нескольким релизам или циклам. Дополнительные сведения см. в разделе 
“Назначение требований релизам и циклам" на стр. 175.

После создания тестов требования можно связать с тестами и дефектами. 
Таким образом, можно отслеживать требования к тестированию на всех 
этапах процесса тестирования. При изменении требования следует сразу 
же определить, на какие тесты и дефекты это может оказать влияние, и кто 
за это несет ответственность. Дополнительные сведения о связывании 
требований с тестами см. в главе Глава 18, "Связывание тестов с 
требованиями". Дополнительные сведения о связывании требований с 
дефектами см. в главе Глава 32, "Связывание дефектов".
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Примечание. В этойглаве для создания дерева требований используется 
окно Requirements Tree модуля Requirements. Сведения об 
окнеRequirements Grid  см. в “Окно RequirementsGrid" на стр. 154. 
Сведения об окнахRequirement Details и Coverage Analysis см. в главе 
Глава 18, "Связывание тестов с требованиями".

Создание  дерева требований
Создание дерева требований начинается с добавления требований в 
корневую папку Requirements. Можно упорядочить разделы требований по 
папкам. Корневую папку переименовать или удалить невозможно.

Примечание. Кроме того, что требования можно создавать 
непосредственно в Quality Center, их можно также импортировать в проект 
Quality Center из приложений Microsoft Word или Microsoft Excel. Для 
импорта из Word необходимо установить надстройки Microsoft Word и 
HP Quality Center Connectivity. Для импорта из Excel необходимо 
установить надстройки Microsoft Excel и HP Quality Center Connectivity. 
Загрузить эти надстройки можно со страницы надстроек HP Quality Center. 
Дополнительные сведения см. в руководстве Руководство по установке 
HP Quality Center. 

Для создания дерева требований:

 1 В модуле Requirements выберите View > Requirements Tree, чтобы 
отобразить представление дерева требований.

 2 Чтобы добавить требование на основной уровень, выберите корневую 
папку Requirements. Для создания дочернего требования выберите 
требование.
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 3 Чтобы добавить папку, нажмите кнопку New Folder или выберите 
Requirements > New Folder. В диалоговом окне Create New Requirement 
Folder введите имя папки и нажмите кнопку OK. Учтите, что имя папки не 
должно содержать следующие символы: \ ^ *

 4 Чтобы добавить требование, нажмите кнопку New Requirement. 
Альтернативный вариант — выберите Requirements > New Requirement. 
Откроется диалоговое окно Create New Requirement.

 5 В списке Requirement Type выберите тип требования. Дополнительные 
сведения о типах требований см. в разделе “Поля требований" на стр. 162.

 6 В поле Requirement Name введите имя нового требования. Имя 
требования не должно содержать следующие символы: \ ^ *
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 7 Нажмите кнопку OK. Откроется диалоговое окно New Requiremen.

 8 Добавьте сведения о требовании. Учтите, что обязательное поле выделено 
красным цветом. Дополнительные сведения о полях, доступных в модуле 
Requirements, см. в разделе “Поля требований" на стр. 162.

 9 Чтобы очистить данные в диалоговом окне New Requirement нажмите 
кнопку Clear.

 10 Для добавления вложения в требование: 

➤ Нажмите кнопку Attach File , чтобы присоединить текстовый файл.

➤ Нажмите кнопку Attach URL , чтобы присоединить URL-адрес.

➤ Нажмите кнопку Attach Snapshot , чтобы присоединить изображение.

➤ Нажмите кнопку Attach Sysinfo, чтобы добавить сведения о системе.

➤ Нажмите кнопку Attach Clipboard, чтобы присоединить текст или 
изображение из буфера обмена.

Дополнительные сведения о добавлении вложений см. в главе Глава 5, 
"Добавление вложений"..
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 11 Для проверки орфографии используйте диалоговое окно New Requirement:

➤ Нажмите кнопку Check Spelling , чтобы проверить правописание 
выбранного слова или текста. 

➤ Чтобы открыть диалоговое окно Spelling Options и выбрать параметры 
проверки правописания Quality Center, нажмите кнопку  Spelling 
Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить для выбранного 
слова синонимы, антонимы или связанные слова, нажмите кнопку 
Thesaurus. 

 12 Нажмите кнопку Submit, чтобы добавить новое требование в дерево. 

 13 Нажмите кнопку Close, чтобы закрыть диалоговое окно New Requirement.

 14 Чтобы добавить тестовое покрытие, выберите View > Requirement Details. 
Для отображения классификации дочерних требований в соответствии со 
статусом тестового покрытия выберите View > Coverage Analysis. 
Дополнительные сведения см. в главеГлава 18, "Связывание тестов с 
требованиями".

 15 Чтобы добавить связи прослеживаемости требований в конкретное 
требование, выберите View > Requirement Details и перейдите на вкладку 
Requirements Traceability.  Дополнительные сведения см. в главе 
Глава 13, "Отслеживание требований".

 16 Чтобы добавить связи дефектов в требование, выберите View > 
Requirement Details и перейдите на вкладку Linked Defects. 
Дополнительные сведения см. в главе Глава 32, "Связывание дефектов".
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Назначение требований релизам и циклам
После определения требований в дереве назначьте требования релизу 
или циклу в модуле Releases. Можно назначать требования одному или 
нескольким релизам или циклам. Дополнительные сведения см. в главе 
Глава 9, "Создание дерева релизов".

На этапе разработки плана тестирования для создания покрытия 
выполняется связывание тестов из модуля Test Plan с назначенными 
требованиями. Благодаря определению покрытия можно отслеживать 
связи между тестами, включенными в план тестирования, и требованиями. 
Дополнительные сведения о покрытии см. в главе Глава 18, "Связывание 
тестов с требованиями".

На этапе выполнения тестов добавьте тесты, покрывающие назначенные 
требования, в наборы тестов модуля Test Lab, а затем назначьте папки 
наборов тестов циклам. Дополнительные сведения см. в разделе 
“Назначение папок наборов тестов циклам" на стр. 355.

Для назначения требования релизу или циклу:

 1 В дереве требований выберите требование, которое необходимо 
назначить релизу или циклу. Чтобы выбрать несколько требований, 
используйте клавишу Ctrl.

 2 Чтобы назначить релиз, выберите Requirements > Assign To Release. 
Альтернативный вариант — щелкните правой кнопкой мыши и выберите 
Assign To Release. Откроется диалоговое окно Assign To Release. 
Раскройте дерево и выберите релиз. Чтобы закрыть диалоговое окно, 
нажмите кнопку OK.

Для назначения требования циклу выберите Requirements > Assign To 
Cycle. Альтернативный вариант — щелкните правой кнопкой мыши и 
выберите Assign To Cycle. Откроется диалоговое окно Assign To Cycle. 
Раскройте дерево и выберите цикл. Чтобы закрыть диалоговое окно, 
нажмите кнопку OK.

 3 Если выбранное требование содержит дочерние требования, откроется 
окно подтверждения. Нажмите кнопку Yes, чтобы назначить требование 
вместе с его дочерними требованиями. Нажмите кнопку No, чтобы 
назначить требование без его дочерних требований.
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Добавление текста в формате RTF в требования
В Quality Center можно добавлять, просматривать и изменять текст в 
формате RTF без необходимости использования приложения Word. При 
переходе к другому требованию или модулю изменения, внесенные в текст 
в формате RTF для требования, сохраняются автоматически.

Примечания. 

➤ Чтобы проверить, какие версии Microsoft Word поддерживаются в Quality 
Center, см. руководство Руководство по установке HP Quality Center.

➤ При добавлении или изменении текста в формате RTF необходимо 
выйти их программы Microsoft Word.

Для добавления текста в формате RTF в требование:

 1 В дереве требований выберите требование и перейдите на вкладку Details.

 2 На вкладке Details выберите вкладку Rich Text. Откроется окно текстового 
редактора Microsoft Word.
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 3 Внесите изменения в текст в формате RTF таким же образом , как в 
программе Word. Дополнительные сведения об использовании текстового 
редактора Word для изменения текста в формате RTF см. в документации 
по Microsoft Word.

 4 Чтобы внести изменения в текст в формате RTF в отдельном окне, 
нажмите кнопку Maximize Content.

 5 Чтобы заменить существующий текст в формате RTF текстом из файла, 
сохраненного в программе Word, на вкладке Rich Text выберите File > 
Import.

 6 Чтобы заменить существующий текст в формате RTF пустой страницей, на 
вкладке Rich Text выберите File > New.

 7 Для сохранения текста в формате RTF как документа Word, выберите File > 
Save.
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Обновление требований 
Обновлять требования можно непосредственно в дереве или таблице 
требований либо в диалоговом окне Requirement Details. В диалоговом 
окне Requirement Details можно обновлять сведения, вложения, покрытие 
тестами, связи прослеживаемости требований, параметры управления 
качеством на основе риска и связи с дефектами для любого требования. 
Кроме того, можно просматривать список изменений, внесенных в любое 
требование.

Для обновления требования:

 1 Дважды щелкните требование, которое необходимо обновить. 
Альтернативный вариант — выберите требование и нажмите кнопку 
Requirement Details. Откроется диалоговое окно Requirement Details.
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 2 Нажмите кнопку First, чтобы отобразить в дереве или таблице первое 
требование, или кнопку Previous, чтобы отобразить предыдущее 
требование.

 3 Нажмите кнопку Next, чтобы отобразить в дереве или таблице следующее 
требование, или кнопку Last, чтобы отобразить в дереве или таблице 
последнее требование.

 4 Нажмите кнопку Send by E-mail, чтобы отправить подробные сведения о 
требовании электронной почтой. Дополнительные сведения об отправке 
требований электронной почтой см. в “Отправка требований по 
электронной почте" на стр. 187.

 5 В представлении Details можно добавлять или изменять сведения о 
выбранном требовании. Дополнительные сведения о полях, доступных в 
представлении Details, см. в “Поля требований" на стр. 162.

 6 Нажмите кнопку Requirements Traceability на боковой панели, чтобы 
добавить связи прослеживаемости к требованию. Дополнительные 
сведения о прослеживаемости см. в Глава 13, "Отслеживание требований".

 7 Нажмите кнопку Test Coverage на боковом поле, чтобы добавить тестовое 
покрытие к требованию. Дополнительные сведения о тестовом покрытии 
см. в Глава 18, "Связывание тестов с требованиями".

 8 Нажмите кнопку Linked Defects на боковом поле, чтобы добавить связи с 
дефектами к требованию. В таблице Requirements рядом с требованием 
располагается выбираемая пиктограмма . Дополнительные сведения о 
связанных дефектах см. в “Связывание дефектов" на стр. 471.

 9 Нажмите кнопкуRisk на боковом поле, чтобы использовать управление 
качеством на основе риска для определения стратегии тестирования 
требования. Дополнительные сведения о тестировании на основе риска 
см. в Глава 14, "Расчет рисков требований".

 10 Нажмите кнопку Attachments на боковом поле, чтобы добавить вложение к 
требованию. Вл ожение может представлять собой файл, адрес URL, 
снимок с экрана приложения, информацию о системе или содержимое 
буфера обмена. В таблице Requirements рядом с требованием 
располагается выбираемая пиктограмма вложения . Дополнительные 
сведения о вложениях приведены см. Глава 5, "Добавление вложений"..
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 11 Нажмите кнопку History на боковом поле, чтобы просмотреть историю 
изменений, внесенных в требование. Дополнительные сведения см. в 
разделе “Просмотр истории изменения требования" на стр. 186.

 12 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно Requirement Details.

Поиск требований
С помощью команды Find можно выполнять поиск конкретного требования 
в дереве или таблице требований.

Совет. Если кнопка Text Search доступна, то используйте ее для поиска 
требований. Текстовый поиск является более мощным инструментом, 
поскольку позволяет выполнять поиск ключевых слов и их вариаций. 
Сведения об использовании текстового поиска приведены в разделе 
“Поиск записей" на стр. 76.

Поиск требований в дереве Requirements
Можно выполнять поиск требования в дереве требований. Если к дереву 
применены фильтры, поиск будет ограничен текущими требованиями.

Чтобы найти требование в дереве требований:

 1 Выберите Edit > Find. Откроется диалоговое окно Find Requirement.

 2 В поле Find in Field выберите критерий поиска. 
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 3 В поле Value to Find введите или выберите значение выбранного поля. 
При поиске регистр не учитывается.

 4 Нажмите Find. Модуль Requirements выполнит поиск местоположения 
требования с указанным значением. При успешном завершении поиска 
откроется диалоговое окно Search Results со списком возможных 
совпадений. Выберите результат из списка и нажмите кнопку Go To, чтобы 
выделить требование в дереве требований. При неуспешном завершении 
поиска откроется информационное окно.

Поиск требований в таблице Requirements
В таблице требований можно выполнять поиск требований по значению 
конкретного поля. Если к таблице применены фильтры, поиск будет 
ограничен текущими требованиями.

Чтобы найти требование в таблице требований:

 1 Выберите Edit > Find. Откроется диалоговое окно Find.

 2 В поле Find in Field выберите поле таблицы.

 3 В поле Value to Find введите или выберите значение поля, которое 
необходимо найти.

 4 Выберите Exact Match, если необходимо найти требования, значения 
полей которых точно совпадают со строкой Value to Find.

 5 Выберите Case Sensitive, чтобы поиск выполнялся с учетом прописных и 
строчных символов.

 6 Выберите Use Wildcards, чтобы можно было использовать символы 
‘звездочки’ (*) в строке поиска и вводить только часть элемента.
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 7 Нажмите Find Next. При успешном завершении поиска соответствующее 
требование будет выбрано в таблице. При неуспешном завершении поиска 
откроется информационное окно.

 8 Нажмите Find Next еще раз, чтобы найти следующее требование, 
соответствующее критерию.

Замена значений полей
С помощью команды Replace можно заменять значения полей в дереве 
или таблице требований.

Замена значений полей в дереве Requirements
В дереве требований можно заменять значения полей в выбранном 
требовании и во всех его дочерних требованиях или во всех требованиях.

Чтобы заменить значение поля в дереве требований:

 1 Для замены значения полей в выбранном требовании и во всех его 
дочерних требованиях выберите Edit > Replace > Replace Selected. 

Чтобы заменить все значения, выберите Edit > Replace > Replace All. 

Откроется диалоговое окно Replace.

 2 В поле Find in Field выберите поле, в котором следует заменить значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 
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 4 В поле Replace with введите или выберите значение, которое будет 
использоваться для замены.

 5 Чтобы выполнить поиск с учетом прописных и строчных знаков, установите 
флажок Case Sensitive.

 6 Для поиска точного значения установите флажок Exact Match. 

 7 Для выдачи запроса перед каждой заменой значения установите флажок 
Prompt on replace. 

 8 Нажмите Replace. Если на этапе 7 был выбран параметр Prompt on 
replace , откроется диалоговое окно подтверждения.

➤ Выберите Yes, чтобы заменить текущий экземпляр значения.

➤ Выберите Replace All, чтобы заменить значение либо в выбранном 
требовании и во всех его дочерних требованиях, либо во всех 
требованиях в зависимости от настройки, выполненной на этапе 1.

 9 Откроется информационное диалоговое окно с указанием количества 
замененных значений и количества экземпляров, в которых значения 
заменены не были. Нажмите кнопку OK.

Замена значений полей в таблице Requirements
С помощью команды Replace можно выполнять замену значений полей в 
таблице требований.

Чтобы заменить значение поля в таблице требований:

 1 Выберите Edit > Replace. Откроется диалоговое окно Find/Replace.
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 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск конкретного значения. 

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение, которое будет 
подставлено в поле вместо старого значения.

 5 Чтобы выполнить поиск с учетом прописных и строчных знаков, установите 
флажок Case Sensitive.

 6 Для поиска точного значения установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы, установите флажок From 
Beginning.

 8 Чтобы можно было использовать в строке поиска символы звездочки (*) и 
вводить только часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажмите кнопку Replace.

 10 Для замены всех экземпляров значения в таблице нажмите кнопку Replace 
All.

Просмотр дерева требований
Можно изменять способ отображения дерева требований в модуле 
Requirements. Данное включает в себя увеличение и уменьшение дерева, 
обновление дерева, фильтрацию дерева, а также развертывание и 
свертывание ветвей дерева.

Увеличение дерева
В дереве требований можно увеличивать и уменьшать тематические 
разделы требований с тем, чтобы изменять уровень детализации 
отображения дерева.

Чтобы увеличить:

 1 Выберите тематический раздел требований в дереве требований.
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 2 Нажмите кнопку Zoom In на панели инструментов. Альтернативный 
вариант —щелкните требование правой кнопкой мыши и выберите Zoom 
In.

В дереве требований будет отображаться только выбранной тематический 
раздел требований с его заголовком и иерархическим путем к нему.

Чтобы уменьшить:

Изменить масштаб изображения можно, уменьшив его либо на один 
уровень, либо до иерархического уровня высшего порядка.

➤ Щелкните стрелку Zoom In и выберите Zoom Out One Level, чтобы 
отменить предыдущую команду масштабирования.

➤ Щелкните стрелку Zoom In и выберите Zoom Out To Root, чтобы 
уменьшить масштаб до иерархического уровня высшего порядка и 
отобразить все дерево требований. 

Обновление дерева
Можно обновить данные в дереве с тем, чтобы на отображение 
выводились самые последние требования. Чтобы обновить дерево, 
нажмите кнопку Refresh All.

Фильтрация требований
В модуле Requirements можно фильтровать и сортировать требования. 
Щелкните стрелку Set Filter/Sort и выберите один из следующих 
параметров.

➤ Задать фильтр/сортировку. Открывает диалоговое окно Filter, в 
котором можно фильтровать и сортировать требования в модуле 
Requirements. 

➤ Очистить фильтр/сортировку. Очищает все фильтры или сортировку, 
примененные пользователем к дереву или таблице требований.

Дополнительные сведения см. Глава 3, "Работа с данными Quality Center".
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Развертывание и свертывание дерева
В дереве требований можно разворачивать и сворачивать ветви с тем, 
чтобы изменять уровень детализации отображения дерева.

Чтобы развернуть и свернуть дерево:

➤ Чтобы развернуть какую-либо ветвь в дереве, щелкните знак Expand  
слева от имени ветви. Чтобы развернуть все уровни ветви, щелкните имя 
ветви правой кнопкой мыши и выберите Expand All. 

➤ Чтобы свернуть какую-либо ветвь в дереве, щелкните знак Collapse  
слева от имени ветви. Чтобы свернуть все уровни ветви, щелкните имя 
ветви правой кнопкой мыши и выберите Collapse.

Просмотр истории изменения требования 
В дереве требований можно просматривать список изменений, внесенных 
в любое требование.

Чтобы просмотреть историю изменений требования:

 1 В дереве требований выберите требование, а затем — View > Information 
Panel. 

 2 Выберите вкладку History. История изменений, внесенных в требование, 
будет отображена в таблице.

Для каждого внесенного в требование изменения в таблице отображается 
дата и время изменения, а также имя пользователя, внесшего изменение. 
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 3 Раскройте изменение, чтобы просмотреть список измененных полей. Для 
каждого поля в таблице отображаются старое и новое значения. Чтобы 
раскрыть все изменения, нажмите кнопку Expand All.

 4 Можно указать, какие изменения должны отображаться в таблице. В списке 
Field выберите имя поля, чтобы просмотреть те изменения, которые были 
внесены только в это поле. Для просмотра изменений, внесенных во все 
поля, выберите <All>.

Сведения об активации параметра History для отдельного поля см. в 
документе Руководство администратора HP Quality Center.

Отправка требований по электронной почте 
Можно отослать сообщение электронной почты о требовании другим 
пользователям, работающим над проектом Quality Center. Эта 
возможность позволяет регулярно информировать персонал групп 
разработки и контроля качества о статусе требований. В сообщение 
электронной почты включается ссылка, которая позволяет адресату 
переходить прямо к требованию.

Примечание. По умолчанию Quality Center отправляет сообщения 
электронной почты в формате HTML. Чтобы отправить сообщение 
электронной почты в виде обычного текста, отредактируйте параметр 
MAIL_FORMAT на вкладке Site Configuration в разделе Site Administration. 
Подробные сведения см. в документе Руководство администратора 
HP Quality Center.
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Чтобы отправить требование по электронной почте: 

 1 Выберите одно или несколько требований и нажмите кнопку Send by 
E-mail. Откроется диалоговое окно Send E-mail.

Совет. Предусмотрена возможность автоматической отсылки сообщений 
электронной почты определенному типу пользователей. Это может быть 
любой столбец требований со значением имени пользователя, включая и 
поля пользователя. Щелкните стрелку Send by E-mail  и выберите 
необходимый параметр. Например, для отсылки сообщения электронной 
почты пользователю, составившему требование, выберите Send by E-mail 
to Author.
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 2 Введите допустимый адрес электронной почты или имя пользователя. 
Альтернативный вариант —нажмите кнопку To или CC, чтобы выбрать 
пользователей. Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять поиск 
пользователей, компоновать пользователей по группам и выбирать 
пользователей из списка или из дерева групп. Дополнительные сведения 
см. в разделе “Выбор пользователей" на стр. 58.

Выберите пользователей или группы пользователей, которым необходимо 
отослать сообщение электронной почты, и нажмите кнопку OK. 

 3 В поле Subject введите тему сообщения электронной почты.

 4 Выберите, следует ли включать Attachments, History, Tests Coverage 
и/или Traced Requirements требования в сообщение. Если активирован 
параметр Attachments, любой текст в формате RTF требования будет 
включен в сообщение в виде отдельного вложения.

 5 В поле Additional comments добавьте необходимые комментарии.
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 6 Чтобы проверить правописание в диалоговом окне:

➤ Нажмите кнопку Check Spelling, чтобы проверить правописание 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки правописания, нажмите кнопку  Spelling 
Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить для выбранного 
слова синонимы, антонимы или связанные слова, нажмите кнопку 
Thesaurus. Замените выбранное слово или выполните поиск новых 
слов.

 7 Чтобы настроить сообщение электронной почты, щелкните Custom. В 
диалоговом окне Select Fields укажите, какие поля следует включить в 
сообщение электронной почты. 

 8 Чтобы отправить сообщение электронной почты, нажмите кнопку Send.

Изменение требований
Данный раздел, посвященный изменению требований, включает в себя 
следующие темы:

➤ Переименование требований

➤ Копирование требований

➤ Копирование URL требований

➤ Перемещение требований

➤ Удаление требований

Переименование требований
В модуле Requirements можно переименовать требование. Имя не может 
включать в себя следующие символы: \ ^ *
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Примечание. Корневую папку переименовать нельзя.

Чтобы переименовать требование:

➤ Чтобы переименовать требование в дереве, выберите его, а затем — Edit 
> Rename. Альтернативный вариант —щелкните правой кнопкой мыши и 
выберите Rename. Отредактируйте имя требования и нажмите ENTER.

➤ Чтобы переименовать требование в таблице, щелкните имя требования и 
введите новое имя.

Копирование требований
Можно копировать требования в одном проекте или между проектами. При 
копировании тематического раздела требования также выполняется 
копирование всех дочерних требований раздела.

Примечание. 

➤ Тестовое покрытие, связи дефектов и данные управления качеством на 
основе риска требования не копируются.

➤ Чтобы скопировать требование со связями прослеживаемости 
необходимо выполнить копирование связанных отслеживаемых 
требований.

➤ Корневую папку копировать в одном и том же проекте нельзя.

Чтобы скопировать требование:

 1 Выберите требование в дереве или таблице требований. Для копирования 
нескольких требований нажмите клавишу Ctrl и выберите подлежащие 
копированию требования.

 2 Выберите Edit > Copy. Альтернативный вариант —щелкните правой 
кнопкой мыши и выберите Copy. 
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 3 При копировании требования из таблицы в дерево требований выберите 
View > Requirements Tree. На отображение будет выведено 
представление Requirements Tree.

 4 Выберите требование в дереве требований.

 5 Выберите Edit > Paste. Альтернативный вариант —щелкните правой 
кнопкой мыши и выберите Paste.

Учтите, что при вставке требования с именем, аналогичным имени уже 
существующего требования, в конец имени требования будет 
автоматически добавлен суффикс _Copy. 

Копирование URL требований
Можно скопировать требование и вставить его URL в качестве ссылки. 
Само требование скопировано не будет не будет. Вместо этого можно 
вставить адрес в другое место, такое как сообщение электронной почты 
или документ. Щелчок по ссылке приведет к открытию Quality Center и 
переходу к требованию. 

Чтобы скопировать URL требование:

 1 Выберите требование в дереве или таблице требований. 

 2 Выберите Edit > Copy URL. Альтернативный вариант —щелкните правой 
кнопкой мыши и выберите Copy URL.

 3 Вставьте URL.

Перемещение требований
Требование можно переместить в другое место в дереве релизов. 
Перемещение требования также ведет к перемещению дочерних 
требований, тестового покрытия, связей прослеживаемости требований и 
связей с дефектами. Переместить корневую папку нельзя.

Совет. Требование также можно переместить в новое место в дереве 
релизов путем перетаскивания мышью.
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Чтобы переместить требование:

 1 Выберите требование в дереве требований. Для перемещения нескольких 
требований нажмите клавишу Ctrl и выберите подлежащие перемещению 
требования.

 2 Выберите Edit > Cut или щелкните требование правой кнопкой мыши и 
выберите Cut.

 3 Выберите требование в дереве требований.

 4 Выберите Edit > Paste. Альтернативный вариант —щелкните правой 
кнопкой мыши и выберите Paste. 

Удаление требований
Можно удалить требование из модуля Requirements. Удаление требования 
также ведет к удалению дочерних требований, тестового покрытия, связей 
прослеживаемости требований и связей с дефектами. Учтите, что 
корневую папку удалить нельзя.

Чтобы удалить требование:

 1 Выберите требование. Для удаления нескольких требований нажмите 
клавишу Ctrl и выберите подлежащие удалению требования.

 2 Нажмите кнопку Delete или щелкните правую кнопку мыши и выберите 
Delete.

 3 Для подтверждения нажмите кнопку Yes.

Создание тестов из требований 
После создания дерева требований используйте требования в качестве 
основные сведения о центре качества для определения тестов дерева 
плана проведения тестирования и выполнения тестов в наборе тестов. 
Учтите, что для создания тестов необходимы соответствующие права 
доступа.
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Создавать тесты из требований можно двумя способами:

➤ Преобразование требований в тесты. Преобразование требований в 
тесты в указанном объекте дерева плана проведения тестирования. Можно 
преобразовать выбранные требования или все требования в дереве 
требований. Такой способ, осуществляемый с помощью мастера Convert to 
Tests, помогает в разработке дерева плана проведения тестирования. См. 
раздел “Преобразование требований в тесты" на стр. 194.

➤ Генерирование теста из требований. Преобразование требований в тест 
в указанном объекте дерева плана проведения тестирования и указанном 
наборе тестов в модуле Test Lab. Данный способ, осуществляемый с 
помощью диалогового окна Generate Test, обеспечивает быстрое 
выполнение теста при анализе требований. См. раздел “Генерирование 
теста из требований" на стр. 199.

Преобразование требований в тесты
С помощью мастера Convert to Tests выполните преобразование 
требований в тесты в указанном объекте дерева плана проведения 
тестирования. Между требованиями и соответствующими им тестами 
тестовое покрытие будет создано автоматически.

Чтобы преобразовать требования в тесты:

 1 Для преобразования конкретного требования выберите его в дереве 
требований. Для преобразования всех требований выберите корневую 
папку требований в дереве требований.

 2 Выберите Requirements > Convert to Tests.
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Откроется диалоговое окно Step 1.

 3 Выберите автоматическое преобразование:

➤ Выберите Convert lowest child requirements to design steps, чтобы 
выполнить преобразование всех дочерних требований низшего уровня в 
этапы проектирования, требований следующего уровня — в тесты, а 
требований всех остальных более высоких уровней — в объекты.

➤ Выберите Convert lowest child requirements to tests, чтобы выполнить 
преобразование всех дочерних требований низшего уровня в этапы 
проектирования, а требований всех остальных более высоких уровней 
— в объекты.

➤ Выберите Convert all requirements to subjects, чтобы преобразовать 
все выбранные требования в объекты.
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 4 Нажмите кнопку Next , чтобы начать преобразование требований. Чтобы 
отменить процесс преобразования и вернуться к диалоговому окну Step 1, 
нажмите кнопку Stop на индикаторе выполнения. По завершении процесса 
преобразования результаты будут выведены в диалоговом окне Step 2.

Примечание. При преобразовании одного требования мастер пропустит 
диалоговое окно.

 5 Чтобы просмотреть условные обозначения мастера, щелкните ссылку 
Legend.

 6 Для каждого преобразованного элемента можно выполнить следующие 
операции:

➤ Выберите элемент и нажмите кнопку Convert to Subject или щелкните 
элемент правой кнопкой мыши и выберите Subject, чтобы изменить 
элемент на объект в дереве плана тестирования. После этого дочерние 
элементы могут быть либо объектами, либо тестами. Имена объектов 
должны быть уникальными.
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➤ Выберите элемент и нажмите кнопку Convert to Test или щелкните 
элемент правой кнопкой мыши и выберите Test, чтобы изменить 
элемент на тест в дереве плана тестирования. После этого дочерние 
элементы будут преобразованы в этапы. Имена тестов должны быть 
уникальными.

➤ Выберите элемент и нажмите кнопку Convert to Step или щелкните 
элемент правой кнопкой мыши и выберите Step, чтобы изменить 
элемент на этап в дереве плана тестирования. После этого дочерние 
элементы будут преобразованы в описания этапов.

➤ Выберите элемент и нажмите кнопку Convert to Description или 
щелкните элемент правой кнопкой мыши и выберитеDescription, чтобы 
изменить элемент на описание этапа в дереве плана тестирования. 
После этого дочерние элементы будут преобразованы в 
структурированный текст описания.

➤ Выберите элемент и нажмите кнопку Exclude from Conversion или 
щелкните элемент правой кнопкой мыши и выберите Exclude, чтобы 
исключить элемент из дерева плана проведения тестирования.

 7 Снимите метку с кнопки-флажка Auto Complete Children, если при 
внесении изменений помощь мастера не нужна. Если данный параметр 
выбран, и родительский элемент подвергается изменению, например 
преобразованию из объекта в тест, мастер изменит уровень дочернего 
объекта, например из тестов в этапы тестов.
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 8 Нажмите кнопку Next. Откроется диалоговое окно Step 3.

 9 В диалоговом окне Select Destination Subject под Destination Subject Path 
нажмите кнопку Select Subject, чтобы выбрать объект в дереве плана 
проведения тестирования. Альтернативный вариант —введите имя нового 
объекта. По умолчанию папка объектов и тесты помещаются в папку 
Subject модуля Test Plan. 

 10 Нажмите кнопку Finish. 

 11 Чтобы остановить процесс преобразования и вернуться к диалоговому окну 
Step 3, нажмите кнопку Stop на индикаторе выполнения. 

Примечание. Если процесс преобразования был остановлен, уже 
преобразованные требования из дерева плана проведения тестирования 
удалены не будут. Удалите такие требования вручную.

 12 Нажмите кнопку Close, чтобы закрыть мастер Convert to Tests или 
просмотреть сгенерированные сообщения об ошибках.
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Генерирование теста из требований
Используйте диалоговое окно Generate Test, чтобы преобразовать 
требования в тест в указанном объекте дерева плана проведения 
тестирования и указанном наборе тестов в модуле Test Lab. Между 
требованиями и соответствующими им тестами тестовое покрытие будет 
создано автоматически. Учтите, что по умолчанию для следующих типов 
требований, не поддерживающих тестовое покрытие, сгенерировать тест 
нельзя: Business, Folder и Group.

Чтобы сгенерировать тест из требований:

 1 Выберите требование, а затем — Requirements > Generate Test. 
Альтернативный вариант —в дереве требований щелкните требование 
правой кнопкой мыши и выберите Generate Test. Откроется диалоговое 
окно Generate Test.

 2 В поле Subject выберите объект из дерева плана проведения 
тестирования или введите имя нового объекта. По умолчанию тест 
помещается в папку Temporary Tests модуля Test Plan.

 3 В поле Test Name введите имя для нового теста. По умолчанию новому 
тесту назначается то же имя, что и имя требования.

 4 Если создавать этапы проектирования нет необходимости, снимите метку с 
кнопки-флажка Create Design Steps. Если данный параметр выбран, этап 
будет добавлен в тест для каждого дочернего требования.

 5 Выберите Add Test to Test Set, чтобы добавить тест в набор тестов в 
модуле Test Lab. В списке Test Set выберите набор тестов или введите имя 
нового набора тестов.

 6 Нажмите кнопку OK.
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13 
Отслеживание требований

Прослеживаемость требований устанавливает взаимосвязи между 
требованиями. При изменении требований или связанных с ними 
требований можно отслеживать и контролировать воздействие этих 
изменений на связанные требования. 

Глава содержит следующие разделы: На стр.

Сведения об отслеживании требований 202

Установление взаимосвязей прослеживаемости 205

Просмотр взаимосвязей прослеживаемости 208

Просмотр воздействия изменения требования при 
прослеживаемости

210

Удаление взаимосвязей прослеживаемости 212
201



Глава 13 • Отслеживание требований
Сведения об отслеживании требований 
Прослеживаемость требований устанавливает взаимосвязи между двумя 
или более требованиями. При анализе воздействия, которое окажет 
изменение, предложенное для внесения в конкретное требование, на 
другие требования связи прослеживаемости указывают на те требования, 
на которые такое изменение может оказать воздействие. 

После определения требований в дереве требований (см. главу Глава 12, 
"Разработка дерева требований") можно установить прослеживаемость 
между требованиями. Добавлять связи прослеживаемости, идущие к 
выбранному требованию и от него, можно на вкладке Requirements 
Traceability окна Requirement Details. Связи Trace from указывают те 
требования, которые воздействуют на выбранное требование. Связи Trace 
to указывают те требования, на которые воздействует выбранное 
требование.

При изменении требования Quality Centerоповещает те требования, на 
которые данное изменение оказывает воздействие. Эти оповещения могут 
видеть все пользователи. Quality Center также передает уведомления 
-электронной почты авторам затронутых изменением требований. 
Дополнительные сведения об оповещениях см. в главеГлава 4, 
"Оповещение об изменениях".
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Пример прослеживаемости требований
Чтобы реализовать взаимосвязи между требованиями, предположим, что 
требования Requirement_1B и Requirement_2B оказывают влияние на 
требование Requirement_1A. Выберите требование Requirement_1A в 
дереве требований. На вкладке Relationships добавьте требования 
Requirement_1B и Requirement_2B в таблицу «Отслеживание от». 
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При выборе требования Requirement_1B в дереве требований в таблице 
«Отслеживание к» будет указано, что требование Requirement_1B 
отслеживается к требованию Requirement_1A. При выборе требования 
Requirement_2B в дереве требований в таблице «Отслеживание к» будет 
указано, что требование Requirement_2B отслеживается к требованию 
Requirement_1A.  
204



Глава 13 • Отслеживание требований
При изменении требования Quality Center устанавливает флажки 
отслеживания для требований, к которым выполняется отслеживание, и 
направляет по -электронной почте уведомления авторам требований, 
чтобы они оценили воздействие изменения на свои требования. Например, 
при изменении требования Requirement_1B или Requirement_2B, 
Quality Center оповещает требование Requirement_1A и уведомляет его 
автора. Учтите, что оповещения могут видеть все пользователи. 

Установление взаимосвязей прослеживаемости
Устанавливать взаимосвязи прослеживаемости между требования можно 
на вкладке Relationships. Эта вкладка содержит таблицы «Отслеживание 
от» и «Отслеживание к». В таблице «Отслеживание от» отображаются 
требования, которые воздействуют на выбранное требование. В таблице 
«Отслеживание к» отображаются требования, на которые воздействует 
выбранное требование.

Чтобы установить взаимосвязь, выберите требование из дерева или 
введите идентификатор требования. 

Чтобы установить взаимосвязь с помощью дерева требований:

 1 В окне Requirement Details выберите требование из дерева и перейдите на 
вкладку Requirements Traceability. По умолчанию отображается вкладка 
Relationships.
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 2 Щелкните стрелку Show/Hide, чтобы отобразить либо таблицу 
«Отслеживание от», либо таблицу «Отслеживание к». 

 3 На вкладке Relationships нажмите кнопку Add Requirement Traceability , 
чтобы открыть дерево требований в правой области.

 4 Чтобы выполнить поиск того или иного требования в дереве, введите имя 
(или часть имени) требования в поле Find и нажмите кнопку Find. При 
успешном завершении поиска требование будет выделено в дереве.

 5 Для фильтрации или сортировки требований в дереве нажмите кнопку Set 
Filter/Sort. Дополнительные сведения о фильтрации и сортировке записей 
см. в главе Глава 3, "Работа с данными Quality Center". 

 6 Чтобы обновить дерево, нажмите кнопку Refresh All. 

 7 Для добавления требования в таблицу выполните одно из следующих 
действий: 

➤ Щелкните стрелку Add to Traceability  и выберите Add to Traceability 
(Trace To), чтобы добавить требование в таблицу «Отслеживание к».

➤ Щелкните стрелку Add to Traceability и выберите Add to Traceability 
(Trace From), чтобы добавить требование в таблицу «Отслеживание 
от».

Требование будет добавлено в таблицу.
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Совет. Также можно добавлять связи прослеживаемости требования 
путем перетаскивания требования из дерева в соответствующую таблицу.

 8 Нажмите кнопку Close, чтобы скрыть дерево требований в правой области.

Чтобы установить взаимосвязь путем ввода идентификатора 
требования:

 1 В окне Requirement Details выберите требование из дерева и перейдите на 
вкладку Requirements Traceability. По умолчанию отображается вкладка 
Relationships.

 2 Щелкните стрелку Show/Hide, чтобы отобразить либо таблицу 
«Отслеживание от», либо таблицу «Отслеживание к». 

 3 Нажмите кнопку Add Requirement Traceability и выберите один из 
следующих параметров:

➤ By ID (Trace From). Добавление связи прослеживаемости в таблицу 
«Отслеживание от» путем ввода идентификатора требования.

➤ By ID (Trace To). Добавление связи прослеживаемости в таблицу 
«Отслеживание к» путем ввода идентификатора требования.

Откроется диалоговое окно Trace Existing Requirement.

 4 Введите идентификатор требования, которое необходимо добавить, и 
нажмите кнопку Trace. Требование будет добавлено в указанную таблицу.
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Просмотр взаимосвязей прослеживаемости
На вкладке Relationships можно отобразить существующие между 
требованиями взаимосвязи прослеживаемости. Эта вкладка содержит 
таблицы «Отслеживание от» и «Отслеживание к». В таблице 
«Отслеживание от» отображаются требования, которые воздействуют на 
выбранное требование. В таблице «Отслеживание к» отображаются 
требования, на которые воздействует выбранное требование. 

Кроме столбцов, описанных в разделе“Поля требований" на стр. 162, 
вкладка Relationships также может содержать следующие столбцы:

Столбец Описание

Created By Имя пользователя лица, создавшего связь для 
требования. По умолчанию это имя пользователя для 
входа в систему. 

Creation Date Дата создания связи для требования. По умолчанию дата 
создания формируется в текущем сервере базы данных.

Modified Дата и время изменения связи для требования. По 
умолчанию дата и время формируются в текущем 
сервере базы данных.
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Для просмотра взаимосвязей прослеживаемости:

 1 В окне Requirement Details выберите требование из дерева требований и 
перейдите на вкладку Requirements Traceability. По умолчанию 
отображается вкладка Relationships.

 2 Для обновления информации, отображаемой в таблицах, нажмите кнопку  
Refresh All. 

 3 Для настройки размеров столбцов и порядка их отображения щелкните 
стрелку Select Columns и выберите Select Column (Trace From) или 
Select Column (Trace To). Откроется диалоговое окно Select Columns. 
Дополнительные сведения см. в разделе “Упорядочивание столбцов" на 
стр. 55.

 4 Чтобы отобразить отслеживаемое требование в дереве, выберите 
требование и нажмите кнопку Go To Requirement.

 5 Что просмотреть сведения об отслеживаемом требовании, выберите 
отслеживаемое требование и нажмите кнопку Requirement Details. 
Откроется диалоговое окно Requirement Details. Дополнительные сведения 
см. в разделе “Обновление требований" на стр. 178.

Requirement Trace 
ID

Уникальный буквенно-цифровой идентификатор связи 
для требования, назначаемый автоматически.

Trace Comment Отображает комментарии к связи для требования.

Столбец Описание
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Просмотр воздействия изменения требования при 
прослеживаемости

После установления взаимосвязей прослеживаемости можно 
проанализировать воздействие изменений требований путем просмотра 
взаимосвязей. С помощью вкладки Impact Analysis можно определить 
количество связей и зависимостей между требованиями, отобразив их в 
виде иерархической структуры — дерева. В отличие от вкладки 
Relationships, на вкладке Impact Analysis отображаются требования, на 
которые оказали влияние изменения, а также их родительские и дочерние 
требования. 

В дереве «Отслеживание от» отображаются требования, которые 
воздействуют на выбранное требование. Например, в дереве Trace From 
видно, что требование Req_A отслеживается от 
требованияRequirement_1B. Requirements является родительским 
требованием для требования Req_A. Req_B является родительским 
требованием для требования Requirement_1B. 
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В дереве Trace To отображаются те требования, на которые воздействует 
выбранное требование. Например, в дереве «Отслеживание к» видно, что 
требование Requirement_1B отслеживается к требованию Req_A, а 
требования Requirement_1A — Requirement_4A являются дочерними 
требованиями для требования Req_A, на которое влияет требование 
Req_A. 

Вкладка Impact Analysis содержит следующие значки:

Значок Описание

Дочернее требование, на которое воздействует изменение в 
выбранном требовании.

Родительское требование, которое воздействует на выбранное 
требование.

Требование, к которому ведется отслеживание.

Требование, от которого ведется отслеживание.

Рекурсивная взаимосвязь между требованиями.
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Для просмотра воздействия изменения требования при 
прослеживаемости:

 1 В окне Requirement Details выберите требование из дерева и перейдите на 
вкладку Requirements Traceability. По умолчанию отображается вкладка 
Relationships.

 2 Выберите вкладку Impact Analysis.

 3 Чтобы обновить дерево, нажмите кнопку  Refresh All. 

 4 Чтобы отобразить отслеживаемое требование в дереве, выберите 
требование и нажмите кнопку Go To Requirement.

 5 Что просмотреть сведения об отслеживаемом требовании, выберите его и 
нажмите кнопку Requirement Details. Откроется диалоговое окно 
Requirement Details. Дополнительные сведения см. в разделе “Обновление 
требований" на стр. 178.

Удаление взаимосвязей прослеживаемости
Удалять взаимосвязи прослеживаемости можно на вкладке Relationships.

Для удаления взаимосвязи прослеживаемости:

 1 В окне Requirement Details выберите требование из дерева требований и 
перейдите на вкладку Requirements Traceability. По умолчанию 
отображается вкладка Relationships.

 2 Щелкните стрелку Show/Hide, чтобы отобразить либо таблицу 
«Отслеживание от», либо таблицу «Отслеживание к». 

 3 В соответствующей таблице выберите взаимосвязь прослеживаемости. 
Для выбора более одной взаимосвязи нажмите клавишу Ctrl и выберите 
взаимосвязи, которые необходимо удалить.

 4 Нажмите кнопку Remove from Traceability или щелкните правой кнопкой 
мыши и выберите Remove from Traceability.

 5 Для подтверждения нажмите кнопку Yes.
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14 
Расчет рисков требований

Управление качеством на основе рисков можно использоваться для 
принятия решения о стратегии тестирования требований.

Глава содержит следующие разделы: На стр.

Сведения о расчете рисков требований 214

Описание процесса управления качеством на основе рисков 215

Определение категории рисков 217

Задание параметров политики тестирования 219

Окончательное оформление политики тестирования 222

Анализ стратегии тестирования 226

Пример управления качеством на основе рисков 231
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Сведения о расчете рисков требований 
Обычно при разработке плана тестирования требований пользователь 
имеет лишь ограниченные ресурсы и не может выполнить тестирование 
каждого требование полностью. Поэтому необходимо прийти к 
определенному компромиссу и выполнять только частичное тестирование 
требований, имеющих низкую критичность для бизнеса, или требований, 
реализация которых связана с минимальными рисками. Функция 
управления качеством на основе рисков позволяет выполнять расчет того, 
на каком уровне следует проводить тестирование каждого требования, 
исходя из характера требования и доступных ресурсов. Затем на основе 
этих рекомендаций можно приступить к планированию процесса 
тестирования.

Для каждого типа требований можно включить функцию управление 
качеством на основе риска. Каждый тип требований, для которого 
включена функция управления качеством на основе рисков, поддерживает 
либо анализ рисков, либо оценку рисков:

➤ Требование анализа — это требование, которое принадлежит к типу 
требований, имеющих более высокий уровень в дерева требований, 
например к типу Folder. Анализ рисков в соответствии с требованиями 
анализа выполняется на основании требований оценки, расположенных в 
дереве под требованиями анализа.

➤ Требование оценки — это требование, которое принадлежит к типу 
требований, являющихся дочерними по отношению к требованиям анализу 
и расположенных на более низком уровне в дереве. Требования оценки, 
расположенные под конкретным требованием анализа, содержат основные 
сведения для анализа рисков в соответствии с таким требованием 
анализа. 

Работа с функцией управления качеством на основе рисков 
осуществляется в окне Requirement Details модуля Requirements. Функцию 
управления качеством на основе рисков также можно использовать в окне 
Risk диалогового окна Requirement Details.

Можно выбрать параметры по умолчанию для функции управления 
качеством на основе рисков Дополнительные сведения о выборе 
параметров управления качеством на основе рисков см. в Руководство 
администратора HP Quality Center. 
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Описание процесса управления качеством на основе 
рисков

Анализ управления качеством на основе рисков в соответствии с 
требованиями анализа включает в себя следующие этапы: 

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements

Определение
категорий рисков

Определение параметров
политики тестирования

Окончательное оформление
политики тестирования

Анализ стратегии
тестирования
215



Глава 14 • Расчет рисков требований
Определение категорий рисков 
Для каждого требования оценки, расположенного под требованием 
анализа, определяется категория рисков. Категория рисковRisk Category 
состоит из двух факторов: Business Criticality и Failure Probability. Business 
Criticality определяет критичность требования для деятельности 
компании. Failure Probability — вероятность того, что тест, разработанный 
на основе требования, не будет пройден, учитывая сложность реализации 
требования. Quality Center может рассчитать значение для каждого из этих 
факторов, на основе из значений, заданных для каждого набора условий, 
связанных с этими факторами. Также можно задать значение каждому 
фактору непосредственно. Дополнительные сведения см. в разделе 
“Определение категории рисков" на стр. 217.

Задание параметров политики тестирования
После определения категории рисков для требований оценки, 
расположенных под требованием анализа, необходимо задать начальные 
параметры тестирования требования анализа и расположенных под ним 
требований оценки. Данные параметры включают время оценки 
требований с конкретной вероятностью отказа полного теста и времени 
выполнения частичного или основного теста для требования. Также 
необходимо определить уровень тестирования требований для каждой 
категории рисков. Дополнительные сведения см. в разделе “Задание 
параметров политики тестирования" на стр. 219.

 Завершение политики тестирования
После задания параметров политики тестирования Quality Center 
вычисляет общее расчетное время тестирования в соответствии с 
требованием анализа и расположенными под ним требованиями оценки. 
Пользователь может определять, какое количество ресурсов необходимо 
назначить для тестирования этих требований, и корректировать политику 
тестирования, чтобы обеспечить достаточное время для выполнения всего 
процесса тестирования и предотвратить нерациональное использование 
ресурсов. Дополнительные сведения см. в разделе “Окончательное 
оформление политики тестирования" на стр. 222.

Анализ стратегии тестирования
После принятия окончательного решения о том, какое количество ресурсов 
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следует выделить каждому требованию, пользователь может просмотреть 
отчет и проанализировать сделанные им выводы. Дополнительные 
сведения см. в разделе “Анализ стратегии тестирования" на стр. 226.

Пример использования функции управления качеством на основе рисков 
при принятии решения о выборе стратегии тестирования требования см .в 
“Пример управления качеством на основе рисков" на стр. 231.

Определение категории рисков
Категорию рисков можно либо назначить требованию оценки, либо 
рассчитать ее. Категория рисков состоит из бизнес-критичности и 
вероятности отказа. Quality Center использует категорию рисков для 
расчета того, какое количество ресурсов следует выделить каждому 
требованию.

➤ Бизнес-критичность требования представляет собой оценку важности 
требования для деятельности компании. Этот параметр не оценивает 
сложность реализации требования. Требование может иметь одно из трех 
значений: A - Critical, B - Important и C - Nice to Have. Например, 
требованию, оказывающему влияние на менее важную функцию, которая 
будет использоваться редко, можно задать бизнес-критичность Nice to 
Have, а требованию, являющемуся существенным для функциональности 
приложения, может быть задана бизнес-критичность Critical.

➤ Вероятность отказа для требования — мера достоверности того, что тест, 
соответствующий определенному требованию, не будет пройден, учитывая 
сложность технической реализации этого требования (при этом не 
учитывается воздействие требования на деятельность компании). 
Требование может иметь одно из трех значений: 1 (Высокая), 2 (Средняя) 
и 3 (Низкая). Например, требование, для реализации которого требуется 
внесение значительных изменений в большинство компонентов 
приложения, возможно, имеет высокий уровень сложности и поэтому ему 
необходимо задать вероятность отказа Высокая. И, наоборот, требование, 
для реализации которого необходимо изменить лишь значок в приложении, 
имеет немного связанных с ним рисков, и поэтому ему может быть задана 
вероятность отказа Низкая.
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Определение бизнес-критичности и вероятности отказа для требования 
выполняется либо путем задания им значений непосредственно, либо 
путем  задания значений набору условий. Если оба этих фактора не 
определены для требования, Quality Center не включает такое требование 
в анализ рисков.

Можно настраивать эти условия, их возможные значения и то, как эти 
значения определяют бизнес-критичность и вероятность отказа. 
Дополнительные сведения см. в разделе Руководство администратора 
HP Quality Center.

Для определения категории рисков для требования:

 1 В окне Requirement Details модуля Requirements выберите требование к 
оценке рисков и перейдите на вкладку Risk. На вкладке Risk выберите 
вкладку Business Criticality. На вкладке Business Criticality отображается 
перечень условий, использующихся для определения бизнес-критичности. 
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 2 Задайте значение каждому условию. Чтобы задать значение условию, в 
столбце Criterion щелкните имя условия и выберите значение из столбца 
Value. Просмотреть описание критерия можно в поле Description of 
Criterion.

После задания значения каждому условию выполняется обновление 
расчетной бизнес-критичности в соответствии с заданными условиям 
значениями.

 3 Чтобы пропустить значение бизнес-критичности, рассчитанное на 
основании значений условий, и при анализе рисков использовать вместо 
него присвоенное пользователем значение, установите флажок Override 
calculated value. В поле Custom Business Criticality выберите значение 
бизнес-критичности, которое необходимо использовать при выполнении 
анализа рисков.

 4 Перейдите на вкладку Failure Probability и повторите шаги 2 —3, 
приведенные выше, чтобы определить значение вероятности отказа для 
требования.

 5 Чтобы при выполнении анализа рисков пропускать требование оценки, 
установите флажок Exclude from Analysis, расположенный в верхней 
части вкладки Risk.

 6 В поле Estimated development time  введите расчетное время, 
необходимое для разработки требования анализа. После этого 
Quality Center сможет рассчитать общее расчетное время разработки 
требования анализа и его дочерних требований как сумму расчетного 
времени, необходимого для разработки дочерних требований. Задавать 
расчетные ресурсы для разработки необязательно, поскольку это не 
оказывает влияния на  анализ рисков 

Задание параметров политики тестирования
После определения категории рисков для каждого требования определите 
время, в течение которого должно тестироваться каждое требование. 
Время, необходимое для тестирования требования, зависит от 
вероятности отказа для требования. Как правило, для требования с 
высокой вероятностью отказа требуется большая время  тестирования, 
поскольку велика вероятность того, что реализация требования содержит в 
219



Глава 14 • Расчет рисков требований
себе дефект. Для каждой вероятности отказа необходимо задать 
длительность тестирования, необходимое для полной проверки 
требования с заданной вероятностью отказа. Длительность тестирования 
измеряется с помощью метки, заданной в окне Project Customization. 
Длительность тестирования измеряется в часах, днях, неделях или 
месяцах.

В Quality Center используются четыре уровня тестирования: Full, Partial, 
Basic и None. Для частичного и основного тестирования можно задать 
необходимую время тестирования в соответствии с требованием (в 
процентах от длительности полного тестирования). Например, если для 
полного тестирования требования необходимо 20 часов, а для частичного 
тестирования задано 75% от продолжительности полного тестирования, 
Quality Center рассчитает, что для выполнения частичного тестирования 
требования необходимо 15 часов. Требование, для которого установлен 
уровень тестирования None, не тестируется, и поэтому значение Testing 
Effor равно нулю.

После определения длительности тестирования для каждого уровня 
тестирования и вероятности отказа можно оценить уровень тестирования 
требований. для каждой категории рисков, назначенных уровню 
тестирования. В результате можно задать уровень тестирования 
требований, соответсвующих этой категории рисков.

Можно настроить политику тестирования, использующуюся по умолчанию. 
Дополнительные сведения см. в руководстве Руководство 
администратора HP Quality Center. 
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Для задания параметров политики тестирования для требования: 

 1 В окне Requirement Details модуля Requirements выберите требование 
анализа и перейдите на вкладкуRisk. Нажмите кнопку Show , чтобы 
отобразить раздел Change Analysis Constants.

 2 Под строкой Testing Time (full) per failure probability для каждого 
указанного значения вероятности отказа введите расчетное время, 
необходимое для того, чтобы полностью протестировать требование.

 3 Под строкой Testing level в полях Partial и Basic введите время 
тестирования по умолчанию, необходимое для частичного и основного 
тестирования требования. Эти значения вводятся в процентах от 
длительности полного тестирования.

 4 В таблице Testing Policy можно задавать уровень тестирования 
требования для каждой категории рисков.

Чтобы задать уровни, щелкните стрелку рядом с ячейкой таблицы, 
соответствующей конкретному значению категории рисков. Выберите 
уровень из доступных уровней тестирования. Доступные уровни 
тестирования: Full, Partial, Basic и None. Рядом с каждым уровнем 
тестирования указано расчетное время, необходимое для тестирования 
требования на данном уровне, с учетом ресурсов и уровней тестирования, 
определенных пользователем. 
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 5 Чтобы отобразить константы, используемые по умолчанию, заданные в 
окне Project Customization, нажмите кнопку Show Defaults. Откроется 
диалоговое окно Risk-Based Quality Management Constants Defaults.

В диалоговом окне Risk-Based Quality Management Constants Defaults 
нажмите кнопку Restore Defaults, чтобы присвоить эти значения по 
умолчанию константам, использующимся в текущем требовании.

Нажмите кнопку Close, чтобы закрыть диалоговое окно Risk-Based Quality 
Management Constants Defaults.

Окончательное оформление политики тестирования
На основании разработанной пользователем политики тестирования 
Quality Center может вычислить общее расчетное время тестирования в 
соответствии с требованием анализа и расположенными под ними 
требованиями оценки. Чтобы не допустить превышения необходимого 
времени тестирования над доступными ресурсами тестирования, следует 
оценить, какой ресурс времени доступен для тестирования этих 
требований, и внести корректировки в политику тестирования.

Например, для тестирования требования требуется 100 часов. 
Quality Center подсчитывает, что для тестирования этого требования с 
текущими уровнями тестирования необходимо 120 часов. Пользователь 
принимает решение о снижении уровня тестирования для требований с 
бизнес-критичностью Nice to Have и вероятностью отказа Medium с Partial 
до Basic. После корректировки уровня тестирования и пересчета времени 
тестирования Quality Center определяет, что для выполнения тестирования 
необходимо 98 часов, что соответствует имеющемуся ресурсу времени. 
Теперь можно разработать план тестирования требований на основе 
рекомендаций Quality Center.

Чтобы окончательно оформить политику тестирования:

 1 Убедитесь, что категория рисков определена для всех требований оценки, 
расположенных под требованием анализа, для которого необходимо 
окончательно оформить политику тестирования и которое следует 
включить в анализ рисков. Дополнительные сведения об определении 
категории рисков см. в разделе “Определение категории рисков" на 
стр. 217.
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 2 Чтобы включить в анализ рисков только требования оценки, можно 
применить фильтр к дереву требований. Дополнительные сведения о 
фильтрации см. в разделе “Фильтрация записей" на стр. 59.

 3 Если не требуется использовать значения Testing Effort и Testing Level по 
умолчанию, задайте для них пользовательские значения. Дополнительные 
сведения см. в разделе “Задание параметров политики тестирования" на 
стр. 219.

 4 В окне Requirement Details модуля Requirements выберите требование 
анализа и перейдите на вкладкуRisk.

 5 В поле Total allocated testing time введите время, имеющееся для 
тестирования требования анализа и расположенных под ним требований 
оценки.
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 6 Нажмите кнопку Perform Risk Analysis. Quality Center рассчитает уровень 
тестирования и время тестирования для каждого требования оценки под 
требованием анализа, соответствующего текущему фильтру. Такой расчет 
основывается на оценке категории рисков для требований, а также 
значениях уровня и времени тестирования, определенных пользователем 
для требования анализа. Результаты расчета отображаются следующим 
образом:

➤ Total required testing time. Общее расчетное время, необходимое для 
тестирования всех требований оценки, расположенных под 
требованием анализа, соответствующих текущему фильтру и 
включенных в анализ рисков.

➤ Total required development time. Общее время, необходимое для 
разработки всех требований оценки, расположенных под требованием 
анализа, на основе необходимого для разработки времени, расчет 
которого был выполнен пользователем отдельно для каждого 
требования оценки рисков.

➤ Диаграмма No. of Requirements per Risk Category. Количество 
дочерних требований для требования анализа для каждой категории 
рисков.

➤ Диаграмма Total Testing Time per Risk Category. Общее расчетное 
время , необходимое для тестирования всех требований для каждой 
категории рисков.

 7 Чтобы отобразить требования, включенные в каждую категорию рисков и 
не включенные в анализ Risk Category рисков, щелкните сегмент на 
диаграмме Requirements per Risk или ссылки missing assessment  и 
excluded. Откроется диалоговое окно Drill Down Results, в котором, 
отображающее таблицу, содержащую требования и категории риска. 
Можно задать порядок отображения и размеры столбцов и просматривать 
сведения по отдельному требованию. Также можно экспортировать 
содержимое таблицы в виде текстового файла, электронной таблицы 
Microsoft Excel, документа Microsoft Word или HTML. Дополнительные 
сведения см. в разделе “Экспорт данных в файл" на стр. 78.
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Совет. Если перейти на ссылку missing assessment , то отобразятся те 
требования, для которых категория рисков не была определена или 
которые были явным образом исключены из анализа рисков. 
Рекомендуется проверять такие требования, чтобы не пропустить те из 
них, которым должна быть назначена категория рисков. Если требование 
не должно содержаться в анализе рисков, рекомендуется исключить его 
явным образом.

 8 Сравните общее расчетное время тестирования с имеющимися ресурсами. 
Если имеющихся ресурсов для тестирования требования с текущими 
параметрами недостаточно, рекомендуется задать более низкий уровень 
тестирования для определенной категории рисков или сократить время 
тестирования для каждого уровня тестирования и выполнить расчет еще 
раз. Дополнительные сведения об изменении уровней и времени 
тестирования см. в разделе“Задание параметров политики тестирования" 
на стр. 219.

 9 Если вы удовлетворены политикой тестирования, нажмите кнопку Save and 
Apply to Children, чтобы применить ее ко всем требованиям оценки, 
расположенным под требованием анализа, соответствующим текущему 
фильтру.

 10 Теперь можно проанализировать, какое влияние политика тестирования, 
разработанная для требования анализа, оказывает на расположенные под 
ним требования оценки и создать подробный отчет о стратегии 
тестирования. Дополнительные сведения см. в разделе “Анализ стратегии 
тестирования" на стр. 226. 
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Анализ стратегии тестирования
После окончательного оформления политики тестирования для 
требования анализа можно проанализировать стратегию тестирования для 
требования анализа и расположенных под ним требований оценки. Учтите, 
что результаты анализа рисков доступны лишь по завершении анализа. 
Если в дальнейшем категория рисков или политика тестирования 
требований будут изменены, следует выполнить анализ повторно.

Анализ стратегии тестирования в соответствии с 
требованиями анализа
После окончательного оформления политики тестирования в соответствии 
с требованиями анализа рисков можно создать подробный отчет о 
стратегии тестирования.

Чтобы проанализировать стратегию тестирования в соответствии с 
требованиями анализа:

 1 В окне Requirement Details модуля Requirements выберите требование 
анализа и перейдите на вкладкуRisk.

 2 Нажмите кнопку Generate Report. Откроется диалоговое окно Generate 
Report.

 3 В поле Default Location введите место и имя файла Word, в который 
следует экспортировать данные. Для выбора местоположения в 
диалоговом окне Save As нажмите кнопку обзора.
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 4 Кроме сохранения отчета в указанной папке его можно добавить как 
вложение в требование анализа. Для этого установите флажок Add report 
as attachment.

 5 Чтобы добавить в отчет перечень требований, включенных в анализ 
рисков, установите флажок Include list of requirements in the report.

 6 Нажмите кнопку Generate. Отчет создается и сохраняется в указанной 
папке.

В зависимости от параметров, выбранных пользователем в диалоговом 
окне Generate Report, отчет может содержать следующие заголовки:

Заголовок Описание

Date last saved Дата выполнения последнего анализа рисков.

Filter Фильтр, использовавшийся для поиска требований, 
которые необходимо включить в анализ рисков.
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Processed Количество требований, включенных в анализ 
рисков. Содержит распределение требований по 
следующим группам: требования , для которых 
есть оценка рисков, требования , для которых нет 
оценки, и требования, которые исключены из 
оценки.

Total required testing time Обще время, необходимое для тестирования 
требований, включенных в анализ рисков в 
соответствии с разработанной пользователем 
политикой тестирования.

Total allocated testing 
time

Общее время, выделенное для тестирования 
требований, включенных в анализ рисков.

Total required 
development time

Общее время, необходимое для разработки 
функций, определенных в требованиях.

No. of Requirements per 
Risk Category

Диаграмма распределения количества требований 
по категориям рисков. 

Total Testing Time per 
Risk Category

Диаграмма, отображающая общее время, 
необходимое для тестирования всех требований 
для каждой категории рисков.

Implemented testing 
policy

Время, необходимое для тестирования 
требований, принадлежащих к каждой категории 
рисков в соответствии с политикой тестирования, 
использующейся для анализа рисков.

Analyzed requirements Перечень требований, включенных в анализ рисков 
и имеющих оценки рисков, а также 
соответствующие категории рисков, уровни 
тестирования и время тестирования.

Заголовок Описание
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Анализ стратегии тестирования в соответствии с 
требованиями оценки
После окончательного оформления политики тестирования в соответствии 
с требованиями анализа можно проанализировать ее воздействие на 
требования оценки, расположенные под требованием анализа. 

Чтобы проанализировать стратегию тестирования для требования 
оценки:

 1 В окне Requirement Details модуля Requirements выберите требование 
оценки рисков и перейдите на вкладкуRisk. Выберите вкладку Analysis 
Results.

Requirements with 
missing assessments

Перечень требований, включенных в анализ 
рисков, которые не имею оценок рисков.

Excluded requirements Перечень требований, исключенных из анализа 
рисков. Он содержит требования, исключенные из 
анализа явным образом, или требования, 
принадлежащие к такому типу, который функция 
управления качеством на основе рисков не 
поддерживает.

Заголовок Описание
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На вкладке Analysis Results отображаются результаты последнего анализа, 
выполненного для требования анализа, являющегося родительским для 
требования оценки:

➤ Based on analysis requirement. Требование анализа, в соответствии с 
которым был выполнен последний анализ, включающий в себя текущее 
требование. Чтобы перейти к требованию анализа в дереве требований, 
щелкните имя требования анализа.

➤ Last analysis on date. Дата выполнения последнего анализа, 
включающего в себя текущее требование.

➤ Overall Risk Assessment. Бизнес-критичность и вероятность отказа для 
требования.

➤ Calculated Testing Level. Уровень тестирования требования, 
рассчитанный при последнем анализе, который включает в себя 
текущее требование.

➤ Calculated Testing Time. Время, выделенное для тестирования 
требования и рассчитанное при последнем анализе, который включает 
в себя текущее требование.

 2 Чтобы переопределить расчетные значения при следующем расчете и 
использовать вместо них пользовательские значения, установите флажок 
Use these for the next calculation. В поле Testing Level выберите уровень 
тестирования, который будет использоваться для следующего расчета. В 
поле Testing Time выберите мероприятие тестирования, которое будет 
использоваться для следующего расчета. При выполнении последующего 
анализа, включающего в себя текущее требование, эти значения будут 
использоваться вместо расчетных значений.

Примечание. Если для требования категория рисков не определена, 
переопределить расчетные значения невозможно. Дополнительные 
сведения об определении категории рисков для требования см. в 
“Определение категории рисков" на стр. 217.
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Пример управления качеством на основе рисков
Предположим, вы работаете с проектом, использующим приложение для 
бронирования авиабилетов. Необходимо разработать план тестирования 
требования анализа Online Travel Information Source, расположенного 
под требованием Mercury Tours Application.
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Сначала следует присвоить значения условиям бизнес-критичности для 
дочернего требования оценки рисков Itineraries Information. Поскольку 
данные о маршрутах путешествий необходимы только для отображения 
информации, и не требуется их расчет или проверка, условиюType of 
Process следует присвоить значение Display. А так как неправильная 
информация о маршрутах путешествий может послужить причиной для 
судебного иска, условиюImpact of failure следует присвоить значение 
Legal. УсловиюFrequency of use необходимо присвоить значение Very 
often, а условиюNumber/Significance of affected users — значение 
Many/High. Quality Center рассчитает бизнес-критичность для требования 
как A.

Определение вероятности отказа выполняется аналогичным образом 
путем присвоения значений условиям. Quality Center рассчитывает 
вероятность отказа как 2, задавая общую категорию рисков A2. Затем 
необходимо задать категорию рисков для каждого требования оценки 
Maps, Travel Guides и Tips & FAQ.
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Теперь все готово для анализа рисков для требования Online Travel 
Information Source. Вы решили использовать для анализа рисков политику 
тестирования Quality Center по умолчанию. Quality Center рассчитал, что 
для тестирования требования необходимо 63 часа. Однако ресурс времени 
составляет всего 50 часов, то есть 79% от необходимых ресурсов. Поэтому 
политику тестирования необходимо изменить.

Вы меняете уровень тестирования для требований с категорией рисковA2 с 
Full на Partial. Quality Center пересчитывает время, необходимое для 
тестирования требований. Теперь это время составляет 58 часов и 
по-прежнему превышает имеющийся ресурс времени. Следовательно, 
необходимо изменить время частичного тестирования, выделив для него 
не 67%, а 55% от времени полного тестирования. Теперь расчетное время, 
необходимое для тестирования требования, составляет 52 часа и 
совпадает с имеющимся ресурсом времени. Поэтому такую политику 
тестирования следует принять.
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Теперь ресурсов для тестирования требования, достаточно, и можно 
создать отчет об анализе рисков, чтобы определить стратегию 
тестирования, рекомендованную Quality Center, а затем предоставить ее 
группе тестировщиков, чтобы они на ее основе разработали план 
тестирования.
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15
Разработка  плана тестирования

Разработка чёткого и краткого плана тестирования имеет большое 
значение для успешного тестирования приложения. Хороший план 
тестирования позволяет оценивать качество приложения на любом этапе 
процесса тестирования.

В этой описано, как разрабатывать план тестирования с помощью модуля 
Test Lab. Разработка плана тестирования включает в себя:: 

Определение 
стратегии 

тестирования

Определение 
объектов 

тестирования

Разработка тестов

Создание покрытия 
требований

Разработка шагов 
тестирования

Автоматизация 
тестов

Анализ плана 
тестирования
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Определение стратегии тестирования
Определите стратегию для удовлетворения определенных в модуле 
Requirements требований к тестированию. Задайте себе два главных 
вопроса: 

Как следует тестировать приложение?

➤ Какие типы тестов необходимо применять ( тесты на стрессовые условия, 
тесты на  проверку  безопасности, тесты производительности,  тесты на 
нагрузку  и т.д.)? 

➤ Как следует работать с дефектами приложений (например, классификация 
дефектов по уровню серьезности, авторизация для обнаружения и 
исправления дефектов)?

Какие потребуются ресурсы?

➤ Какие ресурсы потребуются для тестирования (сотрудники, аппаратные 
средства и т.д.)?

➤ Когда должны быть завершены задачи?

В качестве примера рассмотрим приложение для бронирования 
авиабилетов, с помощью которого можно управлять расписанием полетов, 
заказом и продажей билетов. Для тестирования необходимо разработать 
как ручные, так и автоматизированные тесты. Сотрудникам, имеющим опыт 
программирования, следует поручить  задачи по разработке 
автоматизированных тестов, а тем сотрудникам, у которых нет такого 
опыта, — поручить создание ручных тестов.
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Определение объектов тестирования
Проанализируйте иерархические связи между функциями приложения. 
Распределите функции по объектам и постройте дерево плана 
тестирования, которое в графическом виде  представляет 
функциональность приложения. 

Дерево плана тестирования – это графическое представление плана 
тестирования. Это иерархический список всех тестов, упорядоченных по 
объектам, который описывает набор тестов, предназначенных для 
достижения заданных показателей качества. Например, приложение для 
бронирования  авиабилетов требует включения в список таких объектов 
тестирования, как Flight Finder, Book Flight, Flight Confirmation и Flight 
Cost.

Полное описание и пример создания дерева плана тестирования см. в 
главе Глава 17, "Создание дерева плана тестирования".

Разработка тестов
Запланируйте тесты для каждого объекта, имеющегося в дереве плана 
тестирования. Продумайте, какие типы тестов необходимо создать для 
каждого объекта, например, тесты на  проверку работоспособности 
приложения, регрессионные тесты. (Пояснения к этим типам тестов см. в 
главеГлава 24, "Создание набора тестов".) Затем создайте тесты и 
назначьте их определенной ветви дерева плана тестирования. Например, 
в примере с приложением для бронирования авиабилетов можно добавить 
следующие тесты под объектом Flight Finder: Airline Preference, 
Departing and Arriving Locations, Departing Date, Find Flight, Flight Time 
Preference и Number of Passengers.

Тесты можно связывать с дефектами. Это полезно, например, при 
создании нового теста специального для выявления известного дефекта. 
Создав связь, можно по статусу дефекта определить, необходимо ли 
выполнять тест. 

Дополнительные сведения о планировании тестов см. в главе Глава 17, 
"Создание дерева плана тестирования".
239



Глава 15 • Разработка плана тестирования
Создание покрытия требований
Каждый тест, имеющийся в дереве плана тестирования, свяжите с одним 
или несколькими требованиями, имеющимися в дереве требований. 
Определив покрытие требований для теста, можно отслеживать связи 
между тестами плана тестирования и исходными требованиями к 
тестированию. Например, в случае приложения для бронирования 
авиабилетов  тесты из объекта Registration покрывают раздел требования 
Customer Personal Information.

Сведения о покрытии требований тестами см. в главе Глава 18, 
"Связывание тестов с требованиями".

Разработка шагов теста
Разработайте тесты для дереве плана тестирования. Определите шаги 
теста, описывающие операции, которые необходимо выполнить, и 
ожидаемые результаты. Определив шаги теста, решите, следует ли 
автоматизировать этот тест.

В случае ручного теста необходимо опредить его шаги, выполнить их для 
приложения и записать результаты каждого шага. Ручные тесты 
используются в тех случаях, когда при выполнении теста требуется 
вмешательство тестировщика. К ручным тестам относятся  тесты на 
удобство использования; однократно выполняемые тесты; тесты, которые 
должны быть выполнены немедленно; тесты, для выполнения которых 
требуется знание тестируемого приложения; и тесты с непредсказуемыми 
результатами. 

Например, в случае приложения для бронирования авиабилетов  при 
проверке удобства работы в диалоговом окне желательно знать реакцию 
пользователя. Поэтому этот тест должен быть ручным.

Сведения о разработке шагов теста см. в главе Глава 19, "Разработка 
тестов".
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Автоматизация тестов
Если тест автоматизировать, то его можно будет выполнять без 
вмешательства тестировщика и с большой скоростью. Кроме того, такой 
тест легко выполнять многократно. Например, имеет смысл 
автоматизировать такие тесты, как тест функциональности, тест 
производительности, тест модуля, тест на стрессовые условия, тест на 
нагрузку, а также тесты, требующие подробной информации о приложении. 

По завершении разработки шагов теста, можно решить, какие из них надо 
автоматизировать. При рассмотрении этого вопроса следует учесть такие 
факторы, как частота выполнения теста , объём входных данных, 
продолжительность и сложность выполнения теста. 

Если тест необходимо автоматизировать, то разработанные шаги теста 
следует автоматизировать, создав скрипт. Скрипт теста можно 
использовать в  WinRunner, QuickTest Professional, LoadRunner или Visual 
API-XP.

Например, в случае приложения для бронирования авиабилетов можно 
автоматизировать тест, который проверяет механизма входа в систему. 
После разработки шагов теста, создайте скрипт теста. Затем с помощью 
QuickTest Professional завершите разработку скрипта автоматизированного 
теста.

Дополнительные сведения о создании автоматизированных тестов см. в 
главе Глава 20, "Разработка автоматизированных тестов".

Можно также создать автоматизированный тест для получения сведений о 
системе, для захвата снимков экрана компьютера или для  перезагрузки 
компьютера. Дополнительные сведения см. в разделе Глава 21, "Систем 
ные тесты".
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Анализ плана тестирования
Проанализируйте план тестирования и определите, насколько он 
соответствует тем целями, которые вы определили в начале процесса 
тестирования. Затем проанализируйте план тестирования, создав отчёты и 
графики. Дополнительные сведения см. Часть VII, “Анализ в Quality Center.”

Например, можно создать отчёт, содержащий шаги каждого теста из  
дерева плана тестирования. Затем этот отчёт можно использовать при 
задании приоритетов тестирования.

Чтобы достичь лучших результатов  процесса тестирования, 
рекомендуется анализировать план тестирования в течение всего 
процесса тестирования. Проанализируйте план, определите, хорошо ли он 
соответствует вашим целям. После такого анализв следует вносить в план 
тестирования поправки.
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Краткий обзор модуля Test Plan

В этой кратко описаны основные элементы модуля Test Plan.

Глава содержит следующие разделы: На стр.

Дерево плана тестирования 244

Строка меню модуля Test Lab 246

Панель инструментов модуля Test Plan 247

Таблица тестов 249
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Дерево плана тестирования
Разработка тестов в Quality Center выполняется в модуле Test Plan, окно 
которого открывается нажатием кнопки Test Plan  на боковой панели. 
Чтобы просмотреть дерево плана тестирования, выберите команду View > 
Test Plan Tree. 

Дерево плана тестирования содержит следующие основные элементы:

➤ Строка меню модуля Test Plan. Отображает раскрывающиеся меню с 
командами модуля Test Plan. Дополнительные сведения см. в разделе 
“Строка меню модуля Test Lab" на стр. 246.

➤ Панель инструментов модуля Test Plan. Содержит кнопки вызова 
команд, часто использующихся для создания и изменения дерева плана 
тестирования. Дополнительные сведения см. в разделе “Панель 
инструментов модуля Test Plan" на стр. 247.

➤ Дерево плана тестирования. Графическое представление плана 
тестирования. Дополнительные сведения см. в главе Глава 17, "Создание 
дерева плана тестирования".
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➤ Вкладка Details. Описание папки или теста, выбранного из дерева плана 
тестирования. Дополнительные сведения см. в главе Глава 17, "Создание 
дерева плана тестирования".

➤ Вкладка Design Steps. Список шагов теста, которые поясняют, как 
выполнять тест, выбранный в дереве плана тестирования. Если 
выбранный тест содержит шаги, на вкладки отображается значок . 
Дополнительные сведения см. в главе Глава 19, "Разработка тестов".

➤ вкладка Test Script Скрипт теста, выбранного в дереве плана 
тестирования. Если выбранный тест имеет скрипт , на вкладке 
отображается значок . Дополнительные сведения см. в разделе 
Глава 20, "Разработка автоматизированных тестов".Дополнительные 
сведения об использовании вкладки Test Script при тестировании бизнес-
процесса см. в руководстве пользователяHP Тестирование бизнес-
процессов.

➤ Вкладка Attachments. Список вложений, содержащих дополнительные 
сведения о тесте, выбранном в дереве плана тестирования. Если 
выбранный тест имеет хотя бы одно вложение, на вкладке отображается 
значок . Дополнительные сведения см. в главе Глава 5, "Добавление 
вложений".

➤ Вкладка Req Coverage. Список требований, соответствующих 
конкретному тесту, выбранному в дереве плана тестирования. Если 
выбранный тест имеет покрытие требований, на вкладке отображается 
значок . Дополнительные сведения см. в главе Глава 18, "Связывание 
тестов с требованиями".

➤ Вкладка Linked Defects. Список дефектов, связанных с тестом, 
выбранным в дереве плана тестирования. Дополнительные сведения см. в 
главе Глава 32, "Связывание дефектов".

➤ Вкладка Live Analysis. Графическое представление данных теста, 
связанных с выбранной папкой в дереве плана тестирования. 
Дополнительные сведения см. Глава 35, "Создание диаграмм анализа в 
реальном времени".
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Советы. 

➤ Щёлкните правой кнопкой мыши тест в дереве плана тестирования и 
выберите команду Go to Test in Test Set. Откроется диалоговое окно 
Select Test Set. Выберите набор тестов, содержащий текущий тест и 
экземпляры теста, который необходимо выполнить, и нажмите кнопку 
OK. Откроется модуль Test Lab, в котором выбранный тест будет 
выделен.

➤ Чтобы найти тест по его идентификатору Test ID в дереве плана 
тестирования, выберите Tests > Go to Test, затем введите 
идентификатор теста. Чтобы отобразить идентификатор теста, 
выберите столбец Test ID в диалоговом окне Select Columns. Можно 
переходить только к тем тестам, которые содержатся в текущем 
фильтре.

Строка меню модуля Test Lab 
Строка меню модуля Test Plan содержит следующие меню.

➤ Меню Tests содержит команды, которые позволяют выполнять операции с 
папками и тестами в дереве, переходить к тестам в наборе тестов, 
отправлять тесты по электронной почте. Дополнительные сведения см. в 
главе Глава 17, "Создание дерева плана тестирования". 

➤ Меню Edit содержит команды, которые позволяют вырезать, копировать, 
вставлять, переименовывать, удалять, искать и заменять тесты. Также 
можно просматривать и удалять оповещения тестов и флажки 
отслеживания тестов. Дополнительные сведения об оповещениях и 
флажках отслеживания см. в главе Глава 4, "Оповещение об изменениях"..

➤ Меню View содержит команды, позволяющие отображать тесты в дереве 
или в таблице плана тестирования, фильтровать и сортировать их и 
задавать параметры отображения столбцов.
246



Глава 16 • Краткий обзор модуля Test Plan
➤ Меню Favorites содержит команды, которые позволяют добавлять и 
упорядочивать избранные представления. Доступно только в таблице 
тестов. Дополнительные сведения о представлениях избранного см. в 
главе Глава 6, "Работа с избранными представлениями"..

➤ Меню Analysis содержит команды, которые позволяют создавать отчеты и 
графики при разработке плана тестирования. Дополнительные сведения 
об отчетах при разработке планов см. в главах Глава 33, "Создание 
отчетов". Дополнительные сведения о графиках при планировании см. в 
Глава 34, "Создание диаграмм", и Глава 35, "Создание диаграмм анализа в 
реальном времени".

Совет. Для доступа к строке меню модуля Test Plan из модуля Test Plan 
можно также пользоваться клавишей F9. Кроме того, с помощью 
комбинаций клавиш можно выполнять много других операций в 
Quality Center. Перечень комбинаций клавиш приведен в Приложение B, 
"Quality Center - Комбинации клавиш"..

Панель инструментов модуля Test Plan 
Панель инструментов модуля Test Plan содержит следующие кнопки.

New Folder. Добавление папки нового объекта в дерево плана 
тестирования. Дополнительные сведения см. в разделе “Создание дерева 
плана тестирования" на стр. 258.

New Test. Добавление нового теста в дерево плана тестирования. 
Дополнительные сведения см. в разделе “Добавление тестов в дерево 
плана тестирования" на стр. 259.

Delete. Удаление выбранной папки или выбранного теста из дерева. 
Дополнительные сведения см. в разделе “Удаление папки или теста" на 
стр. 278.

Refresh All.  Обновление дерева плана тестирования, чтобы оно 
отображало самые последние тесты.
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Set Filter/Sort. Содержит следующие параметры:

➤ Set Filter/Sort. Открывает диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты из дерева плана тестирования. 

➤ Очистить фильтр/сортировку. Очищает все фильтры или функцию 
сортировки, примененные к дереву плана тестирования.

Дополнительные сведения о фильтрации и сортировке тестов см. в главе 
Глава 3, "Работа с данными Quality Center".

Sort Folders. Открывает диалоговое окно Sort Folders in Test Plan Tree, в 
котором можно сортировать папки дерева плана тестирования. По 
умолчанию папки сортируются по имени. Дополнительные сведения см. в 
разделе “Сортировка дерева плана тестирования" на стр. 276.

Flag for Follow Up. Открывает диалоговое окно Flag For Follow Up, в 
котором можно добавлять или изменять флажок отслеживания теста. 
Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 88.

Send by E-mail. Открывает диалоговое окно Send E-mail, с помощью 
которого можно отправлять сообщение по электронной почте с 
выбранными тестами получателям из списка или по любым другим 
адресам электронной почты. Дополнительные сведения см. в разделе 
“Отправка тестов по электронной почте" на стр. 267.

Text Search. Открывает в нижней части окна область поиска, в которую 
можно вводить ключевые слова и выполнять поиск предварительно 
заданных полей. Дополнительные сведения см. в разделе “Поиск записей" 
на стр. 76.
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Таблица тестов 
Таблица тестов содержит все тесты проекта Quality Center. Каждая строка 
– это отдельная запись, содержащая сведения о тесте. Каждый столбец – 
отдельный элемент данных.

Чтобы просмотреть таблицу тестов , выберите команду View > Test Grid. 

Информацию в таблице тестов можно просматривать и изменять. 
Например, можно копировать несколько автоматизированных тестов и 
вставлять их в другой проект, или удалять сразу несколько тестов. Кроме 
того, эту таблицу можно сохранять в различных форматах, таких как 
текстовый файл, документ Word, документ HTML, документ XML, таблица 
Excel.

Таблица тестов содержит следующие основные элементы:

➤ Панель инструментов Test Grid. Содержит кнопки команд, часто 
используемых при создании и изменении таблицы тестов. Дополнительные 
сведения см. в разделе “Панель инструментов таблицы тестов" на стр. 251. 
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➤ Indicator columns. Указывают, что тест содержит вложения, связанные 
дефекты, оповещения и флажки отслеживания. Чтобы отобразить эти 
столбцы, выберите команду View > Indicator Columns.

➤ Фильтр таблицы. Отображение текущего фильтра, примененного к 
столбцу. Дополнительные сведения см. в разделе “Фильтрация записей" на 
стр. 59.

➤ Вкладка Description. Содержит описание теста, выбранного в таблице 
тестов.

➤ Вкладка Attachments. Содержит вложения в выбранный тест. 
Дополнительные сведения см. в главе Глава 5, "Добавление вложений".

➤ Вкладка History. Показывает внесенные в тест изменения. Для каждого 
внесенного в тест изменения в таблице отображается дата и время 
изменения, а также имя пользователя, который внес это изменение. 
Раскройте изменение, чтобы просмотреть список измененных полей. 
Каждое поле таблицы содержит старое и новое значения.

Столбец Описание

Attachments Чтобы просмотреть вложения в тест, щёлкните 
значок . Дополнительные сведения см. ув главе 
Глава 5, "Добавление вложений".

Linked Entities Чтобы просмотреть объекты, связанные с тестом, 
щёлкните значок . Дополнительные сведения см. 
в главе Глава 32, "Связывание дефектов".

Alerts Чтобы просмотреть оповещения теста, щёлкните 
значок . Дополнительные сведения см. в разделе 
“Просмотр оповещений" на стр. 85.

Follow Up Flags Чтобы просмотреть оповещения об отслеживании 
теста, щёлкните значок . Дополнительные 
сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 88.
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Совет. Чтобы найти тест по его идентификатору Test ID в таблице тестов, 
выберите команду Test > Go to Test, затем введите идентификатор теста. 
Для отображения идентификатора теста, выберите столбец Test ID в 
диалоговом окне Select Columns.

Панель инструментов таблицы тестов
Панель инструментов таблицы тестов содержит следующие кнопки.

Delete Selected Tests. Удаляет выбранные тесты из таблицы тестов.

Refresh All.  Обновляет таблицу тестов, чтобы она содержала самые 
последние тесты. 

Задать фильтр/сортировку. Содержит следующие параметры:

➤ Задать фильтр/сортировку. Открывает диалоговое окно Filter, в 
котором можно фильтровать, сортировать и группировать тесты в 
таблице тестов.

➤ Clear Filter/Sort. Очищает все фильтры, функцию сортировки или 
группирования, примененные к таблице тестов.

Дополнительные сведения о фильтрации и сортировке тестов см. в главе 
Глава 3, "Работа с данными Quality Center".

Выбрать столбцы. Открывает диалоговое окно Select Columns, в котором 
можно задать, какие столбцы и в каком порядке будут отображаться в 
таблице тестов. Дополнительные сведения см. в разделе “Упорядочивание 
столбцов" на стр. 55.

Go to Test in Test Plan Tree. Закрывает таблицу тестов и отображает 
выбранный тест в дереве плана тестирования.

Attachments. Открывает диалоговое окно Attachments, в котором можно 
добавлять вложения в выбранный тест. Дополнительные сведения см. в 
главе Глава 5, "Добавление вложений".
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Flag for Follow Up. Открывает диалоговое окно Flag For Follow Up, в 
котором можно добавлять или изменять флажки отслеживания тестов. 
Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 88.

Send by E-mail. Открывает диалоговое окно Send E-mail, в котором можно 
отправить 
выбранный тест по электронной почте получателям из списка или по 
другим адресам электронной почты. Дополнительные сведения см. в 
разделе “Отправка тестов по электронной почте" на стр. 267.

Text Search. Открывает в нижней части окна область поиска текста, в 
которую можно вводить ключевые слова и выполнять поиск 
предварительно заданных полей. Дополнительные сведения см. в разделе 
“Поиск записей" на стр. 76.

Столбцы таблицы тестов
Таблица тестов отображает следующие столбцы с данными планирования.

Столбец Описание

Comments Отображает комментарии к тесту.

Creation Date Дата создания теста. По умолчанию дата создания 
теста формируется в текущем сервере. Если 
необходимо задать другую дату создания, щёлкните 
стрелку вниз, чтобы отобразить календарь, и 
выберите другую дату.

Description Описание теста.

Designer Имя пользователя лица, разработавшего тест.

Estimated DevTime Расчетная продолжительность планирования и 
разработки теста.

Execution Status Состояние последнего выполнения экземпляра теста. 
Состояние выполнения может быть одним из 
следующих: Failed, N/A, No Run, Not Completed, 
Passed.

Modified Дата последнего изменения теста.
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Path Путь к файлу теста на сервере (относительно 
репозитория тестов).

Status Состояние планирования теста. Состояние по 
умолчанию – Design.

Subject Папка объекта в дереве плана тестирования, 
содержащая тест.

Template Указывает, является ли шаблоном ручной тест или 
тест QuickTest Professional. Если тест является 
шаблоном, то в этом столбце отображается значение 
Y, в противном случае отображается значение N или 
пустое значение. Дополнительные сведения о ручных 
тестах см. в “Добавление ручному тесту метки 
шаблона" на стр. 303. Дополнительные сведения о 
тестах QuickTest Professional см. в “Добавление 
тестов в дерево плана тестирования" на стр. 259.

Test ID Уникальный цифровой идентификатор теста, 
автоматически назначенный Quality Center. 
Идентификатор теста доступен только для чтения. 

Test Name Имя теста.

Type Тип теста. Например, ручной или WinRunner.

Столбец Описание
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Примечания. 

➤ В таблицу тестов можно добавлять определенные пользователем поля 
и изменять их метки. Также предусмотрена возможность настройки 
списков проектов. Дополнительные сведения см. в Руководство 
администратора HP Quality Center.

➤ Для ограничения и динамического изменения полей и значений в 
таблице тестов можно использовать редактор Script Editor. 
Дополнительные сведения см. в \Руководство администратора 
HP Quality Center.

➤ При выборе столбца, содержащего имя пользователя, Quality Center 
отображает список всех имен пользователей и их полных имен. Можно 
выполнять поиск пользователей, сортировать и группировать их, а 
также выбирать пользователей из списка и дерева групп. 
Дополнительные сведения см. в разделе “Выбор пользователей" на 
стр. 58.
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Создание дерева плана тестирования

Дерево плана тестирования позволяет упорядочить тесты и отобразить  их 
в иерархическом порядке, в соответствии с объектами тестирования.

Глава содержит следующие разделы: На стр.

О дереве плана тестирования 256

Создание дерева плана тестирования 258

Добавление тестов в дерево плана тестирования 259

Просмотр дерева плана тестирования 264

Просмотр экземпляров тестов 266

Отправка тестов по электронной почте 267

Поиск тестов в дереве или в таблице тестов 270

Замена значений полей в таблице тестов 273

Копирование тестов и папок объектов 274

Копирование URL-адресов тестов 276

Сортировка дерева плана тестирования 276

Изменение дерева плана тестирования 278
255



Глава 17 • Создание дерева плана тестирования
О дереве плана тестирования
Обычно приложение трудно протестировать целиком из-за обилия 
функций. Модуль Test Plan  позволяет разделить приложение на несколько 
фрагментов в соответствии с функциональностью. Эти фрагменты 
называются модулями или объектами. Они создаются вместе с деревом 
плана тестирования. Это дерево является  графическим представлением 
плана тестирования. Оно отображает тесты в соответствии с 
иерархическими связями между ними. 

Определив объекты дерева, следует решить, какие тесты необходимо 
разработать для каждого объекта, а затем добавить их в дерево. На этой 
стадии следует определить основные сведения о тесте, в том числе его 
имя, статус и разработчика. Можно также присоединить к тесту файл, 
URL-адрес, сведения о системе или снимок  приложения.  После этого 
необходимо определить шаги теста. Шаги теста содержат подробные 
инструкции по выполнению теста и ожидаемые результаты.

В процессе тестирования иногда приходится изменять план тестирования. 
Обновить дерево плана тестирования можно в любое время.

Существуют различные методы упорядочивания плана тестирования по 
объектам. Например, можно классифицировать объекты по:

➤ функциям  приложения, таким как изменение, операции с файлами, 
создание отчетов;

➤ типу тестирования, например: функциональность, интерфейс 
пользователя, производительность и  загрузка.
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Предположим, вы тестируете приложение для бронирования авиабилетов, 
с помощью которого можно управлять расписанием полетов, заказом и 
продажей билетов. (Более полный пример см. в проекте 
QualityCenter_Demo.) В дереве плана тестирования можно определить 
следующие объекты:

Например, посмотрим, какие папки содержит объект Itinerary. Эти папки 
группируют тесты из дерева с помощью дополнительных уровней 
объектов.

После создания основной структуры плана необходимо разработать тесты 
и назначить их объектам. Например, в приведенном выше дереве плана 
тестирования можно назначить тесты папке Reservation Details, как 
показано ниже.
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Примечание. Создавать и изменять дерево плана тестирования могут 
только пользователи, имеющие соответствующие  права доступа. 
Дополнительные сведения см. в Руководство администратора 
HP Quality Center.

Создание дерева плана тестирования
Иерархическая структура плана тестирования создается путем построения 
дерева плана тестирования, которое содержит папки и вложенные папки. 

Примечание. Дерево плана тестирования можно создать непосредственно 
в Quality Center, а можно импортировать данные тестирования в проект 
Quality Center из Microsoft Word или Microsoft Excel. Для импорта из Word 
необходимо установить надстройки Microsoft Word и HP Quality Center 
Connectivity. Для импорта из Excel необходимо установить надстройки 
Microsoft Excel и HP Quality Center Connectivity. Загрузить эти 
надстройки можно со страницы надстроек  HP Quality Center. 
Дополнительные сведения см. в руководстве Руководство по установке 
HP Quality Center.

Для создания дерева плана тестирования:

 1 Выберите в дереве плана тестирования папку объекта, нажмите кнопку 
New Folder или выберите команду Tests > New Folder. Откроется 
диалоговое окно New Folder.
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 2 В поле Folder Nameимя объекта, затем нажмите кнопку OK. Учтите, что 
имя папки не должно содержать следующие символы: \ ^ *

В дереве плана тестирования под папкой Subject появится созданная 
папка.

 3 В поле Description введите описание объекта. 

 4 Если необходимо добавить в папку вложение, перейдите на вкладку 
Attachments. Вложением может быть файл, URL-адрес, снимок 
приложения, элемент буфера обмена или сведения о системе. 
Дополнительные сведения см. в главе Глава 5, "Добавление вложений".

 5 Чтобы создать дополнительные объекты на основном уровне, повторите 
шаги с 1 по 4.

 6 Чтобы создать вложенную  папку, выберите папку объекта и повторите 
шаги с 1 по 4. 

Добавление тестов в дерево плана тестирования 
Создав дерево плана тестирования, содержащее основные объекты 
тестирования, можно приступить к разработке тестов. Каждый тест должен 
иметь определенную цель, такую как проверка конкретной функции или 
требования к системе. Разрабатываемые тесты должны соответствовать 
целям, поставленным в начале процесса тестирования.

Например, в случае приложения для бронирования авиабилетов  можно 
разработать тест Password Verification, позволяющий убедиться в том, 
что войти в систему сможет только тот пользователь, который введет 
правильный пароль. Этот тест необходимо поместить под объектом 
Sign-On/Sign-Off.

Совет. Тесты можно создавать автоматически на основе требований в 
модуле Requirements. Дополнительные сведения см. в разделе “Создание 
тестов из требований" на стр. 193.
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Для добавления нового  теста:

 1 Выберите папку объектов в дереве плана тестирования.

 2 Нажмите кнопку New Test или выберите Tests > New Test. Откроется 
диалоговое окно Create New Test.

Примечание. Если на компьютере установлена надстройка QuickTest 
Professional Add-in, в диалоговом окне Create New Test должно быть поле 
Template.

 3 В раскрывающемся списке Test Type выберите тип теста. Можно выбрать 
один из следующих типов теста:

Тип теста Описание

MANUAL Ручной тест в Quality Center.

WR-AUTOMATED Этот тест выполняется средством тестирования 
функциональности  WinRunner компании HP, 
предназначенным для тестирования приложений в 
операционной системе Microsoft Windows.

LR-SCENARIO Скрипт, который  выполняется средством тестирования  
загрузки LoadRunner, HP.

QUICKTEST_TEST Тест, который  выполняется QuickTest Professional — 
средством  тестирования функциональности 
предприятия, разработанным компанией HP. 

Этот тип теста доступен только в том случае, если 
установлена соответствующая надстройка, загруженная 
со страницы надстроекHP Quality Center. 
Дополнительные сведения об установке надстроек см. в 
документе Руководство по установке HP Quality Center.
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Примечание. После разработки теста можно изменять его тип в таблице 
тестов. Кроме тестов, перечисленных выше, в таблице тестов можно 
выбирать дополнительные типы тестов, в том числе WR-BATCH – 
пакетный тест, выполняемый средством тестирования пакетов WinRunner.

 4 В поле Test Name введите имя теста. Имя теста не должно содержать 
следующие символы: \ / : " ? < > | * % ' 

 5 Если выбрать QUICKTEST_TEST в списке Test Type, станет доступным 
поле Template. Новый тест создается на основе другого теста QuickTest, 
определенного, как шаблон теста. Шаблон теста копируется в созданный 
тест без результатов тестирования.  

VAPI-XP-TEST Тест, созданный с помощью средства тестирования 
прикладного программного интерфейса открытой 
архитектуры Visual API-XP, используемого Quality Center. 
Дополнительные сведения см. в разделеПриложение A, 
"Работа сс VAPI-XP".

SYSTEM-TEST Тест, который указывает Quality Center  предоставить 
сведения  о системе, захватить снимок экрана или 
перезагрузить компьютер. Дополнительные сведения см. 
в главе Глава 21, "Систем ные тесты".

BUSINESS-PROCES
S

Тест для бизнес-процесса. Дополнительные сведения см. 
в руководстве пользователя HP по тестированию 
бизнес-процессов.

Тип теста Описание
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Примечание. Чтобы установить надстройки QuickTest, которые 
Quality Center связывает с новым тестом QuickTest, выберите шаблон 
теста, содержащий соответствующие надстройки. Альтернативный 
вариант — используйте установленный по умолчанию шаблон теста, 
имеющийся в клиентской части Quality Center. Этот тест по умолчанию 
загружает веб-надстройки и надстройки ActiveX. Дополнительные сведения 
см. в документации по QuickTest и в документации по надстройкам для 
QuickTest.

Чтобы выбрать шаблон теста, нажмите кнопку обзора. Откроется 
диалоговое окно Select Tests. По умолчанию отображаются лишь шаблоны 
QuickTest. 

Выберите шаблон теста, затем нажмите кнопку Add Test. Диалоговое окно 
Select Tests закроется, в поле Template появится шаблон теста.

Примечание. Чтобы сделать тест QuickTest Professional шаблоном теста, 
щелкните правой кнопкой мыши в дереве плана тестирования и выберите 
команду Template Test.

 6 Нажмите кнопку OK, чтобы закрыть диалоговое окно Create New Test.

Если обязательные тестовые поля были определены в окне Project 
Customization, откроется диалоговое окно Required Test Fields. Выберите 
значения обязательных полей и нажмите кнопку OK.

Новый тест появится в дереве плана тестирования под выбранной папкой 
объекта. На вкладке Details в поле Test Name будет добавлено имя.
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 7 На вкладке Details введите следующие сведения о тесте.

Примечание. Метку любого поля сведений о тесте можно изменять. В 
сведения о тесте можно также добавлять свои собственные поля. 
Дополнительные сведения см. в Руководство администратора 
HP Quality Center.

 8 На вкладке Details щелкните Description и введите описание теста.

 9 На вкладке Details щелкните Comments и введите комментарий к тесту. На 
вкладке Comments нажмите кнопку Add Comment. На вкладке Comments 
появится новый раздел, в котором будет отображено имя пользователя и 
текущая дата из базы данных.

 10 Если необходимо добавить вложение в новый тест, перейдите на вкладку 
Attachments. Вложением может быть файл, URL-адрес, снимок 
приложения, элемент буфера обмена или сведения о системе. 
Дополнительные сведения см. Глава 5, "Добавление вложений".

 11 Перейдите на вкладку Req Coverage, чтобы определить покрытие 
требований тестами. Доплнительные сведения см. в главе Глава 18, 
"Связывание тестов с требованиями".

 12 Перейдите на вкладку Linked Defects, чтобы связать дефекты с тестом. 
Доплнительные сведения см. в главе Глава 32, "Связывание дефектов".

Параметр Описание

Designer Разработчик теста. По умолчанию отображается имя 
пользователя, который зарегистрировался в Quality Center. 
Если необходимо, щелкните стрелку вниз, чтобы выбрать 
другое имя пользователя.

Creation Date Дата создания теста. По умолчанию дата создания 
формируется в текущем сервере базы данных. Если 
необходимо, щелкните стрелку вниз, чтобы отобразить 
календарь, и выберите другую дату создания.

Status Текущий статус  теста. По умолчанию он имеет статус Design. 
Щелкните стрелку вниз, чтобы выбрать в списке другой статус.
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 13 Перейдите на вкладку Design Steps, чтобы задать шаги теста. 
Доплнительные сведения см. в главе Глава 19, "Разработка тестов".

Просмотр дерева плана тестирования
В дереве плана тестирования отображается полная структура плана 
тестирования и назначенные объектам тесты.

Дерево плана тестирования может содержать следующие значки тестов.

Ручной тест

Ручной тест, содержащий шаги.

Ручной шаблон теста.

Ручной шаблон теста, содержащий шаги.

Тест WinRunner.

Пакетный тест WinRunner.

Дополнительные сведения о создании и применении пакетных тестов для 
WinRunner см. в Руководстве пользователя по WinRunner.

Скрипт LoadRunner.
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Примечание. Вопросительный знак в дереве плана тестирования 
означает, что на компьютере не установлена надстройка для QuickTest 
Professional. Дополнительные сведения об установке надстроек см. в 
Руководство по установке HP Quality Center.

Для просмотра тестов в дереве плана тестирования:.

По умолчанию в дереве плана тестирования отображаются только объекты 
самого высокого уровня иерархии объектов.

➤ Чтобы развернуть ветвь в дереве, щелкните значок  (Развернуть) слева 
от имени ветви. Чтобы развернуть все ветви дерева, щелкните папку 
Subject правой кнопкой мыши и выберите команду Expand All. 

➤ Чтобы свернуть ветвь дерева, щелкните знак  (Свернуть) слева от имени 
ветви. Чтобы свернуть все ветви дерева, щелкните папку Subject правой 
кнопкой мыши и выберите команду Collapse.

➤ Чтобы просмотреть тесты, связанные с конкретным объектом, дважды 
щелкните папку этого объекта . 

➤ Чтобы обновить все тесты в дереве плана тестирования, нажмите кнопку 
Refresh All.

Тест QuickTest Professional.

Шаблон теста QuickTest Professional.

Тест QuickTest Professional, содержащий шаги.

Шаблон теста QuickTest Professional, содержащий шаги.

Тест Visual API-XP. 

Системный тест.

Тест Vuser Script.
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➤ Нажмите кнопку Set Filter/Sort, чтобы отфильтровать и отсортировать 
тесты в дереве плана тестирования. Дополнительные сведения см. 
Глава 3, "Работа с данными Quality Center". Все примененные фильтры и 
функции сортировки отображаются под панелью инструментов дерева 
плана тестирования.

➤ Чтобы просмотреть все тесты проекта Quality Center, выберите команду 
View > Test Grid. 

Просмотр экземпляров тестов
Экземпляры тестов из наборов, созданных в модуле Test Plan, можно 
просматривать в модуле Test Lab. Можно увидеть, какие наборы тестов 
содержат экземпляр теста, и перейти к экземпляру теста в модуле Test Lab.

Для просмотра экземпляра теста:

 1 В дереве плана тестирования выберите тест, затем команду Tests > Go to 
Test in Test Set. Альтернативный вариант — щелкните тест правой кнопкой 
мыши и выберите команду Go to Test in Test Set. Если существует только 
один экземпляр выбранного теста, откроется модуль Test Lab, в котором 
этот экземпляр будет выделен. Если экземпляров несколько, появится 
диалоговое окно Select Test Set.

 2 В поле Test Set выберите в раскрывающемся списке набор тестов, 
содержащий тот экземпляр теста, к которому необходимо перейти.

 3 В поле Test Instance выберите в раскрывающемся списке экземпляр теста 
из выбранного набора тестов.

 4 Нажмите кнопку OK. Откроется модуль Test Lab, в котором выбранный 
экземпляр теста будет выделен.
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Отправка тестов по электронной почте 
Можно отправить сообщение о тесте по электронной почте  другим 
пользователям, участвующим в данном проекте. Эта возможность 
позволяет регулярно информировать сотрудников групп разработки и 
контроля качества о статусе тестов. Сообщение электронной почты 
содержит ссылку Go To Test, которая позволяет получателю переходить к 
тесту.

Примечание. По умолчанию Quality Center отправляет по электронной 
почте сообщения в формате HTML. Чтобы отправить по электронной почте 
сообщение как обычный текст, измените параметр MAIL_FORMAT на 
вкладке Site Configuration в Site Administration. Дополнительные сведения 
см. в Руководство администратора HP Quality Center.
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Как отправить тест по электронной почте 

 1 Выберите один или несколько тестов в дереве плана тестирования или в 
таблице тестов и нажмите кнопку Send by E-mail. Откроется диалоговое 
окно Send E-mail.

Совет. Предусмотрена возможность автоматической отправки сообщений 
по электронной почте определенному типу пользователей. Это может быть 
любой столбец тестов с именем пользователя, включающий  поля, 
определенные пользователем. Щелкните стрелку Send by E-mail  и 
выберите необходимый параметр. Например, чтобы отправить по 
электронной почте сообщение разработчику теста, выберите команду Send 
Mail to Designer.
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 2 Введите адрес электронной почты или имя пользователя. Альтернативный 
вариант —нажмите кнопку To или CC, чтобы выбрать пользователей. 
Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять поиск 
пользователей, распределять пользователей по группам и выбирать 
пользователей из списка или из дерева групп. Дополнительные сведения 
см. в разделе “Выбор пользователей" на стр. 58. 

Выберите пользователей или группы пользователей, которым необходимо 
отправить сообщение по электронной почте, а затем нажмите кнопку OK. 

 3 В поле Subject введите тему сообщения электронной почты. По умолчанию 
при выборе только одного теста в поле Subject отображаются домен, 
проект, идентификатор теста и краткое описание теста.

 4 Если выбрать несколько тестов, они будут перечислены в поле Item. 
Тесты, которые не требуется включать в сообщение, можно удалить из 
него.

 5 Определите, следует ли включать в тест Attachments, History и Design 
Steps.

 6 В поле Additional comments добавьте необходимые комментарии.
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 7 Для проверки орфографии в диалоговом окне:

➤ Нажмите кнопку Check Spelling , чтобы проверить правописание 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии, нажмите кнопку  Spelling 
Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразить для выбранного 
слова синонимы, антонимы или связанные слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое. 

 8 Чтобы настроить сообщение электронной почты, щелкните Custom. В 
диалоговом окне Select Fields укажите, какие поля следует включить в 
сообщение электронной почты.

 9 Чтобы отправить сообщение по электронной почте, щелкните Send.

Поиск тестов в дереве или в таблице тестов
С помощью команды Find можно найти тест в дереве плана тестирования 
или в таблице тестов.

Совет. Если доступен поиск Text Search, то его можно использовать для 
поиска тестов в дереве плана тестирования или в таблице тестов. 
Текстовый поиск является более мощным инструментом, поскольку  
позволяет выполнять поиск ключевых слов и их вариантов. Сведения об 
использовании текстового поиска см. в разделе “Поиск записей" на стр. 76.

Поиск тестов вдереве плана тестирования
В дереве плана тестирования можно найти нужную папку или тест. Если к 
дереву применены фильтры, то поиск будет выполняться только в 
отображенных тестах.
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Для поиска папки или теста  в дереве плана тестирования

 1 Раскройте папку объекта в дереве плана тестирования, выберите команду 
Edit > Find.

Откроется диалоговое окно Find Folder/Test, в котором в поле Find in 
отображается имя папки. При поиске по всему дереву отображается имя 
папки Subject.

 2 В поле Value To Find введите имя (или часть имени) папки или теста. 
Учтите, что поиск выполняется без учета регистра.

 3 Установите флажок Include Tests, если необходимо найти не только папки, 
но и тесты.

 4 Нажмите кнопку Find.

Модуль Test Plan начнет поиск папки или теста. При успешном завершении 
поиска появится диалоговое окно Search Results, содержащее список 
возможных совпадений. Выберите в этом списке нужный результат, затем 
нажмите кнопку Go To, чтобы выделить папку или тест в дереве плана 
тестирования. 

При неуспешном завершении поиска откроется окно сведений.
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Поиск тестов в таблице тестов
В таблице тестов можно выполнять поиск тестов по значению 
определенного поля. Если к таблице тестов применены фильтры, то поиск 
будет вестись только среди отображенных тестов.

Для поиска тестов в таблице тестов:

 1 Выберите команду View > Test Grid. 

 2 Выберите команду Edit > Find. Откроется диалоговое окно Find.

 3 В поле Find in Field выберите поле таблицы.

 4 В поле Value to Find введите или выберите значение, которое необходимо 
найти.

 5 Установите флажок Exact Match, если необходимо найти тесты со 
значениями полей, точно совпадающими со значением в поле Value to Find.

 6 Установите флажок Case Sensitive, если необходимо различать 
прописные и строчные символы.

 7 Выберите Use Wildcards, чтобы в строке поиска можно было использовать 
символы звездочки (*)   для ввода только части элемента.

 8 Нажмите кнопку Find Next. При успешном завершении поиска в таблице 
будет выделен найденный тест. При неуспешном завершении поиска 
откроется окно сведений.

 9 Чтобы найти следующий тест, удовлетворяющий заданному условию, еще 
раз нажмите кнопку Find Next.
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Замена значений полей в таблице тестов
С помощью команды Replace можно выполнять замену значений полей в 
таблице тестов.

Для замены  значения поля в таблице тестов:

 1 Выберите Edit > Replace. Откроется диалоговое окно Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск конкретного значения. 

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение, на которое 
необходимо заменить прежнее значение.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы найти точное совпадение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы, установите флажок From 
Beginning.

 8 Чтобы  использовать в строке поиска символ звездочки (*) и вводить только 
часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажмите кнопку Replace.
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 10 Чтобы заменить все экземпляры значения в таблице, нажмите кнопку 
Replace All.

Копирование тестов и папок объектов
Тесты и папки можно копировать и вставлять в одном проекте или можно 
копировать их из одного проекта и вставлять в другой.

Копирование тестов и папок в одном проекте
Тесты и папки объектов можно копировать и вставлять в одном проекте. 

Чтобы скопировать тест или папку объекта в одном проекте:

 1 В дереве плана тестирования выберите тест или папку объекта, которую 
необходимо скопировать. Чтобы скопировать несколько тестов или папок, 
воспользуйтесь клавишей Ctrl.

 2 Выберите команду Edit > Copy. Альтернативный вариант — щелкните 
правой кнопкой мыши и выберите команду Copy.

 3 Выберите папку, в которую необходимо скопировать тесты или папки 
объектов.

 4 Выберите команду Edit > Paste. Альтернативный вариант —щелкните 
правой кнопкой мыши и выберите Paste.

Копирование тестов и папок объектов из одного проекта в 
другой
Тесты и папки объектов можно копировать и вставлять из одного проекта в 
другой. Если тесты или папки объектов содержат вызовы других тестов, в 
Quality Center их можно копировать одним из следующих способов:

➤ Скопируйте тесты или папки объектов и свяжите их с существующими 
тестам целевого проекта. Если вызываемый тест отсутствует в проекте, в 
который необходимо его скопировать, Quality Center вставит его, 
скопировав из исходного проекта.

➤ Скопируйте в целевой проект тесты или папки объектов вместе с 
вызываемыми тестами. 
274



Глава 17 • Создание дерева плана тестирования
➤ Скопируйте в целевой проект тесты или папки объектов без вызываемых 
тестов.

Для копирования теста или папки объекта из одного проекта в другой

 1 В дереве плана тестирования выберите тест или папку объекта, которую 
необходимо скопировать. Чтобы скопировать несколько тестов или папок, 
воспользуйтесь клавишей Ctrl.

 2 Выберите команду Edit > Copy. Альтернативный вариант — щелкните 
правой кнопкой мыши и выберите команду Copy.

 3 Откройте другой экземпляр Quality Center и зарегистрируйтесь в том 
проекте, в который необходимо вставить тесты.

 4 Выберите папку, в которую необходимо скопировать тесты или папки 
объектов.

 5 Выберите команду Edit > Paste. Альтернативный вариант —щелкните 
правой кнопкой мыши и выберите Paste. Откроется диалоговое окно Paste 
Tests/Subject Folders to Target Project. 

 6 Выберите один из следующих вариантов.

➤ Copy tests/subject folders and link to existing called tests. 
Quality Center Тесты или папки объектов будут скопированы и 
вставлены в целевой проект. Скопированные тесты или папки объектов 
будут связаны с существующими тестам с теми же именами. Если 
вызываемый тест отсутствует  в проекте, в который необходимо 
скопировать, Quality Center вставит его, скопировав из исходного 
проекта.

➤ Copy tests/subject folders and called tests. Quality Center копирует 
тесты или папки объектов вместе с вызываемыми тестами и вставляет 
их в целевой проект. Если имя вызываемого теста уже существует в 
целевом проекте, то скопированный тест будет вставлен с другим 
именем, чтобы исключить тесты с одинаковыми именами.

➤ Copy tests/subject folders without copying called tests. Quality Center 
копирует тесты или папки объектов без вызываемых тестов и вставит их 
в целевой проект. Скопированные тесты или папки объектов не будут 
связаны с вызываемыми тестам.

Нажмите кнопку OK. 
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Копирование URL-адресов тестов
Можно копировать тест и вставлять его URL-адрес как ссылку. Тест при 
этом не копируется. Вместо этого можно вставить адрес в другое место, 
такое как сообщение электронной почты или документ. Чтобы открыть окно  
Quality Center и перейти к необходимому тесту, щелкните ссылку. 

Для копирования  URL-адреса теста:

 1 Выберите тест в дереве плана тестирования или в таблице. 

 2 Выберите команду Edit > Copy URL. Альтернативный вариант —щелкните 
правой кнопкой мыши и выберите Copy URL.

 3 Вставьте URL-адрес.

Сортировка дерева плана тестирования 
По умолчанию объекты отображаются в дереве плана тестирования в 
алфавитном порядке. Однако папки в дереве плана тестирования можно 
отсортировать иначе. Для этого необходимо создать собственные способы 
сортировки.

Примечание. Чтобы создать собственный способ сортировки, необходимо 
иметь права администратора проекта. Дополнительные сведения о правах 
групп пользователей см. в Руководство администратора 
HP Quality Center.
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Для сортировки в дереве плана тестирования:

 1 На панели инструментов нажмите кнопку Sort Folders. Появится 
диалоговое окно Sort Folders in Test Plan Tree.

По умолчанию выбрано Folder Name.

 2 Чтобы создать свою сортировку, выберите Custom Sort.

 3 Выберите папку объекта в левой части диалогового окна. В правой части 
появятся подпапки.

 4 Выберите вложенную  папку в правой части диалогового окна, с помощью 
кнопок со стрелками Вверх и Вниз переместите  вложенную  папку в 
нужное место. Подпапки также можно перетаскивать вверх и вниз мышью.

 5 Чтобы применить функцию сортировки к дереву, нажмите кнопку Close.
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Изменение дерева плана тестирования
Папки объектов и тесты в дереве плана тестирования можно 
переименовывать и удалять.

Переименование папки или теста
Папку или тест можно переименовать.

Как переименовать папку или тест

 1 Выберите элемент в дереве плана тестирования.

 2 Щелкните этот элемент. Альтернативный вариант —щелкните элемент 
правой кнопкой мыши и выберите команду Rename.

 3 Измените имя элемента, нажмите клавишу Enter или щелкните в другом 
месте.

Удаление папки или теста
Из дерева плана тестирования можно удалять ненужную папку или тест. 
При удалении папки определите, что следует удалить: только папку или 
папку вместе с вложенными  папками и тестами. Если следует удалить 
только папку, то все тесты переместятся  в папку Unattached дерева. Если 
следует удалить папку и тесты, то будут удалены все вложенные папки и 
тесты, расположенные под выбранной папкой, без возможности их 
восстановления. Если следует удалить тест, то он будет удален вместе со 
своим скриптом без возможности восстановления.

Для удаления папки:

 1 Выберите папку в дереве плана тестирования. Чтобы удалить несколько 
папок, нажмите клавишу Ctrl и выберите папки, которые необходимо 
удалить.
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 2 Нажмите кнопку Delete или выберите команду Edit > Delete. 
Альтернативный вариант — 
щелкните папку правой кнопкой мыши и выберите команду Delete. 
Откроется диалоговое окно Confirm Delete Folder.

 3 Выберите Delete folders only или Delete folders and tests.

 4 Нажмите кнопку Yes.

Для удаления теста:

 1 Выберите тест в дереве плана тестирования. Чтобы удалить несколько 
тестов, нажмите клавишу Ctrl и выберите тесты, которые необходимо 
удалить.

 2 Нажмите кнопку Delete или выберите команду Edit > Delete. 
Альтернативный вариант — 
щелкните тест правой кнопкой мыши и выберите команду Delete.

 3 Для подтверждения щелкните Yes.
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18
Связывание тестов с требованиями

Тесты в плане тестирования должны соответствовать исходным 
требованиям. Для отслеживания отношений между требованиями и 
тестами следует добавить связи между ними.

Сведения о связывании тестов с требованиями 
Сначала необходимо определить требования в дереве требований, а 
затем назначить их релизу или циклу в дереве релизов (см. главу Глава 12, 
"Разработка дерева требований"). На этапе разработки плана 
тестирования на основе назначенных требований создаётся дерево плана 
тестирования (см. главу Глава 17, "Создание дерева плана тестирования"). 
Чтобы отслеживать отношения между назначенными требованиями и 
тестами, следует добавить связи между ними.

В модуле Test Plan необходимо создать покрытие требований тестами, 
выбрав требования, которые необходимо связать с тестом. 
Альтернативный вариант — создайте тестовое покрытие  в модуле 
Requirements, выбрав тесты, которые необходимо связать с требованием. 
Тест может покрывать  несколько требований. Требование может 
покрываться несколькими тестами.

Глава содержит следующие разделы: На стр.

Сведения о связывании тестов с требованиями 281

Связывание требований с тестом 285

Связывание тестов стребованием 289

Анализ покрытия 293
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Примечание. Можно также создать покрытие требований экземплярами 
тестов. Эту функцию можно включить с помощью параметра 
ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE в Site Administration. 
Дополнительные сведения об этом параметре см. в Руководство 
администратора HP Quality Center.

Требования и тесты можно связывать с дефектами. Это поможет 
обеспечить соответствие с требованиями к тестированию в течение всего  
процесса тестирования (см. Глава 32, "Связывание дефектов"). При 
изменении любого  требования можно сразу определить, на какие тесты и 
дефекты это изменение окажет воздействие, и кто за это несет 
ответственность.
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Пример покрытия требований тестами
Предположим, вы работаете с проектом  QualityCenter_Demo, 
использующим  приложение Mercury Tours. Нажмите кнопку Test Plan на 
боковой панели. В дереве плана тестирования в папке Profiling разверните 
папку Registration и выберите тест Phone (Contact Information). 

Тест Phone (Contact Information)  служит для проверки номера телефона  
заказчика на странице регистрации. Если перейти на вкладку Req 
Coverage, можно увидеть, что этот тест покрывает следующие разделы 
требования: Customer Personal Information и Correct Error Messages.
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Пример тестового покрытия
Вернемся к примеру с  покрытием требований тестами. Также можно 
просматривать покрытие в проекте QualityCenter_Demo  с другой стороны. 
Нажмите кнопку Requirements на боковой панели. В папке Requirements 
дерева разверните разделы требований  Mercury Tours Application, 
Profile Management и Registration, затем выберите требование Customer 
Personal Information. 

Требование Customer Personal Information обеспечивает наличие 
персональных сведений о клиенте в системе бронирования авиабилетов. 
На вкладке Test Coverage можно видеть, что это требование покрывается 
следующими тестами: Email (Contact Information), First & Last Name 
(Contact Information), Mailing Information, Phone (Contact Information) и 
Registration.
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Связывание требований с тестом 
Если при разработке плана тестирования выбран тест в дереве плана 
тестирования, то на вкладке Req Coverage можно увидеть требования, 
которые покрываются этим тестом. 

Требования, покрываемые выбранным тестом, содержатся в таблице 
покрытия. Требования в таблице покрытия можно просматривать, 
добавлять и удалять. 

Столбцы на вкладке Req Coverage содержат данные о покрываемых 
тестом требованиях. Кроме столбцов, описанных в “Поля требований" на 
стр. 162, в таблице покрытия также можно отобразить следующие столбцы.

Столбец Описание

Coverage Type Тип покрытия. В этом столбце могут быть значения Test 
или Test Instance.

Entity Name Имя объекта.

Entity Status Текущее состояние выполнения теста для объекта.
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Просмотр таблицы покрытия требований тестами
В таблице покрытия можно задавать размеры и порядок расположения 
столбцов.  Можно просматривать требования в таблице покрытия и  
полные пути к ним. Кроме того, можно указать Quality Center переходить к 
необходимому требованию в дереве требований.

Для просмотра таблицы покрытия требований тестами:

 1 Выберите тест  в дереве  плана тестирования.

 2 Перейдите на вкладку Req Coverage.

 3 Чтобы обновить таблицу покрытия и отобразить в ней самые последние 
требования, нажмите кнопку Refresh All.

 4 Для задания размеров столбцов и порядка их расположения в таблице 
нажмите кнопку Select Columns. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 55.

 5 Чтобы отобразить место расположения требований в дереве требований, 
щёлкните таблицу покрытия правой кнопкой мыши и выберите команду 
Show Full Path.

 6 Чтобы перейти к требованию в дереве требований, щёлкните нужное 
требование в таблице покрытия. Альтернативный вариант — щёлкните 
требование правой кнопкой мыши и выберите команду Go To Requirement 
in Requirements Tree.
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Добавление покрытия требований тестами
Чтобы добавить покрытие требований тестами в тест, выберите 
требование или несколько требований в дереве. Учтите, что по умолчанию 
невозможно добавить покрытие для следующих типов требований: 
Business, Folder и Group. Business, Folder и Group.

Примечание. Покрытие требований тестами  создаётся автоматически при 
преобразовании требования в тест. Поэтому, возможно, покрытие 
требований тестами уже существует, даже если оно не  добавлялось. 
Дополнительные сведения см. в разделе “Создание тестов из требований" 
на стр. 193.

Для добавления покрытия требований тестами:

 1 Выберите тест в дереве плана тестирования.

 2 Перейдите на вкладку Req Coverage.

 3 Нажмите кнопку Select Req, чтобы отобразить дерево требований в правой 
области. 

 4 Чтобы найти требование в дереве, введите имя (или часть имени) 
требования в поле Find и нажмите кнопку Find. При успешном завершении 
поиска требование будет выделено в дереве.
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 5 Для фильтрации или сортировки требований в дереве нажмите кнопку Set 
Filter/Sort. Дополнительные сведения см. в разделе Глава 3, "Работа с 
данными Quality Center".

 6 Чтобы обновить дерево требований или таблицу покрытия, нажмите кнопку 
Refresh All. 

 7 Выберите требование или раздел требований, чтобы добавить его в 
покрытие. 

➤ Нажмите кнопку Add to Coverage (Without Children), чтобы добавить 
требование без его дочерних требований. Альтернативный вариант  —  
дважды щёлкните требование.

➤ Щелкните стрелку Add to Coverage и выберите Add to Coverage 
(Include Children), чтобы добавить требование и его дочерние 
требования. В покрытие добавляются только те дочерние требования, 
которые соответствуют текущему фильтру и принадлежат к типу, 
поддерживающему тестовое покрытие.

Требование добавляется в таблицу требований.

Совет. Также можно определить покрытие требований путем 
перетаскивания требования из дерева в таблицу покрытия. В таблицу 
покрытия добавляется  требование без его дочерних требований.

 8 Нажмите кнопку Close, чтобы скрыть дерево требований.

Удаление покрытия требований тестами 
Можно удалять требования из покрытия требований.

Для удаления покрытия требований из теста:

 1 Выберите тест в дереве плана тестирования.

 2 Перейдите на вкладку Req Coverage.

 3 Выберите в таблице покрытия требование, которое необходимо удалить.

 4 Нажмите кнопку Remove Selected, затем нажмите кнопку Yes для 
подтверждения.
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Связывание тестов стребованием 
С помощью модуля Requirements можно связывать тесты с требованиями.

Если в дереве требований выбрать требование, то на вкладке Test 
Coverage отображается покрытие этого требования тестами. Таблица 
покрытия содержит тесты, которые покрывают выбранное требование. 
Требования в таблице покрытия можно просматривать, добавлять и 
удалять. 

Столбцы таблицы Test Coverage содержат данные о тестах, покрывающих 
требование. Кроме столбцов, описанных в разделе “Столбцы таблицы 
тестов" на стр. 252, в таблице покрытия также можно отобразить 
следующие столбцы:

Столбец Описание

Coverage Type Тип покрытия. Этот столбец может содержать значение 
Test или Test Instance.

Entity Name Имя объекта.

Entity Status Текущее состояние выполнения теста для объекта.
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Просмотр таблицы покрытия тестами
В этой таблице можно применять фильтр, отображать или  скрывать 
полное покрытие. Кроме того, Quality Center позволяет перейти к 
необходимому тесту в дереве плана тестирования. 

Для просмотра  таблицы покрытия тестами:

 1 В окне Requirement Details выберите требование.

 2 Перейдите на вкладку Test Coverage.

 3 Для фильтрации таблицы по статусу выберите нужный статус в списке 
Status Filter. Например, необходимо просмотреть только пройденные 
тесты. Чтобы очистить фильтр, выберите All.

 4 Чтобы обновить данные в таблице покрытия, нажмите кнопку Refresh All.

 5 Чтобы фильтровать, сортировать или группировать записи в таблице, 
нажмите кнопку Set Filter/Sort. Чтобы очистить все фильтры, функции 
сортировки или группирования по параметрам, нажмите стрелку Set 
Filter/Sort и выберите команду Clear Filter/Sort.

 6 Для задания размеров и порядка расположения столбцов в таблице 
нажмите кнопку Select Columns. Дополнительные сведения о диалоговом 
окне Select Columns см. в разделе “Упорядочивание столбцов" на стр. 55.

 7 Для отображения покрытия тестами всех дочерних требований установите 
флажок Full Coverage. По умолчанию полное покрытие не отображается.

 8 Чтобы перейти к конкретному тесту в дереве плана тестирования, 
щёлкните этот тест в таблице покрытия. Альтернативный вариант — 
щёлкните этот тест в таблице правой кнопкой мыши и выберите команду 
Go to Test in Test Plan Tree.

 9 Чтобы перейти к конкретному  тесту в модуле Test Lab, щёлкните этот тест 
в таблице правой кнопкой мыши и выберите команду Go to Test in Test 
Set.

 10 В нижней правой части окна щелкните Show, чтобы отобразить диаграмму 
покрытия. На этой круговой диаграмме отображены  состояния выполнения 
тестов, содержащихся  в таблице покрытия.
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Добавление тестового покрытия
Чтобы добавить к требованию покрытие тестами, выберите тесты в дерева 
плана тестирования. По умолчанию невозможно добавлять покрытие для 
следующих типов требований: Business, Folder и Group. Business, Folder и 
Group.

Примечание. Тестовое покрытие создаётся автоматически при создании 
теста из требования. Поэтому даже если тестовое покрытие ещё не 
добавлялось, оно, возможно, уже существует. Дополнительные сведения 
см. в разделе “Создание тестов из требований" на стр. 193.

Для добавления тестового  покрытия к требованию:

 1 В дереве требований выберите требование. На вкладке Test Coverage 
отображается таблица покрытия для выбранного элемента.

 2 На вкладке Test Coverage нажмите кнопку Select Tests, чтобы отобразить 
дерево плана тестирования в правой области.
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 3 Чтобы найти конкретный тест в дереве, введите его имя (или часть имени) 
в поле Find и нажмите кнопку Find. При успешном завершении поиска тест 
будет выделен в дереве.

 4 Для фильтрации или сортировки требований в дереве нажмите кнопку Set 
Filter/Sort. Дополнительные сведения о фильтрации и сортировке записей 
см. в главе Глава 3, "Работа с данными Quality Center". 

 5 Чтобы обновить дерево, нажмите кнопку  Refresh All. 

 6 Чтобы добавить тест в покрытие требования тестами, на вкладке  Test Plan 
Tree выберите тест или папку с тестами и нажмите кнопку Add To 
Coverage. Тест добавляется  в таблицу покрытия. При выборе  папки в 
тестовое покрытие будут добавлены только те тесты. которые 
соответствуют текущему фильтру.

Совет. Также можно определять тестовое  покрытие путем перетаскивания  
теста или папки с тестами из вкладки  Test Plan Tree в таблицу покрытия.

 7 Нажмите кнопку Close, чтобы скрыть дерево плана тестирования в правой 
области.

Удаление тестового покрытия
Можно удалять тесты из покрытия требований тестами.

Для удаления покрытия тестами из требования:

 1 Выберите требование в дереве. На вкладке Test Coverage отображается 
таблица покрытия для выбранного требования.

 2 Выберите тест, который необходимо удалить из таблицы покрытия.

 3 Нажмите кнопку Remove From Coverage, а  затем — Yes для 
подтверждения.
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Анализ  покрытия
В модуле Requirements в окне Coverage Analysis  можно анализировать 
статусы требований. Это позволяет понять распределение дочерних 
требований в соответствии с покрытием требований тестами. Можно 
задать анализ покрытия по циклам, позволяющий просматривать в анализе 
только покрытие тестами, назначенными конкретным циклам.

Например, в проекте QualityCenter_Demo выберите требование 
Application Client System, которое находится в папке Mercury Tours 
Application. Это требование имеет двенадцать дочерних требований, 
включая данное требование. В окне Coverage Analysis видно, что два 
дочерних требования имеют статус Failed (один или несколько тестов, 
покрытых этим требованием, не пройдены). Анализ показывает, что три 
теста (27%) , связанных с выбранным требованием, не пройдены.

Примечание. По умолчанию покрытие доступно только для следующих 
типов требований: Functional, Testing и Undefined.

Для анализа покрытия:

 1 Выберите View > Coverage Analysis. 
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Таблица Coverage Analysis содержит следующие столбцы:

 2 Чтобы включить в анализ лишь те тесты, которые выполнялись для 
определенных циклов, щёлкните в поле Coverage calculation by cycle и 
нажмите кнопку обзора. Откроется дерево версий. Разверните это дерево и 
выберите циклы, для которых необходимо проанализировать покрытие. 
Нажмите кнопку OK, чтобы закрыть дерево версий.

Столбец Описание

Name Дерево, содержащее иерархически упорядоченные 
требования.

Direct Cover Status Текущий статус требования, определённый по статусу 
тестов, связанных с этим требованием. Например, если в 
столбце Direct Cover Status отображается значение Not 
Completed, это значит, что покрытые требованием тесты 
не были завершены. Полное определение см. в “Direct 
Cover Status" на стр. 163. 

Coverage Analysis В этом столбце графически показано статус требования и 
его дочерних требований. При анализе не учитываются 
требования, которые не соответствуют текущему 
фильтру, и требования, у которых в столбце Direct Cover 
Status указан статус N/A.

Если покрытие было задано по циклам, Quality Center не 
использует при расчетах  поле Direct Cover Status. 
Вместо него Quality Center использует значения статуса 
прямого покрытия, вычисленные  на основе тестов, 
которые имеют экземпляры, относящиеся к папкам 
наборов тестов, назначенных включенным в фильтр 
циклам. В этом случае требования, не имеющие 
покрытия тестами ни для одного из циклов в фильтре, не 
учитываются при анализе.

В приведённом выше примере анализ покрытия для 
первого требования Mercury Tours Application 
показывает, что три его дочерних требования самого 
нижнего уровня имеют статус Failed (обнаружены 
ошибки), а десять дочерних требований имеют статус Not 
Covered.
294



Глава 18 • Связывание тестов с требованиями
 3 Щелкните в столбце Coverage Analysis требование, которое необходимо 
проанализировать. Альтернативный вариант — щелкните требование 
правой кнопкой мыши и выберите команду Coverage Analysis. Откроется 
диалоговое окно Coverage Analysis.

Например, щёлкните в столбце Coverage Analysis ячейку требования 
Application Client System. На графике видно, что у этого требования есть 
два дочерних требования, которые имеют статус Failed, и десять дочерних 
требований, которые имеют статус Not Covered.

 4 Щёлкните этот участок на графике, чтобы отобразить список дочерних 
требований с выбранным статусом. В данном примере щёлкните участок 
Failed, чтобы отобразить требования, которые имеют статус Failed. 
Появятся имена двух требований со статусом Failed.

Можно выбрать требование и нажать кнопку Go To, чтобы выделить 
требование в дереве.
295



Глава 18 • Связывание тестов с требованиями
 5 Щёлкните ссылку Show Tests Coverage, чтобы развернуть диалоговое 
окно и отобразить диаграмму Tests Coverage Chart.

Эта круговая диаграмма отображает полное покрытие требования тестами, 
сгруппированными по статусам. В данном примере требование Application 
Client System и его дочерние требования связаны с тремя тестами, которые 
имеют статус Failed, тремя тестами со статусом No Run и  пять тестов со 
статусом Passed. Если родительское требование имеет несколько 
дочерних, и все они покрывают один и тот же тест, то этот тест включается 
в диаграмму Tests Coverage Chart для родительского требования только 
один раз.
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 6 Щёлкните участок на диаграмме, чтобы просмотреть список тестов с 
выбранным статусом , которые покрывают данное требование и его 
дочерние требования. Откроется диалоговое окно Tests Coverage, в 
котором значение в поле Status Filter совпадает со статусом теста на 
выбранном участке диаграммы.

Если родительское требование имеет несколько дочерних, и все они 
покрывают один и тот же тест, то этот тест включается в диаграмму Tests 
Coverage Chart родительского требования  для каждого дочернего 
требования только один раз.

Можно изменять значение в поле Status Filter или покрытие требования 
тестами. Дополнительные сведения см. в разделе “Связывание тестов 
стребованием" на стр. 289.

 7 Чтобы отобразить диаграмму Tests Coverage Chart, нажмите кнопку Show.

 8 Нажмите кнопку Close, чтобы закрыть диалоговое окно Test Coverage.

 9 Нажмите кнопку Close, чтобы закрыть диалоговое окно Coverage Analysis.
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 10 Чтобы сохранить окно Coverage Analysis в документе Word, выберите 
Requirements > Export > Word Document. Создается документ Word с 
гистограммой для каждого родительского требования из  дерева 
требований.
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Разработка тестов

После создания дерева плана тестирования можно перейти к разработке 
тестов. Для этого следует определить шаги теста.

О создании тестов
Можно разрабатывать тесты, определяя шаги тестов  в модуле Test Plan  – 
подробные пошаговые инструкции по выполнению теста.  Шаг теста 
включает в себя операции, связанные с управлением приложением, 
вводимые данные и ожидаемые выходные данные. Шаг также может 
содержать параметры. Шаги теста можно определить лишь после 
добавления этого теста в дерево плана тестирования и определения 
основной информации о тестировании.

Шаги теста можно создавать как для ручных, так и для автоматических 
тестов. Завершив создание шагов, можно приступить к планированию и 
разработке ручного теста. Имея план теста, можно сразу начать 
выполнение теста. Если тесты следует автоматизировать, создайте 
скрипты автоматизированного теста  с помощью средств тестирования 
компании HP; пользовательских средств тестирования или средств 
сторонних производителей. 

Данная глава содержит следующие разделы На стр.

О создании тестов 299

Определение шагов тестирования 301

Вызов ручного теста с параметрами 303

Ведение шагов теста 308
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При необходимости автоматизировать тест следует разработать скрипт 
теста в соответствии с разработанными  шагами теста. После анализа 
проекта решите, следует ли автоматизировать тест. Дополнительные  
сведения см. в Глава 20, "Разработка автоматизированных тестов".

Можно разработать шаги теста  на вкладке Design Steps в дереве плана 
тестирования.
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Определение шагов тестирования 
Шаги теста добавляются в тест с помощью программы Design Step Editor.

Для разработки  шага теста:

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps. 

 2 Нажмите кнопку New Step или щелкните правой кнопкой мыши вкладку 
Design Steps и выберите команду New Step. Откроется окно Design Step 
Editor, в котором в поле Step Name отобразится  имя шага теста по 
умолчанию. 

Установленное по умолчанию имя шага теста – это порядковый номер 
шага (Step 1 для первого шага). Если его необходимо изменить, введите 
другое имя в поле Step Name.

 3 Введите описание   и   ожидаемые результаты шага теста.
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 4 Для добавления параметра нажмите кнопку Insert Parameter. 
Дополнительные сведения о параметрах см. в “Вызов ручного теста с 
параметрами" на стр. 303.

 5 Для сохранения текущего шага вручную нажмите кнопку Save Steps.

 6 Чтобы добавить шаг, нажмите кнопку New Step. В поле Step Name 
отобразится следующий порядковый номер шага.

 7 Чтобы закрыть окно Design Step Editor и добавить шаги, нажмите кнопку 
OK.

Созданные шаги теста появятся на вкладке Design Steps. В дереве плана 
тестирования рядом со значком теста появится значок  , указывающий, 
что шаги теста разработаны.

 8 К шагу теста можно присоединять вложения. Вложением может быть файл, 
URL-адрес, снимок приложения, элемент буфера обмена или сведения о 
системе. Чтобы добавить вложение в шаг теста, выберите шаг, затем 
нажмите кнопку Attachments. Дополнительные сведения см. Глава 5, 
"Добавление вложений".

Примечания. 

➤ Можно копировать шаги из существующего теста. Дополнительные 
сведения см. в разделе “Ведение шагов теста" на стр. 308.

➤ Если в шаг добавлено вложение, то при каждом выполнении теста 
создаётся копия этого вложения. Дополнительные сведения о 
выполнении тестов см. в “Выполнение тестов вручную" на стр. 394.
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Вызов ручного теста с параметрами 
В шаг теста можно добавлять вызов ручного теста. Тогда при выполнении 
вызывающего теста к его шагам добавляются шаги вызываемого теста. 
Это удобно в том случае, если есть шаги, общие для нескольких тестов. 

Чтобы увеличить гибкость и возможности теста, к вызываемому тесту и 
вызывающим его тестам можно добавлять параметры. Параметр – это 
переменная, которой присваивается значение вне теста, в котором она 
была определена. Значение параметра можно изменять в соответствии с 
тестом, вызывающим его, или другими экземплярами теста из  набора. 

Например, можно создать шаблон теста с именем Login_Template, 
который записывает в журнал имя пользователя, запустившего 
приложение. Шаблон теста необходимо вызывать перед каждым тестом. В 
некоторых случаях вам необходимо входить в систему с правами обычного  
пользователя, в других случаях – с правами администратора проекта. 
Поэтому следует создать два параметра: <<<user name>>> и 
<<<password>>> и изменять их значения в зависимости от типа теста, 
вызывающего Login_Template. Если вы чаще входите как обычный 
пользователь, то присвойте этим параметрам имя и пароль обычного 
пользователя как значения по умолчанию.

Этот раздел содержит следующие подразделы.

➤ Добавление ручному тесту метки шаблона

➤ Добавление параметра

➤ Просмотр значения параметра

➤ Вызов теста с параметрами

Добавление ручному тесту метки шаблона
В дереве плана тестирования ручной тест можно пометить как шаблон 
теста. Шаблон теста вызывается другими тестам и обычно содержит 
параметры. 
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Примечание. Чтобы вызывать тест или добавлять в него параметры, 
необязательно помечать тест  как шаблон. Такая метка используется 
только при фильтрации.

Чтобы пометить ручной тест как шаблон:

В дереве плана тестирования щелкните правой кнопкой мыши ручной тест, 
выберите команду Mark as Template Test. Серый значок ручного теста 
заменится белым, а это означает, что теперь тест является шаблоном.

Добавление параметра
В описание или в ожидаемые результаты шага ручного теста можно 
добавлять параметры.

Для добавления параметра:

 1 На в кладке Design Steps поместите курсор в поле Description или 
Expected Results того шага, в который необходимо добавить параметр.

 2 Нажмите кнопку Insert Parameter. Откроется диалоговое окно Parameter 
Properties.

 3 Введите имя параметра в поле Parameter Name, затем нажмите кнопку OK. 
Имя параметра не должно содержать следующие символы : ~ ? ’ < >

Новый параметр будет добавлен к шагу с помощью синтаксиса <<<имя 
параметра>>>. 

Примечание. Если необходимо применить форматирование к имени 
параметра шага теста, то необходимо применить то же самое 
форматирование ко всему имени параметра, включая символы   <<< и >>>. 
Например, если необходимо, чтобы параметр <<<password>>> 
отображался курсивом, то следует выделить курсивом всю строку 
<<<password>>>, а не только слово password.
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Просмотр значения параметра
Можно просматривать значения параметров ручного теста. 

Для просмотра значения параметра:

 1 В дереве плана тестирования выберите ручной тест, перейдите на вкладку 
Design Steps. 

 2 Нажмите кнопку Test Parameters. Откроется диалоговое окно Current Test 
Parameters, в котором будут отображены параметры теста. 

 3 Нажмите кнопку Close.

Вызов теста с параметрами 
При добавлении вызова ручного теста с параметром, можно присвоить 
параметру значение. 
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Для вызова теста с параметрами:

 1 На вкладке Design Steps выберите шаг, после которого необходимо 
вызвать другой тест, затем нажмите кнопку Call to Test. Откроется 
диалоговое окно Select a Test.

 2 По умолчанию видны лишь тесты-шаблоны. Если необходимо добавить 
тест, который не является шаблоном, снимите флажок Show only 
Template Tests.

 3 Для фильтрации и сортировки в диалоговом окне Select a Test нажмите 
кнопку Set Filter/Sort. Откроется диалоговое окно Filter. Дополнительные 
сведения о фильтрации и сортировке см. в Глава 3, "Работа с данными 
Quality Center".

 4 Чтобы найти тест, введите его имя (или часть имени) в поле Find и 
нажмите кнопку Find. При успешном завершении поиска тест будет 
выделен в дереве.

 5 Чтобы обновить все тесты, нажмите кнопку Refresh All. 

 6 Выберите ручной тест с параметрами, который необходимо вызвать. 
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 7 Нажмите кнопку OK. Откроется диалоговое окно Parameters of Test, в 
котором будут отображены параметры теста. 

 8 В столбце Value введите или измените значение параметра. Значение 
параметра не должно содержать следующих символов: ~ ? ’ < >

 9 Нажмите кнопку OK. Вызов вставляется в шаг теста как ссылка. 
Отображаются значения, присвоенные параметрам вызываемого теста.

Примечание. Если не присвоить параметрам значения при вызове теста, 
то будет предложено это сделать при вызове этого теста из другого теста, 
если этот тест добавляется в набор тестов или если он запускается. 

 10 Чтобы изменить значения параметров вызываемого теста, щёлкните 
правой кнопкой мыши вызов теста и выберите Called Test Parameters. В 
диалоговом окне Called Test Parameters введите значения параметров, 
затем нажмите кнопку OK.
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Ведение шагов теста
В этом разделе описано, как управлять шагами теста. Он содержит 
следующие подразделы.

➤ Изменение шагов теста

➤ Изменение порядка шагов теста

➤ Перенумерование шагов тестирования

➤ Изменение размеров строки шага теста

➤ Упорядочивание столбцов на вкладке Design Steps

➤ Удаление шагов теста

➤ Копирование шагов теста в пределах проекта

➤ Копирование шагов из одного проекта в другой

➤ Поиск замена текста шага

Изменение шагов теста
Можно изменять существующие шаги теста и добавлять новые.

Для изменения шагов  теста:

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.
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 2 Дважды щелкните шаг или выберите его, а затем нажмите кнопку Edit Step. 
Откроется окно Design Step Editor. 

Далее пользуйтесь следующими кнопками:

➤ Нажмите кнопку First Step, чтобы отобразить первый шаг теста, или 
кнопку Previous Step, чтобы отобразить предыдущий.

➤ Нажмите кнопку Next Step, чтобы отобразить следующий шаг теста, или 
кнопку Last Step, чтобы отобразить последний шаг.

Совет. Переключаться между шагами в окне Design Step Editor можно с 
помощью следующих комбинаций клавиш. Комбинация клавиш ALT+HOME 
— переход к первому шагу, ALT+СТРЕЛКА ВЛЕВО — переход к предыдущему 
шагу, ALT+СТРЕЛКА ВПРАВО — переход к следующему шагу, ALT+END — 
переход к последнему шагу.

 3 Описание и ожидаемые результаты можно изменять в полях Description и 
Expected Result.
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 4 Нажмите кнопку New Step, чтобы добавить шаг после текущего выбранного 
шага.

 5 Чтобы закрыть Design Step Editor и сохранить изменения, нажмите кнопку 
OK.

Изменение порядка шагов теста
Порядок шагов теста можно изменять.

Для изменения порядка шагов теста:

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.

 2 Наведите курсор мыши на серый прямоугольник слева от шага, 
расположение которого необходимо изменить. Указатель мыши примет вид 

.

 3 Щёлкните и перетащите мышью шаг в нужное место.

Перенумерование шагов тестирования
После добавления, удаления или изменения порядка шагов теста их можно 
перенумеровать. 

Чтобы перенумеровать шаги тестирования:

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.

 2 Нажмите кнопку Renumber Steps.

Изменение размеров строки  шага теста
Размер строки шага теста можно изменять. Это позволяет увидеть весь 
текст в столбцах Description и Expected Result, если текст очень длинный. 

Как изменить размер строки шага

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.
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 2 Наведите курсор мыши на нижний край серого прямоугольника слева от 
шага, размер которого необходимо изменить. Указатель мыши примет вид 

.

 3 Щёлкните и перетащите мышью границу строки в нужное место.

 4 Нажмите кнопку Adjust Rows Height.

Упорядочивание столбцов на вкладке Design Steps
Можно определить, какие столбцы и в каком порядке должны 
отображаются на вкладке Design Steps.

Для упорядочивания столбцов:

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.

 2 Нажмите кнопку Select Columns. Откроется диалоговое окно Select 
Columns. Дополнительные сведения см. в разделе “Упорядочивание 
столбцов" на стр. 55.

Удаление шагов теста
Шаги можно удалять из теста.

Для удаления шага теста:

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.

 2 Выберите шаг, который необходимо удалить. Чтобы удалить несколько 
шагов, сначала наведите курсор мыши на серый прямоугольник слева от 
шага. Указатель мыши примет вид . Щёлкните, чтобы выбрать этот шаг. С 
помощью клавиши CTRL или SHIFT выберите остальные шаги.

 3 Нажмите кнопку Delete Selected. Или щёлкните правой кнопкой мыши и 
выберите команду Delete Selected.

 4 Для подтверждения нажмите кнопку Yes.

Копирование шагов теста в пределах проекта
В пределах проекта можно копировать шаги из другого теста. 
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Дополнительные сведения о копировании шагов из другого проекта см. 
“Копирование шагов из одного проекта в другой" на стр. 312. 

Как копировать шаги теста в пределах проекта

 1 В дереве плана тестирования выберите тест, из которого необходимо 
скопировать шаги, затем перейдите на вкладку Design Steps.

 2 Выберите шаг, который необходимо скопировать. Чтобы скопировать сразу 
несколько шагов, сначала наведите курсор мыши на серый прямоугольник 
слева от шага. Указатель мыши примет вид . Щёлкните, чтобы выбрать 
этот шаг. С помощью клавиши CTRL или SHIFT выберите остальные шаги.

 3 Нажмите кнопку Copy Steps или щелкните правой кнопкой мыши и 
выберите команду Copy.

 4 Выберите тест, в который необходимо вставить шаги, затем перейдите на 
вкладку Design Steps.

 5 Нажмите кнопку Paste Steps или щелкните правой кнопкой мыши и 
выберите команду Paste.

Копирование шагов из одного проекта в другой
Можно копировать шаги из одного проекта и вставлять их в другой. Если 
шаги содержат вызовы других тестов, Quality Center позволяет скопировать 
их одним из следующих способов:

➤ Скопируйте шаги и свяжите их с существующими тестам целевого проекта 
(того проекта, в который необходимо вставить шаги). Если вызываемого 
теста нет в проекте, в который его необходимо скопировать, Quality Center 
вставит его, скопировав из исходного проекта.

➤ Скопируйте шаги и вызываемые тесты и вставьте эти шаги в целевой 
проект.

➤ Скопируйте шаги без копирования вызываемых тестов и вставьте эти шаги 
в целевой проект.

Как скопировать шаг из одного проекта в другой

 1 В дереве плана тестирования выберите тест, из которого необходимо 
скопировать шаги, затем перейдите на вкладку Design Steps.
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 2 Выберите шаг, который необходимо скопировать. Чтобы скопировать сразу 
несколько шагов, сначала наведите курсор мыши на серый прямоугольник 
слева от шага. Указатель мыши примет вид . Щёлкните, чтобы выбрать 
этот шаг. С помощью клавиши CTRL или SHIFT выберите остальные шаги.

 3 Нажмите кнопку Copy Steps или щелкните правой кнопкой мыши и 
выберите команду Copy.

 4 Откройте другой экземпляр Quality Center и зарегистрируйтесь в том 
проекте, в который необходимо вставить шаги.

 5 Выберите тест, в который необходимо вставить шаги, затем перейдите на 
вкладку Design Steps.

 6 Нажмите кнопку Paste Steps или щелкните правой кнопкой мыши и 
выберите команду Paste. Откроется диалоговое окно Paste Design Steps to 
Target Project. 

 7 Выберите один из следующих вариантов:

➤ Copy design steps and link to existing called tests. Quality Center 
Скопируйте шаги теста  и свяжите их с существующими вызываемыми 
тестами. Скопированные шаги будут связаны с существующими тестам 
с теми же именами. Если вызываемого теста нет в проекте, в который 
необходимо скопировать, Quality Center вставит его, скопировав из 
исходного проекта.

➤ Скопируйте шаги теста и вызываемые тесты. Quality Center копирует 
шаги и вызываемые тесты и вставляет  их в целевой проект. Если имя 
вызываемого теста уже есть в целевом проекте, то скопированный тест 
будет вставлен с другим именем, чтобы исключить  разные тесты с 
одинаковыми именами.

➤ Скопируйте шаги теста без копирования вызываемых тестов.  
Quality Center копирует шаги без копирования вызываемых тестов и 
вставляет их в целевой проект. Скопированные шаги теста не будут 
связаны с вызываемыми тестами.

Нажмите кнопку OK. 
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Поиск замена текста шага
На вкладке Design Steps можно найти нужный текст шага. В случае  одного 
шага найти и заменить в нём текст можно также с помощью редактора 
шагов Design Steps Editor.

Для поиска текста на вкладке Design Steps

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.

 2 Нажмите кнопку Find Text. Откроется диалоговое окноFind.

 3 В поле Find in Field выберите условие поиска.

 4 В поле Value to Find задайте значение выбранного поля.

 5 Для поиска с учетом прописных и строчных символов установите флажок 
Case Sensitive.

 6 Для поиска точного значения установите флажок Exact Match.

 7 Чтобы  использовать звездочки (*) в строке поиска и вводить только часть 
элемента, установите флажок Use Wildcard.

 8 Нажмите кнопку Find Next. При успешном завершении поиска шаг будет 
выделен. При неуспешном завершении поиска откроется окно сведений.

 9 Нажмите кнопку Close, чтобы закрыть диалоговое окно.

Как найти и заменить текст в редакторе Design Steps Editor

 1 В дереве плана тестирования выберите тест, перейдите на вкладку Design 
Steps.
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 2 Нажмите кнопку New Step, чтобы добавить новый шаг, или нажмите кнопку 
Edit Step, чтобы изменить уже существующий шаг. Откроется редактор 
Design Step Editor.

 3 Нажмите кнопку Find/Replace Text. Откроется диалоговое окно замены.

 4 В поле Find what введите текст, который необходимо найти.

 5 В поле Replace with введите текст, на который следует заменить 
существующий текст.

 6 Если необходимо найти целое слово, установите флажок Match whole 
word only.

 7 Чтобы найти значение с учётом регистра, установите флажок Match case.

 8 Нажмите кнопку Find Next. При неуспешном завершении поиска откроется 
окно сведений.

 9 Нажмите кнопку Replace, если необходимо заменить найденный текст один 
раз, или кнопку Replace All, чтобы заменить все вхождения текста.
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Разработка автоматизированных тестов

Разработанные шаги теста можно использовать для создания скрипта 
автоматизированного теста.

Сведения о разработке автоматизированных тестов 
При планировании тестирования следует решить, какие тесты должны 
быть автоматизированы. Если тест должен быть автоматизирован,  
необходимо создать  скрипт теста, и выполнить тест можно с помощью 
WinRunner, QuickTest Professional, LoadRunner или Visual API-XP.

При определении того, следует ли автоматизировать тест, необходимо 
учитывать следующее:.

Частота выполнения теста
Тесты, которые необходимо выполнять  для каждой новой версии 
приложения, желательно автоматизировать. К числу таких тестов 
относятся тесты на проверку работоспособности  приложения. Эти тесты 
используются для проверки стабильности каждой новой версии 
приложения. После выполнения этих тестов можно перейти к более 
детальному тестированию.

Глава содержит следующие разделы: На стр.

Сведения о разработке автоматизированных тестов 317

Разработка скриптов автоматизированных тестов 319
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Также желательно автоматизировать тесты, используемые при проверке  
набора значений для одной и той же операции ,. Выполнение теста 
вручную для  различных входных данных весьма утомительно и 
малоэффективно. Если автоматизировать такой тест, то можно выполнять 
один и тот же тест для различных наборов данных.

Тесты на стрессовые условия и тесты на нагрузку
Рекомендуется также автоматизировать многократно выполняемые тесты 
(тесты на стрессовые условия) и тесты, проверяющие нагрузочную 
способности многопользовательской системы клиент-сервер (тесты на 
нагрузку). Например, тест должен повторяться тысячу раз. Выполнять 
такой тест вручную нерационально. В этом случае можно с помощью 
QuickTest Professional разработать тест, который повторяется тысячу раз.

Какие тесты не следует автоматизировать
Обычно чем чаще требуется участие пользователя при выполнении теста, 
тем он менее пригоден для автоматизации. Ниже приведены тесты, 
которые не следует автоматизировать.

➤ Тесты на удобство использования – это тесты, которые на основе моделей 
использования проверяют, насколько приложение удобно для 
пользователя.

➤ Тесты, которые выполняются только один раз.

➤ Тесты, которые необходимо выполнять  немедленно.

➤ Тесты, основанные на интуиции пользователя и его знании приложения.

➤ Тесты с непредсказуемыми результатами.
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Разработка скриптов автоматизированных тестов
После разработки шагов ручного теста можно написать основной скрипт 
теста, в который можно добавлять скрипты, позволяющие выполнять этот 
тест в автоматическом режиме.

Любой текст, содержащийся в шагах ручного теста, представляет собой 
комментарии к разработанному скрипту теста. Если ручной тест содержит 
параметры, они тоже считаются комментарием.

Для создания скрипта  автоматизированного теста

 1 В дереве плана тестирования выберите ручной тест, который необходимо 
автоматизировать.

 2 Перейдите на вкладку Design Steps и нажмите кнопку Generate Script. 

 3 Выберите тип автоматизированного теста, в который необходимо 
преобразовать ручной тест.

Значок 
теста Тип теста Описание

WR-AUTOMATED Этот тест выполняется средством 
тестирования функциональности 
WinRunner, разработанным компанией HP 
для тестирования приложений  Microsoft 
Windows.

VAPI-XP-TEST Этот тест создаётся с помощью средства 
тестирования прикладного программного 
интерфейса открытой архитектуры  Visual 
API-XP, используемого  Quality Center. 
Дополнительные сведения о тестах, 
создаваемых с помощью VAPI-XP, см. в 
Приложение A, "Работа сс VAPI-XP"..
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Примечание. Этот тип тестаQUICKTEST_TEST доступен только в том 
случае, если установлена соответствующая надстройка, которую можно 
загрузить со страницы надстроек HP Quality Center. Дополнительные 
сведения об установке надстроек см. в руководстве Руководство по 
установке HP Quality Center.

На основе шагов выбранного теста модуль Test Plan разрабатывает  скрипт  
автоматизированного теста. Учтите, что в дереве плана тестирования 
значок ручного теста  заменяется значком автоматизированного теста.

 4 Перейдите на вкладку Test Script, чтобы просмотреть  скрипт  теста. 

 5 Если тест выполняется средством WinRunner, то к этому тесту можно 
присоединить скрипт  другого  теста, нажав кнопку Copy From. Откроется 
диалоговое окно Select Test, в котором можно выбрать в файловой системе 
тест, выполняемый средством WinRunner. 

 6 Если тест выполняется средством WinRunner, LoadRunner или QuickTest 
Professional, нажмите кнопку Launch, чтобы просмотреть  скрипт. При 
необходимости тест можно изменить.

LR-SCENARIO Этот тест выполняется средством 
тестирования на нагрузку LoadRunner, 
разработанным компанией HP.

QUICKTEST_TEST Этот тест выполняется QuickTest 
Professional, средством тестирования  
функциональности предприятия, 
разработанным компанией HP.

Значок 
теста Тип теста Описание
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Систем ные тесты

С помощью системных тестов в Quality Center можно получать сведения о 
системе, захватывать снимки экрана и  перезагружать компьютер.

Сведения  о системных тестах
Можно запускать системные тесты  для получения сведений о системе, 
просмотра снимков экрана с ходом  выполнения теста и перезагрузки 
компьютера. Например, можно запустить системный очищающий тест, 
который перезагрузит компьютер, если на нём автоматизированный тест 
завершился с состоянием Failed («Не пройден»). Также можно разработать 
системный тест для получения сведений об использовании ресурсов 
компьютера до или после выполнения теста.

Глава содержит следующие разделы: На стр.

Сведения о системных тестах 321

Добавление системных тестов в дерево плана тестирования 322

Определение системного теста 324

Выполнение системного теста 325

Просмотр результатов выполнения системного теста 326
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Системный тест разрабатывается в следующей последовательности: в 
дерево плана тестирования добавляется системный тест, затем этот тест 
определяется и добавляется в набор тестов.

Примечание. До выполнения системного теста необходимо установить 
надстройки System Test Remote Agent  и HP Quality Center Connectivity-на 
компьютере, на котором будет выполняться этот тест. Дополнительные 
сведения о надстройках для HP Quality Center см. в руководстве 
Руководство по установке HP Quality Center.

При выполнении системного теста создаются следующие шаги:

➤ SysInfo. Сбор сведений о системе.

➤ Snapshot. Захват снимка  экрана.

➤ Reboot Start и Reboot Finish. Перезагрузка компьютера.

После выполнения системного теста можно просмотреть сведения о всех 
этих шагах. Также можно просмотреть изображение хода выполнения 
системного теста  на экране компьютера и полученные сведения о системе, 
в том числе информацию о центральном процессоре, оперативной памяти 
и выполняющихся на компьютере процессах.

Добавление системных тестов в дерево плана 
тестирования

Создание системного теста начинается с его добавления в дерево плана 
тестирования.

Для добавления  системного теста в дерево плана тестирования

 1 Выберите папку объекта в дереве плана тестирования.

 2 Нажмите кнопку New Test или выберите Tests > New Test. Откроется 
диалоговое окно Create New Test.
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 3 В поле Test Type выберите SYSTEM-TEST. 

Примечание. Если на компьютере установлена надстройка QuickTest 
Professional, диалоговое окно Create New Test должно содержать поле 
Template.

 4 В поле Test Name введите имя теста.

 5 Нажмите кнопку OK.

Примечание. Если обязательные поля теста были заданы в окне Project 
Customization, откроется диалоговое окно Required Test Fields. Выберите 
значения обязательных полей, нажмите кнопку OK. 

Новый системный тест со значком  появится в дереве плана 
тестирования под выбранной папкой объекта. 

 6 К тесту можно добавить сведения и вложения и определить покрытие 
требований тестами. Дополнительные сведения см. в главе Глава 17, 
"Создание дерева плана тестирования". 
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Определение системного теста
После добавления системного теста в дерево плана тестирования можно 
разработать скрипт теста. 

Для определения системного теста:

 1 В дереве плана тестирования выберите системный тест, перейдите на 
вкладку Test Script.

 2 Установите флажок Collect system information, если необходимо собрать 
сведения о системе, в том числе информацию о центральном процессоре, 
оперативной памяти и  процессах, выполняющихся на компьютере во 
время выполнения системного теста. 

 3 Установите флажок Capture desktop image, если необходимо добавить 
вложение, содержащее снимок  экрана компьютера во время выполнения 
системного теста. 
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 4 Установите флажок Restart the computer, если необходимо, чтобы 
Quality Center перезагружал компьютер при выполнении системного теста.  

Примечания. 

➤ Для применения флажка Restart the computer требуется 
автоматический вход в систему. Выберите Start > Programs > 
HP Quality Center SystemTest Agent > SystemTest Agent 
(configuration). Откроется диалоговое окно Auto Restart Settings. Про 
умолчанию User Name и Domain доступны только для чтения. Введите 
пароль и нажмите кнопку OK. 

➤ Чтобы выбрать другое имя пользователя, снова откройте диалоговое 
окно Auto Restart Settings. Теперь User Name и Domain уже доступны не 
только для чтения. Измените значения и  нажмите кнопку OK.

 5 Нажмите кнопку Save, чтобы сохранить параметры системного теста.

Определив системный тест в модуле Test Plan, можно добавить этот тест в 
набор тестов в модуле Test Lab. Дополнительные сведения о создании 
наборов тестов см. в главе Глава 24, "Создание набора тестов".

Выполнение системного теста
Определив системный тест и добавив его в набор тестов в модуле Test 
Lab, можно выполнить его. Пользователь может выполнять системные 
тесты на своём компьютере или на нескольких  удалённых хостах, 
подключённых к сети. 

Дополнительные сведения о выполнении тестов см. в главе Глава 27, 
"Автоматическое выполнение тестов".
325



Глава 21 • Систем ные тесты
Просмотр результатов выполнения системного теста
Результаты выполнения системного теста можно просматривать в модуле 
Test Lab.

Для просмотра результатов выполнения системного теста:

 1 В таблице Execution Grid дважды щелкните системный тест, либо выберите 
тест, а затем нажмите кнопку Test Instance Properties. На вкладке 
Execution Flow щёлкните правой кнопкой мыши системный тест, затем 
выберите команду Test Instance Properties. 

Откроется диалоговое окно Test Instance Properties, содержащее 
представление All Runs.

В нем отображаются состояние, дата и время выполнения следующих 
шагов, созданных при выполнении системного теста. 

➤ SysInfo. Сбор сведений о системе.

➤ Snapshot. Захват снимка экрана.
326



Глава 21 • Систем ные тесты
➤ Reboot Start и Reboot Finish. Перезагрузка компьютера.

 2 Щёлкните ссылку Collected System Info, чтобы просмотреть собранные  
сведения о системе, в том числе информацию о процессоре, оперативной 
памяти и процессах, выполняющихся на комьютере.

 3 Щёлкните ссылку Captured Desktop Image, чтобы просмотреть 
изображение хода выполнения системного теста на экране компьютера.
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22
Рабочий процесс модуля Test Lab

В процессе модификации  приложения в проекте необходимо запускать 
ручные и автоматические тесты, чтобы обнаружить дефекты и оценить 
качество приложения.

В этой описан процесс тестирования с применением модуля Test Lab 
Quality Center. Выполнение тестов включает в себя следующие: 

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements

Создание
наборов тестов

План выполнения
тестов

Прогон тестов
вручную

Анализ результатов 
тестирования

Автоматический
прогон тестов
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Создание наборов тестов
Начните с создания наборов тестов. Выберите, какие тесты необходимо 
включить в каждый набор тестов. Набор тестов – это группа тестов проекта 
Quality Center, предназначенная для достижения поставленных целей 
тестирования. Например, в приложении Mercury Tours, которое 
используется в качестве примера, можно создать набор тестов для 
проверки основных функций этого приложения. Можно включить тесты, 
которые проверяют механизм входа, а также тесты, проверяющие 
механизм бронирования авиабилетов. 

После создания наборов тестов необходимо назначить папки наборов 
тестов циклам, определённым в дереве версий в модуле Releases. Цикл 
представляет собой этап разработки и контроля качества на основе 
временных рамок проекта. 

Дополнительные сведения см. в разделе Глава 24, "Создание набора 
тестов".

Составлениерасписания запускатестов 
Quality Center позволяет управлять выполнением тестов, входящих в набор 
тестов. Можно указать условия, дату и время запуска тестов. Также можно 
установить последовательность выполнения тестов. Например, можно 
указать, что тест test2 должен запускаться только после завершения теста 
test1, а тест test3 должен запускаться только в том случае, если тест test1 
не обнаружил ошибок в приложении. 

Дополнительные сведения см. в главе Глава 25, "Составление расписания 
запуска тест".
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Выполнение тестов вручную
После определения наборов тестов можно приступить к выполнению 
тестов. При запуске теста вручную выполняются шаги теста, которые были 
определены при планировании тестирования. Результат каждого шага 
зависит от того, соответствуют ли фактические результаты тестирования 
приложения ожидаемым результатам. 

Предположим, например, что вы тестируете процесс бронирования 
билетов на авиарейсы в примере приложения Mercury Tours. Вы 
открываете это приложение, создаёте заказ и бронируете билет в 
соответствии с инструкциями, прилагаемыми к шагам тестов.

Дополнительные сведения см. в главе Глава 26, "Выполнение тестов 
вручную".

Выполнение автоматизированныхтестов
После определения наборов тестов можно приступить к выполнению 
тестов. Можно выбрать все тесты из набора тестов или только некоторые 
тесты. Среди выбранных тестов могут быть как ручные, так и 
автоматизированные тесты. 

После запуска автоматизированного теста открывается выбранное 
средство тестирования, которое выполняет тест, а затем экспортирует 
результаты тестирования в Quality Center. Если был запущен ручной тест, 
тестировщик получает по электронной почте уведомление, указывающее, 
чтобы он запустил ручной тест.

Дополнительные сведения см. в главе Глава 27, "Автоматическое 
выполнение тестов".

Можно также запустить автоматический тест для получения информации о 
системе, для записи изображения с экрана компьютера или для 
перезагрузки компьютера. Дополнительные сведения о тестировании 
системы см. в Глава 21, "Систем ные тесты".
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Анализ результатов тестирования
После выполнения теста необходимо проанализировать его результаты. 
Следует определить шаги, на которых обнаружился дефект, и определить, 
является ли этот дефект следствием ошибки приложения или необходимо 
просто обновить ожидаемые результаты тестирования. Если был 
обнаружен дефект, можно либо создать новый дефект и связать его с 
выполненным тестом, либо связать с выполненным тестом уже 
существующий дефект. Дополнительные сведения см. в главе Глава 32, 
"Связывание дефектов".

Проверять результаты тестирования можно, регулярно просматривая 
данные выполнения и создавая отчёты и графики. Дополнительные 
сведения см. в главах Глава 33, "Создание отчетов", Глава 34, "Создание 
диаграмм", и Глава 35, "Создание диаграмм анализа в реальном времени".

Дополнительные сведения о данных, которые появляются в Quality Center 
после выполнения теста, см. в главе Глава 28, "Просмотр результатов 
тестирования".
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Краткий обзор модуля Test Lab

В данном разделе кратко описаны основные элементы модуля Test Lab.

Данная глава содержит следующие разделы На стр.

Модуль Test Lab 336

Строка меню модуля Test Lab 338

Панели инструментов модуля Test Lab 339

Таблица Execution Grid 341

Схема выполнения 348
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Модуль Test Lab 
Создание наборов тестов и тестирование выполняются в модуле Test Lab 
приложения Quality Center. Чтобы открыть окно этого модуля, нажмите 
кнопку Test Lab на боковой панели. 

Модуль Test Lab содержит следующие основные элементы:

➤ Строка меню Test Lab. Отображает раскрывающиеся меню с командами 
модуля Test Lab. Дополнительные сведения см. в разделе “Строка меню 
модуля Test Lab" на стр. 338.

➤ Панель инструментов Test Set. Содержит кнопки команд, часто 
использующихся для создания и изменения наборов тестов в дереве 
наборов тестов. Дополнительные сведения см. в разделе “Панель 
инструментов Test Set" на стр. 339.

➤ Область Test Set. Отображает наборы тестов в виде иерархической 
структуры — дерева наборов тестов. По умолчанию тесты сгруппированы в 
папки. Наборы тестов также можно просматривать в виде списка, выбрав 
команду View > Test Sets Grid. Дополнительные сведения о создании 
дерева наборов тестов см. в разделе “Создание дерева наборов тестов" на 
стр. 354.
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➤ Вкладка Execution Grid Отображает данные тестирования в виде 
таблицы. Дополнительные сведения см. в разделе “Таблица Execution 
Grid" на стр. 341.

➤ Вкладка Execution Flow. Отображает данные тестирования в виде схемы. 
Дополнительные сведения см. в разделе “Схема выполнения" на стр. 348.

➤ Вкладка Test Set Properties. Отображает сведения о текущем наборе 
тестов, вложениях, правилах уведомления по электронной почте и 
инструкции при обнаружении ошибок. Дополнительные сведения см. в 
главеГлава 24, "Создание набора тестов".

➤ Вкладка Linked Defects. Содержит список объектов, связанных с текущим 
набором тестов. Дополнительные сведения см. в главе Глава 32, 
"Связывание дефектов".

➤ Область Select Tests. Отображает тесты в правой части экрана и 
позволяет добавлять тесты в набор. Чтобы открыть эту область, нажмите 
кнопку Select Tests  Область Select Tests содержит две вкладки. На 
вкладке Test Plan Tree отображается дерево плана тестирования. На 
вкладке Requirements Tree отображаются тесты в соответствии со 
связанными с ними требованиями.

➤ Вкладка Live Analysis. Графическое представление данных тестирования, 
связанных с выбранной папкой наборов тестов в дереве наборов тестов. 
Дополнительные сведения см. в главе Глава 35, "Создание диаграмм 
анализа в реальном времени".

Совет. Щелкните правой кнопкой мыши тест в таблице Execution Grid или 
на схеме Execution Flow, выберите команду Go to Test in Test Plan Tree, 
чтобы открыть модуль Test Plan и выделить выбранный тест в дереве 
плана тестирования. 
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Строка меню модуля Test Lab
Строка меню модуля Test Lab содержит следующие меню:

➤ Меню Test Sets содержит команды, позволяющие создавать, изменять и 
запускать наборы тестов. Предусмотрены следующие возможности: 
удаление результатов тестирования, просмотр свойств набора тестов, 
добавление хостов, создание групп хостов, экспорт содержимого таблицы 
Execution Grid в файл. Дополнительные сведения см. в главе Глава 24, 
"Создание набора тестов". 

➤ Меню Edit содержит команды, которые позволяют вырезать, копировать, 
вставлять, переименовывать и удалять наборы тестов, а также искать 
папки и наборы тестов. На вкладке Execution Flow это меню позволяет 
найти тест на схеме.

➤ Меню View содержит команды, которые позволяют фильтровать и 
сортировать наборы тестов, а также настраивать отображение дерева и 
таблицы наборов тестов.

➤ Меню Tests доступно только в таблице Execution Grid и на схеме Execution 
Flow. Оно содержит команды, которые позволяют запускать тесты, в том 
числе вручную, продолжать выполнение тестов, удалять тесты из наборов, 
настраивать отображение таблицы Execution Grid, просматривать свойства 
экземпляров тестов, изменять порядок тестов, искать тесты, выбирать их и 
просматривать результат последнего выполнения теста. Дополнительные 
сведения см. в главе Глава 24, "Создание набора тестов". Также можно 
добавлять, просматривать и упорядочивать избранные представления. 
Дополнительные сведения см. в главе Глава 6, "Работа с избранными 
представлениями". Кроме того, можно просматривать и добавлять к тестам 
оповещения и устанавливать для тестов флажки отслеживания. 
Дополнительные сведения см. в главеГлава 4, "Оповещение об 
изменениях".

➤ Меню Analysis содержит команды, которые позволяют формировать 
отчеты о выполнении тестов и диаграммы. Дополнительные сведения об 
отчетах о выполнении тестов см. в главе Глава 33, "Создание отчетов". 
Дополнительные сведения о диаграммах выполнения тестов см. главах 
Глава 34, "Создание диаграмм", и Глава 35, "Создание диаграмм анализа в 
реальном времени".
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Совет. Чтобы получить доступ к строке меню Test Lab из модуля Test Lab, 
нажмите клавишу F9. Кроме того, с помощью комбинаций клавиш можно 
выполнять множество других операций в Quality Center. Перечень 
комбинаций клавиш приведен в Приложение B, "Quality Center - 
Комбинации клавиш"..

Панели инструментов модуля Test Lab
Модуль Test Lab содержит следующие панели инструментов. Test Set и 
Select Tests. 

Кроме того, можно использовать панели инструментов на вкладках 
Execution Grid и Execution Flow. Дополнительные сведения см. в разделах 
“Панель инструментов Execution Grid" на стр. 343 и “Панель инструментов 
Execution Flow" на стр. 349.

Панель инструментов Test Set
Панель инструментов Test Set (набор тестов) содержит следующие кнопки.

New Folder. Открывает диалоговое окно New Folder, в котором можно 
создать папку наборов тестов. Эта папка добавляется к дереву наборов 
тестов в левой области. Дополнительные сведения см. в разделе 
“Создание дерева наборов тестов" на стр. 354.

New Test Set. Открывает диалоговое окно New Test Set, в котором можно 
создать набор тестов в уже существующей папке. Дополнительные 
сведения см. в разделе “Добавление наборов тестов" на стр. 356.

Delete. Удаляет папки и наборы тестов с дерева наборов тестов. Удаляет 
наборы тестов из таблицы наборов тестов. Дополнительные сведения см. в 
разделе “Удаление набора тестов" на стр. 376.

Assign To Cycle. Позволяет назначить циклу папку наборов тестов. 
Дополнительные сведения см. в разделе “Назначение папок наборов 
тестов циклам" на стр. 355.
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Refresh All. Обновляет дерево наборов тестов или таблицу наборов 
тестов, чтобы отображались самые последние наборы тестов.

Set Filter/Sort. Содержит следующие параметры:

➤ Set Filter/Sort. Открывает диалоговое окно Filter, в котором можно 
фильтровать и сортировать наборы тестов. 

➤ Clear Filter/Sort. Очищает все примененные фильтры или функции 
сортировки.

Дополнительные сведения см. в разделе “Фильтрация записей" на стр. 59.

Панель инструментов Select Tests
Чтобы отобразить дерево плана тестирования в правой области, нажмите 
кнопку Select Tests. Отобразится вкладка Test Plan Tree. Если перейти на 
вкладку Requirements Tree, тесты отображаются в соответствии со 
связанными с ними требованиями.

Панель инструментов Select Tests содержит следующие кнопки.

Add Tests to Test Set. Добавляет тесты в набор тестов. 

Refresh All. Обновляет дерево.

Задать фильтр/сортировку. Содержит следующие команды.

➤ Set Filter/Sort. Открывает диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты. 

➤ Clear Filter/Sort. Очищает все примененные фильтры или функции 
сортировки.

Find. Выполняет поиск конкретного теста в дереве. При успешном 
завершении поиска тест будет выделен в дереве.
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Таблица Execution Grid 
На вкладке Execution Grid данные тестирования отображаются в виде 
таблицы. В каждой строке этой таблицы отображается отдельный тест и 
связанные с ним данные. 
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Вкладка Execution Grid содержит следующие основные элементы.

➤ Панель инструментов Execution Grid. Содержит кнопки команд, часто 
использующихся при выполнении и просмотре тестов. См. раздел “Панель 
инструментов Execution Grid" на стр. 343.

➤ Indicator columns. Указывают, что определенный экземпляр теста 
содержит вложения, связанные дефекты, оповещения и флажки 
отслеживания. Чтобы отобразить эти столбцы, выберите команду Tests > 
Indicator Columns.

➤ Фильтр таблицы. Отображает текущий фильтр, примененный к столбцу. 
Чтобы отобразить фильтры, выберите Tests > Grid Filters.

➤ Область Last Run Result. Отображает результаты последнего 
выполнения теста. Чтобы отобразить область результатов последнего 
выполнения теста, выберите Tests > Last Run Result или щелкните 
стрелку Show.

Столбец Описание

Attachments Чтобы просмотреть вложения в экземпляр теста, 
щелкните значок . Дополнительные сведения см. 
в разделеГлава 5, "Добавление вложений".

Linked Entities Чтобы просмотреть связанные с экземпляром 
теста объекты, щелкните значок . 
Дополнительные сведения см. в главе Глава 32, 
"Связывание дефектов".

Alerts Чтобы просмотреть оповещения для экземпляра 
теста , щелкните значок . Дополнительные 
сведения см. в разделе “Просмотр оповещений" на 
стр. 85.

Follow Up Flags Чтобы просмотреть оповещения об отслеживании 
для экземпляра теста, щелкните значок . 
Дополнительные сведения см. в разделе 
“Установка флажков для отслеживания" на стр. 88.
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➤ Favorite views. Позволяет просматривать, добавлять и упорядочивать 
избранные представления в списке Favorites. Чтобы получить доступ к 
командам избранных представлений, выберите Tests > Favorites. 
Дополнительные сведения об избранных представлениях см. в главе 
Глава 6, "Работа с избранными представлениями"..

Панель инструментов Execution Grid
Панель инструментов Execution Grid содержит следующие кнопки:

Select Tests. Отображение дерева плана тестирования в правой области. 
В дереве плана тестирования можно выбирать тесты и добавлять их в 
набор. Можно также перейти на вкладку Requirements Tree, чтобы 
просматривать тесты в соответствии с требованиями. Дополнительные 
сведения см. в разделе “Добавление тестов в набор тестов" на стр. 359.

Run. Если выбран ручной тест, то при нажатии этой кнопки откроется 
диалоговое окно Manual Runner для запуска этого теста. Если выбран 
автоматизированный тест, то — откроется диалоговое окно Automatic 
Runner для запуска этого теста. Включены следующие варианты:

➤ Run Manually. Выполнение автоматизированного теста вручную.

➤ Continue Manual Run. Возобновление выполнения ручного теста.

Дополнительные сведения о выполнении тестов вручную см. в главе 
Глава 26, "Выполнение тестов вручную". Дополнительные сведения о 
выполнении автоматизированных тестов см. в главе Глава 27, 
"Автоматическое выполнение тестов". 

Run Test Set. Открывает диалоговое окно Automatic Runner, в котором 
можно выполнить набор тестов. Набор тестов может содержать как ручные, 
так и автоматизированные тесты. Дополнительные сведения см. в разделе 
“Автоматическое выполнение тестов" на стр. 404.

Remove Tests from Test Set. Удаляет выбранные тесты из набора тестов. 
Дополнительные сведения см. в разделе “Удаления теста из набора 
тестов" на стр. 372.

Refresh All. Обновляет таблицу Execution Grid, после чего в ней в 
соответствии с выбранными фильтрами отображаются самые последние 
тесты. 
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Set Filter/Sort. Открывает диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты в таблице Execution Grid. Включены 
следующие варианты: 

➤ Set Filter/Sort. Открывает диалоговое окно Filter, в котором можно 
фильтровать и сортировать тесты. 

➤ Очистить фильтр/сортировку. Очищает все фильтры и функции 
сортировки, примененные к таблице Execution Grid.

Дополнительные сведения см. в разделе “Фильтрация записей" на стр. 59.

Select Columns. Открывает диалоговое окно Select Columns, в котором 
можно задать, какие столбцы и в каком порядке будут отображаться в 
таблице Execution Grid. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 55.

Test Instance Properties. Открывает диалоговое окно Test Instance 
Properties, в котором отображаются свойства выбранного экземпляра 
теста. Дополнительные сведения см. в разделе “Просмотр результатов 
тестирования" на стр. 415.

Вложения. Открывает диалоговое окно Test Instance Properties, в котором 
можно добавить вложение в экземпляр выполнения теста. 
Дополнительные сведения см. Глава 5, "Добавление вложений".

Flag for Follow Up. Открывает диалоговое окно Flag For Follow Up, в 
котором можно добавить или изменить флажок отслеживания экземпляра 
теста. Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 88.
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Столбцы таблицы выполнения тестов
В таблице выполнения тестов отображаются следующие столбцы, 
содержащие данные о планировании тестирования (план) и результаты 
выполнения тестирования.

Столбец Описание

Exec Date Дата последнего выполнения теста.

Modified Дата и время последнего изменения теста в таблице 
выполнения.

Plan: Comments Отображает комментарии к тесту.

Plan: Creation Date Дата создания теста. По умолчанию дата создания 
формируется в текущем сервере базы данных. 

Plan: Description Описание теста.

Plan: Designer Имя пользователя лица, разработавшего тест.

Plan: Estimated 
DevTime

Расчетная продолжительность планирования и 
разработки теста.

Plan: Execution 
Status

Состояние, с которым завершилось выполнение 
последнего экземпляра теста. Возможны следующие 
состояния выполнения экземпляра теста: Failed, N/A, 
No Run, Not Completed, Passed.

Plan: Modified Дата и время последнего изменения теста в модуле 
Test Plan.

Plan: Path Путь к файлу теста на сервере (относительно 
репозитория тестов).

Plan: Status Статус планирования теста. Статус по умолчанию – 
Design.

Plan: Subject Папка объекта в дереве плана тестирования, в которой 
находится тест.

Plan: Template Указывает, является ли тест шаблоном. В этом 
столбце могут быть лишь значения Y (Да) и N (Нет).

Plan: Test Name Имя теста.
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Plan: Type Тип теста. Например, ручной или WinRunner.

Planned Exec Date Дата, на которую запланировано выполнение теста.

Planned Exec Time Время, на которое запланировано начало выполнения 
теста.

Planned Host Name Имя или IP-адрес компьютера, на котором планируется 
выполнить тест.

Responsible Tester Имя пользователя, который отвечает за выполнение 
теста.

Status Статус последнего выполнения теста. Возможны 
следующие состояния выполнения теста: Failed, N/A, 
No Run, Not Completed, Passed.

Target Cycle Указывает цикл, в котором тест был назначен. Чтобы 
выбрать другой цикл, нажмите кнопку вниз.

Test Version Номер версии теста.

Tester Имя последнего выполнявшего данный тест лица.

Time Время последнего выполнения теста.

Столбец Описание
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Примечания. 

➤ В таблицу выполнения можно добавлять свои поля. Можно также 
изменить метку любого поля этой таблицы. Также предусмотрена 
возможность настройки списков проектов. Дополнительные сведения 
см. в Руководство администратора HP Quality Center.

➤ Для ограничения и динамического изменения полей и значений в 
таблице выполнения можно использовать редактор Script Editor. 
Дополнительные сведения см. в Руководство администратора 
HP Quality Center.

➤ Если в таблице выполнения выбрать столбец, содержащий имя 
пользователя, Quality Center отобразит список с именем и полным 
именем каждого пользователя. Можно выполнять поиск пользователей, 
сортировать и группировать их, а также выбирать пользователей из 
списка и дерева групп. Дополнительные сведения см. в разделе “Выбор 
пользователей" на стр. 58.
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Схема выполнения 
На вкладке Execution Flow отображаются данные тестирования, 
организованные в виде схемы. Схему Execution Flow можно использовать 
для управления способом выполнения тестов. Можно указать, когда и при 
каких условиях должен выполняться тест. 

Дополнительные сведения о вкладке Execution Flow см. в главе Глава 25, 
"Составление расписания запуска тест". 

Вкладка Execution Flow содержит следующие основные элементы:

➤ Панель инструментов Execution Flow. Содержит кнопки команд, часто 
используемых при планировании тестирования. См. раздел “Панель 
инструментов Execution Flow" на стр. 349.

➤ Схема Execution Flow. Показывает тесты и условия в виде схемы. 
Дополнительные сведения см. Глава 25, "Составление расписания запуска 
тест".
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Панель инструментов Execution Flow
Панель инструментов Execution Flow содержит следующие кнопки.

Select Tests. Отображение дерева плана тестирования в правой области. 
В дереве плана тестирования можно выбирать тесты и добавлять их в 
набор. Можно также перейти на вкладку Requirements Tree, чтобы 
просматривать тесты в соответствии с требованиями. Дополнительные 
сведения см. в разделе “Добавление тестов в набор тестов" на стр. 359.

Run. Если выбран ручной тест, откроется диалоговое окно Manual Runner 
для запуска этого теста. Если выбран автоматизированный тест, откроется 
диалоговое окно Automatic Runner для запуска этого теста. Возможны 
следующие варианты:

➤ Run Manually. Выполнение автоматизированного теста вручную.

➤ Continue Manual Run. Возобновление выполнения ручного теста.

Дополнительные сведения о выполнении тестов вручную см. Глава 26, 
"Выполнение тестов вручную". Дополнительные сведения об 
автоматизированном выполнении тестов см. Глава 27, "Автоматическое 
выполнение тестов"..

Run Test Set. Открывает диалоговое окно Automatic Runner, в котором 
можно выполнить набор тестов. Набор тестов может содержать как ручные, 
так и автоматизированные тесты. Дополнительные сведения см. в разделе 
“Автоматическое выполнение тестов" на стр. 404.

Find Test In Flow. Открывает диалоговое окно Find Test, в котором можно 
найти тест на схеме выполнения. Дополнительные сведения см. в разделе 
“Поиск тестов" на стр. 390.

Remove Tests from Test Set. Удаляет выбранные тесты из набора тестов.

Refresh Flow. Обновление схемы выполнения для отображения самых 
последних тестов.

ArrangeLayout. Упорядочивает тесты в иерархическом порядке, чтобы 
можно было видеть зависимости между тестами.

Увеличение. Увеличивает схему выполнения, чтобы можно было лучше 
рассмотреть нужную часть схемы.
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Уменьшение. Уменьшает схему выполнения, чтобы можно было видеть 
большую часть схемы.

Fit Picture In Window. Масштаб схемы изменяется так, чтобы она 
полностью помещалась в окне. Щелкните стрелку Fit Picture In Window, 
чтобы выбрать нужный масштаб. Дополнительные сведения см. в разделе 
“Просмотр схемы выполнения" на стр. 391.

Add Time Dependency to Flow Добавление значка временной зависимости 
в схему. Чтобы создать для теста временную зависимость, укажите на 
схеме стрелку от этого значка к тесту. По умолчанию временной 
зависимостью является текущие дата и время, сформированные на 
сервере Quality Center. Дополнительные сведения см. в разделе 
“Составление расписания запускатестов" на стр. 383.
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Создание набора тестов

Управлять выполнением тестов можно путём создания наборов тестов. 
Набор тестов — это подмножество тестов проекта. Дерево наборов тестов 
упорядочивает и отображает наборы тестов в иерархическом порядке.

Глава содержит следующие разделы: На стр.

Сведения о создании наборов тестов 352

Создание дерева наборов тестов 354

Назначение папок наборов тестов циклам 355

Добавление наборов тестов 356

Добавление тестов в набор тестов 359

Настройка уведомлений о наборе тестов 361

Настройка правил при отрицательном результате выполнения 
набора тестов

364

Ведение наборов тестов 368
351



Глава 24 • Создание набора тестов
Сведения о создании наборов тестов
После разработки тестов в модуле Test Plan можно создать дерево 
наборов тестов. Наборы тестов позволяют организовать процесс 
тестирования путём размещениянаборов тестов в соответствующих 
папках и распределения их по иерархическим уровням в модуле Test Plan. 
Набор тестов – это группа тестов проекта Quality Center, предназначенная 
для достижения поставленных целей. Набор тестов может содержать как 
ручные, так и автоматизированные тесты. После создания дерева наборов 
тестов необходимо назначить папки с наборами тестов циклам, 
определённым в дереве версий в модуле Releases.

Принимая решение о том, какие наборы тестов необходимо создать, 
руководствуйтесь теми целями тестирования, которые вы определили в 
начале процесса тестирования. Следует учитывать такие вопросы, как 
текущее состояние приложения, добавление к нему новых функций и их 
модификация.

Ниже приведены примеры общих категорий наборов тестов, которые 
можно создавать.

набор тестов Описание

Проверка 
общей 
работоспособн
ости

Проверяет всё приложение на базовом уровне, его 
работоспособность и стабильность. При этом главное 
внимание уделяется широте, а не глубине проверки. Этот 
набор тестов содержит основные тесты, в том числе 
"положительные" проверки, то есть такие проверки, которые 
показывают, что приложение работает правильно. 
Например, при тестировании приложения Mercury Tours 
можно проверить, запускается ли оно и позволяет ли 
выполнить вход в него.

Регрессивный Тестирует систему глубже, чем набор тестов для проверки 
общей работоспособности. Этот набор тестов содержит как 
"положительные", так и "отрицательные" проверки. 
Отрицательной проверкой называется попытка найти 
ошибку в приложении, чтобы показать, что оно работает 
неправильно.
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Предположим, необходимо протестировать все новые функции, 
добавленные в версию 10.5 приложения Mercury Tours. Версия 10.5 
состоит из четырех циклов. Необходимо протестировать новые функции 
версии в циклах 1, 2 и 4. Поскольку тесты, которые необходимо выполнить 
для проверки новых функций, одинаковы для всех этих циклов, можно 
использовать один и тот же набор тестов для каждого цикла.

В дереве тестов следует создать папку для релиза Release 10.5. Под этой 
папкой создайте папку Cycle 1 для первого цикла релиза. В папке Cycle 1 
создайте набор тестов New Features, содержащий тесты, необходимые 
для тестирования новых функций релиза. Создав этот набор тестов и 
добавив в него тесты, можно копировать и вставлять папку Cycle 1, 
создавая на её основе другие циклы для тестирования новых функций.

Расширенный Тестирует приложение как в ширину, так и в глубину. Этот 
набор тестов охватывает всё приложение, в том числе его 
расширенные функции. Выполнять его можно в случае, если 
на тестирование выделено много времени.

Проверка 
функций

Тестирует подсистему приложения. Это может быть одна 
функция или группа функций. Например, при тестировании 
приложения Mercury Tours можно проверить все действия, 
связанные с бронированием билетов на авиарейс. 

набор тестов Описание
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Обратите внимание, что самый верхний уровень дерева наборов тестов – 
папка Root. Папку Root невозможно удалить, в неё также нельзя добавлять 
наборы тестов (их можно добавлять только в её вложенные папки). 
Подпапка Unattached папки Root содержит все наборы тестов, которые 
больше не связаны с папкой. В папку Unattached добавлять наборы тестов 
невозможно. При удалении какой-либо папки можно указать модулю Test 
Lab, что необходимо  переместить эту папку в папку Unattached или 
удалить данные наборы тестов без возможности восстановления. 

Создание дерева наборов тестов
Иерархическая структура наборов тестов создаётся путём построения 
дерева наборов тестов. Дерево наборов тестов состоит из папок самого 
верхнего уровня, содержащих вложенные папки. Для каждой папки дерева 
наборов тестов определяется набор тестов, а затем в неё добавляются 
экземпляры тестов. Начать создание дерева наборов тестов необходимо с 
добавления папки в папку Root.

После создания дерева наборов тестов необходимо назначить папки с 
наборами тестов циклам, определённым в дереве релизов в модуле 
Releases. Более подробные сведения приведены в “Назначение папок 
наборов тестов циклам" на стр. 355. 

Как создать дерево наборов тестов

 1 Выберите View > Test Sets Tree, чтобы в области Test Set появилось 
дерево набора тестов.

 2 В дереве набора тестов выберите папку Root.

 3 Нажмите кнопку New Folder или выберите Test Sets > New Folder. 
Откроется диалоговое окно New Folder.
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 4 В поле Folder Name ведите имя новой папки, затем нажмите кнопку OK. 
Учтите, что имя папки не должно содержать следующие символы: \ ^ * 

В дереве набора тестов под папкой Root появится созданная папка.

 5 На вкладке Details укажите сведения о папке с набором тестов, назначив 
эту папку циклу. Дополнительные сведения см. в разделе “Назначение 
папок наборов тестов циклам" на стр. 355.

 6 На вкладке Description введите описание папки наборов тестов. 

 7 Перейдите на вкладку Attachments и добавьте вложение к созданной 
папке наборов тестов (если это необходимо). Вложением может быть 
файл, URL-адрес, снимок приложения, элемент буфера обмена или 
информация о системе. Дополнительные сведения см. в главе Глава 5, 
"Добавление вложений".

 8 Если необходимо создать ещё одну папку, выберите папку и повторите 
шаги с 3 по 7. 

Назначение папок наборов тестов циклам
После создания дерева наборов тестов необходимо назначить папки 
наборов тестов циклам, определённым в дереве релизов в модуле 
Releases. Дополнительные сведения см. в главе Глава 9, "Создание 
дерева релизов".

Как назначить циклу папку наборов тестов

 1 В дереве набора тестов выберите папку наборов тестов, которую 
необходимо назначить циклу. 

 2 Нажмите кнопку Assign To Cycle или выберите Test Sets > Assign To 
Cycle. Можно также перейти на вкладку Details и нажать кнопку обзора 
рядом с полем Assigned to cycle. Откроется диалоговое окно Assign To 
Cycle. 

 3 Разверните дерево и выберите цикл. 

 4 Чтобы закрыть диалоговое окно Assign To Cycle, нажмите кнопку OK. В 
дереве набора тестов значок папки заменится значком назначенной 
папки наборов тестов . 
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На вкладке Details появятся следующие сведения о папке наборов тестов:

Если нажать кнопку Show, отобразятся следующие сведения:
 

 5 Чтобы очистить назначенную папку наборов тестов, щелкните стрелку 
Assign To Cycle, затем выберите команду Clear Assigned Cycle. 
Альтернативный вариант — выделите назначенную папку наборов тестов, 
а затем выберите Test Sets > Clear Assigned Cycle. 

Добавление наборов тестов
В папку в дереве наборов тестов или в таблицу наборов тестов можно 
добавлять новые наборы тестов.

Как добавить набор тестов

 1 Добавить набор тестов можно в папку из дерева наборов тестов или в 
таблицу наборов тестов.

➤ Выведите на экран дерево набора тестов командой View > Test Sets 
Tree. Выберите в дереве набора тестов папку, затем нажмите кнопку 
New Test Set или выберите Test Sets > New Test Set.

Поле Описание

Assigned to cycle Указывает цикл, которому назначена выбранная 
папка наборов тестов.

Cycle start date Дата начала цикла. 

Cycle end date Дата завершения цикла. 

Remaining days in cycle Суммарное количество дней, оставшихся до 
завершения цикла.

Total test instances Суммарное количество экземпляров тестов в 
выбранной папке наборов тестов.

Remaining test instances 
to run

Суммарное количество экземпляров тестов в 
выбранной папке наборов тестов, которые ещё не 
выполнялись.
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➤ Выведите на экран таблицу набора тестов с помощью команды View > 
Test Sets Grid. Нажмите кнопку New Test Set или выберите Test Sets > 
New Test Set.

Откроется диалоговое окно New Test Set.

Если открыть это диалоговое окно из дерева набора тестов, то в поле Test 
Set Folder будет отображаться имя ранее выбранной папки.

 2 Если диалоговое окно New Test Set открыто из таблицы набора тестов, 
нажмите кнопку обзора в поле Test Set Folder и выберите папку.

 3 В поле Test Set Name введите имя набора тестов. Учтите, что имя набора 
тестов не должно содержать следующие символы: \ ^ , " *

 4 В поле Description введите описание набора тестов.

 5 Нажмите кнопку OK. Имя набора тестов появится в дереве набора тестов. 
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 6 Перейдите на вкладку Test Set Properties и нажмите ссылку Details. 
Альтернативный вариант — выберите Test Sets > Test Set Properties > 
Test Set Details.

 7 В поле Close Date выберите планируемую дату завершения создания 
набора тестов.

 8 В поле Open Date выберите текущую дату. По умолчанию устанавливается 
текущая дата, сформированная в сервере базы данных.

 9 В поле ITG Request Id добавьте идентификатор запроса IT Governance. 
Это требуется только при интеграции со средством IT Governance. 

 10 В поле Status выберите статусOpen или Closed.

 11 Нажмите ссылку Attachments и добавьте вложение в набор тестов. 
Вложением может быть файл, URL-адрес, снимок приложения, элемент 
буфера обмена или сведения о системе. Дополнительные сведения о 
вложениях см. в главе Глава 5, "Добавление вложений"..

 12 Щелкните ссылку Notifications , чтобы указать Quality Center отправлять 
определенным пользователям сообщения по электронной почте при 
наступлении тех или иных событий. Дополнительные сведения см. в 
разделе “Настройка уведомлений о наборе тестов" на стр. 361.
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 13 Щелкните ссылку On Failure и задайте правила для автоматизированных 
тестов из набора тестов, которые должны выполняться в случае 
отрицательного результата тестирования. Дополнительные сведения см. в 
разделе “Настройка правил при отрицательном результате выполнения 
набора тестов" на стр. 364.

Добавление тестов в набор тестов 
Определив набор тестов, можно добавлять к нему ручные и 
автоматизированные тесты из дерева плана тестирования, а также тесты, 
покрывающие требования из дерева требований. Можно также включать 
экземпляры одного теста в различные наборы тестов, причём в один набор 
тестов можно включать несколько экземпляров одного и того же теста.

Как добавить в набор тестов тесты из дерева плана тестирования

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов. 

 2 На вкладке Execution Grid или Execution Flow нажмите кнопку Select Tests. 
По умолчанию в правой области на вкладке Test Plan Tree отображается 
дерево плана тестирования. 

 3 Выберите тест или папку и нажмите кнопку Add Tests to Test Set. 

Совет. Добавлять тесты можно также двойным щелчком или 
перетаскиванием папки или теста из дерева плана тестирования в таблицу 
Execution Grid или в схему Execution Flow.

 4 При добавлении папки открывается окно сообщения. Для подтверждения 
нажмите кнопку Yes.

Примечание. Добавляются только те тесты, которые соответствуют 
текущему фильтру на вкладке Test Plan Tree.
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 5 Если в наборе тестов уже есть добавляемый тест, откроется диалоговое 
окно Create Test Instance. В этом окне отображены все тесты, которые есть 
в данном наборе тестов, и количества экземпляров тестов. Выберите 
тесты, которые необходимо добавить в набор тестов, а затем нажмите 
Create.

 6 Если добавляемый тест имеет неприсвоенные параметры, откроется 
диалоговое окно Parameters, в котором можно присвоить параметрам 
значения. Дополнительные сведения о параметрах см. в “Вызов ручного 
теста с параметрами" на стр. 303.

 7 Чтобы закрыть правую область, нажмите кнопку Close.

Как добавить тесты из дерева требований в набор тестов

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 На вкладке Execution Grid или Execution Flow нажмите кнопку Select Tests. 

 3 На правой области перейдите на вкладку Requirements Tree. Тесты 
отображаются в соответствии со связанными требованиями. 

 4 Чтобы добавить тест, выберите его и нажмите кнопку Add Tests Covering 
Requirement.

Совет. Добавлять тесты можно также двойным щелчком или 
перетаскиванием теста или требования из вкладки Requirements Tree в 
таблицу Execution Grid или Execution Flow.
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 5 Чтобы добавить все тесты, связанные с выбранным требованием, 
выберите требование и нажмите кнопку Add Tests Covering Requirement.

Чтобы добавить все тесты, связанные с выбранным требованием и его 
дочерним требованиям, выберите требование. Нажмите стрелку Add Tests 
Covering Requirement, а затем выберите Add Tests Covering 
Requirement and Children.

Откроется окно с сообщением. Для подтверждения нажмите кнопку Yes.

Примечание. Добавляются только те тесты, которые соответствуют 
текущему фильтру на вкладке Requirements Tree.

 6 Если в наборе тестов уже есть добавляемый тест, откроется диалоговое 
окно Create Test Instance. В этом окне отображены все тесты, которые есть 
в данном наборе тестов, и количества экземпляров тестов. Выберите 
тесты, которые необходимо добавить в набор тестов, а затем нажмите 
Create.

 7 Если добавляемый тест имеет неприсвоенные параметры, откроется 
диалоговое окно Parameters, в котором можно присвоить параметрам 
значения. Дополнительные сведения о параметрах см. в “Вызов ручного 
теста с параметрами" на стр. 303.

 8 Чтобы закрыть правую область, нажмите кнопку Close. 

Настройка уведомлений о наборе тестов 
Можно указать Quality Center  отправлять определенному пользователю 
сообщение по электронной почте в следующих случаях, связанных с 
набором тестов:

➤ Какой либо тест из набора тестов даст отрицательный результат.
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➤ Какой либо тест из набора тестов даст отрицательный результат по 
причинам, не связанным с логикой теста. Возможны следующие причины 
отрицательного результата теста: невозможность вызова функций, 
нарушение прав доступа, несовместимость версий компонентов 
приложения, отсутствие библиотеки DLL, неадекватные права доступа.

➤ Закончено выполнение всех тестов из набора тестов. Учтите, что это не 
касается тестов, которые не запускались.

Как добавлять уведомления о выполнении наборов тестов

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Перейдите на вкладку Test Set Properties и щёлкните ссылку Notifications. 
Или выберите Test Sets > Test Set Properties > Notifications.

 3 Выберите для данного набора теста одно или несколько событий. 
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 4 Укажите адрес электронной почты, по которому необходимо отправлять 
сообщение.

Или нажмите кнопку To. Откроется диалоговое окно Select Recipients. 
Выберите пользователей или группу пользователей. Нажмите кнопку OK. 
Сообщение будет отправлено пользователю, если в его профиле есть 
допустимый адрес электронной почты. Дополнительные сведения об 
определении свойств пользователя см. в Руководство администратора 
HP Quality Center.
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 5 В поле Message введите сообщение электронной почты.

Настройка правил при отрицательном результате 
выполнения набора тестов 

В Quality Center можно задать для набора тестов правила, которые должны 
выполняться в случае отрицательного результата автоматизированного 
теста. В этих правилах можно указать количество повторных выполнений 
теста и задать очищающий тест, который должен быть выполнен перед 
повторным запуском теста. Для каждого автоматизированного теста из 
набора можно изменить правила, применяемые по умолчанию в случае 
отрицательного результата тестирования. 

Как настроить правила на случай отрицательного результата 
тестирования

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Перейдите на вкладку Test Set Properties и щёлкните ссылку On Failure. 
Или выберите Test Sets > Test Set Properties > On Failure.
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 3 Чтобы настроить правило при отрицательном результате выполнения 
набора тестов, установите первый флажок и укажите, сколько раз должен 
быть повторно выполнен автоматизированный тест. 

 4 Чтобы добавить очищающий тест, установите второй флажок, нажмите 
кнопку обзора и выберите тест в дереве плана тестирования в диалоговом 
окне Select Cleanup Test.

 5 Для набора тестов можно изменять правила, применяемые по умолчанию 
при отрицательном результате тестирования. Дополнительные сведения 
см. в разделе “Изменение правил, применяемых по умолчанию при 
отрицательном результате тестирования" на стр. 365.

 6 Если при последнем выполнении теста из набора был получен 
отрицательный результат, можно указать приложению Quality Center 
выполнить одно из следующих действий:

➤ Do nothing.

➤ Stop the test set.

➤ Run the test set again a specified number of times.

Изменение правил, применяемых по умолчанию при 
отрицательном результате тестирования
Для набора тестов можно изменять правила, применяемые по умолчанию 
при отрицательном результате тестирования. Эти правила содержат 
инструкции для Quality Center в случае, если тест завершился со статусом 
Failed. В том числе можно задать количество повторных запусков теста и 
очищающий тест, который должен быть выполнен перед повторением 
теста.

Примечание. Можно также воспользоваться представлением Run Events в 
диалоговом окне Test Instance Properties, чтобы задать правила, 
применяемые при отрицательном результате теста из набора тестов. 
Дополнительные сведения см. в разделе “Просмотр событий выполнения 
теста" на стр. 428.
365



Глава 24 • Создание набора тестов
Как изменить правила, применяемые по умолчанию при 
отрицательном результате тестирования

 1 Задайте правила, применяемые по умолчанию при отрицательном 
результате тестирования. Дополнительные сведения см. в разделе 
“Настройка правил при отрицательном результате выполнения набора 
тестов" на стр. 364.

 2 Чтобы изменить эти правила для какого либо теста, нажмите кнопку 
Settings per test. Откроется диалоговое окно On Test Failure.
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 3 Чтобы указывать количество повторных запусков автоматизированного 
теста, предусмотрены следующие возможности:

➤ Если необходимо указать количество повторных запусков выбранного 
теста, дважды щёлкните соответствующую ячейку в столбце Number of 
Reruns. Откроется диалоговое окно Number of Reruns. Укажите 
количество повторных запусков, а затем нажмите кнопку Apply. 

➤ Чтобы указать количество повторных запусков выбранных тестов, 
выберите тесты или нажмите кнопку Select All. Нажмите клавишу Ctrl, 
затем дважды щёлкните любую ячейку в столбце Number of Reruns. 
Альтернативный вариант — нажмите стрелку Change Selected Tests и 
выберите команду Change Number of Reruns. Откроется диалоговое 
окно Number of Reruns. При этом выбран вариант Apply to all selected 
tests. Укажите количество повторных запусков и нажмите кнопку Apply.

 4 Для задания очищающего теста предусмотрены следующие варианты:

➤ Чтобы указать для выбранного теста, дважды щёлкните 
соответствующую ячейку в столбце Cleanup Test. Откроется 
диалоговое окно Select Cleanup Test. В дереве плана тестирования 
выберите очищающий тест, затем нажмите кнопку Apply.

➤ Чтобы указать один очищающий тест для выбранных тестов, выберите 
тесты или нажмите кнопку Select All. Нажмите клавишу Ctrl, затем 
дважды щёлкните любую ячейку в столбце Cleanup Test. Или нажмите 
стрелку Change Selected Tests и выберите команду Change Cleanup 
Test. Откроется диалоговое окно Select Cleanup Test. При этом выбран 
вариант Apply to all selected tests. В дереве плана тестирования 
выберите очищающий тест, затем нажмите кнопку Apply.

 5 Чтобы сбросить правила для теста до установок по умолчанию,выберите 
этот тест и нажмите кнопку Set to Default. Для подтверждения нажмите 
кнопку Yes.

 6 Чтобы отменить параметры теста, выберите этот тест и нажмите кнопку 
Clear. Для подтверждения нажмите кнопку Yes.

 7 Чтобы скопировать параметры из одного теста в другой, выберите тест, из 
которого необходимо скопировать параметры, а затем нажмите кнопку 
Copy Test Settings.
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Выберите тест, в который необходимо вставить параметры, затем нажмите 
кнопку Paste Test Settings.

 8 Нажмите кнопку OK, чтобы сохранить изменения и закрыть диалоговое 
окно On Test Failure. 

Ведение наборов тестов 
Содержание раздела об управлении наборами тестов:.

➤ Поиск набора тестов в дереве

➤ Поиск теста в таблице Execution Grid конец

➤ Замена значений полей в таблице Execution Grid

➤ Удаления теста из набора тестов

➤ Копирование набора тестов или папки наборов тестов в том же проекте

➤ Копирование набора тестов или папки наборов тестов из одного проекта в 
другой

➤ Копирование URL-адреса набора тестов

➤ Переименование набора тестов

➤ Удаление папки наборов тестов

➤ Удаление набора тестов

➤ Сброс набора тестов

➤ Удаления результатов тестирования из набора тестов

Поиск набора тестов в дереве
Предусмотрена возможность поиска папки или набора тестов в дереве 
наборов тестов. Если к дереву набора тестов применить фильтр, то модуль 
Test Lab будет выполнять поиск только в текущем (отображаемом) наборе 
тестов.
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Как найти папку или набор тестов

 1 Выберите папку в дереве набора тестов.

 2 Выберите Edit > Find Folder/Test Set. Откроется диалоговое окно Find 
Folder/Test Set, в котором в поле Find отображается имя папки. При поиске 
по всему дереву именем папки является Root.

 3 В поле Value To Find введите имя (или часть имени) папки или набора 
тестов. Учтите, что поиск выполняется без учета регистра.

 4 Установите флажок Include Test Sets, если в поиск необходимо включить 
наборы тестов.

 5 Нажмите кнопку Find.

Модуль Test Lab начнёт поиск папки или набора тестов. Если поиск 
окажется успешным, появится диалоговое окно Search Results, 
содержащее список возможных совпадений. Выберите в этом списке 
нужный результат, затем нажмите кнопку Go To, чтобы выделить папку или 
набор тестов в дереве набора тестов. 

При неуспешном завершении поиска откроется окно сведений.
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Поиск теста в таблице Execution Grid конец
 Можно искать тесты в таблице Execution Grid по значению поля. Если к 
таблице применены фильтры, то поиск будет вестись только среди 
отображаемых тестов.

Как найти тест в таблице Execution Grid

 1 Выберите Tests > Find. Откроется диалоговое окно Find.

 2 В поле Find in Field выберите поле таблицы.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти.

 4 Установите флажок Exact Match, если необходимо найти тесты со 
значениями полей, точно совпадающими со значением в поле Value to Find.

 5 Установите флажок Case Sensitive, если необходимо различать 
прописные и строчные символы.

 6 Если необходимо использовать звездочки (*) в строке поиска, чтобы 
вводить только часть элемента, установите флажок Use Wildcard.

 7 Нажмите кнопку Find Next. При успешном завершении поиска в таблице 
будет выделен найденный тест. При неуспешном завершении поиска 
откроется окно сведений.

 8 Чтобы найти следующий тест, удовлетворяющий заданному условию, ещё 
раз нажмите кнопку Find Next.
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Замена значений полей в таблице Execution Grid
С помощью команды Replace можно выполнять замену значений полей в 
таблице Execution Grid.

Как заменить значение поля в таблице требований

 1 Выберите Tests > Replace. Откроется диалоговое окно Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск конкретного значения. 

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение, которое будет 
подставлено в поле вместо старого значения.

 5 Для поиска с учетом прописных и строчных символов установите флажок 
Case Sensitive.

 6 Для поиска точного значения установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы, установите флажок From 
Beginning.

 8 Чтобы можно было использовать в строке поиска символы звездочки (*) и 
вводить только часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажмите кнопку Replace.

 10 Чтобы заменить все экземпляры значения в таблице, нажмите кнопку 
Replace All.
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Удаления теста из набора тестов
Предусмотрена возможность удаления тестов из набора тестов.

Как удалить тест из набора тестов

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов. Тесты отображаются в таблице Execution Grid или схеме Execution 
Flow.

 2 Выберите тест, который необходимо удалить. Чтобы удалить несколько 
тестов из таблицы Execution Grid или схемы Execution Flow, нажмите 
клавишу Ctrl, затем выберите тесты, которые необходимо удалить.

 3 Нажмите кнопку Remove Tests from Test Set.

 4 Для подтверждения нажмите кнопку Yes. 

Копирование набора тестов или папки наборов тестов в 
том же проекте
Предусмотрена возможность копирования набора тестов или папки 
наборов тестов в том же проекте. При этом информация о выполнении 
тестов не копируется. 

Как скопировать набор тестов или папку наборов тестов в том же 
проекте

 1 Выберите набор тестов или папку наборов тестов в дереве наборов тестов. 
Чтобы скопировать несколько наборов тестов или папок, воспользуйтесь 
клавишей Ctrl.

 2 Выберите Edit > Copy. Альтернативный вариант — щелкните правой 
кнопкой мыши и выберите Copy.

 3 Выберите папку, в которую необходимо скопировать набор тестов или 
вложенную папку.

 4 Выберите Edit > Paste. Альтернативный вариант —щелкните правой 
кнопкой мыши и выберите Paste.
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Копирование набора тестов или папки наборов тестов из 
одного проекта в другой
Предусмотрена возможность копировать наборы тестов и папки наборов 
тестов из одного проекта в другой. Если наборы тестов или папки наборов 
тестов содержат вызовы других тестов, в Quality Center можно скопировать 
их одним из следующих способов:

➤ Скопируйте наборы тестов или папки набора тестов и свяжите их с 
существующими тестами того проекта, в который необходимо копировать. 
Если вызываемого теста нет в проекте, в который необходимо 
скопировать, Quality Center вставит его, скопировав из исходного проекта.

➤ Скопируйте наборы тестов или папки наборов тестов вместе с 
вызываемыми тестами из исходного проекта, затем вставьте их в другой 
проект. 

➤ Скопируйте наборы тестов или папки наборов тестов из исходного проекта 
без вызываемых тестов и вставьте их в другой проект. 

При этом информация о выполнении тестов не копируется.

Как скопировать набор тестов или папку наборов тестов из одного 
проекта в другой

 1 В дереве набора тестов выберите набор тестов или папку наборов тестов. 
Чтобы скопировать несколько наборов тестов или папок, воспользуйтесь 
клавишей Ctrl.

 2 Выберите Edit > Copy. Альтернативный вариант — щелкните правой 
кнопкой мыши и выберите Copy.

 3 Откройте другой экземпляр Quality Center и зарегистрируйтесь в том 
проекте, в который необходимо вставить тесты.

 4 Выберите папку, в которую необходимо скопировать наборы тестов или 
папки наборов тестов.

 5 Выберите Edit > Paste. Альтернативный вариант — щелкните правой 
кнопкой мыши и выберите Paste. Откроется диалоговое окно Paste Test 
Sets/Test Set Folders to Target Project. 
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 6 Выберите один из следующих вариантов:

➤ Copy test sets/test set folders and link to existing called tests. 
Quality Center скопирует наборы тестов или папки наборов тестов из 
исходного проекта и вставит их в другой проект. Скопированные наборы 
тестов или папки наборов тестов будут связаны с существующими 
тестами с теми же именами. Если вызываемого теста нет в проекте, в 
который его необходимо скопировать, Quality Center вставит его, 
скопировав из исходного проекта.

➤ Copy test sets/test set folders and called tests. Quality Center скопирует 
из исходного проекта наборы тестов или папки наборов тестов вместе с 
вызываемыми тестами и вставит их в другой (целевой) проект. Если имя 
вызываемого теста уже существует в целевом проекте, то 
скопированный тест будет вставлен с другим именем, чтобы не было 
разных тестов с одинаковыми именами.

➤ Copy test sets/test set folders and called tests. Quality Center скопирует 
из исходного проекта наборы тестов или папки наборов тестов без 
вызываемых тестов и вставит их в целевой проект. Скопированные 
наборы тестов или папки наборов тестов не будут связаны с 
вызываемыми тестам. 

Нажмите кнопку OK. 

Копирование URL-адреса набора тестов
Можно скопировать набор тестов и вставить его URL-адрес как ссылку. При 
этом сам набор тестов не копируется. Вместо этого можно вставить адрес в 
другое место, такое как сообщение электронной почты или документ. Если 
щёлкнуть эту ссылку, откроется окно Quality Center, в котором отобразится 
набор тестов. 

Как скопировать URL-адрес набора тестов

 1 Выберите набор тестов в дереве или в таблице наборов тестов. 

 2 Выберите Edit > Copy URL. Альтернативный вариант — щелкните правой 
кнопкой мыши и выберите Copy URL.

 3 Вставьте URL-адрес.
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Переименование набора тестов
Набор тестов или папку набора тестов можно переименовывать. Нельзя 
переименовать только такой набор тестов, который принят по умолчанию.

Как переименовать набор тестов

 1 В дереве наборов тестов или в таблице выберите набор тестов или папку 
наборов тестов.

 2 Щёлкните правой кнопкой мыши набор тестов или папку наборов тестов, а 
затем выберите команду Rename.

 3 Измените имя набора тестов, затем нажмите клавишу Ввод. 

Удаление папки наборов тестов
Папку наборов тестов можно удалить, переместив все её наборы тестов в 
папку Unattached, или удалить вместе со всеми её наборами тестов без 
возможности восстановления.

Как удалить папку наборов тестов 

 1 Выберите папку в дереве набора тестов. Чтобы удалить несколько папок, 
нажмите клавишу Ctrl и выберите папки, которые необходимо удалить.

 2 Нажмите кнопку Delete или выберите Edit > Delete. Откроется диалоговое 
окно Confirm Delete Folder.
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 3 Предусмотрены следующие варианты удаления:

➤ Выберите Delete folders only, если необходимо удалить папку и 
переместить все её наборы тестов в папку Unattached. Папка 
Unattached содержит все наборы тестов, которые больше не связаны с 
папкой.

➤ Выберите Delete folders and test sets, если необходимо удалить папку 
и все её наборы тестов без возможности восстановления.

 4 Для подтверждения нажмите кнопку Yes.

Удаление набора тестов
Из проекта можно удалять наборы тестов. Учтите, что удалить набор 
тестов, установленный по умолчанию, невозможно.

Как удалить набор тестов

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов. Чтобы удалить несколько наборов тестов, нажмите клавишу Ctrl и 
выберите наборы тестов, которые необходимо удалить.

 2 Нажмите кнопку Delete или выберите Edit > Delete.

 3 Для подтверждения нажмите кнопку Yes. 

Сброс набора тестов
После сброса набора тестов статус всех его тестов изменяется на No Run. 
При сбросе набора тестов можно также удалить результаты выполнения 
тестов. 

Как сбросить текущий набор тестов

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Выберите Test Sets > Reset Test Set. Откроется диалоговое окно Confirm 
Reset Test Set.

 3 Чтобы модуль Test Lab не удалил результаты выполнения набора тестов, 
снимите флажок Delete all the test run results in test set.

 4 Для подтверждения нажмите кнопку Yes.
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Удаления результатов тестирования из набора тестов 
С помощью мастера Purge Runs можно удалить из проекта старые 
результаты тестирования.

Как удалить результаты тестирования из набора тестов

 1 Выберите Test Sets > Purge Runs. Откроется диалоговое окно Select Test 
Sets to Purge, в котором можно выбрать наборы тестов, результаты 
выполнения которых необходимо удалить.

С помощью кнопок со стрелками переместите имена соответствующих 
наборов тестов из списка Available Test Sets в список Selected Test Sets. 

Совет. Наборы тестов также можно перетаскивать мышью из одного 
списка в другой.
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 2 Нажмите кнопку Next. Откроется диалоговое окно Choose Type of Purge, в 
котором можно выбрать тип удаления и определить условия удаления.

По умолчанию мастер удаления результатов тестирования удаляет все 
результаты выполнения выбранных наборов тестов. Чтобы мастер удалил 
только шаги тестов, но сохранил общие сведения о выполнении тестов, в 
поле Delete выберите Run Steps Only.

➤ Если выбрать Runs

Под From runs older than выберите период времени. Полученные до 
него результаты тестирования будут удалены.

В поле Keep last выберите количество запусков каждого теста; 
результаты выполнения которого необходимо сохранить.

➤ Если выбрать Run Steps Only

Под надписью From runs older than выберите период времени. 
Выполненные до него шаги теста будут удалены.
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 3 Нажмите кнопку Next. Откроется диалоговое окно Confirm Purge Request со 
сводкой выбранных вариантов удаления.

 4 Нажмите кнопку Purge, чтобы подтвердить удаление.
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Составление расписания запуска тест

Модуль Test Lab позволяет управлять выполнением тестов из набора. 

Сведения о расписании  запуска тестов 
На схеме Execution Flow можно указать дату, время и условия выполнения 
теста. В основе условия лежат результаты выполнения другого теста, 
заданного в схеме выполнения. Задавая условия, можно указать модулю 
Test Lab отложить выполнение текущего теста до завершения или 
успешного выполнения другого определенного теста. Также можно 
установить последовательность выполнения тестов. 

Например, в наборе тестов Mercury Tours можно указать, что тест test2 
должен выполняться только в том случае, если тест test1 не обнаружил 
ошибок, а тест test3 должен выполняться только в том случае, если тест 
test2 не обнаружил ошибок. 

Глава содержит следующие разделы: На стр.

Сведения о расписании запуска тестов 381

Составление расписания запускатестов 383

Изменение плана выполнения тестов 386

Определение последовательности тестов 389

Поиск тестов 390

Просмотр схемы выполнения 391
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В отличие от вкладки Execution Grid, которая содержит тесты и 
информацию об их выполнении, вкладка Execution Flow показывает тесты и 
условия в виде схемы выполнения тестов.

Набор тестов на схеме Execution Flow изображается в виде значка . 
Каждый тест на этой схеме изображается в виде значка. 

Штриховая линия со стрелкой  означает, что тест должен 
выполняться после предыдущего теста без каких-либо условий. 

Сплошная линия со стрелкой  обозначает условие. Она может 
быть синей или зелёной. Если сплошная линия синяя, значит тест должен 
выполняться только в том случае, если предыдущий тест имеет статус 
Finished. Если сплошная линия зелёная, значит тест должен выполняться 
только в том случае, если предыдущий тест имеет статус Passed.
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Если тест зависит от времени, то на схему добавляется значок 
зависимости от времени  . 

Составление расписания запускатестов 
На вкладке Execution Flow можно видеть процесс выполнения тестов и 
управлять ходом их выполнения. Можно указать, при каких условиях тест 
должен выполняться (условия выполнения) и в какое время (временная 
зависимость)

Примечание. После составления расписания запуска тестов следует 
приступить к их выполнению. Дополнительные сведения см. в “Выполнение 
тестов вручную" на стр. 393 и “Автоматическое выполнение тестов" на 
стр. 403.
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Как составить расписание запуска тестов

 1 На вкладке Execution Flow дважды щёлкните тест. Или щелкните правой 
кнопкой мыши и выберите команду Test Run Schedule. Откроется 
диалоговое окно Run Schedule, в котором будет отображаться вкладка 
Execution Conditions.

 2 Чтобы добавить условие, нажмите кнопку New. Откроется диалоговое окно 
New Execution Condition.
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 3 В поле Test выберите тест, от которого должен зависеть текущий тест.

➤ Выберите Finished (это значение установлено по умолчанию), чтобы 
модуль Test Lab выполнял текущий тест только после завершения 
выполнения указанного теста.

➤ Выберите Passed, чтобы модуль Test Lab выполнял текущий тест 
только после того как указанный тест завершится со статусом Passed.

 4 В поле Comments добавьте сведения об условии.

 5 Нажмите кнопку OK. Условие будет добавлено в список.

Совет. Условие также можно добавить непосредственно на вкладке 
Execution Flow. Щёлкните значок теста (а не имя теста) и перетащите 
мышью стрелку к другому тесту. По умолчанию устанавливается условие 
Finished. Чтобы изменить это условие, дважды щёлкните стрелку условия 
и выберите Passed. 

 6 Перейдите на вкладку Time Dependency, если необходимо указать, в какое 
время должен быть выполнен тест.
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 7 Выберите Run At Specified Time, затем выберите дату в поле Дата и/или 
время в поле Time.

Совет. Запланировать дату и время запуска теста можно также 
следующим способом: нажмите кнопку Add Time Dependency To Flow  и 
свяжите её с тестом. Дважды щёлкните значок, чтобы установить время в 
диалоговом окне Time Dependency.

 8 Чтобы закрыть диалоговое окно Run Schedule, нажмите кнопку OK. На 
вкладке Execution Flow показаны тесты и условия в виде схемы. 

Изменение плана выполнения тестов
В расписании запуска тестов можно изменять и удалять условия, дату и 
время запуска.

Данный раздел содержит следующие подразделы.

➤ Изменение условий выполнения тестов

➤ Удаление условий выполнения тестов

➤ Изменение даты и времени

➤ Удаление зависимости от времени

➤ Удаление всех условий и зависимостей

Изменение условий выполнения тестов
Предусмотрена возможность изменения условий выполнения тестов.
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Как изменить условие выполнения тестов

 1 На вкладке Execution Flow дважды щёлкните стрелку условия. Или 
щелкните стрелку условия правой кнопкой мыши и выберите команду 
Execution Condition. Откроется диалоговое окно Execution Condition.

 2 Измените условие, затем нажмите кнопку OK.

Удаление условий выполнения тестов
Можно удалить либо одно условие, либо все связанные с тестом условия. 

Как удалить условие выполнения теста

 1 На вкладке Execution Flow щелкните правой кнопкой мыши стрелку условия 
и выберите команду Remove Execution Condition.

 2 Для подтверждения нажмите кнопку Yes. Стрелка условия будет удалена.

Как удалить все условия выполнения теста

 1 На вкладке Execution Flow щелкните правой кнопкой мыши тест и выберите 
команду Remove Test’s Execution Conditions.

 2 Для подтверждения нажмите кнопку Yes. Будут удалены все соединяющие 
стрелки.

Изменение даты и времени
Предусмотрена возможность изменять дату и время запланированного 
запуска теста.
387



Глава 25 • Составление расписания запуска тест
Как изменить дату и время запуска теста

 1 На вкладке Execution Flow дважды щёлкните связанный с тестом значок 
Time Dependency . Откроется диалоговое окно Time Dependency. 

 2 Измените дату и/или время, затем нажмите кнопку OK.

Удаление зависимости от времени
Можно удалять указанную ранее временную зависимость.

Как удалить временную зависимость

 1 На вкладке Execution Flow щёлкните правой кнопкой мыши связанный с 
тестом значок Time Dependency , выберите команду Remove Time 
Dependency. 

 2 Для подтверждения нажмите кнопку Yes. Значок временной зависимости 
исчезнет со вкладки Execution Flow.

Удаление всех условий и зависимостей
Из набора тестов можно удалить все условия выполнения и временные 
зависимости.

Как удалить все условия выполнения набора тестов

 1 Щёлкните правой кнопкой мыши на вкладке Execution Flow, выберите 
команду Remove All Execution Conditions.
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 2 Если набор тестов содержит не только условия выполнения, но временные 
зависимости, откроется диалоговое окно Remove All Execution Conditions.

Выберите один из следующих вариантов:

➤ Run conditions and time dependencies. Из набора тестов удаляются 
все условия выполнения и временные зависимости.

➤ Run conditions only. Из набора тестов удаляются условия выполнения.

➤ Time dependencies only. Из набора тестов удаляются временные 
зависимости.

Нажмите кнопку OK. Условия выполнения и/или временные зависимости 
будут удалены.

 3 Если набор тестов содержит только условия выполнения или только 
временные зависимости, откроется диалоговое окно подтверждения. Для 
подтверждения нажмите кнопку Yes. Условия выполнения или временные 
зависимости будут удалены.

Определение последовательности тестов 
На схеме выполнения можно изменить порядок выполнения отображенных 
на ней тестов.

Как изменить последовательность запуска тестов

 1 Нажмите клавишу CTRL и выберите на вкладке Execution Flow несколько 
тестов.
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 2 Щёлкните правой кнопкой мыши тест и выберите команду Order Tests. 
Откроется диалоговое окно Order Tests. 

 3 Выберите в списке тест и с помощью кнопок вверх и вниз измените 
положение теста в последоваиельности.

 4 Нажмите кнопку OK. 

Поиск тестов 
На схеме выполнения можно найти нужный тест.

Как найти тест

 1 Нажмите кнопку Find Test In Flow на панели инструментов, либо выберите 
команду Edit > Find Test in Flow. Откроется диалоговое окно Find Test.
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 2 В поле Value To Find введите имя или часть имени теста. Поиск 
выполняется без учета регистра.

 3 Нажмите кнопку Find. Модуль Test Lab начнёт поиск теста.

 4 При успешном завершении поиска откроется диалоговое окно Search 
Results со списком возможных совпадений. Выберите результат из списка и 
нажмите кнопку Go To, чтобы выделить тест на схеме выполнения. 

Нажмите кнопку Keep on Top, чтобы диалоговое окно Find Results 
отображалось поверх других открытых окон. 

Нажмите кнопку Not on Top, чтобы выбранные окна отображались поверх 
диалогового окна Find Results.

 5 При неуспешном завершении поиска откроется окно сведений. 

Просмотр схемы выполнения
Вид схемы выполнения можно изменять. Например, можно увеличивать 
или уменьшать схему, упорядочивать тесты в иерархическом порядке, 
обновлять схему и отображать на схеме полные названия тестов. Можно 
также копировать схему в буфер обмена.

Компоновка
Нажмите кнопку Arrange Layout  , чтобы упорядочить тесты в 
иерархическом порядке. Такой вид схемы позволяет просматривать 
зависимости между тестами.

Увеличение
Нажмите кнопку Zoom In , чтобы увеличить схему.

Уменьшение
Нажмите кнопку Zoom Out , чтобы уменьшить схему.

Изображение по размеру окна
Нажмите кнопку Fit Picture in Window , чтобы изменить масштаб так, 
чтобы схема поместилась в окне. Можно также щёлкнуть стрелку вниз, 
чтобы выбрать нужный масштаб.
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➤ Выберите масштаб, например 25%, 50%, 150% или 200%.

➤ Выберите Normal , чтобы отобразить схему в масштабе 100%.

➤ Выберите Fit In Window, если необходимо, чтобы вся схема 
поместилась в окне.

➤ Выберите Custom Zoom, чтобы указать масштаб. В диалоговом окне 
Custom Zoom введите масштаб, затем щёлкните Zoom.

Обновление схемы
Нажмите кнопку Refresh Flow , чтобы обновить схему Execution Flow. 
После обновления она будет показывать самую свежую информацию о 
тестах.

Отображение полных имён тестов
Выберите команду Tests > Flow > Show Full Test Names, чтобы а схеме 
Execution Flow отображались полные имена тестов. По умолчанию 
длинные имена обрезаются.

Копирование в буфер обмена
Выберите команду Tests > Flow > Copy to Clipboard, чтобы скопировать 
схему Execution Flow в буфер обмена как рисунок в формате BMP.
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26
Выполнение тестов вручную

При выполнении тестов вручную выполняются шаги тестов и операции с 
тестируемым приложением. Каждый шаг теста имеет положительный или 
отрицательный результат. Результат каждого шага зависит от того, 
соответствуют ли фактические результаты тестирования приложения 
ожидаемым результатам. Вручную можно выполнять как ручные, так и 
автоматические тесты.

Сведения о выполнении тестов вручную
Тесты можно запускать вручную в соответствии со следующими шагами, 
определёнными при планировании тестирования: 

 1 Выполните операции в тестируемом приложении. Следуйте инструкциям, 
приведённых в описании шагов тестов.

 2 Сравните фактические результаты с ожидаемыми. Выполняя шаги, 
проверьте, правильно ли реагирует приложение.

 3 В зависимости от того, соответствуют ли фактические результаты 
тестирования приложения ожидаемым, назначьте каждому шагу статус 
Passed («Пройден») или Failed («Не пройден»). 

Глава содержит следующие разделы: На стр.

Сведения о выполнении тестов вручную 393

Выполнение тестов вручную 394

Изменение шагов тестов 400

Возобновление выполнения ручного теста 401
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 4 Если при выполнении шага обнаружена ошибка в приложении, опишите 
поведение приложения при этой ошибке. Тест получает статус Failed, если 
этот статус получил хотя бы один шаг.

Тесты из одного и того же набора можно выполнять многократно. Каждое 
повторное выполнение теста считается новым выполнением. 

После завершения тестирования можно просмотреть сводку результатов 
тестирования в модуле Test Lab. Новый статус выполненного теста 
появляется на вкладке Execution Grid. Результаты каждого шага 
тестирования отображаются в области Last Run Result. Подробные 
результаты отображаются в диалоговом окне Test Instance Properties. 
Дополнительные сведения о просмотре результатов тестирования см. в 
главе Глава 28, "Просмотр результатов тестирования"..

Выполнение тестов вручную 
При выполнении теста вручную выполняются шаги тестов и операции в 
тестируемом приложении. Фактические результаты необходимо записать и 
сравнить с ожидаемыми результатами. Один и тот же тест можно 
выполнять многократно. При этом сохраняются результаты выполнения 
каждого теста. Вручную можно выполнять как ручные, так и 
автоматические тесты.

При выполнении тестов вручную можно изменять шаги теста. Эти 
изменения можно сохранять в исходном тесте в модуле Test Plan, а 
экземпляр теста можно сохранить в модуле Test Lab. Можно также 
сохранять их только для текущего выполнения теста. Дополнительные 
сведения см. в разделе “Изменение шагов тестов" на стр. 400.

Если выполнение теста вручную было приостановлено, его можно 
продолжить. Дополнительные сведения см. в разделе “Возобновление 
выполнения ручного теста" на стр. 401.
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Примечание. Сведения о выполнении теста для проверки бизнес-процесса 
см. в разделе  Тестирование бизнес-процессов руководства 
пользователя HP.

Как выполнить тест вручную

 1 На вкладке Execution Grid или Execution Flow выберите тест, который 
необходимо выполнить вручную. 

➤ Если необходимо выполнить только один ручной тест, выберите тест и 
нажмите кнопку Run.

➤ Если необходимо выполнить более одного ручного теста, выберите 
нужные тесты и нажмите кнопку Run. Откроется диалоговое окно Manual 
Test Run.

По умолчанию выбран вариант Manual Runner (Run according to the 
order in the Execution Grid). В этом случае тесты запускаются в том 
порядке, в котором они отображаются в таблице Execution Grid.

Чтобы запускать ручные тесты автоматически, выберите вариант 
Automatic Runner (Run according to the order in the Execution Flow). В 
этом случае тесты запускаются в том порядке, в котором они 
отображаются на схеме Execution Flow. Дополнительные сведения об 
автоматическом выполнении тестов см. в разделе“Автоматическое 
выполнение тестов" на стр. 404.
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Если необходимо, чтобы диалоговое окно Manual Test Run больше не 
появлялось, установите флажок Don’t show this again. Чтобы 
возобновить отображение этого окна, выберите команду Tests > Enable 
Manual Test Run Confirmation. 

Нажмите кнопку OK. 

➤ Чтобы запускать автоматизированные тесты вручную, выберите тесты, 
нажмите на стрелку Run, а затем выберите Run Manually. 

Откроется диалоговое окно Manual Runner.

 2 В области Run Details можно изменить следующую информацию.

➤ Run Name. Имя выполнения теста.

➤ Tester. Имя пользователя лица, выполнившего данный тест.
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 3 Чтобы просмотреть информацию об операционной системе, щёлкните 
ссылку Operating System Info. Откроется диалоговое окно Operating 
System Information.

В этом окне можно изменять следующую информацию об операционной 
системе.

➤ Operating System. Операционная система, установленная на 
компьютере, на котором выполняются шаги теста. По умолчанию 
отображается операционная система клиентского компьютера 
Quality Center.

➤ OS Service Pack. Пакет обновлений операционной системы.

➤ OS Build Number. Номер сборки операционной системы.

 4 В области Test Details можно увидеть следующую информацию о тесте. 
Чтобы открыть диалоговое окно Test Properties, содержащее сведения о 
тесте и вложения, щёлкните ссылку More. Дополнительные сведения о 
свойствах тестов см. в главе Глава 17, "Создание дерева плана 
тестирования"..

 5 Чтобы добавить вложение к тесту, нажмите кнопку Attach to Run. 
Вложением может быть файл, URL-адрес, снимок приложения, элемент 
буфера обмена или сведения о системе. Дополнительные сведения о 
вложениях см. в главе Глава 5, "Добавление вложений"..

 6 Чтобы добавить дефект в тест, нажмите кнопку New Defect. Откроется 
диалоговое окно New Defect. Quality Center автоматически создает связь 
между тестом и новым дефектом. Дополнительные сведения см. в главах 
Глава 31, "Добавление и отслеживание дефектов" и Глава 32, "Связывание 
дефектов".
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 7 Чтобы завершить выполнение теста, нажмите кнопку End Run. 
Quality Center сохранит результаты выполнения теста. Чтобы полностью 
отменить выполнение теста, нажмите кнопку Cancel Run, затем нажмите 
кнопку No.

 8 Чтобы запустить тест, нажмите кнопку Begin Run. 

Если выполняемый тест имеет параметры с неприсвоенными значениями, 
откроется диалоговое окно Parameter Values for Run, в котором можно 
присвоить значения. Дополнительные сведения о параметрах см. в 
разделе “Вызов ручного теста с параметрами" на стр. 303.

Manual Runner: Откроется диалоговое окно Step Details.

Примечание. Во время выполнения теста присвоить параметру несколько 
значений невозможно.

Список Filter by позволяет фильтровать шаги теста по столбцу Status.
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Совет. Можно просматривать сведения о каждом шаге теста и записывать 
результаты его выполнения удобно в компактном представлении этого 
диалогового окна. Чтобы открыть это представление, нажмите кнопку 
Compact View. Чтобы вернуться к таблице, нажмите кнопку Back to Steps 
Grid.

 9 Если шагов теста нет или требуется изменить шаги, измените их до начала 
их выполнения. Дополнительные сведения см. в разделе “Изменение 
шагов тестов" на стр. 400.

 10 Чтобы просмотреть значения параметров теста, нажмите кнопку Show 
Parameters. Откроется диалоговое окно Parameter Values for Run. 
Дополнительные сведения о параметрах см. в “Вызов ручного теста с 
параметрами" на стр. 303.

 11 Откройте тестируемое приложение и выполните первый шаг теста.

➤ Нажмите кнопку Pass Selected, если полученный результат совпадает с 
ожидаемым. Шаг получит статус Passed и будет помечен зелёным 
флажком. (Чтобы установить статус Passed сразу для всех шагов теста, 
нажмите стрелку Pass Selected и выберите Pass All.)

➤ Если полученный результат отличается от ожидаемого, введите 
полученный результат в поле Actual и нажмите кнопку Fail Selected. 
Шаг получит статус Failed и будет помечен красным знаком "X". (Чтобы 
установить статус Failed сразу для всех шагов теста, нажмите стрелку 
Fail Selected и выберите Fail All.)

 12 Чтобы добавить вложение к шагу теста, нажмите кнопку Attachments. 
Чтобы добавить вложение ко всем тестам, нажмите стрелку Attachments, 
затем выберите Attach to Run. Дополнительные сведения о вложениях см. 
в главе Глава 5, "Добавление вложений"..

 13 Если при тестировании приложения обнаружена ошибка, нажмите кнопку 
New Defect. Откроется диалоговое окно New Defect, в котором можно 
добавить дефект. Quality Center автоматически создает связь между 
тестом и новым дефектом. Дополнительные сведения см. в “Добавление 
новых дефектов" на стр. 451 и “Связывание дефектов" на стр. 471.
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 14 Нажмите кнопку Keep on Top , чтобы диалоговое окно Manual Runner: Step 
Details отображалось поверх других открытых окон. Чтобы выбранные окна 
отображались поверх диалогового окна Manual Runner: Step Details, 
нажмите кнопку Not on Top.

 15 Выполните оставшиеся шаги.

 16 Нажмите кнопку End Run после завершения тестирования или чтобы 
приостановить выполнение теста. О том, как продолжить выполнение 
приостановленного ручного теста см. в “Возобновление выполнения 
ручного теста" на стр. 401.

Изменение шагов тестов 
При выполнении теста в диалоговом окне Manual Runner: Step Details 
можно добавлять, удалять и изменять шаги теста. По окончании 
выполнения теста можно сохранить изменённые шаги. 

Как изменить шаг теста

 1 Откройте диалоговое окно Manual Runner: Step Details. Дополнительные 
сведения см. в разделе “Выполнение тестов вручную" на стр. 394.

 2 Нажмите кнопку Add Step , чтобы добавить шаг. Добавится новый шаг с 
именем по умолчанию. В поле Description можно ввести сведения о новом 
шаге.

 3 Нажмите кнопку Delete Selected , чтобы удалить выбранный шаг, затем 
нажмите кнопку Yes для подтверждения.

 4 Чтобы закрыть диалоговое окно, нажмите кнопку End Run. Откроется окно 
с сообщением. 

 5 Нажмите кнопку Yes, чтобы сохранить изменения и обновить тест в 
модулях Test Plan и Test Lab. Нажмите кнопку No, чтобы сохранить 
изменения только в текущем выполнении теста.

Модуль Test Lab позволяет обновлять изменения, внесенные в 
вызывавшиеся тесты, только в текущем тесте. Изменения не затрагивают 
вызываемых тестов. Более подробные сведения о вызываемых тестах см. 
в “Вызов ручного теста с параметрами" на стр. 303.
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Возобновление выполнения ручного теста 
Если выполнение ручного теста было приостановлено, его можно 
продолжить. 

Примечание. Команда Continue Manual Run возобновляет последнее 
выполнение выбранного теста. Если необходимо продолжить предыдущее 
выполнение теста, нажмите кнопку Test Instance Properties, выберите All 
Runs на боковой панели, затем выберите то выполнение, которое 
необходимо продолжить. Нажмите кнопку Continue.

Как продолжить выполнение ручного теста

 1 На вкладке Execution Grid или Execution Flow выберите тест, который 
необходимо продолжить.

 2 Выберите Tests > Continue Manual Run. Или нажмите стрелку Run и 
выберите команду Continue Manual Run. Откроется диалоговое окно 
Manual Runner с выбранным тестом.

 3 Продолжайте тестирование. 
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27
Автоматическое выполнение тестов 

Запускать тесты можно автоматически непосредственно в Quality Center. 
Выполнять тесты можно как на своём компьютере, так и на удалённых 
хостах. 

Сведения об автоматическом выполнении тестов
Выполнять тесты можно автоматически как на своём компьютере, так и на 
удалённых хостах. Хостом называется подключённый к сети компьютер, 
на котором установлено средство тестирования.

Запускать можно тесты, выбранные на вкладке Execution Grid или Execution 
Flow. Можно выполнять либо все тесты из набора , либо только конкретные 
тесты, причём среди выбранных тестов могут быть как 
автоматизированные, так и ручные тесты. Выбранные тесты отображаются 
в диалоговом окне Automatic Runner. 

Глава содержит следующие разделы: На стр.

Сведения об автоматическом выполнении тестов 403

Автоматическое выполнение тестов 404

Просмотр журнала выполнения 408

Настройка хостов для удалённого выполнения 409

Упорядочивание тестов в таблице выполнения 411

Поиск и замена значений в таблице Execution Grid 413
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Если запущен автоматизированный тест, Quality Center автоматически 
открывает выбранное средство тестирования, запускает тест на локальном 
компьютере или на удалённом хосте, а затем экспортирует результаты 
тестирования в Quality Center. 

Если запущен ручной тест из диалогового окна Automatic Runner, 
Quality Center уведомляет тестировщика по электронной почте, чтобы он 
запустил тест на заданном хосте.

Можно также запустить автоматизированный тест для получения сведений 
о системе, захвата снимка экрана или перезагрузки компьютера. Более 
подробные сведения о тестировании системы см. в Глава 21, "Систем ные 
тесты".

Автоматическое  выполнение тестов
Если запущен автоматизированный тест, Quality Center автоматически 
открывает выбранное средство тестирования, запускает тест, а затем 
экспортирует результаты тестирования в Quality Center. Если запущен 
ручной тест, тестировщик получает по электронной почте уведомление, что 
необходимо запустить ручной тест. 

Можно запустить весь набор тестов или лишь некоторые тесты из набора, 
включая автоматизированные и ручные тесты. Выбранные тесты 
отображаются в диалоговом окне Automatic Runner.

При запуске автоматизированных тестов следует учитывать следующее:

➤ Прежде чем запускать тест на удалённом хосте, сначала настройте 
хосты в диалоговом окне Host Manager. Дополнительные сведения см. в 
разделе “Настройка хостов для удалённого выполнения" на стр. 409.

➤ Чтобы запустить один тест одновременно на нескольких удалённых 
хостах, добавьте в набор тестов несколько экземпляров этого теста. 
Дополнительные сведения см. в разделе “Добавление тестов в набор 
тестов" на стр. 359.

➤ Чтобы запустить несколько тестов одновременно на нескольких 
удалённых хостах, откройте новый экземпляр диалогового окна 
Automatic Runner для каждого набора тестов. 
404



Глава 27 • Автоматическое выполнение тестов
➤ Чтобы программа Quality Center могла запускать тесты QuickTest 
Professional и WinRunner на удалённом хосте, откройте 
соответствующее приложение на удалённом хосте, затем выберите 
нужный параметр. Более подробные сведения см. в Руководстве 
пользователя QuickTest Professional или в Руководстве пользователя 
WinRunner.

➤ Если тест WinRunner запустить в пакетном режиме, то каждый тест, 
вызываемый из пакетного теста, считается отдельным тестом, а не 
частью пакета. Любой тест, вызванный из того пакетного теста, который 
ещё не включён в набор тестов, добавляется в этот набор тестов после 
заврешения выполнения теста.

Пользователи QuickTest Professional должны учитывать следующее:

➤ Прежде чем запустить тест QuickTest, Quality Center загружает те 
надстройки для QuickTest, которые связаны с выбранным тестом. 
Убедитесь, что эти надстройки для QuickTest установлены на 
компьютере, на котором необходимо запустить тест. Более подробные 
сведения о работе с надстройками и связанными с ними списками в 
QuickTest см. в документации по QuickTest Professional и в 
документации по соответствующим надстройкам для QuickTest.

➤ Тесты QuickTest Professional, которые запускаются из модуля Test Lab, 
автоматически запускаются в режиме Fast. Они не могут выполняться в 
режиме Normal.

Как запускать тесты автоматически 

 1 Выберите набор тестов в дереве наборов тестов или в таблице наборов 
тестов.

 2 Можно указать условия, дату и время запуска тестов. Также можно 
установить порядок запуска тестов. Дополнительные сведения см. в главе 
Глава 25, "Составление расписания запуска тест".
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 3 Можно запускать все тесты из набора или только конкретные тесты.

➤ Чтобы выполнить весь набор тестов, на вкладке Execution Grid или на 
вкладке Execution Flow нажмите кнопку Run Test Set. Альтернативный 
вариант — выберите Test Sets > Run Test Set.

➤ Чтобы выполнить только выбранные тесты, на вкладке Execution Grid 
или на вкладке Execution Flow выберите нужные тесты, а затем нажмите 
кнопку Run. Альтернативный вариант — выберите Tests > Run.

Откроется диалоговое окно Automatic Runner, в котором будут отображены 
выбранные тесты.

 4 Тесты можно выполнять локально или удалённо.

➤ Чтобы выполнять тесты на локальном компьютере, установите флажок 
Run All Tests Locally.

➤ Чтобы выполнять тесты на удалённом компьютере, снимите флажок 
Run All Tests Locally. Для каждого теста необходимо выбрать хост. В 
столбце Run on Host щелкните нужную ячейку, нажмите кнопку обзора. 
Откроется диалоговое окно Select Host. В разделе <Any Host> можно 
выбрать хост, на котором должен выполняться тест.
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Альтернативный вариант — выберите группу хостов. Если выбрать 
группу хостов, Quality Center будет запускать тест на первом доступном 
хосте из этой группы, а не на каждом хосте.

 5 Если требуется, чтобы Quality Center создал журнал выполнения тестов, 
установите флажок Enable Log. Дополнительные сведения см. в разделе 
“Просмотр журнала выполнения" на стр. 408.

 6 Чтобы запустить выбранные тесты, нажмите кнопку Run. Чтобы запустить 
все тесты, нажмите кнопку Run All в диалоговом окне Automatic Runner. 

Если тест автоматизированный, Quality Center автоматически откроет 
выбранное средство тестирование и запустит тест. Выполнение теста 
начнётся только тогда, когда станет доступен выбранный хост, на котором 
должен выполняться данный тест.

Если тест ручной, Quality Center уведомит заданного тестировщика по 
электронной почте, чтобы он запустил тест. Это уведомление может быть 
отправлено только в том случае, если для теста назначен тестировщик и 
известен его адрес электронной почты. Чтобы назначить тестировщика, на 
вкладке Execution Grid найдите нужный тест, в столбце Responsible Tester 
щёлкните соответствующую ячейку, а затем нажмите кнопку со стрелкой. 
Выберите имя из списка.

Ход выполнения теста отображается в столбце Status.

 7 Если потребуется прекратить выполнение теста до его завершения, 
нажмите кнопку Stop.

 8 Если перед запуском теста был установлен флажок Enable Log (см. шаг 5), 
можно просмотреть журнал выполнения, выбрав Run > View Execution 
Log. Дополнительные сведения см. в разделе “Просмотр журнала 
выполнения" на стр. 408.

 9 Чтобы закрыть диалоговое окно Automatic Runner, выберите Run > Exit.

 10 После того как тест будет выполнен, в Quality Center можно просматривать 
сводку результатов тестирования. Новый статус теста появляется на 
вкладке Execution Grid после каждого выполнения теста. Результаты 
каждого шага тестирования отображаются в области Last Run Result. 
Подробные результаты отображаются в диалоговом окне Test Instance 
Properties. Более подробные сведения о результатах тестирования см. в 
Глава 28, "Просмотр результатов тестирования"..
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Просмотр журнала выполнения 
Журнал выполнения содержит информацию о выполненных тестах, в том 
числе название проекта, имя пользователя, имя набора тестов. Для 
каждого теста в журнал записывается дата и время выполнения, хост и 
описание выполнения.

Примечание. Просматривать журнал выполнения можно лишь в том 
случае, если перед запуском теста был установлен флажок Enable Log в 
диалоговом окне Automatic Runner. Дополнительные сведения см. в 
описании этапа 5 на стр. 407.

Как просматривать журнал выполнения

 1 После того как тест будет выполнен, в диалоговом окне Automatic Runner 
выберите Run > View Execution Log. Откроется диалоговое окно Execution 
Log.
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 2 Как отфильтровать журнал выполнения.

➤ В раскрывающемся списке Test выберите тест, затем нажмите кнопку 
Refresh. 

➤ В раскрывающемся списке Host выберите хост, затем нажмите кнопку 
Refresh. 

 3 Чтобы просмотреть другой журнал выполнения, выберите команду Log > 
Open.

 4 Чтобы удалить журнал выполнения, выберите команду Log > Delete. Для 
подтверждения нажмите кнопку Yes.

 5 Чтобы закрыть журнал выполнения, выберите команду Log > Exit.

Настройка  хостов для удалённого выполнения 
Выполнять тесты можно на любом подключённом к сети хосте. С помощью 
диалогового окна Host Manager можно создать список доступных хостов, на 
которых можно выполнять тесты. Можно также распределить хосты по 
группам для конкретного проекта.

Примечание. Если задать группу хостов для удалённого выполнения 
тестов, Quality Center будет запускать тест на первом доступном хосте, а не 
на каждом хосте группы.
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Как настроить хосты для удалённого выполнения тестов

 1 Выберите Test Sets > Host Manager. Откроется диалоговое окно Host 
Manager.

Если в списке Available Hosts нет доступных хостов, нажмите кнопку Get 
Hosts on the Network. Quality Center просмотрит каталог «Сетевое 
окружение» и добавит все найденные хосты в список Available Hosts.

Чтобы синхронизировать хосты из списка Available Hosts с хостами из 
каталога "Сетевое окружение", нажмите стрелку Get Hosts on the Network 
и выберите команду Synchronize Hosts in the Project with Hosts on Net. 
Quality Center добавит найденные в каталоге "Сетевое окружение" хосты и 
удалит те хосты, которые не были найдены в этом каталоге.

 2 Чтобы добавить хост в список Available Hosts, нажмите кнопку New Host. 
Откроется диалоговое окно New Host. В поле Host Name введите имя 
хоста. В поле Description введите описание хоста. Нажмите кнопку OK. 

 3 Чтобы удалить хост из списка Available Hosts, выберите хост и нажмите 
кнопку Delete Host. Для подтверждения нажмите кнопку Yes.
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 4 Чтобы создать группу хостов, нажмите кнопку New Host Group. Откроется 
диалоговое окно New Host Group. В поле Group Name введите имя группы 
хостов. В поле Description введите описание группы хостов. Нажмите 
кнопку OK.

 5 Чтобы добавить хост в группу хостов, выберите группу из списка Host 
Group. Выберите хост из списка Available Hosts, затем нажмите кнопку 
Add Host To Host Group. Или дважды щёлкните группу.

 6 Чтобы удалить хост из группы хостов, выберите группу в списке Host 
Group. Выберите хост в списке Hosts in Group. Нажмите кнопку Remove 
Host From Host Group.

 7 Чтобы удалить группу хостов, выберите группу в списке Host Group. 
Нажмите кнопку Delete Host Group. Для подтверждения нажмите кнопку 
Yes.

 8 Чтобы закрыть диалоговое окно Host Manager, нажмите кнопку Close.

Упорядочивание тестов в таблице выполнения 
Порядок тестов в таблице выполнения можно изменить. Quality Center 
запускает тесты в заданном порядке, группируя их по типу узла. Например, 
если вы указали порядок тестов test1, test2 и test3, то Quality Center 
сначала запустит тесты test1 и test3, если они должны выполняться на 
одном и том же хосте, а затем запустит тест test2, который будет 
выполняться на другом хосте.

Примечание. Определяя порядок запуска тестов, Quality Center сначала 
проверяет Execution Flow. Порядок, определённый в Execution Grid, 
используется только в том случае, если в Execution Flow не заданы 
условия. Дополнительные сведения о планировании тестов в Execution 
Flow см. в глааве Глава 25, "Составление расписания запуска тест". 
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Как упорядочить тесты в таблице Execution Grid

 1 Выберите Tests > Order Tests. Откроется диалоговое окно Order Tests. 

 2 Выберите в списке тест и с помощью кнопок вверх и вниз переместите его в 
нужное место. 

Совет. Тесты также можно перетаскивать вверх или вниз мышью.

 3 Нажмите кнопку OK.
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Поиск и замена значений  в таблице Execution Grid 
В таблице Execution Grid можно выполнять поиск и замену значений полей.

Для поиска нужного значения выполните следующие действия:

 1 Выберите Tests > Find. Откроется диалоговое окно Find.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск конкретного значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти.

 4 Если необходимо найти точное значение, установите флажок Exact Match.

 5 Чтобы выполнить поиск с учетом прописных и строчных знаков, установите 
флажок Case Sensitive.

 6 Если необходимо использовать звездочки (*) в строке поиска, чтобы 
вводить только часть элемента, установите флажок Use Wildcard.

 7 Нажмите кнопку Find Next. Quality Center попытается найти тесты с 
указанным значением. При успешном завершении поиска тест будет 
выделен в таблице Execution Grid. При неуспешном завершении поиска 
откроется окно сведений.
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Для замены значения выполните следующие действия: 

 1 Выберите Tests > Replace. Откроется диалоговое окно Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск конкретного значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти.

 4 В поле Replace with введите или выберите значение, на которое будет 
заменено старое значение.

 5 Чтобы выполнить поиск с учетом регистра, установите флажок Case 
Sensitive.

 6 Если необходимо найти точное значение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы выполнения, установите 
флажок From Beginning.

 8 Если необходимо использовать звездочки (*) в строке поиска, чтобы 
вводить только часть элемента, установите флажок Use Wildcard.

 9 Выполнение замены.

➤ Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажмите кнопку Replace.

➤ Чтобы заменить все найденные элементы в таблице Execution Grid, 
нажмите кнопку Replace All. 
414



28
Просмотр результатов тестирования

После выполнения экземпляров тестов необходимо проанализировать 
результаты тестов и определить, какие экземпляры завершились с 
ошибками и на каких шагах были выявлены эти ошибки. 

Данная глава содержит следующие разделы На стр.

О просмотре результатов тестирования 416

Просмотр результатов тестирования 417

Просмотр сведений о выполнении теста 419

Сравнение результатов всех выполнений тестов 422

Просмотр конфигурации выполнения теста 425

Просмотр связанных дефектов 430

Просмотр истории выполнения теста 431
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О просмотре результатов тестирования
После выполнения экземпляров тестов в Quality Center можно увидеть 
результаты тестирования. Результаты тестирования – это статусы Pass 
("Пройден")/Fail ("Не пройден") для экземпляра теста в целом и каждого 
шага экземпляра теста. Эти результаты помогают выявить ошибки в 
разрабатываемом приложении.  Иногда может оказаться, что шаг получил 
статус Fail только потому, что ожидаемые результаты уже не 
действительны, и тогда их необходимо обновить. 

После выполнения ручного или автоматизированного теста можно 
просмотреть результаты и общие сведения о тестировании в таблице 
Execution Grid на вкладке Execution Grid. В диалоговом окне Test Instance 
Properties можно просматривать результаты выполнения теста, сравнивать 
результаты последнего выполнения теста с результатами предыдущих 
запусков теста, управлять вложениями, просматривать информацию о 
конфигурации выполнения теста, просматривать связанные дефекты и 
историю изменения выполнений теста.

Примечание. Дополнительные сведения о просмотре результатов 
выполнения системного теста см. в главе Глава 21, "Систем ные тесты"..

Кроме того, имеется возможность анализировать ход выполнения набора 
тестов, периодически создавая отчеты и диаграммы. Дополнительные 
сведения см. в главах Глава 33, "Создание отчетов", Глава 34, "Создание 
диаграмм", и Глава 35, "Создание диаграмм анализа в реальном времени".
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Просмотр результатов тестирования
Результаты тестирования отображаются в диалоговом окне Test Instance 
Properties.

Как просматривать результаты тестирования

 1 В таблице Execution Grid дважды щелкните тест, либо выберите экземпляр 
теста, а затем нажмите кнопку Test Instance Properties. 

На вкладке Execution Flow щелкните правой кнопкой мыши экземпляр теста 
и выберите команду Test Instance Properties. 

Откроется диалоговое окно Test Instance Properties, в котором можно 
видеть имя и тип теста. По умолчанию отображается представление All 
Runs.
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 2 Щелкните представление на боковой панели. Диалоговое окно Test 
Instance Properties содержит следующие представления:

Представление Описание

Details Отображает сведения о выполнении экземпляра теста. 
Дополнительные сведения см. в разделе “Просмотр 
сведений о выполнении теста" на стр. 419.

All Runs Отображает результаты всех выполнений теста. 
Дополнительные сведения см. в разделе “Сравнение 
результатов всех выполнений тестов" на стр. 422.

Attachments Отображает вложения в экземпляр теста. Также 
отображает все вложения, которые были добавлены при 
планировании тестирования. Дополнительные сведения 
см. в главе Глава 5, "Добавление вложений".

Configuration Отображаются сведения о конфигурации выполнения 
экземпляра теста. Дополнительные сведения см. в 
разделе “Просмотр конфигурации выполнения теста" на 
стр. 425. 

Linked Defects Отображает связанные дефекты и покрытие требований 
экземлярами тестов. Дополнительные сведения см. в 
разделе “Просмотр связанных дефектов" на стр. 430.

Примечание. Если покрытие требований экземплярами 
тестов активировано с помощью параметра 
ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE , 
вместо представления Linked Defects доступны 
представления Linkage и Coverage. Представления 
Linkage и Coverage показывают сведения о дефектах, 
связанных с данным экземпляром теста, и покрытие 
требований экземплярами тестов. Дополнительные 
сведения об этом параметре см. в Руководство 
администратора HP Quality Center. Дополнительные 
сведения о покрытии требований см. в разделе 
“Связывание требований с тестом" на стр. 285.

History Отображает историю изменения экземпляра теста. 
Дополнительные сведения см. в разделе “Просмотр 
истории выполнения теста" на стр. 431.
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 3 Нажмите кнопку First Test, чтобы просмотреть первый экземпляр теста, 
или кнопку Previous Test, чтобы просмотреть предыдущий экземпляр теста 
в текущей таблице Execution Grid.

 4 Нажмите кнопку Next Test, чтобы просмотреть следующий экземпляр 
теста, или кнопку Last Test, чтобы просмотреть последний экземпляр теста 
в текущей таблице Execution Grid.

 5 Чтобы добавить или изменить флаг отслеживания экземпляра теста, 
нажмите кнопку Flag for Follow Up. Дополнительные сведения см. Глава 4, 
"Оповещение об изменениях".

 6 Если у экземпляра теста есть предупреждение, нажмите кнопку Alerts, 
чтобы открыть диалоговое окно Alerts. Дополнительные сведения см. в 
разделе “Просмотр оповещений" на стр. 85.

Просмотр сведений о выполнении теста 
Сведения о выполнении теста отображаются в представлении Details. 

Как просмотреть сведения о выполнении теста

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов тестирования" на стр. 417.
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 2 На боковой панели диалогового окна Test Instance Properties нажмите 
значок Details. 

 3 В представлении Details можно видеть следующую информацию о тесте.

Параметр Описание

Описание Описание теста.

Exec Date Дата последнего выполнения теста.

Planned Exec Time Запланированное время запуска теста.

Responsible Tester Имя пользователя, который последним выполнил данный 
тест.

Planned Exec Date Запланированная дата запуска теста. 
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Изменения, вносимые в информацию о тесте, будут отображаться в 
таблице Execution Grid.

Примечание. Метку любого поля вкладки Details можно изменять. В 
представление Details можно также добавлять свои собственные поля. 
Подробные сведения см. в Руководство администратора 
HP Quality Center.

Planned Host Name Имя или IP-адрес компьютера, на котором 
планировалось выполнить данный тест.

Status Текущий статус теста. Статус может иметь одно из 
следующих значений:

Failed. При выполнении теста обнаружены ошибки в 
приложении.

N/A. Текущий статус теста неприменим.

No Run.  Данный тест еще не выполнялся.

Not Completed. Выполнение теста не завершено. 

Passed. При выполнении теста ошибки в приложении не 
обнаружены.

Tester Имя пользователя, который фактически выполняет 
данный тест.

Time Время последнего выполнения теста.

Параметр Описание
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Сравнение результатов всех выполнений тестов 
Quality Center позволяет сравнивать результаты выполнения теста с 
результатами предыдущих запусков. В представлении All Runs можно 
видеть сведения о выполнениях теста и о каждом шаге выбранного 
экземпляра теста.

Как просмотреть результаты всех выполнений теста

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов тестирования" на стр. 417.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
значок All Runs. 

 3 Если необходимо просматривать только записи с конкретным состоянием, 
выберите нужное статус в списке View Runs.
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 4 Чтобы фильтровать, группировать или сортировать записи выполнений 
теста, нажмите кнопку Set Filter/Sort. Дополнительные сведения о 
фильтрации, сортировке и группировании записей см. в главе Глава 3, 
"Работа с данными Quality Center". Если задать фильтр, то над таблицей 
появится его описание.

 5 Если необходимо очистить примененные к записям фильтры и функции 
сортировки, нажмите стрелку Set Filter/Sort и выберите команду  Clear 
Filter/Sort.

 6 Чтобы обновить таблицу для отображения последних выполнений теста в 
соответствии с выбранными фильтрами, нажмите кнопку Refresh.

 7 Для настройки вида столбцов и порядка их расположения в таблице 
нажмите кнопку Select Columns. Подробные сведения о диалоговом окне 
Select Columns см. в разделе “Упорядочивание столбцов" на стр. 55.

 8 Чтобы удалить результат выполнения теста из таблицы, выберите его, а 
затем нажмите кнопку Delete Selected. Для подтверждения нажмите кнопку 
Yes.

 9 Чтобы просмотреть шаги выполнения теста, выберите результат 
выполнения, а затем нажмите кнопку Show Run Steps. Откроется 
диалоговое окно Run Steps с описанием этапов, ожидаемыми и 
фактическими результатами. Дополнительные сведения об этапах теста 
см. Глава 19, "Разработка тестов"..

 10 Чтобы добавить вложение в результат выполнения теста, выберите 
результат, затем нажмите кнопку Attachments. Откроется диалоговое окно 
Attachments. Дополнительные сведения о вложениях приведены см. 
Глава 5, "Добавление вложений"..

 11 Чтобы добавить в результат выполнения связи с дефектами, выберите 
результат, затем нажмите кнопку Linked Defects. Откроется диалоговое 
окно Linked Defects. Дополнительные сведения о связанных дефектах см. 
Глава 32, "Связывание дефектов"..

 12 Чтобы продолжить выполнение приостановленного теста, выберите его, 
затем нажмите кнопку Continue.
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 13 Для экземпляров автоматизированного теста выберите одну из следующих 
кнопок или ссылок:

Примечание. Тип QUICKTEST_TEST доступен только в том случае, если 
установлена соответствующая надстройка, загруженная со страницы 
надстроек HP Quality Center. Подробные сведения об установке надстроек 
см. в Руководство по установке HP Quality Center.

Кнопка или 
ссылка Тип теста Описание

LR-SCENARIO Открывает результаты анализа 
LoadRunner.

QUICKTEST_TEST Открывает отчет QuickTest 
Professional.

Collected 
System Info

Captured 
Desktop Image

SYSTEM-TEST Если щелкнуть ссылку Collected 
System Info, откроется диалоговое 
окно с информацией о системе.

Если щелкнуть ссылку Captured 
Desktop Image, откроется снимок 
экрана. 

Более подробные сведения о 
просмотре системных тестов см. в 
разделе “Просмотр результатов 
выполнения системного теста" на 
стр. 326.

WR-AUTOMATED 
или WR-BATCH

Открывает отчет WinRunner.
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Просмотр конфигурации выполнения теста
В представлении Configuration можно просматривать и задавать 
параметры экземпляра ручного или автоматизированного теста. Можно 
также просматривать и изменять правила, применяемые при обнаружении 
ошибки, для экземпляра автоматизированного теста. 

Содержание раздела:

➤ Установка параметров ручного теста

➤ Установка параметров автоматизированного теста

➤ Просмотр событий выполнения теста

 Установка параметров ручного теста
Просматривать заданные параметры ручного теста можно на вкладке 
Design Steps в модуле Test Plan. До начала выполнения теста можно также 
присвоить этим параметрам нужные значения. Более подробные сведения 
о добавлении параметров ручного теста см. в разделе “Вызов ручного 
теста с параметрами" на стр. 303.

Как просматривать и присваивать значения параметрам ручного теста

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов тестирования" на стр. 417.
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 2 На боковой панели диалогового окна Test Instance Properties нажмите 
значок Configuration. Появится вкладка Manual. 

 3 В столбце Value можно не только просматривать значения, но и 
присваивать их параметрам. Измененное значение параметра начнет 
действовать при запуске теста. 

Установка параметров автоматизированного теста
В представлении Configuration можно присваивать параметрам значения 
и задавать другие настройки конфигурации экземпляра 
автоматизированного теста. Дополнительные сведения о параметрах и 
других настройках выполнения автоматического теста см. в руководстве 
пользователя автоматического теста, в Руководстве пользователя 
QuickTest Professional и Руководстве пользователя WinRunner.
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Как задать параметры и другие настройки конфигурации 
автоматизированного теста

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов тестирования" на стр. 417.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
значок Configuration и перейдите на вкладку Automated. 

 3 В столбце Parameter Value можно просматривать значения и присваивать 
параметрам другие значения. Учтите, что измененное значение параметра 
начнет действовать только при следующем запуске теста. 
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Примечание. При определении параметра WinRunnerCommandLine 
необходимо указать путь в кавычках. Пример:

-ini “C:\program files\wrun.ini”

 4 Некоторые типы автоматизированных тестов позволяют задавать 
дополнительные настройки конфигурации. Дополнительные сведения об 
автоматических тестах см. в руководстве пользователя 
автоматизированного теста.

Просмотр событий выполнения теста
Представление Run Events позволяет просматривать и изменять правила, 
применяемые при обнаружении ошибки, для экземпляра 
автоматизированного теста. Эти правила содержат инструкции для 
Quality Center применямые в том случае, если при выполнении экземпляра 
теста обнаружатся ошибки в тестируемом приложении. В том числе можно 
указать количество повторных запусков экземпляра теста, а также 
подготовительный тест, который должен быть выполнен перед повторным 
выполнением экземпляра теста. 

Примечание. Если изменить правила, применямые при обнаружении 
ошибки в представлении Run Events, эти изменения начнут действовать 
при очередном запуске теста.

Задать правила, применяемые при обнаружении ошибки, для теста можно 
также таким способом: выберите Test Set > Test Set Properties > On 
Failure, затем нажмите кнопку Settings per Test. Дополнительные 
сведения см. в разделе “Настройка правил при отрицательном результате 
выполнения набора тестов" на стр. 364.
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Как просматривать события выполнения теста

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов тестирования" на стр. 417.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
значок Configuration и перейдите на вкладку Run Events. 

 3 Чтобы настроить правило, применяемое при  обнаружении ошибки, 
сначала установите первый флажок и укажите, сколько раз после этого 
должен быть выполнен экземпляр теста. 

 4 Если необходимо включить подготовительный тест, установите флажок 
Run clean up test, затем нажмите кнопку обзора. В диалоговом окне Select 
Clean Up Test выберите тест в дереве плана тестирования, затем щелкните 
пиктограмму Add Test.
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Просмотр связанных дефектов
В Quality Center предусмотрена возможность просматривать и связывать 
дефекты с другими объектами.

Как просматривать связанные дефекты

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов тестирования" на стр. 417.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
значок Linked Defects.

Примечание. Если активировано покрытие требований экземплярами 
тестов с параметром ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE, 
щелкните на боковой панели значок Linkage and Coverage. 
Дополнительные сведения об этом параметре см. в Руководство 
администратора HP Quality Center.
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 3 На вкладке Linked Defects можно просматривать, добавлять и удалять 
связи между объектами и дефектами. Дополнительные сведения см. 
Глава 32, "Связывание дефектов".

Просмотр истории выполнения теста
В представлении History можно просматривать список внесенных в 
экземпляр теста изменений.

Как просматривать историю изменения выполнений теста

 1 Откройте диалоговое окно Test Instance Properties. Дополнительные 
сведения см. в разделе “Просмотр результатов тестирования" на стр. 417.

 2 На боковой панели диалогового окна Test Instance Properties нажмите 
значок History. 
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Для каждого внесенного в экземпляр теста изменения в таблице 
отображается дата и время изменения, а также имя пользователя, 
внесшего это изменение.

 3 Раскройте изменение, чтобы просмотреть список измененных полей. Для 
каждого поля в таблице отображаются старое и новое значения. Чтобы 
раскрыть все изменения, нажмите кнопку Expand All.

 4 Можно указать, какие изменения должны отображаться в таблице. В списке 
Field выберите имя поля, чтобы просмотреть те изменения, которые были 
внесены только в это поле. Для просмотра изменений, внесенных во все 
поля, выберите <All>.

Сведения об активации параметра History для отдельного поля см. в 
документе Руководство администратора HP Quality Center.
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Жизненный цикл ошибки

Важной частью процесса разработки приложения является обнаружение и 
исправление ошибок в нём. Пользователи могут обнаруживать и добавлять 
дефекты в проект Quality Center на всех этапах процесса тестирования. С 
помощью модуля Defects среды Quality Center можно сообщать об ошибках 
проектирования приложений и отслеживать данные, извлеченные из 
записей о дефектах.

В этой главе описан порядок отслеживания дефектов. Процесс 
отслеживания дефектов включает в себя следующее: 

Define Testing 
Scope

Create
Requirements

Create
Requirements

Detail 
Requirements

Detail 
Requirements

Analyze 
Requirements

Analyze 
Requirements

Добавление
дефектов

Анализ новых
дефектов

Устранение
открытых дефектов

Тестирование
новой сборки

Анализ данных
о дефектах
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Добавление дефектов
При обнаружении дефекта в приложении необходимо задокументировать 
его в проекте Quality Center. Проект хранит информацию о дефекте, доступ 
к которой могут получить такие авторизованные пользователи, такие как 
члены групп разработки, контроля качества и поддержки. Новый дефект 
можно связать с циклом и релизом, в которых он был обнаружен.

Предположим, что выполняется тестирование приложения Mercury Tours. 
При выполнении набора тестов Cycle 1 из папки набора тестов Release 
10.5  во время выполнения одного из тестов был обнаружен дефект, 
связанный с вводом дат истечения срока действия кредитных карт. При 
первом документировании дефекта в проект поле Detected in Release 
назначается релизу Release 10.5, а поле Detected in Cycle – циклу 
Cycle 1 - New Features. Дополнительные сведения о релизах и циклах см. 
в главе  Глава 7, "Процесс управления релизами".

Этот новый дефект можно связать с тестом, который выполняется в 
настоящее время. Также можно связать дефекты с другими объектами 
Quality Center, такими как требования, тесты и другие дефекты. 
Дополнительные сведения см. Глава 32, "Связывание дефектов".

Также предусмотрена возможность просмотра, обновления и анализа 
дефектов в проекте. Дополнительные сведения см. в главе Глава 31, 
"Добавление и отслеживание дефектов".

Анализ новых дефектов
Следует проанализировать все новые дефекты в проекте и принять 
решение о том, какие из них следует устранить. Как правило, это делает 
руководитель проекта. Затем следует изменить статус нового дефекта на 
Open и назначить его члену группы разработки. 

В поле Target Release назначьте открытый дефект релизу, чтобы его 
устранить. В поле Target Cycle назначьте открытый дефект циклу, который 
необходимо закрыть. Например, запланировано устранить дефект, 
обнаруженный при вводе дат истечения срока действия кредитных карт, в 
следующем цикле. Назначьте поле Target Release релизу Release 10.5, а 
поле Target Cycle циклу Cycle 2 - New Features + Regression. 
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Если при анализе новых дефектов в проекте появились дубликаты 
дефектов, измените их статус либо на Closed, либо наRejected, или 
удалите их из проекта.

Устранение открытых дефектов
Устраните дефекты со статусом Open. Для этого необходимо сначала 
определить причину дефектов, а затем модифицировать приложение и 
разработать его новую сборку. Эти задачи возлагаются на разработчиков 
приложений. После исправления дефекта присвойте ему статус Fixed. 
Например, дефект, обнаруженный при вводе дат истечения срока действия 
кредитных карт, был устранен в новой сборке приложения. Обновите 
статус дефекта с Open на Fixed.

Тестирование новой сборки приложения
Протестируйте новую сборку приложения. Если дефект не будет 
обнаружен повторно, присвойте ему статус Closed. При повторном 
обнаружении дефекта присвойте ему статус Reopen и вернитесь к 
предыдущему этапу (см. раздел “Устранение открытых дефектов" на 
стр. 437). Как правило, эта задача возлагается на менеджера по контролю 
качества или руководителя проекта. Дополнительные сведения о 
выполнении тестов см. в главах Глава 26, "Выполнение тестов вручную" и 
Глава 27, "Автоматическое выполнение тестов".

Анализ данных одефектах
Чтобы узнать, сколько дефектов было устранено, а сколько еще осталось 
открытыми, просмотрите данные отчетов о дефектах. Во время работы 
можно сохранять параметры, которые помогут при отслеживании 
дефектов, а затем загружать их при необходимости. Дополнительные 
сведения см. в главеГлава 6, "Работа с избранными представлениями".

Отчеты и графики позволяют анализировать ход устранения дефектов и 
узнавать, сколь долго дефекты присутствовали в проекте. Это помогает 
определить, когда можно выпускать приложение. Дополнительные 
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сведения см. в главе Глава 33, "Создание отчетов" или Глава 34, 
"Создание диаграмм".
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Краткий обзор модуля Defects

В этой главе приведено краткое описание основных элементов модуля 
Defects.

Глава содержит следующие разделы: На стр.

Модуль Defects 440

Строка меню Defects 443

Панель инструментов Defects 444

Таблица Defects Grid 446
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Модуль Defects 
Отслеживание дефектов (учет ошибок и несоответствий) выполняется в 
модуле Quality Center Defects, для открытия окна которого следует нажать 
кнопку Defects на боковой панели. 

Модуль Defects содержит следующие основные элементы:

➤ Строка меню Defects. Отображение раскрывающегося меню с командами 
модуля Defects. Дополнительные сведения см. в разделе “Строка меню 
Defects" на стр. 443.

➤ Панель инструментов Defects. Содержит кнопки команд, часто 
использующихся для добавления, управления и отслеживания дефектов. 
Дополнительные сведения см. в разделе “Панель инструментов Defects" на 
стр. 444.
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➤ Indicator Columns. Указывают на то, что тот или иной дефект содержит 
вложения, связанные объекты, оповещения и флажки отслеживания. 
Чтобы отобразить эти столбцы, выберите командуView > 
Indicator Columns.

➤ Фильтр таблицы. Отображение текущего фильтра, примененного к 
столбцу.

➤ Таблица Defects. Отображение данных дефекта в таблице. 
Дополнительные сведения см. в разделе “Таблица Defects Grid" на 
стр. 446.

Столбец Description

Attachments Для просмотра вложений дефекта щелкните значок 
. Дополнительные сведения см. Глава 5, 

"Добавление вложений".

Linked Entities Для просмотра связанных объектов дефекта 
щелкните значок . Дополнительные сведения см. 
Глава 32, "Связывание дефектов".

Alerts Для просмотра оповещений дефекта щелкните 
мышью значок . Дополнительные сведения см. в 
разделе “Просмотр оповещений" на стр. 85.

Follow Up Flags Для просмотра оповещений об отслеживании 
дефекта щелкните значок . Дополнительные 
сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 88.
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➤ Information Panel. Отображение следующих вкладок. Description, 
Attachments и History. Выберите пункт меню View > Information Panel > 
Show или щелкните стрелку Show , чтобы отобразить эти вкладки.
 

Совет. Для поиска конкретного дефекта по идентификатору Defect ID в 
таблице Defects Grid выберите Defects > Go To Defect. 

Вкладка Описание

Description Отображение описания выбранного дефекта. 
Также можно отобразить следующие параметры:

➤ Summary. Выберите View > Information Panel > 
Summary, чтобы отобразить краткое описание 
дефекта. 

➤ Comments. Выберите View > Information Panel 
> Comments, чтобы просмотреть или добавить 
комментарии дефекта.

Дополнительные сведения см. в разделе 
“Обновление дефектов" на стр. 458.

Attachments Отображение вложений выбранного дефекта. 
Дополнительные сведения см. Глава 5, 
"Добавление вложений".

History Отображение истории изменения дефекта. 
Дополнительные сведения см. в разделе 
“Просмотр истории дефекта" на стр. 463.
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Строка меню Defects 
Строка меню Defects содержит следующие разделы:

➤ Меню Defects содержит команды, с помощью которых можно добавлять 
дефекты, переходить к тому или иному дефекту, отправлять дефекты по 
электронной почте, экспортировать дефекты, а также просматривать 
подробные сведения о дефектах.

➤ Меню Edit содержит команды, с помощью которых можно копировать, 
вставлять или удалять дефекты, выполнять поиск и замену значений в 
полях, искать дефекты, переходить к тому или иному дефекту в таблице и 
находить аналогичные дефекты или текст. Также можно просматривать и 
удалять оповещения дефектов и снимать флажки отслеживания дефектов. 
Дополнительные сведения о предупреждениях и флажках отслеживания 
см. Глава 4, "Оповещение об изменениях"..

➤ Меню View содержит команды, позволяющие настраивать отображение в 
таблице Defects Grid. 

➤ Меню Favorites содержит команды, с помощью которых можно 
просматривать выбранный в списке Favorites элемент, добавлять 
представление таблицы Defects Grid в список Favorites и упорядочивать 
список Favorites. Дополнительные сведения о избранных представлениях 
см. в главе Глава 6, "Работа с избранными представлениями"..

➤ Меню Analysis содержит команды, позволяющие формировать отчеты о 
дефектах и диаграммы. Дополнительные сведения об отчетах о дефектах 
см. Глава 33, "Создание отчетов".. Дополнительные сведения о 
диаграммах дефектов см. Глава 34, "Создание диаграмм"..

Совет. Для получения доступа к строке меню Defects из модуля Defects 
нажмите клавишу F9. Кроме того, с помощью комбинаций клавиш можно 
выполнять множество других операций в среде Quality Center. Перечень 
комбинаций клавиш приведен в Приложение B, "Quality Center - 
Комбинации клавиш"..
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Панель инструментов Defects 
Панель инструментов Defects содержит следующие кнопки.

New Defect. Открывает диалоговое окно New Defect, в котором можно 
добавить новый дефект в таблицу Defects Grid. Дополнительные сведения 
см. в разделе “Добавление новых дефектов" на стр. 451.

Delete. Удаляет выбранные дефекты из таблицы Defects Grid. 
Дополнительные сведения см. в разделе “Удаление дефектов" на стр. 469.

Refresh All. Обновляет таблицу Defects Grid таким образом, что в ней в 
соответствии с выбранными фильтрами отображаются самые последние 
дефекты. 

Set Filter/Sort.  Выберите один из следующих вариантов:

➤ Set Filter/Sort. Открывает диалоговое окно Filter, в котором можно 
фильтровать, сортировать и группировать дефекты в таблице Defects.

➤ Clear Filter/Sort. Очищает все фильтры, сортировку или группировки, 
примененные пользователем к таблице Defects. 

Дополнительные сведения о фильтрации и сортировке дефектов см. 
Глава 3, "Работа с данными Quality Center"..

Select Columns. Открывает диалоговое окно Select Columns, в котором 
можно задать, какие столбцы будут отображаться в таблице Defects, и 
порядок их вывода. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 55.

Defect Details. Открывает диалоговое окно Defect Details, в котором 
отображаются подробные сведения о дефекте. Дополнительные сведения 
см. в разделе “Обновление дефектов" на стр. 458.

Attachments. Открывает диалоговое окно Defect Details, в котором можно 
добавить к дефекту новое вложение. Дополнительные сведения см. в 
главе Глава 5, "Добавление вложений".

Flag for Follow Up. Открывает диалоговое окно Flag For Follow Up, в 
котором можно добавить или изменить флажок отслеживания дефекта. 
Дополнительные сведения см. в разделе “Установка флажков для 
отслеживания" на стр. 88.
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Send by E-mail. Открывает диалоговое окно Send E-mail, с помощью 
которого можно отправить дефект электронной почтой выбранным из 
списка получателям или на любые другие адреса электронной почты. 
Дополнительные сведения см. в разделе “Отправка дефектов по 
электронной почте" на стр. 464.

Find Similar Defects. Содержит следующие команды.

➤ Find Similar Defects. Выполняет поиск аналогичных дефектов и при 
нахождении выводит их в диалоговом окне Similar Defects. 

➤ Find Similar Text. Открывает диалоговое окно Find Similar Text, с 
помощью которого можно выполнять поиск аналогичных дефектов 
путем задания текстовой строки и при нахождении выводит их в 
диалоговом окне Similar Defects.

Подробные сведения о поиске аналогичных дефектов приведены в 
разделе “Сопоставление дефектов" на стр. 453.

Text Search. Открывает в нижней части окна область поиска текста, в 
которую можно вводить ключевые слова и выполнять поиск 
предварительно заданных полей. Дополнительные сведения см. в разделе 
“Поиск записей" на стр. 76.

Favorite. Щелкните стрелку Favorite , чтобы отобразить список избранных 
представлений. Используя избранные представления, можно повторно 
загружать окно Quality Center с примененными к нему параметрами. Если 
панель Favorite не отображается, выберите View > Favorite Bar. 
Дополнительные сведения об избранных представлениях см. в главе 
Глава 6, "Работа с избранными представлениями"..
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Таблица Defects Grid
Quality Center упорядочивает и отображает данные о дефектах в таблице. 
В каждой строке таблицы Defects Grid отображается отдельная запись 
дефекта. Таблица Defects Grid может содержать следующие столбцы:

Столбец Описание

Actual Fix Time Указывает фактическое количество дней, необходимых 
для устранения дефекта. Если оставить это поле пустым, 
Quality Center автоматически рассчитывает фактическое 
время, необходимое для устранения дефекта, вычитая 
из даты закрытия дефекта дату его обнаружения.

Assigned To Имя пользователя, которому назначена задача по 
устранению дефекта. Щелкните кнопку вниз, чтобы 
отобразить имя и полное имя каждого пользователя. 

Closed in Version Указывает версию приложения, в которой дефект был 
закрыт. Чтобы отобразить список версий, щелкните 
кнопку вниз.

Closing Date Указывает дату закрытия дефекта. Щелкните кнопку со 
стрелкой вниз, чтобы отобразить календарь и выбрать 
дату закрытия.

Comments Отображает комментарии к дефекту.

Defect ID Уникальный числовой идентификатор дефекта, 
автоматически назначенный Quality Center. 
Идентификатор дефекта доступен только для чтения.

Описание Подробное описание дефекта.

Detected By Имя пользователя, обнаружившего дефект. По 
умолчанию среда Quality Center вставляет в это поле имя 
пользователя, выполнившего вход в неё.

Detected in Cycle Указывает цикл, в котором был обнаружен дефект. Чтобы 
выбрать другой цикл, щелкните кнопку со стрелкой вниз. 

Учтите, что при назначении дефекта циклу в поле 
Detected in Cycle Quality Center автоматически 
присваивает значение соответствующего релиза полю 
Detected in Release.
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Detected in Release Указывает релиз, в котором был обнаружен дефект. 
Чтобы выбрать другой релиз, щелкните кнопку со 
стрелкой вниз.

Detected in Version Указывает версию приложения, в котором был 
обнаружен дефект. Чтобы отобразить список версий, 
щелкните кнопку со стрелкой вниз.

Detected on Date Дата обнаружения дефекта. По умолчанию отображается 
текущая дата сервера базы данных. Чтобы выбрать 
другую дату обнаружения, щелкните кнопку со стрелкой 
вниз.

Estimated Fix Time Указывает расчетное количество дней, необходимых для 
устранения дефекта.

Modified Указывает дату и время последнего изменения дефекта.

Planned Closing 
Version

Указывает, в какой версии планируется устранить 
дефект. Чтобы отобразить список версий, щелкните 
кнопку со стрелкой вниз.

Priority Приоритет дефекта от низкого (уровень 1) до 
неотложного (уровень 5). 

Project Имя проекта, в котором обнаружен дефект. Чтобы 
отобразить список проектов, щелкните кнопку со 
стрелкой вниз.

Reproducible Указывает, возможно ли воспроизвести дефект при тех 
же условиях, при которых он был обнаружен. Щелкните 
кнопку со стрелкой вниз, чтобы выбрать Y (Да) или N 
(Нет).

Severity Серьезность дефекта от низкой (уровень 1) до 
чрезвычайной (уровень 5).

Status Текущий статус дефекта. По умолчанию дефекту 
назначается статус New. Для дефекта может 
использоваться один из следующих статусов: Closed, 
Fixed, New, Open, Rejected, Reopen. 

Subject Указывает папку объектов. Чтобы отобразить список 
объектов, щелкните кнопку со стрелкой вниз.

Столбец Описание
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Примечания. 

➤ Для любого поля таблицы Defects можно добавить поля пользователя и 
изменить заголовок. Также предусмотрена возможность настройки 
списков проектов. Подробные сведения см. в документе Руководство 
администратора HP Quality Center.

➤ Для ограничения и динамического изменения полей и значений таблицы 
Defects Grid можно использовать редактор Script Editor. Подробные 
сведения см. в документе Руководство администратора 
HP Quality Center.

➤ При выборе столбца дефектов, содержащего значение имени 
пользователя, Quality Center отображает список с именем и полным 
именем каждого пользователя. Можно выполнять поиск пользователей, 
сортировать и группировать их, а также выбирать пользователей из 
списка и дерева групп. Дополнительные сведения см. в разделе “Выбор 
пользователей" на стр. 58.

Summary Краткое описание дефекта.

Target Cycle Указывает, в каком цикле планируется устранить дефект. 
Чтобы выбрать другой цикл, щелкните кнопку со стрелкой 
вниз.

Учтите, что при назначении дефекта циклу в полеTarget 
Cycle Quality Center автоматически присваивает 
значение соответствующего релиза полю Target Release.

Target Release Указывает, в каком релизе планируется закрыть дефект. 
Чтобы выбрать другой релиз, щелкните кнопку со 
стрелкой вниз.

Столбец Описание
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31
Добавление и отслеживание дефектов

Модуль Defects используется для добавления дефектов приложений 
непосредственно В проект Quality Center. После добавления можно 
отслеживать дефекты до того момента, когда разработчики и тестировщики 
приложений не определят, что дефекты устранены.

Глава содержит следующие разделы: На стр.

Сведения о добавлении и отслеживании дефектов 450

Добавление новых дефектов 451

Сопоставление дефектов 453

Обновление дефектов 458

Поиск и замена значений 460

Просмотр истории дефекта 463

Отправка дефектов по электронной почте 464

Копирование дефектов 467

Копирование URL-адресов дефектов 468

Распечатка дефектов 468

Удаление дефектов 469
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Сведения о добавлении и отслеживании дефектов
Записи дефектов информируют членов групп по разработке приложений и 
контролю качества о новых дефектах, обнаруженных другими членами 
групп. Благодаря совместного использования сведений о дефектах 
ускоряется как процесс разработки приложений, так и процесс устранения 
дефектов, что делает их более эффективными и всеобъемлющими. По 
мере того, как пользователь осуществляет текущий контрольхода 
устранения дефектов, он обновляет сведения в проекте Quality Center.

Предположим, пользователь обнаружил дефект в приложении Mercury 
Tours. При первоначальном предоставлении сведений о дефекте в 
Quality Center ему по умолчанию присваивается статус New. Менеджер по 
контролю качества или руководитель проекта анализирует сведения о 
дефекте, определяет приоритеты его устранения, изменяет его статус на 
Open и передает дефект члену группы разработки приложений. 
Разработчик устраняет дефект и назначает ему статус Fixed. 
Пользователь проводит повторное тестирование приложения, чтобы 
убедиться, что дефект не появляется повторно. Менеджер по контролю 
качества или руководитель проекта проверяет, чтодефект действительно 
устранен, и присваивает ему статус Closed.

Примечания. 

➤ Можно связывать дефекты с различными объектами Quality Center, 
такими как требования, тесты и другие дефекты. Дополнительные 
сведения см. главе Глава 32, "Связывание дефектов".

➤ Для ограничения и динамического изменения полей и значений модуля 
Defects можно использовать редактор Workflow Script Editor. Также 
предусмотрена возможность настройки полей для определенной группы 
пользователей. Подробные сведения см. в Руководство 
администратора HP Quality Center.
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Добавление новых дефектов 
Добавить новый дефект в проект Quality Center можно из любого модуля на 
любом этапе процесса тестирования.

Примечание. Кроме непосредственного добавления дефектов в 
Quality Center также можно импортировать данные дефекта из Microsoft 
Excel в проект Quality Center. Для импорта из Excel необходимо установить 
надстройки Microsoft Excel и HP Quality Center Connectivity. Их можно 
загрузить со страницы надстроек HP Quality Center. Более подробные 
сведения см. в руководстве Руководство по установке HP Quality Center.

Для добавления нового дефекта выполните следующие действия:

 1 Чтобы добавить новый дефект из любого модуля, нажмите кнопку Tools  в 
верхнем правом углу окна Quality Center. Выберите New Defect. 

Чтобы добавить дефект из модуля Defects, нажмите кнопку New Defect. 
Откроется диалоговое окно New Defect.
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 2 Введите сведения о дефекте. Учтите, что обязательные поля выделены 
красным цветом, а некоторые поля Quality Center заполняет значениями по 
умолчанию. Дополнительные сведения о полях, доступных в диалоговом 
окне New Defect, см. Глава 30, "Краткий обзор модуля Defects"..

 3 Для очистки всех данных в диалоговом окне New Defect нажмите кнопку 
Clear.

 4 К дефекту можно добавить вложение.

➤ Нажмите кнопку Attach File , чтобы вложить файл.

➤ Нажмите кнопку Attach URL , чтобы вложить URL.

➤ Нажмите кнопку Attach Snapshot , чтобы захватить и присоединить 
снимок экрана.

➤ Нажмите кнопку Attach SysInfo , чтобы вложить сведения о системе.

➤ Нажмите кнопку Attach Clipboard Content , чтобы присоединить 
содержимое буфера обмена.

Дополнительные сведения о добавлении вложений см. в главе Глава 5, 
"Добавление вложений"..

 5 Для устранения дубликатов дефектов или аналогичных дефектов 
выполните следующие действия:

➤ Нажмите кнопку Find Similar Defects , чтобы выполнить поиск 
аналогичных дефектов по ключевым словам в полях Summary и 
Description.

➤ Щелкните стрелку Find Similar Defects и выберите пункт Find Similar 
Text , чтобы выполнить поиск аналогичных дефектов по введенной 
текстовой строке.

Дополнительные сведения см. в разделе “Сопоставление дефектов" на 
стр. 453.

 6 В диалоговом окне можно проверить правописание.

➤ Нажмите кнопку Check Spelling , чтобы проверить орфографию 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.
452



Глава 31 • Добавление и отслеживание дефектов
➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки орфографии Quality Center, нажмите 
кнопку  Spelling Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразитьдля выбранного 
слова синонимы, антонимы или связанные слова, нажмите кнопку 
Thesaurus. Замените выбранное слово или выполните поиск новых 
слов.

 7 Для добавления дефекта в проект нажмите кнопку Submit. Quality Center 
назначит идентификатор новому дефекту.

 8 Нажмите кнопку Close.

Сопоставление дефектов 
Сопоставление дефектов позволяет устранять в проекте дубликаты 
дефектов или аналогичные дефекты. При каждом добавлении нового 
дефекта Quality Center сохраняет списки ключевых слов из полей Summary 
и Description. При поиске аналогичных дефектов ключевые слова из этих 
полей сопоставляются с другими дефектами.

Учтите, что ключевые слова имеют длину больше двух символов, и регистр 
на результаты не влияет. Пропускается следующее: артикли (a, an, the); 
соединительные/сочинительные союзы (and, but, for, nor, or); знаки 
логических операций (and, or, not, if, then); подстановочные знаки (?, *, [ ]). 

Поиск аналогичных дефектов можно выполнять двумя способами.

➤ Find Similar Defects. Сопоставление выбранного дефекта со всеми 
остальными дефектами, существующими в проекте. Поиск аналогичных 
дефектов можно выполнять в таблице Defects Grid или перед добавлением 
нового дефекта в диалоговое окно New Defect. См. раздел “Поиск 
аналогичных дефектов" на стр. 454.

➤ Find Similar Text. Сопоставление указанной текстовой строки со всеми 
остальными дефектами, существующими в проекте. Поиск аналогичных 
дефектов можно выполнять в таблице Defects Grid или перед добавлением 
нового дефекта в диалоговое окно New Defect. Для ограничения вывода 
результатов можно указать процент обнаруженного сходства. См. раздел 
“Поиск аналогичного текста" на стр. 456. 
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Совет. Если параметр Text Search доступен, то для поиска аналогичных 
дефектов рекомендуется использовать его. Текстовый поиск является 
более мощным инструментом, посколькупозволяет выполнять поиск 
ключевых слов и их вариаций. Сведения об использовании текстового 
поиска приведены в разделе “Поиск записей" на стр. 76.

Поиск аналогичных дефектов
Можно сопоставлять дефекты путем сравнения выбранного дефекта со 
всеми остальными дефектами, существующими в проекте. При 
обнаружении аналогичных дефектов они отображаются в соответствии с 
процентом обнаруженного сходства. 

Для поиска аналогичных дефектов выполните следующие действия:

 1 В таблице Defects Grid выберите дефект и нажмите кнопку Find Similar 
Defects. Альтернативный вариант — в диалоговом окне New Defect перед 
добавлением дефекта нажмите кнопку Find Similar Defects.
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Результаты отображаются в диалоговом окне Similar Defects, 
упорядоченные в соответствии с процентом обнаруженного сходства и 
отображаютсяв столбце Similar. Если аналогичные дефекты обнаружены 
не были, отобразится соответствующее сообщение.

 2 Чтобы отобразитьв диалоговом окне Similar Defects подробные сведения о 
дефекте, дважды щелкните дефект.

 3 Чтобы закрыть диалоговое окно Similar Defects, нажмите кнопку Close.
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Поиск аналогичного текста
Можно сопоставлять дефекты путем сравнения указанной текстовой строки 
со всеми остальными дефектами, существующими в проекте. Можно 
ограничить результаты поиска дефектов только теми, которые 
соответствуют указанному проценту сходства. Например, предположим, 
что выполняется поиск дефектов со словом Help. Если ограничить 
результаты 25 процентами, то результаты поиска будут следующими:

Если ограничить результаты 100 процентами, то результаты поиска будут 
следующими:

Для поиска аналогичного текста выполните следующие действия:

 1 В таблице Defects Grid щелкните стрелку Find Similar Defects  и выберите 
Find Similar Text. Альтернативный вариант — в диалоговом окне New 
Defect перед добавлением дефекта щелкните стрелку Find Similar Defects 
и выберите Find Similar Text.

Откроется диалоговое окно Find Similar Text. 
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 2 Для ограничения вывода результатов об обнаруженных дефектах лишь 
теми, которые имеют минимальное сходство, введите процент в поле 
Percent of Similarity. По умолчанию Quality Center возвращает дефекты с 
процентом сходства не менее 25.

 3 В поле Text to Find введите текстовую строку. 

 4 Нажмите кнопку OK. Результаты отображаются в диалоговом окне Similar 
Defects, упорядоченные в соответствии с процентом обнаруженного 
сходства, как перечислено в столбце Similar. Если аналогичные дефекты 
обнаружены не были, отобразится соответствующее сообщение.

 5 Чтобы отобразитьв диалоговом окне Similar Defects подробные сведения о 
дефекте, дважды щелкните мышью дефект.

 6 Чтобы закрыть диалоговое окно Similar Defects, нажмите кнопку Close.
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Обновление дефектов
Отслеживание устранения дефектов в проекте требует периодического 
обновления дефектов. Обновлять дефекты можно непосредственно в 
таблице Defects Grid или в диалоговом окне Defect Details.

Для обновления дефектов выполните следующие действия.

 1 В таблице Defects дважды щелкните мышью дефект, который необходимо 
обновить. Альтернативный вариант — выберите дефект и нажмите кнопку 
Defect Details. Откроется диалоговое окно Defect Details. 

 2 Нажмите кнопку First , чтобы отобразить в таблице первый дефект, или 
кнопку Previous , чтобы отобразить предыдущий дефект.

 3 Нажмите кнопку Next , чтобы отобразить в таблице следующий дефект, 
или кнопку Last , чтобы отобразить последний дефект.
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 4 Для отображения в диалоговом окне Defect Details конкретного дефекта 
нажмите кнопку Go To Defect. Откроется диалоговое окно Go To Defect. 
Введите идентификатор дефекта и нажмите кнопку OK.

 5 Для добавления или изменения флажка отслеживания нажмите кнопку 
Flag for Follow Up. Дополнительные сведения см. Глава 4, "Оповещение 
об изменениях".

 6 Если у дефекта есть оповещение, нажмите кнопку Alerts , чтобы открыть 
диалоговое окно Alerts. Дополнительные сведения см. в разделе 
“Просмотр оповещений" на стр. 85.

 7 Нажмите кнопку Send by E-mail, чтобы отправить подробные сведения о 
дефекте по электронной почте. Подробные сведения об отправке сведений 
о дефектах электронной почтой приведены в разделе “Отправка дефектов 
по электронной почте" на стр. 464.

 8 Нажмите кнопку Create Report For This Defect, чтобы сформировать отчет 
о дефекте. Дополнительные сведения об отчетах о дефектах см. в главе 
Глава 33, "Создание отчетов"..

 9 Если дефект связан с выполнением теста, щелкните ссылку Execution 
Report в нижней части диалогового окна Defect Details, чтобы создать отчет 
о выполнении. Отчет о выполнении предоставляет подробные сведения о 
выполнении связанного теста. Дополнительные сведения об отчетах о 
выполнении см. в главе Глава 33, "Создание отчетов"..

 10 В представлении Details можно добавлять или изменять сведения о 
выбранном дефекте. Дополнительные сведения о полях, доступных в 
представлении Details, см. в главе Глава 30, "Краткий обзор модуля 
Defects"..

Чтобы добавить новый комментарий, нажмите кнопку Add Comment. 
Новый раздел будет добавлен в поле Comments с именем пользователя и 
текущей датой базы данных.

 11 Щелкните Attachments на боковой панели, чтобы добавить вложение к 
дефекту. Вл ожение может представлять собой файл, адрес URL-адрес, 
снимок экрана приложения, информацию о системе или содержимое 
буфера обмена. В таблице Defects Grid рядом с дефектом отображается 
значок вложения . Дополнительные сведения о вложениях приведены 
см.в главе Глава 5, "Добавление вложений"..
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 12 Щелкните Linked Entities на боковой панели. Доступны следующие 
вкладки:

➤ Defects. Позволяет просматривать и добавлять связи к существующим 
дефектам. Например, можно связать дефект с дубликатом дефекта.

➤ Others. Позволяет просматривать и удалять связи с другими объектами. 
Новые связи добавлять невозможно.

Дополнительные сведения о связанных дефектах см. в главе Глава 32, 
"Связывание дефектов"..

 13 Щелкните History на боковой панели, чтобы просмотреть историю 
изменений, внесенных в дефект. Дополнительные сведения см. в разделе 
“Просмотр истории дефекта" на стр. 463.

 14 Нажмите кнопку OK, чтобы сохранить изменения и вернуться в таблицу 
Defects.

Поиск и замена значений 
С помощью команды Find/Replace можно выполнять поиск и замену 
значений в таблице Defects.

Совет. Если доступен текстовый поиск , то его можно использовать для 
поиска дефектов в таблице Defects Grid. Текстовый поиск является более 
мощным инструментом, поскольку позволяет выполнять поиск ключевых 
слов и их вариаций. Сведения об использовании текстового поиска 
приведены в разделе “Поиск записей" на стр. 76.
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Для поиска значения выполните следующие действия.

 1 В таблице Defects выберите Edit > Find. Откроется диалоговое окноFind.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск конкретного значения.

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 Для поиска точного совпадения установите флажок Exact Match.

 5 Для поиска с учетом прописных и строчных символов установите флажок 
Case Sensitive.

 6 Чтобы можно было использовать в строке поиска символы звездочки (*) и 
вводить только часть элемента, установите флажок Use Wildcard.

 7 Нажмите кнопку Find Next. Quality Center попытается найти любые 
дефекты с указанным значением. При успешном завершении поиска 
дефект будет выделен в таблице Defects Grid. При неуспешном 
завершении поиска откроется окно сведений.
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Для замены значения выполните следующие действия:

 1 В таблице Defects Grid выберите Edit > Replace. Откроется диалоговое 
окно Find/Replace.

 2 В поле Find in Field выберите столбец, в котором необходимо выполнить 
поиск конкретного значения. 

 3 В поле Value to Find введите или выберите значение, которое необходимо 
найти. 

 4 В поле Replace with введите или выберите значение, на которое будет 
заменено старое значение.

 5 Чтобы выполнить поиск с учетом прописных и строчных символов, 
установите флажок Case Sensitive.

 6 Чтобы найти точное значение, установите флажок Exact Match.

 7 Чтобы начать поиск с верхней части таблицы Defects Grid, установите 
флажок From Beginning.

 8 Чтобы можно было использовать в строке поиска символ звездочки (*) и 
вводить только часть элемента, установите флажок Use Wildcard.

 9 Чтобы заменить найденный элемент и продолжить поиск следующего 
элемента, нажмите кнопку Replace.

 10 Для замены всех экземпляров значения в таблице Defects Grid нажмите 
кнопку Replace All.
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Просмотр истории дефекта
Предусмотрена возможность просмотра списка изменений, внесенных в 
дефект. Учтите, что просматривать изменения для выбранных полей, 
предварительно заданных администратором проекта, можно только в окне 
Project Customization. Подробные сведения об активации параметра History 
для отдельного поля приведены в Руководство администратора 
HP Quality Center.

Для просмотра истории изменения дефекта выполните следующие 
действия:

 1 Выберите дефект, а затем — View > Information Panel > Show, чтобы 
отобразитьисторию изменений в таблице Defects Grid. Выберите вкладку 
History. 

Альтернативный вариант — в таблице Defects Grid дважды щелкните 
мышью дефект, чтобы открыть диалоговое окно Defect Details, а затем 
щелкните History на боковой панели.

История изменений, внесенных в дефект, будет отображена в таблице.

Для каждого внесенного в дефект изменения в таблице отображается дата 
и время изменения, а также имя пользователя, внесшего изменение.

 2 Раскройте изменение, чтобы просмотреть список измененных полей. Для 
каждого поля в таблице отображаются старое и новое значения. Чтобы 
раскрыть все изменения, нажмите кнопку Expand All.
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 3 Можно указать, какие изменения должны отображаться в таблице. В списке 
Field выберите имя поля, чтобы просмотреть те изменения, которые были 
внесены только в это поле. Для просмотра изменений, внесенных во все 
поля, выберите <All>.

Отправка дефектов по электронной почте 
Можно отправить сообщение о дефекте по электронной почте другому 
пользователю. Эта функция позволяет информировать сотрудников групп 
разработки и контроля качества о мерах по устранению дефектов. 
Quality Center снабжен ссылкой Go To Defect в электронной почте, которая 
позволяет получателю сообщения переходить непосредственно к дефекту.

Примечание. По умолчанию Quality Center отправляет сообщения по 
электронной почте в формате HTML. Чтобы отправить сообщение по 
электронной почтев виде обычного текста, измените параметр 
MAIL_FORMAT на вкладке Site Configuration в разделе Site Administration. 
Подробные сведения см. в Руководство администратора 
HP Quality Center.
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Чтобы отправить дефект по электронной почте, выполните 
следующие действия: 

 1 В таблице Defects Grid выберите один или несколько дефектов и нажмите 
кнопку Send by E-mail. Откроется диалоговое окно Send E-mail.

Совет. Предусмотрена возможность автоматической отправки сообщений 
по электронной почте определенному типу пользователей. Это может быть 
любой столбец дефектов со именем пользователя, включая и поля 
пользователя. Щелкните стрелку Send by E-mail  и выберите необходимый 
параметр. Например, для отправки сообщения по электронной 
почтепользователю, обнаружившему дефект, выберите Send Mail to 
Detected By.
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 2 Введите допустимый адрес электронной почты или имя пользователя. 
Альтернативный вариант — нажмите кнопку To или CC, чтобы выбрать 
пользователей. Откроется диалоговое окно Select Recipients. 

Можно сортировать список пользователей, выполнять их поиск , 
распределять пользователей по группам и выбирать пользователей из 
списка или из дерева групп. Дополнительные сведения см. в разделе 
“Выбор пользователей" на стр. 58.

Выберите пользователей или группы пользователей, которым необходимо 
отправить сообщение по электронной почте, и нажмите кнопку OK. 

 3 В поле Subject введите тему сообщения электронной почты. По умолчанию 
при выборе только одного дефекта в поле Subject отображаютсядомен, 
проект, идентификатор дефекта и его краткое описание.

 4 В поле Items можно удалять любые элементы, которые нет необходимости 
включать в сообщение электронной почты.

 5 Выберите, следует ли включать элементы Attachments и/или History 
дефекта.

 6 В поле Additional comments добавьте необходимые комментарии.
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 7 В диалоговом окне можно проверить правописание.

➤ Нажмите кнопку Check Spelling, чтобы проверить правописание 
выбранного слова или текста. При отсутствии ошибок открывается 
подтверждающее сообщение. При обнаружении ошибок открывается 
диалоговое окно Spelling, в котором отображается неправильно 
написанное слово вместе с предложениями по замене.

➤ Чтобы открыть диалоговое окно Spelling Options, в котором можно 
настроить параметры проверки правописания Quality Center, нажмите 
кнопку  Spelling Options. 

➤ Чтобы открыть диалоговое окно Thesaurus и отобразитьдля выбранного 
слова синонимы, антонимы или связанные слова, нажмите кнопку 
Thesaurus. Можно заменить выбранное слово или найти новое.

 8 Чтобы настроить сообщение электронной почты, щелкните Custom. В 
диалоговом окне Select Fields укажите, какие поля следует включить в 
сообщение электронной почты.

 9 Чтобы отправить сообщение электронной почты, нажмите кнопку Send.

Копирование дефектов
Можно копировать дефекты в любой проект Quality Center.

Чтобы скопировать дефект, выполните следующие действия:

 1 В таблице Defects Grid выберите дефект, который необходимо 
скопировать. Для копирования нескольких дефектов нажмите и 
удерживайте клавишу CTRL и выберите дефекты, которые необходимо 
скопировать.

 2 Выберите Edit > Copy. Альтернативный вариант — щелкните правой 
кнопкой мыши и выберите Copy.

 3 В таблице Defects Grid в том проекте, в который необходимо скопировать 
дефекты, выберите Edit > Paste. Альтернативный вариант — щелкните 
правой кнопкой мыши и выберите Paste.
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Копирование URL-адресов дефектов
Можно скопировать дефект и вставить его URL-адрескак ссылку. Сам 
дефект скопирован не будет. Вместо этого можно вставить адрес в другое 
место, такое как сообщение электронной почты или документ. Если 
щелкнут такую ссылку, откроется окноQuality Center, содержащее дефект. 

Чтобы скопировать URL-адрес дефекта, выполните следующие 
действия:

 1 В таблице Defects Grid выберите дефект. 

 2 Выберите Edit > Copy URL. Альтернативный вариант — щелкните правой 
кнопкой мыши и выберите Copy URL.

 3 Вставьте URL.

Распечатка дефектов
В таблице Defects Grid можно распечатать все или выбранные дефекты.

Чтобы распечатать дефекты, выполните следующие действия:

 1 Можно распечатать все или выбранные дефекты:

➤ Для печати всех дефектов выберите Defects > Print > All.

➤ Для печати выбранных дефектов выберите их с помощью клавиш CTRL 
или SHIFT, а затем выберите Defects > Print > Selected. 

Откроется диалоговое окно предварительного просмотра печати. 

 2 С помощью кнопок на панели инструментов отрегулируйте и настройте 
страницу пред печатью.

 3 Нажмите кнопку Print или выберите File > Print.
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Удаление дефектов
Можно удалять старые дефекты или дубликаты дефектов из проекта. 
После удаления дефекта Quality Center не использует идентификатор 
данного дефекта повторно.

Чтобы удалить дефект, выполните следующие действия:

 1 В таблице Defects Grid выберите подлежащий удалению дефект.

 2 Нажмите кнопку Delete или выберите команду Edit > Delete. 
Альтернативный вариант — щелкните дефект правой кнопкой мыши и 
выберите Delete.

 3 Для подтверждения щелкните Yes.
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32
Связывание дефектов

Дефекты можно связывать с любым другим объектом в Quality Center. 

Сведения о связывании дефектов
Дефект можно связать со следующими объектами: требованиями, тестами, 
наборами тестов, экземплярами тестов, выполнениями тестов, шагами 
тестов и другими дефектами. Связывание дефектов удобно, например, при 
создании нового теста для отслеживания конкретного дефекта. Создав 
такую связь, можно задать выполнение теста в зависимости от статуса 
дефекта. 

Дефекты могут быть связаны с объектами напрямую или косвенно. При 
добавлении связи дефекта к объекту Quality Center добавляет прямую 
связь к такому объекту и косвенные связи к другим объектам. Кроме того, 
при добавлении дефекта во время выполнения ручного теста Quality Center 
автоматически создает связь между выполнением теста и новым 
дефектом.

Глава содержит следующие разделы: На стр.

Сведения о связывании дефектов 471

Просмотр связей дефектов 474

Добавление связей дефектов 475

Удаление связей дефектов 477
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На приведенной ниже схеме показан процесс косвенного связывания:

Например, при связывании дефекта с шагом выполнения теста, 
Quality Center добавляет косвенную связь к выполнению теста, экземпляру 
теста, набору тестов и тесту. В том случае, если этот тест покрывается 
требованием, косвенная связь добавляется также к требованию. Учтите, 
что косвенное связывание представляет собой однонаправленный 
процесс. Например, при связывании дефекта с выполнением теста дефект 
не является косвенно связанным с шагами выполнения теста.
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Просматривать связи дефектов и управлять ими можно с помощью 
диалогового окна или вкладки Linked Defects.

Таблица Linked Defects содержит следующие столбцы:

Столбец Описание

Created By Имя пользователя, создавшего связь.

Creation Date Дата создания связи.

Defect ID Уникальный числовой идентификатор дефекта, 
автоматически назначенный в среде Quality Center. 
Идентификатор дефекта доступен только для чтения.

Link Comment Позволяет добавлять комментарии к связи.

Link ID Уникальный числовой идентификатор связи, 
автоматически назначенный в среде Quality Center. 
Идентификатор связи доступен только для чтения.
473



Глава 32 • Связывание дефектов
Дополнительные сведения о полях дефектов см. раздел “Таблица Defects 
Grid" на стр. 446.

Просмотр связей дефектов
Можно фильтровать связи, задавать размеры столбцов и порядок их 
расположения в таблице, а также обновлять информацию, отображаемую 
в ней. Кроме того, предусмотрена возможность просмотра подробных 
сведений о дефекте и задания команды Quality Center перейти к модулю и 
выделить в нем связанной объект.

➤ Для обновления информации, отображаемой в таблице, нажмите кнопку 
Refresh All. 

➤ Для фильтрации и сортировки связей дефектов нажмите кнопку Set 
Filter/Sort. Подробные сведения о фильтрации и сортировке приведены в 
разделе “Фильтрация записей" на стр. 59. При задании фильтра его 
описание отображается над таблицей.

➤ Для задания размеров столбцов и порядка их расположения в таблице 
нажмите кнопку Select Columns. Дополнительные сведения см. в разделе 
“Упорядочивание столбцов" на стр. 55.

Link Type Значение настраиваемого списка Link Type. 
Дополнительные сведения о списках см. Руководство 
администратора HP Quality Center.

Linked By Status Текущий статус связанного объекта.

Linked Entity ID Уникальный числовой идентификатор связанного 
объекта, автоматически назначенный в среде 
Quality Center. Идентификатор связанного объекта 
доступен только для чтения.

Linked Entity Name Имя связанного объекта. Например, имя требования.

Link Entity Type Тип связанного объекта (например, шаг, тест, набор 
тестов).

Столбец Описание
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➤ Для просмотра подробных сведений о дефекте выберите связь дефекта и 
нажмите кнопку Defect Details. Откроется диалоговое окно Defect Details. 
Дополнительные сведения см. в разделе “Обновление дефектов" на 
стр. 458.

➤ Чтобы открыть модуль Defects и выделить связанный дефект, выберите 
связь дефекта. Нажмите кнопку Go To  и выберите Go To Defect. 

Альтернативный вариант —щелкните ссылку Defect ID, чтобы открыть 
модуль Defects и выделить в нем связанный дефект.

➤ Чтобы открыть соответствующий модуль и выделить связанный объект, 
выберите связь дефекта. Нажмите кнопку Go To и выберите Go To ‘Linked 
By’ Entity.

Альтернативный вариант — щелкните ссылку Linked Entity Name, чтобы 
открыть соответствующий модуль и выделить в нем связанный объект.

➤ Чтобы отобразить прямые связи, выберите Direct Links в списке типов 
связей Type of Link. Для отображения прямых и косвенных связей выберите 
All Links. В модуле Defects данный параметр недоступен.

➤ Чтобы отобразить связи дефектов, добавленных к родительским 
требованиям, выберите Current Req Links в списке Show Links For. Чтобы 
отобразить связи дефектов, добавленных к родительским или дочерним 
требованиям, выберите Including Child’s Links. Данный параметр 
доступен только в модуле Requirements.

Добавление связей дефектов
Добавить дефект можно либо представив новый дефект, либо  выбрав 
существующий дефект. При связывании объекта с дефектом 
Quality Center добавляет к объекту и связанному дефекту значок . 
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Добавление связей путем представления новых дефектов
Добавить связь дефекта можно путем добавления нового дефекта.

Чтобы добавить связь путем добавления нового дефекта выполните 
следующие действия:

 1 На вкладке или в диалоговом окне Linked Defects нажмите кнопку Add and 
Link Defect  или щелкните правой кнопкой мыши таблицу и выберите во 
всплывающем меню команду Add and Link Defect. Откроется диалоговое 
окно New Defect.

 2 Введите сведения о дефекте. Подробные сведения о добавлении 
дефектов приведены в разделе “Добавление новых дефектов" на стр. 451. 

 3 В диалоговом окне New Defect нажмите кнопку Submit. Дефект будет 
добавлен в проект, а его связь отобразится в таблице Linked Defects.

Добавление связей путем выбора существующих 
дефектов
Добавить связь дефекта можно путем выбора существующего дефекта.

Чтобы добавить связь путем выбора существующего дефекта, 
выполните следующие действия.

 1 На вкладке или в диалоговом окне Linked Defects нажмите кнопку Link 
Existing Defect  или щелкните правой кнопкой мыши таблицу и выберите 
во всплывающем меню команду Link Existing Defect. 

 2 Выберите вариант By ID или Select.

➤ Чтобы добавить связь путем ввода идентификатора дефекта, выберите 
By ID. В диалоговом окне Link Existing Defect введите идентификатор 
дефекта и нажмите кнопку Link. Связь дефекта отобразится в таблице.

➤ Чтобы добавить связь путем выбора дефекта, выберите Select. 
Выберите дефект в диалоговом окне Defects to Link. Для выбора 
нескольких дефектов нажмите и удерживайте клавишу CTRL и выберите 
подлежащие связыванию дефекты. Нажмите кнопку Link. Связи 
дефектов отобразятся в таблице.
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Удаление связей дефектов
Связи дефектов из таблицы Linked Defects можно удалить.

Примечание. Можно удалять только прямые связи. Косвенные связи 
удаляются автоматически после удаления прямых связей.

Чтобы удалить связь дефекта, выполните следующие действия.

 1 В таблице на вкладке или в диалоговом окне Linked Defects выберите 
связь. Для выбора нескольких дефектов нажмите и удерживайте клавишу 
Ctrl и выберите дефекты, которые необходимо удалить.

 2 Нажмите кнопку Remove Link  или щелкните правой кнопкой мыши и 
выберите Remove Link.

 3 Для подтверждения нажмите кнопку Yes.
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33
Создание отчетов 

Отчеты можно создавать в любом модуле среды Quality Center.

Сведения о создании отчетов
Отчеты Quality Center помогают анализировать процесс определения 
требований и тестового покрытия, планирования тестирования, 
выполнения тестов и отслеживания дефектов. Такие отчеты можно 
использовать в качестве вспомогательного средства для определения 
приоритетов тестирования и разработки расписания устранения дефектов, 
а также назначения дат выпуска приложений. Пользователь может 
создавать отчеты в любое время в процессе тестирования.

Отчеты можно создавать в модулях Requirements, Test Plan, Test Lab и 
Defects. Можно отображать отчеты с параметрами по умолчанию или 
настраивать их. При настройке можно применять фильтры и условия 
сортировки, а также определять компоновку полей отчета. Кроме того, 
пользователь может настроить отчет путем добавления в него суботчетов. 
Подробнее о настройке отчетов см. “Настройка отчетов" на стр. 489.

Глава содержит следующие разделы: На стр.

Сведения о создании отчетов 481

Доступные отчеты и суботчеты 482

Создание отчетов 486

Настройка отчетов 489
481



Глава 33 • Создание отчетов
Пользователь может сохранить собственные настройки отчетов в качестве 
избранных представлений и загружать их при необходимости. Также 
пользователь может сохранять отчеты в виде текстовых файлов или 
документов HTML. Кроме того, предусмотрена возможность экспорта 
данных в Microsoft Excel.

Примечание. Пользователь может экспортировать данные таблицы в виде 
текстового файла, рабочей таблицы Microsoft Excel, документа Microsoft 
Word или HTML. Возможен экспорт данных из таблиц Requirements, Test, 
Execution или Defects Grid. Дополнительные сведения см. в разделе 
“Экспорт данных в файл" на стр. 78.

Доступные отчеты и суботчеты
Пользователь может создавать отчеты в модулях Requirements, Test Plan, 
Test Lab и Defects. В каждый отчет можно добавлять суботчеты.

Доступные отчеты
Пользователь может создавать отчеты в модулях Requirements, Test Plan, 
Test Lab и Defects.

Отчеты модуля Requirements
В модуле Requirements доступны следующие отчеты:

Отчет Описание

Standard Requirements Перечень требований, отображающихся в дереве 
требований. 

Tabular Отображение требований из дерева в виде таблицы. 

Requirements with 
Coverage Tests

Отображение перечня требований из дерева и 
сведений о покрытии этих требований тестами. 
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Отчеты модуля Test Plan
В модуле Test Plan доступны следующие отчеты: 

Requirements with 
Coverage Tests and 
Steps

Отображение перечня требований из дерева и 
сведений о покрытии этих требований тестами. Кроме 
того, отображаются шаги тестов из каждого тестового 
покрытия. 

Requirements with 
Linked Defects

Перечень требований из дерева вместе со 
связанными с ними дефектами. 

Requirements with 
Traceability

 Перечень требований из дерева вместе со с 
вязанными с ними требованиями, к которым 
выполняется отслеживание и от которых выполняется 
отслеживание. 

Отчет Описание

Standard Test Planning Перечень тестов дерева плана тестирования.

Subject Tree Перечень тестов дерева плана тестирования по 
объектам.

Tests with Design 
Steps

Перечень тестов дерева плана тестирования, 
включая шаги тестов.

Tests with Covered 
Requirements

Перечень тестов дерева плана тестирования вместе 
со сведениями о покрытии требований тестами. 

Tests with Linked 
Defects

Перечень тестов дерева плана тестирования вместе 
со связанными с ними дефектами.

Отчет Описание
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Отчеты модуля Test Lab
В модуле Test Lab доступны следующие отчеты:

Отчеты модуля Defects
В модуле Defects доступны следующие отчеты:

Отчет Описание

Current Test Set Перечень тестов текущего набора тестов.

Cross Test Set Перечень наборов тестов списка Test Sets без 
указания содержащихся в них тестов.

Test Set Hierarchy with 
Tests

Перечень наборов тестов в иерархическом порядке с 
указанием статуса каждого набора тестов. 

Cross Test Set with 
Tests

Перечень наборов тестов списка Test Sets с 
указанием содержащихся в них тестов.

Current Test Set with 
Failed Test Runs

Перечень тестов текущего набора тестов с 
состоянием выполнения «Failed».

Cross Test Set with 
Failed Test Runs

Перечень тестов всех наборов тестов со статусом 
«Failed».

Execution Notification Перечень тестов текущего набора тестов с 
результатами последнего выполнения.

Отчет Описание

Standard Defects Перечень дефектов в проекте. 

Tabular Defects Отображение дефектов в проекте в виде таблицы.

Defects with Linked 
Tests and Runs

Перечень дефектов со связанными с ними тестами и 
результатами выполнения тестов.

Fixed or Rejected 
Defects

Перечень дефектов со статусом‘Fixed’ или ‘Rejected’.
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Доступные суботчеты
Каждый отчет может содержать суботчеты. Кроме того, сами суботчеты 
могут содержать другие суботчеты. То, какие суботчеты доступны, зависит 
от типа родительского отчета.

Могут быть доступны следующие суботчеты:

Fixed or Rejected 
Defects Detected by 
Current User

Перечень дефектов со статусом ‘Fixed’ или ‘Rejected’, 
выявленных текущим пользователем.

Opened Defects 
Assigned to Current 
User

Перечень дефектов со статусом ‘Open’, назначенных 
текущему пользователю.

Отчет Описание

Contained Tests Перечень тестов из набора.

Coverage 
Requirements

Перечень сведений о требованиях, покрывающих 
тест.

Design Steps Перечень шагов теста.

Linked Defects Перечень дефектов, связанных с записью.

Linked Entities Перечень всех объектов, связанных с дефектом.

Parent Test Перечень родительских тестов теста.

Related Defects Перечень связанных дефектов для каждого объекта 
дерева плана тестирования.

Related Requirements Перечень требований, связанных с дефектом.

Requirements 
Coverage

Перечень тестов, покрывающих требования.

Run Steps Перечень шагов выполнения теста.

Runs Перечень всех выполнений теста.

Отчет Описание
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Создание отчетов 
Отчеты можно создавать в модулях Requirements, Test Plan, Test Lab и 
Defects. В зависимости от текущего модуля доступны различные 
параметры отчетов. Можно либо использовать отчет по умолчанию, либо 
настраивать его в соответствии с потребностями пользователя.

Для создания отчета:

 1 Выберите тот модуль Quality Center, в котором необходимо создать отчет.

 2 Выберите Analysis > Reports, а затем — тип отчета, который необходимо 
создать. Дополнительные сведения о типах отчетов см. в “Доступные 
отчеты" на стр. 482.

Совет. Для некоторых записей можно создавать ‘быстрые отчеты’. 
Дополнительные сведения см. в разделе “Создание "быстрых отчетов"" на 
стр. 488.

Source Execution Test Перечень выполненных тестов, связанных с 
дефектом.

Source Run Перечень выполнений теста, связанных с дефектом.

Source Test Перечень тестов, связанных с дефектом.

Trace To Перечень требований, отслеживаемых к текущему 
требованию.

Trace From Перечень требований, отслеживаемых от текущего 
требования.

Отчет Описание
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Откроется отчет с данными по умолчанию. 

 3 Чтобы отобразить первую страницу отчета, нажмите кнопку First Page или 
нажмите кнопку Previous Page , чтобы отобразить предыдущую страницу.

 4 Чтобы отобразить следующую страницу отчета, нажмите кнопку Next Page  
или нажмите кнопку Last Page , чтобы отобразить последнюю страницу.

 5 Чтобы настроить отчет, нажмите кнопку Configure Report and Sub-
Reports. Дополнительные сведения см. в разделе “Настройка отчетов" на 
стр. 489.

 6 Чтобы создать отчет, в котором будут приведены самые последние 
сведения, нажмите кнопку Generate Report.

 7 Чтобы распечатать отчет, щелкните стрелку Print  и выберите Current 
Page или 
All Pages. Откроется диалоговое окно Print. При необходимости измените 
настройки принтера. Нажмите кнопку Print.
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 8 Чтобы сохранить отчет, щелкните стрелку Save и выберите Current Page 
или All Pages. Откроется диалоговое окно Save Web Page. При 
необходимости измените имя файла. Чтобы сохранить отчет в его 
исходном формате, выберите параметр Web Page, complete  в списке 
Save as type. Чтобы сохранить отчет как текстовый файл, выберите Text 
File и нажмите кнопку Save.

 9 Чтобы экспортировать все данные отчета в Microsoft Excel, щелкните отчет 
правой кнопкой мыши и выберите Export to Microsoft Excel. Для экспорта 
данных на компьютере должен быть установлен Excel.

 10 Чтобы сохранить параметры отчета в виде избранного представления, 
нажмите кнопку Add to Favorites. Дополнительные сведения см. в главе 
Глава 6, "Работа с избранными представлениями".

 11 Нажмите кнопку Close, чтобы закрыть отчет и вернуться в текущий модуль 
Quality Center.

Создание "быстрых отчетов"
Для некоторых записей можно создавать ‘"быстрые отчеты"’. Кроме того, в 
модуле Requirements можно создавать ‘"быстрые отчеты"’ для требования 
и его дочерних объектов.

Примечание. Просмотр "быстрого отчета" для нескольких узлов в дереве 
плана тестирования невозможен. 

Для создания «быстрого отчета»:

 1 Выберите требования, тесты или дефекты, для которых необходимо 
создать отчет. Чтобы создать отчет для нескольких записей, нажмите 
клавишу Ctrl и выберите записи, для которых необходимо создать отчет.

 2 Создайте отчет, выбрав один из следующих вариантов: 

➤ Чтобы создать отчет для выбранных записей, выберите Analysis > 
Report Selected. Альтернативный вариант — щелкните записи правой 
кнопкой мыши и выберите Report Selected. Откроется отчет с данными 
по умолчанию для выбранных записей.
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➤ Чтобы создать "быстрый отчет" в модуле Requirements для требования 
и его дочерних объектов, выберите Analysis > Report Selected with 
Children. Альтернативный вариант — щелкните требование правой 
кнопкой мыши и выберите Report Selected with Children. Откроется 
отчет с данными для выбранного требования и его дочерних объектов.

Настройка  отчетов
Можно определить внешний вид и содержимое отчетов Quality Center.

Для настройки отчета:

 1 Выберите тот модуль Quality Center, в котором необходимо создать отчет.

 2 Выберите Analysis > Reports, а затем — отчет, который необходимо 
настроить. Дополнительные сведения о типах отчетов см. в “Доступные 
отчеты" на стр. 482. Откроется отчет с данными по умолчанию.
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 3 Чтобы настроить отчет, нажмите кнопку Configure Report and Sub-
Reports. Откроется страница Report Configuration с параметрами по 
умолчанию.

 4 В списке Reports выберите основной отчет или суботчет. Откроется 
область Report Configuration с доступными параметрами.

 5 Под Page настройте количество элементов, которые будут отображаться 
на одной странице (доступно для основного отчета):

➤ Чтобы ограничить количество элементов, отображаемых на одной 
странице, выберите Limit items per page to и задайте количество 
элементов.

➤ Чтобы отобразить все элементы на одной странице, выберите All items 
in one page.

 6 Под Template выберите шаблон отчета Quality Center по умолчанию или 
свой собственный шаблон. (Данный параметр доступен только для 
основного отчета.)
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 7 Под Filter можно задавать или очищать фильтры и приоритеты сортировки: 

➤ Нажмите кнопку Set Filter/Sort, чтобы выполнить фильтрацию и 
сортировку данных в соответствии с выбранными критериями.

➤ Нажмите кнопку Clear Filter/Sort, чтобы сбросить все фильтры и 
приоритеты сортировки.

Подробнее см. Глава 3, "Работа с данными Quality Center".

 8 Под Fields настройте те поля, которые будут использоваться в отчете, и 
порядок их отображения.

➤ Чтобы вывести на отображение все поля, выберите All Fields (auto-
layout).

➤ Чтобы выбрать поля и настроить порядок их отображения, выберите 
Custom Fields (layout) и нажмите кнопку Select Fields. Дополнительные 
сведения см. в разделе “Упорядочивание столбцов" на стр. 55.

 9 Также можно выбрать следующие параметры. Не все параметры доступны 
для всех модулей.

Параметр Описание

Grid View Отображение отчета в виде таблицы.

Attachments Отображение списка связанных вложений.

History Отображение списка изменений, внесенных в 
требование, тест или дефект.

Keep Parent-Child Order Отображение раздела требования с дочерним 
требованием под ним. Если выбран данный 
параметр, задать фильтры или приоритеты 
сортировки невозможно. 

Show Paragraph Number Отображение иерархического номера, назначенного 
каждому требованию в дереве. Номера не связаны 
с уникальным идентификатором Req ID, 
назначенным каждому требованию. 

Rich Text Включение в отчет текста требований формате 
RTF.
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 10 Чтобы добавить суботчет, нажмите кнопку Add Sub-Report. В списке Type 
выберите тип суботчета и нажмите кнопку OK. Суботчет будет добавлен в 
список Reports. Дополнительные сведения о доступных типах суботчетов 
см. в “Доступные суботчеты" на стр. 485.

 11 Чтобы удалить суботчет, выберите его и нажмите кнопку Delete Sub-
Report.

 12 Чтобы создать новый отчет, нажмите кнопку Apply.

Show Full Coverage Отображение тестового покрытия для каждого 
требования из дерева. 

Show Steps only for 
"Failed" Runs 

Отображение шагов тестов только для неуспешных 
выполнений тестов. 

Show Test Set Name Отображение имени набора тестов в сведениях о 
выполнении тестов.

Параметр Описание
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Создание диаграмм

Можно создавать диаграммы для просмотра данных проекта Quality Center 
в графическом виде.

Сведения о создании диаграмм
С помощью диаграмм Quality Center можно быстро принимать решения и 
просматривать связи между различными данными проекта. Создавать 
диаграммы можно на любом этапе процесса тестирования с тем, чтобы 
проверять выполнение требований к тестированию, планирование и 
проведение тестирования, а также отслеживать дефекты приложения. 
После создания диаграммы можно настраивать ее свойства таким 
образом, чтобы данные отображались в соответствии с условиями 
пользователя. 

Глава содержит следующие разделы: На стр.

Сведения о создании диаграмм 493

Quality Center Типы диаграмм 494

Создание диаграмм 514

Пользовательская настройка содержимого диаграммы 519

Настройка параметров диаграмм 525

Пользовательская настройка описания диаграмм 530
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Quality Center Типы диаграмм
Quality Center позволяет создавать диаграммы в модулей Requirements, 
Test Plan, Test Lab и Defects.

Диаграммы модуля Requirements
В модуле Requirements можно создавать следующие диаграммы:

Диаграмма Описание

Requirements - 
Summary Graph

Отображает общее количество текущих требований в 
проекте Quality Center. Дополнительные сведения см. в 
разделе “Requirements - Summary Graph" на стр. 497.

Requirements - 
Progress Graph

Отображает данные о количестве требований, 
накопленных в проекте Quality Center в определенных 
точках за тот или иной период времени. Дополнительные 
сведения см. в разделе “Requirements - Progress Graph" 
на стр. 498.

Requirements - 
Coverage Graph

Отображает общее количество текущих требований в 
проекте Quality Center в соответствии со статусом 
тестового покрытия. Дополнительные сведения см. в 
разделе “Requirements - Coverage Graph" на стр. 499.

Requirements - 
Trend Graph

Отображает историю изменения содержимого тех или 
иных полей требований в проекте Quality Center для 
каждого отображаемого временного интервала. 
Дополнительные сведения см. в разделе “Requirements - 
Trend Graph" на стр. 501.
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Диаграммы модуля Test Plan
В модуле Test Plan можно создавать следующие диаграммы:

Диаграммы модуля Test Lab
В модуле Test Lab можно создавать следующие диаграммы:

Диаграмма Описание

Test Planning - 
Summary Graph

Отображает общее количество текущих тестов в проекте 
Quality Center. Дополнительные сведения см. в разделе 
“Test Planning - Summary Graph" на стр. 502.

Test Planning - 
Progress Graph

Отображает данные о количестве тестов, накопленных в 
проекте Quality Center в определенных точках за тот или 
иной период времени. Дополнительные сведения см. в 
разделе “Test Planning - Progress Graph" на стр. 503.

Test Planning - 
Trend Graph

Отображает историю изменений в тех или иных полях 
плана тестирования в проекте Quality Center для каждого 
отображаемого временного интервала. Дополнительные 
сведения см. в разделе “Test Planning - Trend Graph" на 
стр. 504.

Диаграмма Описание

Test Execution - 
Summary Graph 
(Current Test Set)

Отображает количество тестов проекта Quality Center, 
относящихся к текущему набору тестов. Дополнительные 
сведения см. в разделе “Test Execution - Summary Graph 
(Current Test Set)" на стр. 505.

Test Execution - 
Progress Graph 
(Current Test Set) 

Отображает данные о количестве тестов, накопленных в 
текущем наборе тестов в определенных точках за тот или 
иной период времени. Дополнительные сведения см. в 
разделе “Test Execution - Progress Graph (Current Test 
Set)" на стр. 506.
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Диаграммы модуля Defects
В модуле Defects можно создавать следующие диаграммы:

Test Execution - 
Summary Graph 
(Cross Test Set)

Отображает количество тестов проекта Quality Center, 
относящихся ко всем наборам тестов. Дополнительные 
сведения см. в разделе “Test Execution - Summary Graph 
(Cross Test Set)" на стр. 507.

Test Execution - 
Progress Graph 
(Cross Test Set)

Отображает данные о количестве тестов, накопленных 
во всех наборах тестов в определенных точках за тот или 
иной период времени. Дополнительные сведения см. в 
разделе “Test Execution - Progress Graph (Cross Test Set)" 
на стр. 508.

Диаграмма Описание

Defects - Summary 
Graph

Отображает общее количество дефектов в проекте 
Quality Center или расчетное/фактическое количество 
времени, необходимого для устранения этих дефектов. 
Дополнительные сведения см. в разделе “Defects - 
Summary Graph" на стр. 509.

Defects - Progress 
Graph

Отображает количество накопленных в проекте 
Quality Center дефектов или расчетное/фактическое 
количество времени, необходимого для устранения этих 
дефектов в определенных точках за тот или иной период 
времени. Дополнительные сведения см. в разделе 
“Defects - Progress Graph" на стр. 510.

Defects - Age Graph Отображает период существования дефектов в проекте 
Quality Center. Дополнительные сведения см. в разделе 
“Defects - Age Graph" на стр. 511.

Defects - Trend 
Graph

Отображает историю изменений в тех или иных полях 
дефектов в проекте Quality Center для каждого 
отображаемого временного интервала. Дополнительные 
сведения см. в разделе “Defects - Trend Graph" на 
стр. 513.

Диаграмма Описание
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Requirements - Summary Graph 
Диаграмма Requirements - Summary Graph отображает общее количество 
текущих требований в проекте Quality Center. Количество требований 
отображается в соответствии с критериями, заданными пользователем. 
Пользователь может задать тип данных, отображаемых по оси Х, и 
сведения о требованиях, в соответствии с которыми Quality Center будет 
группировать данные. 

Например, для отображения количества требований, существующих в 
проекте, по их авторам необходимо выбрать параметр Author по оси X. 
Чтобы сгруппировать требования в столбцы диаграммы в соответствии с 
уровнем их приоритета, необходимо выбрать параметр Priority из списка 
Grouped By. Чтобы включить в диаграмму родительские требования со 
статусом ‘Not Covered’, необходимо установить флажок Show ‘Not 
Covered’ parents. Нажмите кнопку Refresh, чтобы обновить отображение 
диаграммы.

Дополнительные сведения о настройке диаграммы Requirements - 
Summary Graph см. в “Пользовательская настройка сводных диаграмм" на 
стр. 520. 

По умолчанию диаграммы отображаются в виде гистограмм. Чтобы 
отобразить круговую диаграмму, выберите вкладку Pie Chart.
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Requirements - Progress Graph 

Диаграмма Requirements - Progress Graph отображает количество 
требований, накопленных в проекте Quality Center в определенных точках 
за тот или иной период времени. Количество требований отображается в 
соответствии с критериями, заданными пользователем. Пользователь 
может задать временной интервал, отображаемый по оси Х, и сведения о 
требованиях, в соответствии с которыми Quality Center будет группировать 
данные. Также можно указать, что необходимо выводить на отображение 
— количество требований или изменения в количестве требований. 

Например, чтобы сгруппировать отображаемые требования в соответствии 
со статусом тестового покрытия, необходимо выбрать параметр Direct 
Cover Status из списка Group By. Под Period выберите Last 5 weeks, 
чтобы этот интервал (последние 5 недель) отображался по оси Х. (На 
диаграмме отображаются данные, замеряемые в последний день каждой 
недели.) Под Display Options выберите Regular, чтобы просмотреть 
количество требований, а не изменения в количестве требований. Нажмите 
кнопку Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Requirements - Progress 
Graph см. в “Настройка диаграмм выполнения" на стр. 521. 

Диаграмму можно вывести на отображение только в виде линейного 
графика.
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Requirements - Coverage Graph 

Диаграмма Requirements - Coverage Graph отображает общее количество 
текущих требований в проекте Quality Center в соответствии со статусом 
тестового покрытия.

Пользователь может задать сведения о требованиях, в соответствии с 
которыми Quality Center будет группировать данные. Например, чтобы 
сгруппировать требования в столбцы диаграммы в соответствии с уровнем 
их приоритета, необходимо выбрать параметр Priority из списка Grouped 
By. Чтобы включить в диаграмму родительские требования со статусом 
‘Not Covered’, необходимо установить флажок Show ‘Not Covered’ parents. 
Нажмите кнопку Refresh, чтобы обновить отображение диаграммы.

Примечание. Диаграмма Requirements - Coverage Graph представляет 
собой сводную диаграмму специального типа. При выборе другого поля 
требования по оси Х отображается стандартная диаграмма Requirements - 
Summary Graph.
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Дополнительные сведения о пользовательской настройке диаграммы 
Requirements - Coverage Graph см. в “Пользовательская настройка сводных 
диаграмм" на стр. 520. 

По умолчанию диаграммы выводятся в виде гистограмм. Чтобы вывести на 
отображение круговую (секторную) диаграмму, выберите вкладку Pie 
Chart.
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Requirements - Trend Graph 

Диаграмма Requirements - Trend Graph отображает историю изменений в 
тех или иных полях требований в проекте Quality Center для каждого 
отображаемого временного интервала. Можно задать поле, по которому 
будет осуществляться просмотр количества изменений, а также период 
времени для просмотра данных. 

Например, чтобы вывести на отображение количество изменений, 
внесенных в поле ‘Direct Cover Status’, необходимо выбрать параметр 
Direct Cover Status в списке Count Changes in Field. Под Period выберите 
Last 5 weeks, чтобы этот интервал (последние 5 недель) отображался по 
оси Х. (На диаграмме отображаются сводные данные для каждой недели.) 
Нажмите кнопку Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Requirements - Trend 
Graph см. в “Настройка диаграмм тенденций" на стр. 524. 

Каждое изменение статуса для этой диаграммы записывается только один 
раз. Например, если статус поля был изменен с ‘Not Completed’ на ‘Passed’, 
а затем опять на ‘Not Completed’, в эту диаграмму один раз будет записан 
только статус ‘Not Completed’.

Диаграмму Requirements - Trend Graph можно отображать только в виде 
гистограммы.
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Test Planning - Summary Graph 

Диаграмма Test Planning - Summary Graph отображает общее количество 
текущих тестов в проекте Quality Center. Количество тестов отображается в 
соответствии с критериями, заданными пользователем. Пользователь 
может задать тип данных, отображаемых по оси Х, и сведения о плане 
тестирования, в соответствии с которыми Quality Center будет 
группировать данные. 

Например, для отображения количества тестов, существующих в проекте, 
по их проектировщикам необходимо выбрать параметр Designer по оси X. 
Чтобы сгруппировать тесты в столбцы диаграммы в соответствии с 
уровнем их приоритета, необходимо выбрать параметр Priority из списка 
Grouped By. Нажмите кнопку Refresh, чтобы обновить отображение 
диаграммы.

Дополнительные сведения о настройке диаграммы Test Planning - Summary 
Graph см. в “Пользовательская настройка сводных диаграмм" на стр. 520. 

По умолчанию диаграммы выводятся в виде гистограмм. Чтобы отобразить 
круговую диаграмму, выберите вкладку Pie Chart.
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Test Planning - Progress Graph
Диаграмма Test Planning - Progress Graph отображает количество тестов, 
накопленных в проекте Quality Center в определенных точках за тот или 
иной период времени. Количество тестов отображается в соответствии с 
критериями, заданными пользователем. Пользователь может задать 
временной интервал, отображаемый по оси Х, и сведения о плане 
тестирования, в соответствии с которыми Quality Center будет 
группировать данные. Также можно указать, что необходимо отобрахать — 
количество тестов или изменения в количестве тестов. 

Например, чтобы сгруппировать отображаемые тесты в соответствии с 
уровнем их приоритета, необходимо выбрать параметр Status из списка 
Group by. Под Period выберите All days и Show daily info, чтобы по оси Х 
отображался каждый день. Под Display Options выберите Regular, чтобы 
просмотреть количество тестов, а не изменения в количестве тестов. 
Нажмите кнопку Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Test Planning - Progress 
Graph см. в “Настройка диаграмм выполнения" на стр. 521. 

Диаграмму можно отобразить только в виде линейного графика. 
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Test Planning - Trend Graph
Диаграмма Test Planning - Trend Graph отображает историю изменений в 
тех или иных полях плана тестирования в проекте Quality Center для 
каждого отображаемого временного интервала. Можно задать поле, по 
которому будет осуществляться просмотр количества изменений, а также 
период времени для просмотра данных. 

Например, чтобы отобразить количество изменений, внесенных в поле 
‘Status’ плана тестирования, необходимо выбрать параметр Status в 
списке Count changes in field. Под Period выберите Last 5 weeks, чтобы 
этот интервал (последние 5 недель) отображался по оси Х. (На диаграмме 
отображаются суммированные данные, измеренные для каждой недели.) 
Нажмите кнопку Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Test Planning - Trend 
Graph см. в “Настройка диаграмм тенденций" на стр. 524. 

Каждое изменение статуса для этой диаграммы записывается только один 
раз. Например, если статус поля был изменен с ‘Ready’ на ‘Repair’, а затем 
опять на ‘Ready’, в эту диаграмму один раз будет записан только статус 
‘Ready’.

Диаграмму Test Planning - Trend Graph можно вывести на отображение 
только в виде гистограммы.
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Test Execution - Summary Graph (Current Test Set)
Диаграмма Test Execution - Summary Graph (Current Test Set) отображает 
количество тестов проекта Quality Center, относящихся к текущему набору 
тестов. Количество тестов отображается в соответствии с критериями, 
заданными пользователем. Пользователь может задать тип данных, 
отображаемых по оси Х, и сведения о плане тестирования и тесте набора 
тестов, в соответствии с которыми Quality Center будет группировать 
данные. 

Например, для отображения количества тестов, существующих в проекте, 
по их статусу необходимо выбрать параметр Status по оси X. Выберите 
параметр Plan: Priority из списка Grouped By, чтобы сгруппировать тесты 
в столбцы диаграммы в соответствии с уровнем их приоритета. Нажмите 
кнопку Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграмма Test Execution - 
Summary Graph (Current Test Set) см. в “Пользовательская настройка 
сводных диаграмм" на стр. 520.

По умолчанию диаграммы отображаются в виде гистограмм. Чтобы 
отобразить круговую диаграмму, выберите вкладку Pie Chart.
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Test Execution - Progress Graph (Current Test Set)
Диаграмма Test Execution - Progress Graph (Current Test Set) отображает 
количество тестов, накопленных в текущем наборе тестов в определенных 
точках за тот или иной период времени. Количество тестов отображается в 
соответствии с критериями, заданными пользователем. Пользователь 
может задать временной интервал, отображаемый по оси Х, и сведения о 
плане тестирования и тесте набора тестов, в соответствии с которыми 
Quality Center будет группировать данные. Также можно указать, что 
необходимо отобразить — количество тестов или изменения в количестве 
тестов. 

Например, чтобы сгруппировать отображаемые тесты в соответствии с их 
статусом, необходимо выбрать параметр Status из списка Group by. Под 
Period выберите Last 5 weeks, чтобы этот интервал (последние 5 недель) 
отображался по оси Х. (На диаграмме отображаются данные, замеряемые 
в последний день каждой недели.) Под Display Options выберите Regular, 
чтобы просмотреть количество тестов, а не изменения в количестве тестов. 
Нажмите кнопку Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Test Execution - 
Progress Graph (Current Test Set) см. в “Настройка диаграмм выполнения" 
на стр. 521. 

Диаграмму можно отобразить только в виде линейного графика.
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Test Execution - Summary Graph (Cross Test Set)
диаграмма Test Execution - Summary Graph (Cross Test Set) отображает 
количество тестов проекта Quality Center, относящихся ко всем наборам 
тестов. Количество тестов отображается в соответствии с критериями, 
заданными пользователем. Пользователь может задать тип данных, 
отображаемых по оси Х, и сведения о плане тестирования и тесте набора 
тестов, в соответствии с которыми Quality Center будет группировать 
данные. 

Например, для отображения количества тестов, существующих в проекте, 
по проектировщикам плана тестирования необходимо выбрать параметр 
Plan: Designer по оси X. Чтобы сгруппировать тесты в столбцы диаграммы 
в соответствии с их статусами, необходимо выбрать параметр Status из 
списка Grouped By. Нажмите кнопку Refresh, чтобы обновить отображение 
диаграммы.

Дополнительные сведения о настройке диаграммы Test Execution - 
Summary Graph (Cross Test Set) см. в “Пользовательская настройка 
сводных диаграмм" на стр. 520.

По умолчанию диаграммы отображаются в виде гистограмм. Чтобы 
отобразить круговую диаграмму, выберите вкладку Pie Chart.
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Test Execution - Progress Graph (Cross Test Set)
Диаграмма Test Execution - Progress Graph (Cross Test Set) отображает 
количество тестов, накопленных во всех наборах тестов в определенных 
точках за тот или иной период времени. Количество тестов отображается в 
соответствии с критериями, заданными пользователем. Пользователь 
может задать временной интервал, отображаемый по оси Х, и сведения о 
плане тестирования и тесте набора тестов, в соответствии с которыми 
Quality Center будет группировать данные. Также можно указать, что 
необходимо отображать — количество тестов или изменения в количестве 
тестов. 

Например, чтобы сгруппировать отображаемые тесты в соответствии с их 
статусом, необходимо выбрать параметр Status из списка Group by. Под 
Period выберите Last 5 weeks и Show daily info, чтобы по оси Х 
отображались данные за каждый день для такого временного интервала. 
Под Display Options выберите Regular, чтобы просмотреть количество 
тестов, а не изменения в количестве тестов. Нажмите кнопку Refresh, 
чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Test Execution - 
Progress Graph (Cross Test Set) см. в “Настройка диаграмм выполнения" на 
стр. 521. 

Диаграмму можно отображать только в виде линейного графика. 
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Defects - Summary Graph
Диаграмма Defects - Summary Graphотображает общее количество 
дефектов в проекте Quality Center или расчетное/фактическое количество 
времени, необходимого для устранения этих дефектов. Данные 
отображаются в соответствии с критериями, заданными пользователем. 
Пользователь может задать тип данных, отображаемых по оси Х, тип 
данных, отображаемых по оси Y, и сведения о дефектах, в соответствии с 
которыми Quality Center будет группировать данные. 

Например, для отображения количества дефектов, существующих в 
проекте, по тем лицам, которым они назначены, необходимо выбрать 
параметр Assigned To по оси X. Чтобы сгруппировать дефекты в столбцы 
диаграммы в соответствии с их статусом, необходимо выбрать параметр 
Status из списка Grouped By. Под Data Type выберите Count, чтобы по 
оси Y отображалось количество дефектов. Нажмите кнопку Refresh, чтобы 
обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Defects - Summary 
Graph см. в “Пользовательская настройка сводных диаграмм" на стр. 520. 

По умолчанию диаграммы выводятся в виде гистограмм. Чтобы отобразить 
круговую диаграмму, выберите вкладку Pie Chart.
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Defects - Progress Graph
Диаграмма Defects - Progress Graph отображает количество накопленных в 
проекте Quality Center дефектов или расчетное/фактическое количество 
времени, необходимого для устранения этих дефектов в определенных 
точках за тот или иной период времени. Данные отображаются в 
соответствии с критериями, заданными пользователем. Пользователь 
может задать временной интервал, отображаемый по оси Х, и сведения о 
требованиях, в соответствии с которыми Quality Center будет группировать 
данные, а также данные, отображаемые по оси Y. Также можно указать, что 
необходимо отображать — количество дефектов или изменения в 
количестве дефектов. 

Например, чтобы сгруппировать отображаемые дефекты в соответствии с 
их статусом, необходимо выбрать параметр Status из списка Group by. 
Под Data Type выберите Count, чтобы по оси Y отображалось количество 
дефектов, а не расчетное/фактическое количество времени, необходимого 
для устранения этих дефектов. Под Period выберите Last 5 weeks, чтобы 
этот интервал (последние 5 недель) отображался по оси Х. (На диаграмме 
отображаются данные, замеряемые в последний день каждой недели.) Под 
Display Options выберите Regular, чтобы просмотреть количество 
дефектов, а не изменения в количестве дефектов. Нажмите кнопку 
Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Defects - Progress Graph 
см. в “Настройка диаграмм выполнения" на стр. 521. 
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Диаграмму можно отображать только в виде линейного графика.

Defects - Age Graph
Диаграмма Defects - Age Graph отображает время существования 
дефектов в проекте Quality Center. Период существования дефекта 
начинается с момента сообщения о нем и заканчивается его закрытием. 
Данные отображаются на этой диаграмме в соответствии с критериями, 
заданными пользователем. Пользователь может задать сведения о 
дефектах, в соответствии с которыми Quality Center будет группировать 
данные, а также данные, отображаемые по оси Y. При необходимости 
вывода данных в два столбца пользователь также может задать 
временной интервал, который будет использоваться для разделения 
данных. 

Например, чтобы сгруппировать отображаемые дефекты в соответствии с 
их статусом, необходимо выбрать параметр Status из списка Group by. 
Под Data Type выберите Count, чтобы по оси Y отображалось количество 
дефектов, а не расчетное/фактическое количество времени, необходимого 
для устранения этих дефектов. Под Age Grouping выберите No Grouping , 
чтобы вывести на отображение все доступные классификации по периодам 
существования. Нажмите кнопку Refresh, чтобы обновить отображение 
диаграммы.
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Дополнительные сведения о настройке диаграммы Defects - Age Graph см. 
в “Настройка диаграмм периода существования дефектов" на стр. 523. 

Период существования для дефекта со статусом ‘Closed’ равен разнице 
между датой, на которую о нем было сообщено, и датой, на которую он был 
закрыт. После закрытие дефекта, период его существования фиксируется.

Диаграмму Defects - Age Graph можно отображать только в виде 
гистограммы.
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Defects - Trend Graph
Диаграмма Defects - Trend Graph отображает историю изменений в тех или 
иных полях дефектов в проекте Quality Center для каждого отображаемого 
временного интервала. Можно задать поле, по которому будет 
осуществляться просмотр количества изменений, а также период времени 
для просмотра данных. 

Например, чтобы отобразить количество изменений, внесенных в поле 
‘Priority’ дефекта, необходимо выбрать параметр Priority в списке Count 
changes in field. Под Period выберите Last 5 weeks, чтобы этот интервал 
(последние 5 недель) отображался по оси Х. (На диаграмме отображаются 
сводные данные, измеренные для каждой недели.) Нажмите кнопку 
Refresh, чтобы обновить отображение диаграммы.

Дополнительные сведения о настройке диаграммы Defects - Trend Graph 
см. в “Настройка диаграмм тенденций" на стр. 524. 

Каждое изменение приоритета для этой диаграммы записывается только 
один раз. Например, если приоритет поля был изменено с ‘Urgent’ на ‘Very 
High’, а затем опять на “Urgent”, в эту диаграмму один раз будет записан 
только приоритет ‘Urgent’.
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Диаграмму Defects - Trend Graph можно отображать только в виде 
гистограммы.

Создание диаграмм
Диаграммы можно создавать в любом модуле Quality Center. В 
зависимости от текущего модуля среды Quality Center доступны различные 
параметры диаграмм. Например, в модуле Defects можно создать 
диаграмму, на которой будет отображаться количество дефектов, 
назначенных каждому члену группы контроля качества. 

Для создания диаграммы:

 1 Выберите модуль Quality Center, в котором необходимо создать 
диаграмму.

 2 Выберите Analysis > Graphs, а затем — тип диаграммы. Дополнительные 
сведения о типах диаграмм см. в “Quality Center Типы диаграмм" на 
стр. 494.

Совет. Для создания диаграмм также можно воспользоваться мастером 
диаграмм. Дополнительные сведения об использовании мастера диаграмм 
см. в “Создание диаграмм с помощью мастера диаграмм" на стр. 516.
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Диаграмма открывается с параметрами данных и вида, установленными по 
умолчанию.  

Диаграмма состоит из следующих компонентов:

➤ Вкладки Display. Отображают диаграмму в виде гистограммы, круговой 
диаграммы, линейного графика или таблицы данных. Также можно 
отобразить сведения о диаграмме.

➤ Область Favorite graphs. Позволяет сохранять и загружать избранные 
диаграммы с пользовательскими настройками.

➤ Панель инструментов Graph. Содержит команды для отображения, 
печати, увеличения и настройки диаграмм.

➤ Область свойств для настройки диаграмм. Позволяет задавать 
данные, отображаемые на диаграмме.

 3 Выберите доступную вкладку отображения диаграммы:

➤ Bar Chart. Отображение диаграммы в виде гистограммы. 

➤ Pie Chart. Отображение диаграммы в виде круговой диаграммы. 

➤ Line Chart. Отображение диаграммы в виде линейного графика. 

➤ Data Grid. Отображение диаграммы в виде таблицы.
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 4 Настройте содержимое диаграммы. Дополнительные сведения см. в 
разделе “Пользовательская настройка содержимого диаграммы" на 
стр. 519.

 5 Чтобы проанализировать данные, щелкните сегмент диаграммы. 
Откроется диалоговое окно Drill Down Results с таблицей, содержащей 
более подробные данные. Можно определить внешний вид и порядок 
отображения столбцов. Также можно сохранить содержимое таблицы в 
виде текстового файла, таблицы Microsoft Excel, документа Microsoft Word 
или HTML. Подробнее см. Глава 3, "Работа с данными Quality Center". 

 6 С помощью панели инструментов диаграмм можно настроить параметры и 
вид диаграммы, а также распечатать ее и скопировать в буфер обмена. 
Подробнее см. “Настройка параметров диаграмм" на стр. 525.

 7 Чтобы сохранить содержимое диаграммы в виде текстового файла, 
таблицы Microsoft Excel или документа HTML, нажмите кнопку Save Graph 
Data.

 8 Чтобы добавить диаграмму в список избранного, нажмите кнопку Add to 
Favorites. Подробнее см. Глава 6, "Работа с избранными 
представлениями". 

После сохранения в виде избранного представления можно изменить 
предварительно заданное описание диаграммы. Дополнительные 
сведения см. в разделе “Пользовательская настройка описания диаграмм" 
на стр. 530.

 9 Нажмите кнопку Close, чтобы закрыть диаграмму и вернуться в текущий 
модуль Quality Center.

Создание диаграмм с помощью мастера диаграмм
Диаграммы можно создавать с помощью мастера диаграмм, который 
проведет пользователя через все этапы создания диаграммы и задания ее 
параметров.

Для создания диаграммы с помощью мастера диаграмм:

 1 Выберите модуль Quality Center, в котором необходимо создать 
диаграмму.
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 2 Выберите Analysis > Graphs > Graph Wizard. Откроется диалоговое окно 
мастера диаграмм для текущего модуля.

 3 Под Graph type выберите тип диаграммы, которую необходимо отобразить 
. Дополнительные сведения о типах диаграмм см. в “Quality Center Типы 
диаграмм" на стр. 494. Нажмите кнопку Next.

 4 Данная операция выполняется при работе в модуле Test Lab. Под Select a 
test set option укажите, какие наборы тестов следует включить в 
диаграмму. Доступны следующие параметры: 

➤ Show current test set. Включение в диаграмму данных только из 
текущего выбранного набора тестов. Выбирается по умолчанию.

➤ Show all test sets. Включение в диаграмму данных из всех наборов 
тестов.

Нажмите кнопку Next.
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 5 Под Select a filter option укажите, какой фильтр следует применить, чтобы 
задать записи для добавления в диаграмму:

➤ Use current filter. Применение фильтра, заданного в текущем 
представлении. Выбирается по умолчанию.

➤ Do not use a filter. Включение в диаграмму всех записей текущего 
модуля.

➤ Define a new filter. Позволяет задавать новый фильтр. Чтобы открыть 
диалоговое окно Filter и задать фильтр, нажмите кнопку Filter.

Дополнительные сведения о фильтрации данных Quality Center см. в 
“Фильтрация записей" на стр. 59.

Нажмите кнопку Next. 

 6 В окне Group By выберите поле, по которому данные будут группироваться 
в диаграмме. Для диаграммы выполнения можно выбрать поле, для 
которого активирован параметр истории изменения. Дополнительные 
сведения об активации параметра изменения содержимого поля см. в 
документе Руководство администратора HP Quality Center. 

При работе в модуле Requirements и выборе на этом шаге параметра 
Direct Cover Status далее необходимо указать, следует ли включать в 
диаграмму родительские требования со статусом ‘Not Covered’ .

Нажмите кнопку Next, если применимо.

 7 Данная операция выполняется при создании сводной диаграммы. В окне 
X-Axis выберите то поле, которое будет отображаться по оси Х. Нажмите 
кнопку Next, если применимо.

 8 Данная операция выполняется при работе в модуле Requirements и выборе 
параметра Direct Cover Status в окне Group By. Под Select a coverage 
option выберите, требования, которые следует включить в диаграмму.

➤ Do not show ‘Not Covered’ parents. Родительские требования со 
статусом ‘Not Covered’ не будут включены в диаграмму. 

➤ Show ‘Not Covered’ parents. В диаграмму будут включены все 
требования. 

Дополнительные сведения о покрытии см. в Глава 18, "Связывание тестов 
с требованиями".
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 9 Нажмите кнопку Finish. Откроется диаграмма с параметрами, заданными в 
мастере диаграмм.

Пользовательская настройка содержимого диаграммы
Можно указать, какие данные будут отображаться на диаграмме. Это 
делается при настройке сводной диаграммы, диаграммы выполнения, 
диаграммы периода существования и диаграммы тенденций.

Примечание. При группировании данных по полям, содержащим несколько 
значений, данные в каждом значении группируются как целое значение. 
Значение выступает в качестве категории для группирования. Например, 
значение, содержащее English и French, будет сгруппировано как 
English;French, а не как части отдельных категорий English и French. 
Дополнительные сведения об использовании нескольких значений см. в 
документе Руководство администратора HP Quality Center.
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Пользовательская настройка сводных диаграмм 
Можно задать данные, отображаемые на сводной диаграмме.

Для настройки сводной диаграммы: 

 1 Выберите поле из списка X-Axis, чтобы задать данные, отображаемые по 
оси Х диаграммы.

 2 Выберите поле из списка Grouped By, чтобы задать сведения, по которым 
Quality Center будет группировать данные в диаграмме.

Данные можно группировать только по полям строк или списков.

 3 Если для группирования было выбрано поле Direct Cover Status в модуле 
Requirements установите флажок Show ‘Not Covered’ parents, чтобы 
включить в диаграмму родительские требования со статусом Not Covered.
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 4 Под Data Type настройте ось Y диаграммы.

➤ Выберите Count, чтобы отобразить общее количество элементов 
(например, количество открытых дефектов). 

➤ Выберите Sum of и Estimated Fix Time, чтобы отобразить расчетное 
время, необходимое для устранения дефектов, или Actual Fix Time, 
чтобы отобразить фактическое время, затраченное на устранение 
дефектов. (Доступно только в модуле Defects.) 

 5 Чтобы открыть диалоговое окно Filter и выполнить фильтрацию 
содержимого диаграммы, нажмите кнопку Filter. Дополнительные сведения 
см. в разделе “Фильтрация записей" на стр. 59.

 6 Нажмите кнопку Refresh, чтобы внести изменения в диаграмму. 
Отобразится новая диаграмма.

Настройка диаграмм выполнения
Можно задать данные, отображаемые на диаграмме выполнения.
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Для настройки диаграммы выполнения: 

 1 Выберите поле из списка Group by, чтобы задать сведения, по которым 
Quality Center будет группировать данные в диаграмме. Можно выбрать 
только то поле, для которого в окне Project Customization был задан 
параметр History.

 2 Под Data Type настройте ось Y диаграммы.

➤ Выберите Count, чтобы отобразить общее количество элементов 
(например, количество открытых дефектов). 

➤ Выберите Sum of и Estimated Fix Time, чтобы отобразить расчетное 
время, необходимое для устранения дефектов, или Actual Fix Time, 
чтобы отобразить фактическое время, затраченное на устранение 
дефектов. (Доступно только в модуле Defects.)

 3 Под Period выберите период времени для отображения на диаграмме.

 4 Под Display Options:

➤ Выберите Regular, чтобы просмотреть количество требований, тестов 
или дефектов для выбранного периода времени. 

➤ Выберите Changes over Time, чтобы просмотреть изменения в 
количестве требований, тестов или дефектов для выбранного периода 
времени. Каждая запись начинается с 0.

 5 Чтобы открыть диалоговое окно Filter и выполнить фильтрацию 
содержимого диаграммы, нажмите кнопку Filter. Дополнительные сведения 
см. в разделе “Фильтрация записей" на стр. 59.

 6 Нажмите кнопку Refresh, чтобы применить изменения. Отобразится новая 
диаграмма.
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Настройка диаграмм периода существования дефектов
Можно задать данные, отображаемые на диаграмме периода 
существования. Диаграмма периода существования доступна только в 
модуле Defects.

Для настройки диаграммы периода существования: 

 1 Выберите поле из списка Group By, чтобы задать сведения, по которым 
Quality Center будет группировать данные в диаграмме.

 2 Под Data Type настройте ось Y диаграммы.

➤ Выберите Count, чтобы отобразить общее количество элементов 
(например, количество открытых дефектов). 

➤ Выберите Sum of и Estimated Fix Time, чтобы отобразить  расчетное 
время, необходимое для устранения дефектов, или Actual Fix Time, 
чтобы отобразить фактическое время, затраченное на устранение 
дефектов. 
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 3 Можно просматривать содержимое диаграммы в двух столбцах данных. 
При этом все данные, старше определенного временного интервала 
(например старше шести месяцев), будут отображаться в одном столбце, 
все данные, моложе такого временного интервала (например моложе 
шести месяцев), будут отображаться в другом столбце. 

Чтоб отобразить содержимое диаграммы в виде двух столбцов данных, 
выберите временной интервал под Age Grouping.

 4 Чтобы открыть диалоговое окно Filter и выполнить фильтрацию 
содержимого диаграммы, нажмите кнопку Filter. Дополнительные сведения 
см. в разделе “Фильтрация записей" на стр. 59.

 5 Нажмите кнопку Refresh, чтобы применить изменения. Отобразится новая 
диаграмма.

Настройка диаграмм тенденций
Можно задать данные, отображаемые на диаграмме тенденций.
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Для настройки диаграммы тенденций:

 1 Выберите поле из списка Count changes in field, чтобы задать сведения, 
по которым Quality Center будет отображать изменения в диаграмме. 
Можно выбрать одно поле или все поля. 

 2 Под Period выберите период времени для отображения на диаграмме.

 3 Чтобы открыть диалоговое окно Filter и выполнить фильтрацию 
содержимого диаграммы, нажмите кнопку Filter. Дополнительные сведения 
см. в разделе “Фильтрация записей" на стр. 59.

 4 Нажмите кнопку Refresh, чтобы применить изменения. Отобразится новая 
диаграмма.

Настройка  параметров диаграмм 
С помощью панели инструментов диаграмм пользователь может задать 
порядок отображение данных на диаграмме. Панель инструментов 
содержит следующие кнопки. Некоторые кнопки могут быть недоступны 
для диаграмм того или иного типа. итогов

Show Total Values. Отобразить/скрыть итоговые значения на диаграмме. 
Данный параметр доступен только в для диаграмм хода выполнения.

Scroll to the Left. Выполняет прокрутку диаграммы влево. (Эта кнопка 
активируется при использовании кнопок ‘Zoom In’ и ‘Zoom Out’.)

Scroll to the Right. Выполняет прокрутку диаграммы вправо. (Эта кнопка 
активируется при использовании кнопок ‘Zoom In’ и ‘Zoom Out’.)

Show All. Восстанавливает обычный размер диаграммы. (Эта кнопка 
активируется при использовании кнопок ‘ Zoom In’ и ‘Zoom Out’.)

Zoom In. Увеличивает диаграмму.

Zoom Out. Уменьшает диаграмму.

Настроить внешний вид диаграммы. Изменяет вид диаграммы, позволяя 
пользователю настраивать заголовок диаграммы, ее цвета и отображение. 
Дополнительные сведения см. в разделе “Настройка вида диаграмм" на 
стр. 527.  
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Копировать в буфер обмена. Можно выбрать следующие варианты:

➤ Copy Graph (Color). Копирует диаграмму в буфер обмена в цветном 
изображении.

➤ Copy Graph (Monochrome). Копирует диаграмму в буфер обмена в 
черно-белом изображении.

➤ Copy Full Screen Graph (Color). Копирует диаграмму, увеличенную до 
полноэкранного размера, в буфер обмена в цветном изображении.

➤ Copy Full Screen Graph (Monochrome). Копирует диаграмму, 
увеличенную до полноэкранного размера, в буфер обмена в черно-
белом изображении.

Печать диаграммы. Содержит следующие команды.

➤ Print Graph (Color). Цветная печать диаграмм.

➤ Print Graph (Monochrome). Черно-белая печать диаграмм.

➤ Print Graph and Details (Color). Цветная печать диаграмм и их 
описания.

➤ Print Graph and Details (Monochrome). Черно-белая печать диаграмм и 
их описания.

Edit Categories. Позволяет объединять значения полей X-Axis и Group By 
в категории. Дополнительные сведения см. в разделе “Изменение 
категорий диаграмм" на стр. 528.
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Настройка вида диаграмм
После создания диаграммы можно изменять ее заголовок и внешний вид. 
Для гистограммы можно задать параметры отображения столбцов. Для 
линейного графика можно задать параметры отображения линий.

Для настройки внешнего вида диаграммы:

 1 Нажмите кнопку Set Graph Appearance , расположенную на панели 
инструментов диаграмм. Откроется диалоговое окно Graph Appearance.

 2 Чтобы изменить заголовок диаграммы, ось Y или ось Х, выберите вкладку 
Titles. Чтобы изменить шрифт или цвет заголовка, нажмите кнопку Font. 
Чтобы вернуться к первоначальным параметрам, нажмите кнопку Reset 
Titles. Учтите, что у круговой диаграммы можно изменять только заголовок.

 3 Перейдите на вкладку Appearance, чтобы изменить цвет различных 
компонентов диаграммы, ориентацию надписей в основании диаграммы 
(только у гистограммы и линейного графика) или отобразить трехмерную 
диаграмму.

 4 При создании гистограммы перейдите на вкладку Bar Parameters и 
укажите, необходимо ли отображать значение для каждого столбца. 
Пользователь также может настроить ширину столбцов. В том случае, если 
задано отображение значений для каждого столбца, то можно изменять 
данные столбцов или их положение относительно столбцов. 
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При создании линейного графика перейдите на вкладку Line Parameters и 
укажите, должна ли отображаться рамка линии, а также формат даты по 
оси Х.

Изменение категорий диаграмм
Можно объединять значения полей X-Axis и Grouped By в категории. Это 
позволяет объединять данные в группы для различных значений полей и 
отображать объединенные данные в виде одной категории. Например, 
поле Priority имеет пять значений: Low, Medium, High, Very High и Urgent. 
Можно объединить значения Medium и High в категорию Important, а 
значения Very High в Urgent — в категорию Critical. При этом диаграмма 
будет отображать три категории данных: Low, Important и Critical.

Для изменения категорий диаграммы:

 1 Нажмите кнопку Edit Categories, расположенную на панели инструментов 
диаграмм, и выберите один из следующих вариантов. 

➤ Edit X-Axis Categories.  Позволяет объединять значения полей X-Axis в 
категории для отображения на диаграмме. Эта возможность доступна 
только для сводных диаграмм и диаграмм покрытия требований 
тестами.

➤ Edit Group By Categories.  Позволяет объединять значения полей 
Group By в категории для отображения на диаграмме. 

Откроется либо диалоговое окно Edit X-Axis Categories, либо диалоговое 
окно Edit Group By Categories.
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 2 В столбце Name введите имя категории.

 3 Выберите столбец Expression и нажмите кнопку обзора. Откроется 
диалоговое окно New Category.

 4 Чтобы выбрать значения полей для добавления в категорию, выберите 
необходимые значения и с помощью кнопок со стрелками (> и <), 
переместите их из списка Available groups в список Groups in new 
category. Чтобы переместить все значения полей из одного списка в 
другой, используйте кнопки с двумя стрелками (>> и <<). Также можно 
перетаскивать значения полей из одного списка в другой. 

Примечание. Значение поля может быть включено только в одну 
категорию.

Нажмите кнопку OK, чтобы закрыть диалоговое окно New Category.

 5 Чтобы добавить новую категорию, нажмите кнопку New и выполните 
операции с 2 по 4 еще раз.

 6 Чтобы удалить категорию, выберите ее и нажмите кнопку Delete.
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 7 Чтобы удалить все категории, нажмите кнопку Clear All. Для 
подтверждения нажмите кнопку Yes.

 8 Нажмите кнопку OK, чтобы закрыть диалоговое окно Edit X-Axis Categories 
или Edit Group By Categories.

 9 Чтобы сбросить категории X-Axis или Grouped By до значения по 
умолчанию, нажмите кнопку Edit Categories, расположенную на панели 
инструментов диаграмм, и выберите один из следующих вариантов:

➤ Reset X-Axis Categories. Восстанавливает категории X-Axis. Эта 
возможность доступна только для сводных диаграмм и диаграмм 
покрытия требований тестами.

➤ Reset Group By Categories. Восстанавливает категории Group By.

Для подтверждения нажмите кнопку Yes. Будут восстановлены либо 
категории X-Axis, либо категории Grouped By. 

Пользовательская настройка описания диаграмм
После сохранения диаграммы в виде избранного представления можно 
изменить предварительно заданное описание диаграммы. Также в 
описание можно добавить любой текст.

Для настройки описания диаграммы:

 1 Выберите вкладку Description, чтобы отобразить область Graph 
Description. 

 2 В области Graph Description измените описание диаграммы.
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35 
Создание диаграмм анализа в реальном 
времени 

Диаграммы анализа в реальном времени позволяют динамически 
создавать и отображать в графическом виде представления данных, 
связанных с планами тестирования и наборами тестов. Диаграммы 
анализа в реальном времени можно использовать для просмотра данных, 
относящихся к папке объектов тестирования или папке наборов тестов. 
Диаграммы изменяются при каждом выборе папки объектов тестирования 
или папки наборов тестов, отображая выбираемые пользователем данные.

Глава содержит следующие разделы: На стр.

Сведения о создании диаграмм анализа в реальном времени 532

Создание диаграмм анализа в реальном времени 533

Удаление диаграмм Live Analysis 542

Настройка внешнего вида диаграмм 543
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Сведения о создании диаграмм анализа в реальном 
времени

Создание диаграмм анализа в реальном времени выполняется с целью 
предоставления динамичного и быстрого обзора всех тестов или наборов 
тестов в папке. После создания диаграммы к ней можно перейти, выбрав 
вкладку Live Analysis в представлении дерева в модуле Test Plan или Test 
Lab.

При обновлении записи в папке измененные данные отображаются на 
диаграмме без каких-либо ручных операций по повторному созданию 
диаграммы.

Диаграммы анализа в реальном времени отличаются от диаграмм, 
описанных в главе Глава 34, "Создание диаграмм", тем, что для просмотра 
измененных данных не требуется создавать диаграмму повторно. Кроме 
того, при выборе другой папки в том же самом модуле компоновка и 
параметры диаграммы сохраняются, что позволяет просматривать один и 
тот же графический анализ различных папок без повторного создания 
диаграмм.
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Создание диаграмм анализа в реальном времени
Можно создавать диаграммы анализа в реальном времени для папок 
объектов тестирования или папок наборов тестов. Подробнее о создании 
диаграмм анализа в реальном времени для папок объектов тестирования 
см. в разделе “Создание диаграмм для папок объектов тестирования" на 
стр. 533. Подробнее о создании диаграмм анализа в реальном времени 
для папок наборов тестов см. в разделе “Создание диаграмм для папок 
наборов тестов" на стр. 537.

Примечание. Диаграммы анализа в реальном времени уникальны для 
имени, под которым пользователь вошел в систему. Каждый пользователь 
проекта может создавать диаграммы анализа в реальном времени, 
которые будут доступны для просмотра только ему и недоступны другим 
пользователям.

Создание диаграмм для папок объектов тестирования
На вкладке Live Analysis можно создавать диаграммы анализа в реальном 
времени для тестов в папках объектов тестирования пользователя. После 
определения данных, которые необходимо отобразить, диаграммы 
обновляются автоматически при каждом изменении данных в одном или 
более тестов из той папки объектов тестирования, для которой была 
создана диаграмма.

Примечание. Диаграммы анализа в реальном времени отображают только 
те тесты, которые расположены непосредственного под выбранной папкой 
объектов тестирования. Тесты, расположенные в дочерних папках на 
более низких иерархических уровнях выбранной папки объектов 
тестирования, в диаграммы не включаются.
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Для создания диаграммы папки объектов тестирования:

 1 Нажмите кнопку Test Plan на боковой панели, чтобы отобразить модуль 
Test Plan.

 2 Выберите View > Test Plan Tree. Отобразится дерево плана тестирования.

 3 В дереве плана тестирования выберите папку объектов тестирования.

 4 Перейдите на вкладку Live Analysis.

Вкладка Live Analysis содержит две области, в каждой из которых можно 
отобразить диаграмму. 

 5 В том случае, если уже отображаются две диаграммы или необходимо 
создать новую диаграмму, удалите одну из текущих диаграмм. 
Дополнительные сведения см. в разделе “Удаление диаграмм Live 
Analysis" на стр. 542.
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 6 Щелкните ссылку Add Graph в той области, в которой необходимо 
отобразить диаграмму. Альтернативный вариант — выберите Analysis > 
Live Analysis > Add Graph. Откроется диалоговое окно Graph Wizard: Test 
Plan Module. 

 7 Под Graph type выберите тип диаграммы, которую необходимо 
отобразить. В модуле Test Plan можно создавать следующие диаграммы:

Нажмите кнопку Next.

Диаграмма Описание

Summary Graph Отображает текущее количество тестов в выбранной 
папке объектов тестирования.

Progress Graph Отображает количество тестов, накопленных в 
выбранной папке объектов тестирования в 
определенных точках за конкретный период времени. 

Trend Graph Отображает историю изменений в определенных полях 
плана тестирования в выбранной папке объектов 
тестирования для каждого отображаемого временного 
интервала. 
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 8 В окне Group By выберите поле, по которому тесты будут группироваться в 
диаграмме. Для диаграммы выполнения можно выбрать поле, для которого 
активирован параметр истории изменения. Дополнительные сведения об 
активации параметра History для поля см. в Руководство 
администратора HP Quality Center.

 9 Если необходимо создать сводную диаграмму, нажмите кнопку Next. В окне 
X-Axis выберите то поле, которое будет отображаться по оси Х. 

 10 Нажмите кнопку Finish. Диаграмма анализа в реальном времени будет 
отображаться в выбранной пользователем области.

Заданные пользователем свойства диаграммы отображаются в верхней 
части диаграммы. 
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Примечание. Представленные на диаграмме данные отображают 
фильтры, настроенные пользователем для дерева плана тестирования. 
Дополнительные сведения о фильтрации см. в “Фильтрация записей" на 
стр. 59.

 11 Нажмите кнопку Full Screen View, чтобы максимально увеличить 
диаграмму. Чтобы восстановить обычный вид диаграммы, нажмите кнопку 
Close.

 12 Чтобы проанализировать данные, щелкните сегмент диаграммы. 
Откроется диалоговое окно Drill Down Results с таблицей, содержащей 
более подробные данные. Можно определить размеры и порядок 
отображения столбцов. Также можно экспортировать содержимое таблицы 
в виде текстового файла, таблицы Microsoft Excel, документа Microsoft 
Word или HTML. Дополнительные сведения см. в разделе “Экспорт данных 
в файл" на стр. 78. 

 13 Чтобы изменить цвет столбца гистограммы или линии линейного графика, 
щелкните столбец или линию правой кнопкой мыши или выберите 
соответствующий элемент в легенде диаграммы. В открывшемся 
диалоговом окне Color выберите новый цвет из одной из цветовых палитр.

 14 Нажмите кнопку Set Graph Appearance, чтобы настроить заголовок 
диаграммы, ее цвет и отображение. Дополнительные сведения о 
параметрах внешнего вида диаграммы см. в “Настройка внешнего вида 
диаграмм" на стр. 543.

Создание диаграмм для папок наборов тестов
На вкладке Live Analysis можно создавать диаграммы анализа в реальном 
времени для наборов тестов из папок наборов тестов. После определения 
данных, которые необходимо отобразить, диаграммы обновляются 
автоматически при каждом изменении данных в одном или более наборах 
тестов из той папки, для которой была создана диаграмма. 
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Примечание. Диаграммы анализа в реальном времени отображают только 
те наборы тестов, которые расположены непосредственного под 
выбранной папкой наборов. Наборы тестов, расположенные в дочерних 
папках на более низких иерархических уровнях выбранной папки наборов 
тестов, в диаграммы не включаются.

Чтобы создать диаграмму папки наборов тестов:

 1 Нажмите кнопку Test Lab на боковой панели, чтобы отобразить модуль 
Test Lab.

 2 Выберите View > Test Sets Tree. Отобразится дерево наборов тестов.

 3 В дереве наборов тестирования выберите папку наборов тестирования.

 4 Перейдите на вкладку Live Analysis. 
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Вкладка Live Analysis содержит две области, в каждой из которых можно 
отобразить диаграмму. 

 5 В том случае, если уже отображаются две диаграммы или необходимо 
создать новую диаграмму, удалите одну из текущих диаграмм. 
Дополнительные сведения см. в разделе “Удаление диаграмм Live 
Analysis" на стр. 542.

 6 Щелкните ссылку Add Graph в той области, в которой необходимо вывести 
диаграмму. Альтернативный вариант — выберите Analysis > Live Analysis 
> Add Graph. Откроется диалоговое окно Graph Wizard: Test Lab Module.

 7 Под Graph type выберите тип диаграммы, которую необходимо 
отобразить. В модуле Test Lab можно создавать следующие диаграммы:

Нажмите кнопку Next.

Диаграмма Описание

Summary Graph Отображает количество тестов из наборов тестов в 
выбранной папке. 

Progress Graph Отображает количество тестов, накопленных в наборе 
тестов выбранной папки в определенных точках за 
конкретный период времени.
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 8 В окне Group By выберите поле, по которому тесты будут группироваться в 
диаграмме. Для диаграммы выполнения можно выбрать поле, для которого 
активирован параметр истории изменения. Дополнительные сведения об 
активации параметра History для поля см. в документе Руководство 
администратора HP Quality Center.

 9 Если необходимо создать сводную диаграмму, нажмите кнопку Next. В окне 
X-Axis выберите то поле, которое будет отображаться по оси Х.

 10 Нажмите кнопку Finish. Диаграмма анализа в реальном времени будет 
отображаться в выбранной пользователем области.

Заданные пользователем свойства диаграммы отображаются в верхней 
части диаграммы. 
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Примечание. Представленные на диаграмме данные отображают 
фильтры, заданные пользователем для дерева наборов тестов. 
Дополнительные сведения о фильтрации см. в “Фильтрация записей" на 
стр. 59.

 11 Нажмите кнопку Full Screen View, чтобы максимально увеличить 
диаграмму. Чтобы восстановить обычный вид диаграммы, нажмите кнопку 
Close.

 12 Чтобы проанализировать данные, щелкните сегмент диаграммы. 
Откроется диалоговое окно Drill Down Results с таблицей, содержащей 
более подробные данные. Можно определить внешний вид и порядок 
отображения столбцов. Также можно экспортировать содержимое таблицы 
в виде текстового файла, таблицы Microsoft Excel, документа Microsoft 
Word или HTML. Дополнительные сведения см. в разделе “Экспорт данных 
в файл" на стр. 78.

 13 Чтобы изменить цвет столбца гистограммы или линии линейного графика, 
щелкните столбец или линию правой кнопкой мыши или выберите 
соответствующий элемент в легенде диаграммы. В открывшемся 
диалоговом окне Color выберите новый цвет на одной из цветовых палитр.

 14 Нажмите кнопку Set Graph Appearance, чтобы настроить заголовок 
диаграммы, ее цвет и отображение. Дополнительные сведения о 
параметрах внешнего вида диаграммы см. в “Настройка внешнего вида 
диаграмм" на стр. 543.
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Удаление диаграмм Live Analysis
Диаграмму анализа в реальном времени можно удалять. В том случае, 
если для папки отображаются две диаграммы и необходимо создать новую 
диаграмму, сначала необходимо удалить одну из текущих диаграмм.

Чтобы удалить диаграмму анализа в реальном времени:

 1 Нажмите кнопку Remove Graph, расположенную в верхней части 
диаграммы, которую необходимо удалить. Альтернативный вариант — 
выберите Analysis > Live Analysis > Remove Graph.

 2 Для подтверждения нажмите кнопку Yes. Диаграмма будет удалена из 
выбранной области, и отобразится ссылка Add Graph.
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Настройка внешнего вида диаграмм
После создания диаграммы пользователь может изменить ее заголовки и 
внешний вид. Для гистограммы можно задать параметры отображения 
столбцов. Для линейного графика можно задать параметры отображения 
линий.

Чтобы настроить внешний вид диаграммы:

 1 Нажмите кнопку Set Graph Appearance , расположенную в верхней части 
диаграммы. Альтернативный вариант — выберите Analysis > Live 
Analysis > Set Graph Appearance. Откроется диалоговое окно Graph 
Appearance и отобразится вкладка General.

На вкладке General содержатся доступные только для чтения сведения о 
диаграмме.

 2 Чтобы изменить заголовки диаграммы, ось Y или ось Х, выберите вкладку 
Titles. Чтобы изменить шрифт, размер, формат или цвет заголовка, 
нажмите кнопку Font. Чтобы вернуться к первоначальным настройкам, 
нажмите кнопку Reset Titles.

 3 Перейдите на вкладку Appearance, чтобы изменить цвет различных 
компонентов диаграммы, ориентацию надписей в основании диаграммы 
или отобразить трехмерную диаграмму.
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 4 При создании гистограммы перейдите на вкладку Bar Parameters и 
укажите, должны ли отображаться значение для каждого столбца. 
Пользователь также может настроить ширину столбцов. В том случае, если 
задано отображение значений для каждого столбца, то можно изменять 
данные столбцов или их положение относительно столбцов. 

При создании линейного графика перейдите на вкладку Line Parameters и 
укажите, должна ли отображаться рамка линии, а также формат даты по 
оси Х.
544



36
Создание документов в проекте

Quality Center Приложение «Генератор документов» позволяет создавать 
документы Microsoft Word, включающие в себя требования, сведения о 
планировании, списки тестов, папки наборов тестов, а также данные об 
отслеживании дефектов.

Примечания. 

➤ Генератор документов можно запускать только если в Microsoft Word 
задан параметр включения макросов. Если при использовании 
Генератора документов появляется сообщение системы безопасности, 
необходимо задать в Microsoft Word уровень безопасности "Средний" 
или "Низкий". Для этого в строке меню приложения Word выберите 
Сервис > Макрос > Безопасность. На вкладке «Уровень 
безопасности» выберите необходимый уровень защиты ("средний" или 
"низкий") и нажмите кнопку OK. 

➤ Для получения сведений о том, какие версии Microsoft Word 
поддерживаются, см. руководство Руководство по установке 
HP Quality Center.

Глава содержит следующие разделы: На стр.

Сведения о программе Генератор документов 547

Запуск программы Document Generator 549

Установка инструкций по форматированию 550
545
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Конкретизация данных проекта 556

Создание проектного документа 583

Глава содержит следующие разделы: На стр.
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Сведения о программе Генератор документов
Генератор документов позволяет создавать твердые копии данных, 
содержащихся в проекте Quality Center. Документ создается путем 
выполнения следующих задач:

 1 Определение формата документа;

 2 Определение содержимого документа;

 3 Создание и правка документа. 

Во-первых, даются инструкции по форматированию для определения 
внешнего вида документа. Например, можно напечатать логотип компании 
на каждой странице документа, создать оглавление и указатель, а также 
добавить скрипты тестов и вложения в документ.

Затем необходимо указать данные проекта, которые будет содержать 
документ. Можно выбирать информацию из модулейQuality Center. 
Например, из модуля Test Plan можно выбрать папки и тесты, которые 
необходимо добавить в документ из дерева плана тестирования, 
расположить эти данные в алфавитном или применить специальный метод 
сортировки, а также отобразить данные в виде списков или таблиц. 

После разработки инструкций по форматированию и определению 
содержимого документа можно сохранить его параметры как избранное 
представление для использования в дальнейшем и создать документ. 
После того, как будет завершено создание документа, его можно 
просматривать и редактировать в Microsoft Word. Информация о каждом 
выбранном модуле печатается в отдельной главе документа проекта. 
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Ниже приведен пример страницы документа Microsoft Word, созданной с 
помощью генератора документов. 
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Запуск программы Document Generator
Чтобы запустить генератор документов, нажмите кнопку Tools в верхнем 
правом углу окна Quality Center. Выберите Document Generator. Откроется 
генератор документов. 
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Установка инструкций по форматированию 
Перед созданием документа необходимо задать инструкции по 
форматированию, определяющие вид документа и титульную страницу.

Как задать инструкции по форматированию

 1 Откройте генератор документов. По умолчанию в дереве генератора 
документов выбрана ссылка Document и отображается вкладка Document 
Settings.

 2 Введите Title документа, сведения об Author и Description документа.
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 3 Перейдите на вкладку Options.  

 4 Под надписью Include with Document можно выбрать следующие 
параметры, определяющие, что следует добавить в документ:

Параметр Описание

First page Титульный лист проектного документа. Отображает 
название, дату создания и имя автора документа. Эти 
сведения указываются на вкладке Document Settings

Table of contents Список всех разделов документа проекта.

Index Список всех сведений документа проекта в алфавитном 
порядке. Указатель размещается в конце документа.
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 5 Под надписью Attachment Placement Options выберите, в каком месте 
документа появятся вложения: 

 6 Под надписью Attachment Embedding Options выберите способ 
добавления вложения в документ: в виде значка со ссылкой или в виде 
встроенного текста.

 7 Под надписью Test Script Options выберите место в документе, в котором 
появятся скрипты тестов:

 8 Под надписью Graph Options выберите место в документе, в котором 
появятся диаграммы.

 9 Установите флажок Do not generate a paragraph if there is no 
corresponding project information, если вы не хотите включать пустые 
поля данных в документ проекта.

Параметр Описание

In text Отображает вложения в основном тексте документа.

In appendix Размещает вложения в приложении к документу.

Параметр Описание

As icons Размещает ссылку на вложение в виде значка

As expanded text Добавляет вложение в документ в виде расширения 
текста. 

Параметр Описание

In text Отображает скрипты тестов в основном тексте 
документа.

In appendix Размещает скрипты тестов в приложении к документу.

Параметр Описание

In text Отображает диаграммы в основном тексте документа.

In appendix Размещает диаграммы в приложении к документу.
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 10 Чтобы задать изображение, которое будет размещаться в верху каждой 
страницы документа проекта, перейдите на вкладку Logo.

Для документа проекта можно выбрать логотип и сохранить изображение, 
чтобы оно было доступно другим пользователям данного проекта. Если 
изображение выбрано не будет, генератор документов будет использовать 
в документе проекта логотип HP.

 11 Нажмите кнопку Load from File. Откроется диалоговое окно Open. 

 12 Найдите изображение и нажмите кнопку Open. Изображение будет 
отображено на вкладке Logo. Чтобы выгрузить изображение, нажмите 
кнопку Unload.

 13 Чтобы сохранить отображенное изображение в текущем проекте, нажмите 
кнопку Save. Чтобы удалить изображение, нажмите кнопку Remove Saved. 

 14 Чтобы загрузить удаленное изображение (с использование кнопки Unload), 
нажмите кнопку Load from Saved.
553



Глава 36 • Создание документов в проекте
 15 Чтобы задать параметры страницы, перейдите на вкладку Customization и 
нажмите кнопку Page Setup.
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Откроется диалоговое окно Page Setup.

 16 Задайте единицы измерения, поля, ориентацию и размер страницы для 
документов проекта Нажмите кнопку OK для возврата на вкладку 
Customization.
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Конкретизация данных проекта 
Установите флажок в дереве генератора документов , чтобы задать, какие 
данные проекта следует включить в документ.

Флажок Описание

Document Использование вкладок Document Settings, Options, Logo, 
и Customization для задания инструкций по 
форматированию. Дополнительные сведения см. в 
разделе “Установка инструкций по форматированию" на 
стр. 550. Обратите внимание, этот параметр выбран 
всегда.

Requirements Задание требований, отслеживаемых требований, 
тестового покрытия и связанных дефектов для 
добавления их в документ из модуля Requirements. 
Дополнительные сведения см. в разделе “Задание 
данных в модуле Requirements" на стр. 558. 

Business 
Components

Если используется приложение HP Business Process 
Testing, см. Руководство пользователяHP 
Тестирование бизнес-процессов.
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Test Plan Задание того, какие папки объектов тестирования и какие 
тесты добавить в документ из модуля Test Plan. 
Дополнительные сведения см. в “Конкретизация данных 
модуля Test Plan из дерева Test Plan" на стр. 561 и 
“Конкретизация данных модуля Test Plan из контрольной 
сетки Test Grid View" на стр. 566.

Выберите Subject Tree , чтобы задать, какие папки с 
объектов тестирования добавить в документ из модуля 
Test Plan.

Выберите Subject Tree , чтобы задать, какие тесты 
добавить в документ из выбранных папок.

Выберите Test List , чтобы задать, какие тесты добавить 
в документ из таблицы Test Grid.

Test Lab Задайте, какие папки наборов тестов добавить в 
документ из модуля Test Lab. Раскройте папку, чтобы 
выбрать наборы тестов, тесты и выполнения тестов, 
которые необходимо добавить. Дополнительные 
сведения см. в разделе “Конкретизация данных модуля 
Test Lab" на стр. 570.

Выберите Test Sets , чтобы задать, какие наборы тестов 
необходимо добавить.

Выберите Tests , чтобы задать, какие тесты из 
выбранных наборов тестов необходимо добавить.

Выберите Runs , чтобы задать, какие выполнения тестов 
из выбранных тестов набора тестов необходимо 
добавить. 

Defects Задайте, какие дефекты из модуля Defects необходимо 
добавить. Дополнительные сведения см. в разделе 
“Задание данных в модуле Defects" на стр. 580.

Флажок Описание
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Задание данных в модуле Requirements 
На странице Requirements можно задавать сведения о требовании из 
модуля Requirements, которые должны появляться в разделе Requirements 
документа проекта.

Примечание. Microsoft Word создает не более 9 уровней заголовков в 
оглавлении. Если дерево требований содержит более 9 уровней иерархии, 
эти уровни не появятся в оглавлении сгенерированного документа проекта.

Для задания данных в модуле Requirements.

 1 Поставьте флажок Requirements в дереве генератора документов и 
щелкните ссылку Requirements. Отобразится страница Requirements.
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 2 Под надписью Requirements выберите один из следующих параметров:

 3 Под надписью Requirements Layout выберите один из следующих 
параметров.

Параметр Описание

All Добавляет все требования из дерева. 

By status Добавляет только требования с выбранным статусом.

Selected Добавляет только выбранные требования. Нажмите 
кнопку Filter & Sort, чтобы задать условия для выбора 
требований. Дополнительные сведения об 
использовании диалогового окна Filter см. раздел 
Глава 3, "Работа с данными Quality Center"..

Параметр Описание

Full page Отображает список выбранных требований. Нажмите 
кнопку Customize, чтобы выбрать сведения, которые 
появятся в документе.

Tabular Отображает требования в виде таблицы. Нажмите кнопку 
Customize, чтобы открыть диалоговое окно Tabular 
Layout для настройки параметров таблицы. В диалоговом 
окне Tabular Layout, выберите столбцы, которые 
необходимо отобразить в таблице, задайте порядок их 
расположения, их ширину и заголовки.

Coverage Analysis Отображает в графическом виде статус каждого 
требования. Нажмите кнопку Customize, чтобы открыть 
диалоговое окно Coverage Analysis и выбрать вид 
отображения анализа: черно-белый или цветной, 
количество отображаемых уровней иерархии, а также 
отображать или не отображать легенду.
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 4 Если выбран способ компоновки Full page, можно задать следующие 
параметры:

Параметр Описание

Page break after 
each requirement

Вставляет разрывы страниц в документе проекта после 
каждого требования.

Rich content Добавляет для каждого требования содержимое в 
формате RTF 

Trace From Добавляет в документ требования, от которых 
выполняется отслеживание. Нажмите кнопку Customize, 
чтобы открыть диалоговое окно Tabular Layout и 
настроить таблицу отслеживаемости. В диалоговом окне 
Tabular Layout, выберите столбцы, из которых будет 
состоять таблица, задайте порядок их расположения, их 
ширину и заголовки.

Trace To Добавляет в документ требования, к которым 
выполняется отслеживание. Нажмите кнопку Customize, 
чтобы открыть диалоговое окно Tabular Layout для 
настройки таблицы отслеживаемости. Используйте 
диалоговое окно Tabular Layout, чтобы выбрать столбцы, 
из которых будет состоять таблица, задать порядок 
столбцов, их ширину и заголовки.

Coverage Добавляет в документ тестовое покрытие к требованиям. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы 
покрытия. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы, из которых будет состоять 
таблица, задать порядок их расположения, ширину и 
заголовки.
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 5 Чтобы добавить в документ проекта диаграммы, выберите параметр 
Graphs , а затем — нужные диаграммы из списка диаграмм внизу 
страницы. Список содержит только диаграммы, которые сохранены как 
"избранное". Дополнительные сведения о избранных представлениях см. в 
главе Глава 6, "Работа с избранными представлениями"..

Конкретизация данных модуля Test Plan из дерева Test 
Plan
Страницы дерева объектов и тестов объектов используются, чтобы задать, 
какие сведения из дерева плана тестирования модуля Test Plan, должны 
появиться в документе проекта.

Примечание.  Microsoft Word создает не более 9 уровней заголовков в 
оглавлении. Если дерево плана тестирования содержит более 9 уровней, 
эти уровни не появятся в оглавлении сгенерированного документа проекта. 

Attachments Добавляет в документ вложения к требованиям. 
Вложения к требованию — это файлы, связанные с 
требованием, такие как текстовые файлы, изображения 
или URL-адреса.

Linked defects Добавляет в документ связанные дефекты. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки таблицы связанных 
дефектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы с дефектами, из которых будет 
состоять таблица, задать порядок столбцов, их ширину и 
заголовки. Также можно задать какие дефекты 
отображать: напрямую связанные с требованиями или 
также включать косвенно связанные дефекты.

Параметр Описание
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Как задать данные из дерева плана тестирования модуля Test Plan:

 1 Разверните узел Test Plan в дереве генератора документов. Установите 
флажок Subject Tree  и нажмите на ссылку Subject Tree. Отобразится 
страница Subject Tree.
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 2 Под надписью Tree Sort определите в документе порядок расположения 
информации о дереве плана тестирования.

 3 Под надписью Folders задайте, какие папки из дерева плана тестирования 
необходимо включить в документ.

Параметр Описание

Alphabetical Содержимое папок будет упорядочено в документе в 
алфавитном порядке. Например, предположим, что в 
дереве плана тестирования две папки: Automated Tests и 
Manual Tests. Тесты в папке Automated Tests будут 
выводиться на печать раньше тестов в папке Manual 
Tests.

Custom Содержимое папок будет упорядочено в соответствии с 
порядком сортировки, установленным пользователем 
для отображения папок в дереве плана тестирования. По 
умолчанию папки объектов в дереве плана тестирования 
появляются в алфавитном порядке (по имени). 
Например, предположим, что в дереве плана 
тестирования две папки: Automated Tests и Manual Tests. 
Можно создать порядок сортировки такой, чтобы 
выводить на печать тесты из папки Manual Tests перед 
тестами из папки Automated Tests. Подробную 
информацию о создании пользовательского порядка 
сортировки для дерева плана тестирования см. в 
разделе Глава 17, "Создание дерева плана 
тестирования".

Параметр Описание

All Добавляет в документ все папки из дерева плана 
тестирования.

Selected Добавляет только выбранные папки из дерева плана 
тестирования. Пользователь выбирает папки из дерева 
плана тестирования, размещенного на правой стороне 
страницы Subject Tree.
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 4 Чтобы добавлять в документ вложения к папкам, выберите Attachments. 
Вложения к папкам представляют собой файлы, связанные с папкой, такие 
как текстовые файлы, изображения или URL-адреса.

 5 Чтобы после каждой папки объектов с тестами вставить разрыв страницы, 
установите флажок Page break after each folder. 

 6 Чтобы добавить диаграммы в документ, выберите Graphs и щелкните 
нужные диаграммы из списка. Только диаграммы, которые сохранены как 
"избранное", добавляются в список. Дополнительные сведения о 
представлениях избранного см. Глава 6, "Работа с избранными 
представлениями"..

 7 Чтобы добавить данные тестов в проектный документ, разверните узел 
Subject Tree на дереве Document Generator. Поставьте флажок Subject 
Tests и щелкните ссылку Subject Tests. Отобразится страница Subject 
Tests.
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 8 Под надписью Tests задайте, какие тесты необходимо добавить в 
документ.

 9 Чтобы добавить в документ шаги теста из теста, выберите Design steps.

Под надписью Layout задайте способ упорядочивания шагов теста.

Под надписью Properties задайте элементы, которые необходимо 
добавить из шагов теста.

 10 Чтобы добавить в документ скрипты тестов, выберите Test scripts.

Параметр Описание

All tests Добавляет все тесты из выбранных папок в дереве плана 
тестирования.

Selected Добавляет только выбранные тесты. Нажмите кнопку 
Filter & Sort, чтобы задать критерии выбора тестов. 
Дополнительные сведения об использовании 
диалогового окна Filter см. раздел Глава 3, "Работа с 
данными Quality Center"..

Параметр Описание

Full page Отображает список всех шагов теста в тесте. Нажмите 
кнопку Customize, чтобы выбрать информацию, которая 
появится в документе.

Tabular Отображает в виде таблицы список всех шагов теста в 
тесте. Нажмите кнопку Customize, чтобы открыть 
диалоговое окно Tabular Layout для настройки 
параметров таблицы. Используйте диалоговое окно 
Tabular Layout, чтобы выбрать столбцы, из которых будет 
состоять таблица, задать порядок столбцов, их ширину и 
заголовки.

Параметр Описание

Recursive Добавляет вызванные тесты из этапов проектирования.

Attachments Добавляет все вложения к к шагам теста.
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 11 В случае использования Business Process Testing можно добавлять 
компоновку компонентов, входящих в тесты. Выделите Components 
detailed layout  и выберите элементы для включения в подробный формат.

➤ Чтобы добавить шаги компонентов, установите флажок Component 
steps. Нажмите кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки параметров таблицы этапов компонентов. 
Используйте диалоговое окно Tabular Layout, чтобы выбрать столбцы с 
дефектами, из которых будет состоять таблица, задать порядок 
столбцов, их ширину и заголовки. 

➤ Чтобы включить список итераций, установите флажок Iterations list.

 12 Чтобы включить в документ приложения к тестам, установите флажок 
Attachments.

 13 Чтобы отобразить список всех изменений, внесенных в тесты, а также 
авторов каждого изменения, установите флажок History.

 14 Чтобы после каждого теста вставить в проектный документ разрыв 
страницы, установите флажок Page break after each test.

 15 Чтобы включить таблицу связанных дефектов, установите флажок Linked 
defects. Нажмите кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки таблицы связанных дефектов. Используйте 
диалоговое окно Tabular Layout, чтобы выбрать столбцы с дефектами, из 
которых будет состоять таблица, задать порядок столбцов, их ширину и 
заголовки. Также можно конкретизировать какие дефекты отображать: 
непосредственно связанные с тестами или также включать косвенно 
связанные дефекты.

Конкретизация данных модуля Test Plan из контрольной 
сетки Test Grid View
Страница Test List используется для задания тестов из таблицы Test Grid, 
которые должны появиться в документе проекта. Дополнительные 
сведения о контрольной сетке Test Grid см. раздел Глава 3, "Работа с 
данными Quality Center".
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Как задать данные из таблицы Test Grid в модуле Test Plan.

 1 Разверните узел Test Plan в дереве Document Generator. Поставьте 
флажок Test List и щелкните ссылку Test List. Отобразится страница Test 
List.

 2 Под надписью Tests задайте, какие тесты необходимо включить в 
документ.

Параметр Описание

All tests Добавляет в документ все тесты из таблицы Test Grid.

Selected Добавляет только выбранные тесты. Нажмите кнопку 
Filter & Sort, чтобы конкретизировать критерии для 
выбора тестов. Дополнительные сведения об 
использовании диалогового окна Filter см. раздел 
Глава 3, "Работа с данными Quality Center"..
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 3 Под надписью Test Layout задайте способ упорядочивания тестов.

 4 Чтобы после каждого теста вставить в проектный документ разрыв 
страницы, установите флажок Page break after each test.

 5 Если в параметре Test Layout выбран вариант Full page, можно выбрать 
Design steps для включения из теста этапов проектирования.

Под надписью Layout задайте способ упорядочивания шагов теста.

Параметр Описание

Full page Отображает список всех тестов проекта. Нажмите кнопку 
Customize, чтобы выбрать информацию, которая 
появится в документе.

Tabular Отображает все тесты в виде таблицы. Нажмите кнопку 
Customize, чтобы открыть диалоговое окно Tabular 
Layout для настройки параметров таблицы. Используйте 
диалоговое окно Tabular Layout, чтобы выбрать столбцы, 
из которых будет состоять таблица, задать порядок 
столбцов, их ширину и заголовки.

Параметр Описание

Full page Отображает список всех шагов теста в тесте. Нажмите 
кнопку Customize, чтобы выбрать информацию, которая 
появится в документе.

Tabular Отображает в виде таблицы список всех шагов теста. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
Используйте диалоговое окно Tabular Layout, чтобы 
выбрать столбцы, из которых будет состоять таблица, 
задать порядок столбцов, их ширину и заголовки.
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В параметре Properties конкретизируйте элементы, которые необходимо 
включить из этапов проектирования.

 6 Если в качестве компоновки тестов выбран Full page, можно задать 
следующие свойства:

Параметр Описание

Recursive Добавляет вызванные тесты из шагов теста.

Attachments Добавляются все вложения к шагам теста.

Параметр Описание

Test scripts Добавляет в документ скрипты тестов.

Components 
detailed layout

В случае использования HP Business Process Testing 
можно добавлять подробную компоновку компонентов, 
входящих в тесты. В подробной компоновке выберите 
элементы, которые необходимо включить.

Component steps: Добавляет шаги компонентов. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы 
шагов компонентов. Используйте диалоговое окно 
Tabular Layout, чтобы выбрать столбцы с дефектами, из 
которых будет состоять таблица, задать порядок 
столбцов, их ширину и заголовки. 

Список итераций: содержит список итераций.

Attachments Добавляет в документ вложения к выполнениям тестов.

Linked defects Добавляет таблицу связанных дефектов. Нажмите кнопку 
Customize, чтобы открыть диалоговое окно Tabular 
Layout для настройки таблицы связанных дефектов. 
Используйте диалоговое окно Tabular Layout, чтобы 
выбрать столбцы с дефектами, из которых будет 
состоять таблица, задать порядок столбцов, их ширину и 
заголовки. Также можно конкретизировать какие дефекты 
отображать: напрямую связанные с тестами или также 
включать косвенно связанные дефекты.

History Отображает список всех изменений, внесенных в тесты, а 
также их авторов.
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 7 Чтобы добавить в документ диаграммы, выберите Graphs и щелкните 
нужные диаграммы из списка диаграмм внизу страницы. Только 
диаграммы, которые сохранены как "избранное", включаются в список. 
Дополнительные сведения о представлениях избранного см. Глава 6, 
"Работа с избранными представлениями"..

Конкретизация данных модуля Test Lab
Страницы Test Lab, Test Sets, Tests и Runs используются для задания 
информации из модуля Test Lab, которая должна появиться в документе 
проекта.

Примечание. Microsoft Word создает не более 9 уровней заголовков в 
оглавлении. Если в дереве наборов тестов иерархия насчитывает более 9 
уровней, эти уровни не появятся в оглавлении сгенерированного документа 
проекта.
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Как задать данные в модуле Test Lab

 1 Установите флажок Test Lab  дерева Document Generator и щелкните 
ссылку Test Lab. Отобразится страница Test Lab.

 2 Под надписью Folders задайте, какие папки тестовой лаборатории 
необходимо включить в документ.

 3 Чтобы включить в документ вложения к наборам тестов, установите 
флажок Attachments.

Параметр Описание

All Добавляет все папки в дереве наборов тестов.

Selected Добавляет только выбранные папки из дерева наборов 
тестов. Выберите папки из дерева наборов тестов, 
отображенного под надписью Folders.
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 4 Чтобы после каждой папки с наборами тестов вставить разрыв страницы, 
установите флажок Page break after each test sets folder.

 5 Чтобы включить диаграммы в документ, откройте параметр Graphs и 
выберите диаграммы из списка диаграмм внизу страницы. Только 
диаграммы, которые сохранены как "избранное", включаются в список. 
Дополнительные сведения о представлениях избранного см. Глава 6, 
"Работа с избранными представлениями"..

 6 Разверните узел Test Lab в дереве Document Generator.

Чтобы включить данные наборов тестов в проектный документ, установите 
флажок Test Sets  и нажмите на ссылку Test Sets в  дереве Document 
Generator. Отобразится страница Test Sets.
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 7 В параметре Available Test Sets конкретизируйте, какие наборы тестов 
необходимо включить в документ.

 8 Чтобы добавить связанные дефекты, установите флажок Linked defects. 
Нажмите кнопку Customize для настройки связанных дефектов. 
Используйте диалоговое окно Tabular Layout, чтобы выбрать столбцы с 
дефектами, из которых будет состоять таблица, задать порядок столбцов, 
их ширину и заголовки. Также можно задавать, какие дефекты отображать: 
напрямую связанные с наборами тестов или также включать косвенно 
связанные дефекты.

 9 Чтобы после каждого набора тестов вставить в проектный документ разрыв 
страницы, установите флажок Page break after each test set.

 10 Чтобы включить диаграммы в документ, откройте параметр Graphs и 
выберите диаграммы из списка. Только диаграммы, которые сохранены как 
"избранное", включаются в список. Дополнительные сведения о 
представлениях избранного см. Глава 6, "Работа с избранными 
представлениями"..

 11 Разверните Tests Sets в дереве Document Generator.

Параметр Описание

All Добавляет все наборы тестов из выбранной папки 
набора тестов.

Selected Добавляет только выбранные наборы тестов. Нажмите 
кнопку Filter & Sort, чтобы задать критерии выбора 
набора тестов. Дополнительные сведения об 
использовании диалогового окна Filter см. раздел 
Глава 3, "Работа с данными Quality Center"..
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Чтобы включить данные тестов в проектный документ, установите флажок 
Tests и нажмите на ссылку Tests. Отобразится страница Test Page.

 12 В параметре Tests конкретизируйте, какие тесты необходимо включить в 
документ.

Параметр Описание

All tests Добавляет в документ все тесты из выбранного набора 
тестов.

Selected Добавляет только выбранные тесты. Нажмите кнопку 
Filter & Sort, чтобы задать критерии для выбора тестов. 
Дополнительные сведения об использовании 
диалогового окна Filter см. раздел Глава 3, "Работа с 
данными Quality Center"..
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 13 В параметре Test Layout задайте способ упорядочивания тестов.

 14 Если в качестве компоновки тестов выбран вариант Full page, можно 
задать следующие параметры:

Параметр Описание

Full page Отображает информацию о тесте в виде списка. 
Нажмите кнопку Customize, чтобы выбрать информацию, 
которая появится в документе.

Tabular Отображает информацию о тесте в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
Используйте диалоговое окно Tabular Layout, чтобы 
выбрать столбцы, из которых будет состоять таблица, 
задать порядок столбцов, их ширину и заголовки.

Примечание. В случае выбора варианта Tabular в 
документ будет невозможно включить выполнения 
тестов.

Параметр Описание

Test scripts Добавляет в документ скрипты тестов.

Components 
detailed layout

В случае использования HP Business Process Testing 
можно добавлять подробный формат компонентов, 
входящих в тесты. В подробном формате выберите 
элементы, которые необходимо включить.

Component steps: Добавляет шаги компонентов. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы 
шагов компонентов. Используйте диалоговое окно 
Tabular Layout, чтобы выбрать столбцы с дефектами, из 
которых будет состоять таблица, задать порядок 
столбцов, их ширину и заголовки.

Список итераций: содержит список итераций.

Attachments Добавляет в документ вложения к выполнениям тестов.
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 15 Чтобы добавить данные о выполнении теста в документ проекта, 
разверните узел Tests в дереве Document Generator. Установите флажок 
Runs и нажмите на ссылку Runs. Отобразится страница Runs. 

Linked defects Добавляет связанные дефекты в виде таблицы. Нажмите 
кнопку Customize для настройки таблицы связанных 
дефектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы с дефектами, из которых будет 
состоять таблица, задать порядок столбцов, их ширину и 
заголовки. Также можно конкретизировать какие дефекты 
отображать: непосредственно связанные с тестами или 
также включать косвенно связанные дефекты.

History Отображает список всех изменений, внесенных в тесты, а 
также их авторов.

Page break after 
each test

Вставляет разрывы страниц в документ проекта после 
каждого теста.

Параметр Описание
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 16 Под надписью Runs выберите один из следующих параметров:

 17 Под надписью Run Layout выберите один из следующих параметров:

 18 Если в параметре Run Layout выбран вариант Full page, можно выбрать 
Run steps для включения в документ список шагов тестирования.

Параметр Описание

Last run Добавляет только последнее выполнение теста.

All runs Добавляет все выполнения теста. 

Selected Добавляет в документ только выбранные выполнения 
теста. Нажмите кнопку Filter & Sort, чтобы задать 
критерии для выбора тестов. Дополнительные сведения 
об использовании диалогового окна Filter см. раздел 
Глава 3, "Работа с данными Quality Center"..

Параметр Описание

Full page Отображает список всех выполнений теста. Нажмите 
кнопку Customize, чтобы выбрать информацию, которая 
появится в документе.

Tabular Отображает все выполнения теста в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
Используйте диалоговое окно Tabular Layout, чтобы 
выбрать столбцы, из которых будет состоять таблица, 
задать порядок столбцов, их ширину и заголовки.
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Если в документ включаются шаги тестирования, выберите один из 
следующих вариантов в параметре Layout.

Также можно установить флажок Defects, чтобы включить в документ 
таблицу дефектов, связанную с шагами тестирования. Нажмите кнопку 
Customize, чтобы открыть диалоговое окно Tabular Layout для настройки 
таблицы связанных дефектов. Используйте диалоговое окно Tabular 
Layout, чтобы выбрать столбцы с дефектами, из которых будет состоять 
таблица, задать порядок столбцов, их ширину и заголовки. Также можно 
задавать, какие дефекты следует отображать: напрямую связанные с 
шагами тестирования или также включать косвенно связанные дефекты.

Если в документ включаются шаги тестирования, можно установить 
флажок Attachments, чтобы добавить в документ вложения к шагам 
тестирования.

Параметр Описание

Full page Отображает список всех шагов тестирования. Нажмите 
кнопку Customize, чтобы выбрать информацию, которая 
появится в документе.

Tabular Отображает в виде таблицы список всех шагов 
тестирования. Нажмите кнопку Customize, чтобы открыть 
диалоговое окно Tabular Layout для настройки 
параметров таблицы. Используйте диалоговое окно 
Tabular Layout, чтобы выбрать столбцы, из которых будет 
состоять таблица, задать порядок столбцов, их ширину и 
заголовки.
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 19 Если под надписью Run Layout выбран вариант Full page, можно 
установить следующие параметры:

Параметр Описание

Linked defects Добавляет таблицу дефектов, связанных с 
выполнениями теста. Нажмите кнопку Customize, чтобы 
открыть диалоговое окно Tabular Layout для настройки 
таблицы связанных дефектов. Используйте диалоговое 
окно Tabular Layout, чтобы выбрать столбцы с 
дефектами, из которых будет состоять таблица, задать 
порядок столбцов, их ширину и заголовки. Также можно 
задавать, какие дефекты необходимо отображать: 
напрямую связанные с выполнениями тестов или также 
включать косвенно связанные дефекты.

Attachments Добавляет в документ вложения к выполнениям теста.
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Задание данных в модуле Defects
Страница Defects используется для задания информации о дефектах в 
модуле Defects, которые должны появиться в разделе Track Defects 
документа проекта.

Как задать данные в модуле Defects.

 1 Чтобы включить данные о дефектах в документ проекта , установите 
флажок Defects и щелкните ссылку Defects в  дереве Document Generator. 
Отобразится страница Defects.
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 2 Под надписью Defects выберите один из следующих параметров:

 3 Под надписью Defects Layout выберите один из следующих параметров.

Параметр Описание

All defects Добавляет все дефекты из таблицы Defects Grid.

Selected Добавляет только выбранные дефекты. Нажмите кнопку 
Filter & Sort, чтобы задать критерии выбора дефектов. 
Дополнительные сведения об использовании 
диалогового окна Filter см. в главе Глава 3, "Работа с 
данными Quality Center"..

Параметр Описание

Full page Отображает все выбранные дефекты в виде списка. 
Нажмите кнопку Customize, чтобы выбрать информацию, 
которая появится в документе.

Tabular Отображает все выбранные дефекты в виде таблицы. 
Нажмите кнопку Customize, чтобы открыть диалоговое 
окно Tabular Layout для настройки параметров таблицы. 
Используйте диалоговое окно Tabular Layout, чтобы 
выбрать столбцы, из которых будет состоять таблица, 
задать порядок расположения столбцов, их ширину и 
заголовки.
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 4 Если в качестве компоновки дефектов выбран Full page, можно задать 
следующие параметры:

 5 Чтобы добавить диаграммы в документ, выберите Graphs и щелкните 
нужные диаграммы из списка. Только диаграммы, которые сохранены как 
"избранное", будут добавлены в список. Дополнительные сведения об 
избранных представлениях см. в главе Глава 6, "Работа с избранными 
представлениями"..

Параметр Описание

Attachments Добавляет в документ вложения к дефектам.

Linked defects Добавляет связанные дефекты в виде таблицы. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки таблицы связанных 
дефектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы с дефектами, из которых будет 
состоять таблица, задать порядок столбцов, их ширину и 
заголовки. Также можно задать отображение только 
прямых ссылок.

Linked entities Добавляет связанные объекты в виде таблицы. Нажмите 
кнопку Customize, чтобы открыть диалоговое окно 
Tabular Layout для настройки таблицы связанных 
объектов. Используйте диалоговое окно Tabular Layout, 
чтобы выбрать столбцы с дефектами, из которых будет 
состоять таблица, задать порядок столбцов, их ширину и 
заголовки. Также можно изменять заголовки и ширину 
столбцов.

History Отображает список всех изменений, внесенных в 
дефекты.

Page break after 
each defect

Вставляет разрывы страниц в проектном документе 
после каждого дефекта.
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Создание проектного документа
После установки инструкций по форматированию и задания данных 
проекта, можно создавать документ проекта. Документ сохраняется в виде 
файла Microsoft Word.

Совет. Можно сгенерировать документ проекта без включения в него 
подробных сведений для предварительного просмотра, что позволит 
быстро оценить вид документа. Для создания документа проекта для 
предварительного просмотра нажмите кнопку Preview. Quality Center 
откроет Microsoft Word и отобразит документ для предварительного 
просмотра.

Как создать документ

 1 Если открыты файлы документов проекта, созданные во время 
предыдущего выполнения генератора документов, закройте эти файлы.

 2 Нажмите кнопку Full Document. Откроется диалоговое окно Save As.

 3 В поле Save As выберите папку для сохранения документа в файловой 
системе сети.

 4 В поле File name присвойте документу имя.

 5 Нажмите кнопку Save. 

Quality Center Quality Center начнет создание документа, а в диалоговом 
окне будет отображен процесс создания документа.Для отмены создания 
документа нажмите кнопку Stop.

По завершении процесса откроется Microsoft Word и отобразит документ.

Если в созданном документе содержатся ссылки на вложения, то в том же 
месте, где расположен документ, будет создана папка, содержащая 
скопированные в нее вложения. Название папки с вложениями будет 
совпадать с названием документа, но оно буде содержать суффикс 
"_Attachments". При отправке документа по электронной почте вместе с 
ним можно отправить папку с вложением, чтобы получатель мог перейти к 
вложениям по ссылкам.
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37
Создание отчетов Excel

Можно создавать отчеты Excel, позволяющие экспортировать данные 
среды Quality Center в приложение Microsoft Excel и анализировать их в 
этой программе.

Примечание. Чтобы проверить, какие версии Microsoft Excel 
поддерживаются, см. руководство Руководство по установке 
HP Quality Center.

Глава содержит следующие разделы: На стр.

Сведения о создании отчетов Excel 586

Запуск генератора отчетов Excel 587

Создание отчетов Excel. 588

Добавление параметров 597

Создание отчетов 600

Управлением отчетами Excel 601
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Сведения о создании отчетов Excel
Можно экспортировать данные  среды Quality Center в Microsoft Excel. Это 
позволяет использовать Excel для анализа данных и их отображения в 
графическом виде. Отчет состоит из набора данных, полученного из базы 
данных проекта с помощью  запроса SQL. Также для обработки и анализа 
полученных данных можно запустить скрипт Visual Basic. 

Например, можно создать сводную таблицу для суммирования данных 
модуля Defects, чтобы отобразить в виде таблицы количество дефектов, 
соответствующих  пользователям с разными статусами.

Также можно создавать отчеты с параметрами. Это позволяет создать 
более гибкий отчет, который необходимо составляется только один раз, но 
который можно использовать в разных ситуациях. 

После создания отчета его можно удалять, переименовывать, копировать 
или экспортировать его определение в файл XML. Можно также 
импортировать определение отчета, ранее экспортированное в файл XML.
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Запуск генератора отчетов Excel
С помощью генератора отчетов Excel можно создавать отчеты и управлять 
ими. Чтобы открыть генератор отчетов Excel, нажмите кнопку Tools в 
верхнем правом углу окна Quality Center и выберите Excel Report 
Generator.

Примечание. Большинство функциональных возможностей отчетов Excel 
остаются недоступными, если вы не принадлежите к группе пользователей 
с необходимыми  привилегиями. Дополнительные сведения о группах 
пользователей и привилегиях см. в разделе Руководство 
администратора HP Quality Center. 
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Генератор отчетов Excel состоит из следующих основных элементов.

➤ Панель инструментов Excel Reports. Содержит кнопки команд, часто 
использующихся для создания и изменения отчетов Excel.

➤ Дерево Excel Reports. Расположено в левом окне; отображает доступные 
отчеты проекта.

➤ Вкладка General. Содержит основные данные об отчете.

➤ Вкладка Query. С ее помощью можно определять и тестировать запросы 
SQL, позволяющие получать данные из базы данных проекта Quality Center  
в Excel.

➤ Вкладка Post-processing. Позволяет определить, какой скрипт Visual Basic 
необходимо запустить в программе Excel после экспорта данных отчета.

➤ Вкладка Generation Settings. Позволяет определить параметры создания 
отчета.

Создание отчетов Excel.
Чтобы создать отчет Excel выполните следующие действия:

➤ Сначала добавьте отчет к дереву отчетов Excel. Дополнительные сведения 
см. в разделе “Добавление отчетов" на стр. 589.

➤ Затем с помощью запроса SQL на получение данных из базы данных 
проекта определите, какие данные включать в отчет. Дополнительные 
сведения см. в разделе “Создание аззапросов SQL" на стр. 591. 

➤ По желанию можно также добавить скрипт Visual Basic для обработки 
данных в программе Excel после экспорта данных отчета из Quality Center. 
Дополнительные сведения см. в разделе “Создание сценария Post-
processing" на стр. 594.

После того, как будут заданы эти установки, можно создавать отчет. 
Дополнительные сведения о создании отчетов см. “Создание отчетов" на 
стр. 600.
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Добавление отчетов
Создание отчета начинается с добавления отчета к дереву отчетов Excel.

Для добавления отчета:

 1 Нажмите кнопку Tools в верхнем правом углу окна Quality Center и 
выберите Excel Report Generator. Откроется генератор отчетов Excel.

 2 В дереве отчетов Excel выберите папку, в которой необходимо создать 
отчет:

➤ Public. Доступ к отчетам из этой папке имеют все пользователи проекта.

➤ Private. Доступ к отчетам из этой папке имеют только их создатели.

Нажмите Add Excel Report кнопка. Откроется диалоговое окно New Excel 
Report.

 3 В поле Excel Report Name  введите имя отчета и нажмите OK. Учтите, что 
имя отчета не должно содержать следующие символы: / \ ? * = < > | : . " ' %

Отчет добавится в дерево отчетов Excel.
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 4 Перейдите на вкладку General. На вкладке General отображаются общие 
параметры отчета.

 5 В поле Designer выберите имя лица, создавшего отчет. По умолчанию 
отображается ваше имя пользователя.

 6 В поле Status  выберите статус отчета. 

Статус отчета информирует других пользователей о степени готовности 
отчета к созданию. Доступны следующие статусы отчета:

➤ Ready. Показывает, что отчет готов к созданию. 

➤ Not Ready. Показывает, что отчет не готов к созданию. Если 
пользователь попытается создать отчет с этим статусом, появится 
сообщение с предупреждением.

 7 В поле Description введите описание отчета. Можно изменить 
форматирование описания с помощью следующих параметров на панели 
инструментов форматирования. Если эта панель инструментов 
недоступна, щелкните правой кнопкой мыши Description и выберите 
Toolbar Visible.

 8 Теперь можно формулировать запросы SQL для получения данных из 
проектаQuality Center. Дополнительные сведения см. в разделе “Создание 
аззапросов SQL" на стр. 591.
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Создание аззапросов SQL
После добавления отчета в дерево отчетов Excel необходимо определить, 
какие данные проекта должны быть включить в отчет. Эти данные 
определяются на основании запросов SQL на получение данных из базы  
данных.

Внимание! Рекомендуется запускать только те запросы, которые 
извлекают данные из базы данных проекта. Не следует запускать запросы, 
изменяющие базу данных проекта путем добавления, модификации или 
удаления в ней записей.

По умолчанию, в целях обеспечения действенности запросов и во 
избежание изменения базы данных проекта Quality Center установите 
следующие флажки:

➤ запрос начинается с команды SELECT;

➤  запрос содержит только одну инструкцию SQL;

➤ запрос не содержит следующих команд (допускаются только в 
комментариях): INSERT, DELETE, UPDATE, DROP, CREATE, COMMIT, 
ROLLBACK, ALTER, EXEC, EXECUTE, MERGE, GRANT, REVOKE, SET, 
INTO или TRUNCATE.

Настройку выполнения этой проверки и способ ее проведения можно 
задать с помощью параметров SQL_QUERY_VALIDATION_ENABLED и 
SQL_QUERY_VALIDATION_BLACK_LIST в разделе Site Administration. 
Подробные сведения приведены в разделе Руководство администратора 
HP Quality Center.
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Порядок создания SQL-запроса.

 1 В дереве отчетов Excel выберите отчет. Перейдите на вкладку Query. 

На вкладке Query расположены следующие области и вкладки:

➤ Область SQL. Содержит в отчете инструкции SQL для запросов;

➤ вкладка Query Parameters. Содержит перечень параметров запроса.

➤ вкладка Query Results. Содержит результаты проверок запроса.

➤ панель Entities. Содержит перечень Quality Center полей базы данных и 
логические объекты, которые можно добавить к запросу. Можно 
осуществлять просмотр полей и логических объектов по их имени, 
имени столбца в базе данных или обоими способами. Чтобы изменить 
вид, нажмите кнопку Entities View и выберите нужный вид. 

 2 В области  SQL введите инструкцию SQL для определения массива 
данных, который будет использоваться в отчете.

Панель 
SQL

Панель 
объектов
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Примечания. 

➤ Необходимо записать инструкцию SQL с помощью версии SQL, 
применяющейся в базе данных проекта. Для просмотра типа базы 
данных, использующегося в базе данных проекта, нажмите кнопку 
Database Type.

➤ Символы @ и \ имеют особое значение и не читаются буквально, при 
выполнении инструкций  SQL в базе данных проекта. Если необходимо 
читать эти символы буквально, следует заменить @ на \@ , а  \ на \\. 
Например, если необходимо, чтобы инструкция  
SELECT * FROM BUG WHERE BUG.BG_SUMMARY = ‘@parameter@’ 
читалась буквально в базе данных Quality Center,  введите 
SELECT * FROM BUG WHERE BUG.BG_SUMMARY = ‘\@parameter\@’.

 3 В инструкцию SQL можно добавить логический объект проекта. Доступны 
следующие возможности:

➤ Чтобы добавить логический объект проекта без псевдонима столбца, 
дважды щелкните объект в области Entities или выберите объект и 
нажмите кнопку Add Entity to Query. 

➤ Чтобы добавить логический объект проекта с псевдонимом столбца, 
определенным по названию логического объекта, выберите объект, 
который следует добавить. Нажмите стрелку Add Entity to Query и 
выберите Add Entity to Query with Entity Title as Alias.

Логический объект добавится к инструкции SQL в текущем месте 
расположения курсора.

 4 К SQL-оператору можно добавить параметр. Дополнительные сведения см. 
в разделе “Добавление параметров" на стр. 597.
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 5 Можно провести проверку запроса и просмотреть его результаты на 
вкладке Query Results. Можно также просмотреть все результаты запроса 
или только первые десять записей.

➤ Для просмотра результатов запроса на вкладке Query Results нажмите 
Run Query. Если запрос содержит параметры, программа попросит 
ввести значение каждого параметра или подтвердить значения по 
умолчанию.

➤ Для отображения только первых десяти результатов запроса нажмите 
Test Query. Если запрос содержит параметры, Quality Center 
используйте значения параметров по умолчанию.

 6 В запросе можно указать поиск текста. Для поиска текста укажите строку, 
которую необходимо искать, в поле Find и нажмите кнопку Find.

 7 Чтобы добавить новый запрос, нажмите кнопку Add Query. Запрос с 
именем по умолчанию Номер<листа> добавляется как новая вкладка на 
панель SQL.  Результаты каждого запроса отображаются в отдельной 
рабочей таблице Excel.

 8 Запросы можно переименовывать. Чтобы переименовать запрос, выберите 
его и нажмите кнопку Rename. В диалоговом окне Rename Sheet Name 
введите новое имя и нажмите кнопку OK. Рабочая таблица Excel, 
содержащая выбранные в ходе запроса данные, будет иметь то же самое 
имя, что и  запрос.

 9 Для удаления запроса выберите его и нажмите кнопку Delete. 
Альтернативный вариант —  щелкните запрос правой кнопкой мыши и 
выберите Delete. Для подтверждения нажмите кнопку Yes.

Создание сценария Post-processing
Можно создать скрипт Visual Basic, который будет запускаться  после 
экспорта данных в программу Excel Используйте этот скрипт для операций 
с данными в Excel. Например, можно представлять требуемые данных в 
Excel в виде сводной таблицы, выполнять вычисления с данными о 
дефектах для подсчета среднего времени, необходимого для устранения 
обнаруженного дефекта. Кроме того, на основании выбранных данных 
можно создавать диаграммы.
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Для создания скрипта Post-processing.

 1 В дереве отчетов Excel выберите отчет. Перейдите на вкладку Post-
processing.

 2 В окне редактора скриптов укажите скрипт Visual Basic, который 
необходимо запустить после импорта в Excel данных, определенные в 
запросе. Этот скрипт должен использовать шаблон скрипта, отображенный  
в окне Script Editor. Дальнейшие рекомендации по созданию скрипта 
последующей обработки данных  см. в “Инструкции по созданию скрипта 
Post-Processing" на стр. 596.

 3 Для запуска   скрипта последующей обработки данных после их импорта в 
Excel выберите Run post-processing. Если не установить этот флажок, 
скрипт не будет запущен после создания отчета.

 4 В скрипте последующей обработки можно выполнять поиск текста. Для 
поиска текста укажите строку, которую необходимо искать, в поле Find и 
нажмите кнопку Find.
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Инструкции по созданию скрипта Post-Processing
При записи скрипта последующей обработки, обратите внимание на 
следующие инструкции:

➤ Перед запуском скрипта последующейобработки необходимо задать 
параметры безопасности в Microsoft Excel таким образом, чтобы 
приложение Excel могло выполнить скрипт. В Excel выберите Сервис > 
Макрос > Безопасность. Откроется диалоговое окно "Безопасность". На 
вкладке "Уровень безопасности" установите Низкий. На вкладке 
"Надежные источники" выберите "Доверять проекту Visual Basic".

➤ Скрипт последующей обработки должен содержать подпрограмму 
QC_PostProcessing. Эта подпрограмма используется в качестве точки 
входа в скрипт. Эта подпрограмма не возвращает значение и не 
использует никаких аргументов.

➤ Перед началом работы с данными отчета в программе Excel необходимо 
определить диапазон, содержащий данные отчета. Этот диапазон 
определяется за два шага: 

➤ Сначала определяется рабочая таблица, содержащая данные отчета, 
путем создания объекта рабочей таблицы с данными. Например, если 
рабочая таблица имеет имяSheet1, можно использовать инструкцию Set 
MainWorksheet = ActiveWorkbook.Worksheets(“Sheet1”).

➤ После определения рабочей таблицы, содержащей данные отчета, 
определяется диапазон с данными путем создания объекта диапазона, 
содержащего данные. Например, если определена рабочая таблица с 
именемMainWorksheet, можно использовать инструкцию Set DataRange 
= MainWorksheet.UsedRange. 

После определения этого диапазона можно оперировать данными, 
содержащимися в нем, с использованием кода на языке Visual Basic.

➤ Новые Quality Center проекты содержат несколько отчетов о дефектах. 
Можно использовать скрипты этих отчетов как основу для разработки 
собственных скриптов.
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Добавление параметров
 Можно добавлять параметры в запрос SQL на получение отчета. Каждому 
параметру можно присвоить значение по умолчанию. Во время создания 
отчета программа предложит ввести значение каждого параметра или 
подтвердить значения по умолчанию. Или можно всегда использовать 
значения по умолчанию без необходимости получения подсказки среды 
Quality Center каждый раз при создании отчета.

Например, предположим, что необходимо создать отчет, содержащий 
диаграмму количества запросов, добавленных в проект в течение 
определенного периода времени. Возможно, потребуется запускать отчет 
несколько раз (каждый раз для другого периода времени). Можно избежать 
создания нескольких отчетов, создав один отчет с параметрами даты 
начала и даты конца периода. Каждый раз при создании отчета программа 
попросит ввести начальную и конечную дату периода.

Сначала добавьте параметры к каждому отчету в списке параметров. 
Можно добавить глобальные параметры, доступные для всех запросов в 
отчете, или добавить параметры, которые могут использоваться только в 
отдельных запросах. После добавления параметров в  список параметров 
можно добавить параметры из списка Parameters List к запросам в отчете.

Добавление параметров к списку Parameters List
Перед добавлением параметра в запрос необходимо его добавить в список 
Parameters List.

Для добавления параметра в список:

 1 В дереве отчетов Excel выберите отчет. Нажмите вкладку Query.
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 2 На вкладке Query Parameters нажмите кнопку New Parameter. Откроется 
диалоговое окно New Parameter.

 3 В поле Parameter Name введите имя параметра.

 4 В поле Default Value введите значение параметра по умолчанию. Если 
необходимо  создать отчет в автоматическом режиме (без подсказок 
программы для ввода значений параметров), будет использоваться это 
значение. Оно также отображается как значение по умолчанию при 
использовании подсказок программы для ввода  параметров.

 5 В поле Description введите описание параметра.

 6 Установите флажок Hide On Run, если не требуется, чтобы Quality Center, 
предлагал ввести значения параметров при создании запроса.

 7 Поставьте флажок в поле Global Parameter, чтобы сделать параметр 
доступным для всех запросов в отчете. Если в этом поле флажок будет 
снят, параметр будет доступен только для текущего запроса.

 8 Нажмите кнопку OK. Параметр будет добавлен в список параметров.

 9 Для удаления параметра из списка  выделите его и нажмите Delete. Для 
подтверждения нажмите кнопку Yes.
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Примечание. В случае удаления параметра, использующегося в запросе 
на получение отчета, запросы с этим параметром станут 
недействительными. Если попытаться удалить такой параметр из списка 
параметров, отобразится сообщение с предупреждением.

 10 Для изменения параметра в списке параметров, выделите этот параметр и 
нажмите Edit Parameter. В диалоговом окне Edit Parameter измените 
параметр и нажмите кнопку OK.

Добавление параметра в SQL-запросу
После добавления параметра в список параметров его можно добавить в 
SQL-запрос.

Для добавления параметра в SQL-запрос:

 1 В дереве отчетов Excel выберите отчет. Перейдите на вкладку Query.

 2 В области SQL, расположенной вверху слева на вкладке Query, поместите 
курсор в то место, в которое необходимо добавить параметр.

 3 На вкладке Query Parameters выберите параметр в списке параметров и 
нажмите кнопку Add Parameter to Query. Параметр будет добавлен к 
запросу.

Примечание. Для параметра, представляющего собой текстовую 
величину, необходимо на панели SQL вручную добавить одинарные 
кавычки ('). Например, если панель SQL содержит фразу WHERE 
BUG.BG_DETECTED_BY = @name@, необходимо заменить текст 
@name@ на '@name@'.
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Создание отчетов
После создания отчета, можно составить отчет для получения данных из 
базы данных проекта, указанных в SQL-запросах, и экспортировать его в 
Excel.

Для создания отчета:

 1 В дереве отчетов Excel выберите отчет. Перейдите на вкладку Generation 
Settings.

 2 Если необходимо Quality Center открыть отчет в программе Excel после его 
создания, установите флажок Open Report.

 3 В поле Save report as target file укажите папку и название файла Excel, в 
который необходимо  экспортировать данные. Для выбора папки нажмите 
кнопку обзора в диалоговом окне Save Report.

 4 Нажмите кнопку Generate Excel Report  для создания отчета.

➤ Если отчет имеет статус Not Ready, то об этом предоставляется 
информация и запрашивается, хотите ли вы создать отчет. Нажмите 
кнопку Yes, чтобы создать отчет.

➤ Если запрос отчета содержит параметры, откроется диалоговое окно 
Report Parameters. Введите значение параметра в столбец Value и 
нажмите кнопку OK.
600



Глава 37 • Создание отчетов Excel
Отчет сохранится в указанной папке. Если необходимо открыть отчет после 
его создания, запустится приложение Excel, которое  отобразит отчет. Если 
не требуется открывать отчет после его создания, отобразится 
подтверждающее сообщение.

Управлением отчетами Excel
После создания отчета Excel можно удалять, переименовывать или 
копировать его. Также можно экспортировать и импортировать 
определение отчета.

Удаление отчетов Excel
Отчет Excel можно удалить.

Для удаления отчета Excel:

 1 В дереве отчетов Excel выделите отчет и нажмите кнопку Delete. 
Альтернативный вариант — щелкните отчет правой кнопкой мыши и 
выберите Delete.

 2 Для подтверждения нажмите кнопку Yes.

Переименовывание отчетов Excel
Отчет Excel можно переименовать.

Порядок переименования отчета Excel.

 1 В дереве отчетов Excel выделите отчет и щелкните по имени отчета.

 2 Введите новое имя отчета и нажмите ENTER.

Копирование отчетов Excel
Отчет Excel можно копировать. Это позволяет создать новый отчет Excel 
на основе существующего отчета путем  копирования последнего и 
внесения изменений в копию.

Для копирования отчета Excel:

 1 В дереве отчетов Excel выберите отчет.
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 2 Нажмите кнопку Duplicate Excel Report. Альтернативный вариант — 
щелкните по отчету правой кнопкой мыши и выберите Duplicate Excel 
Report. Будет создана копия отчета в той же самой папке дерева отчетов 
Excel.

Экспорт определений отчетов Excel
Определение отчета Excel можно экспортировать в файл XML. Это 
позволяет передавать параметры конфигурации отчета Excel из одного 
проектаQuality Center в другой или архивировать определение отчета Excel 
для последующего использования.

Для экспорта определения отчета Excel:

 1 В дереве отчетов Excel выделите отчет и нажмите кнопку Export Excel 
Report Definition. Альтернативный вариант — щелкните отчет правой 
кнопкой мыши и выберите Export Excel Report Definition. Откроется 
диалоговое окно Export Excel Report Definition.

 2 В поле Save in выберите папку для сохранения файла XML.

 3 В поле File name введите имя файла XML. 

 4 Нажмите кнопку Save.

Импорт определений отчетов Excel
Можно импортировать определение отчета Excel, ранее сохраненное как 
файл XML.

Для импорта определения отчета Excel:

 1 В дереве отчетов Excel выделите папку для импорта отчета и нажмите 
кнопку Import Excel Report Definition. Альтернативный вариант — 
щелчком правой кнопки мыши выделите папку для импорта отчета и 
нажмите Import Excel Report Definition. Откроется диалоговое окно Import 
Excel Report Definition.

 2 В поле File name выберите определение отчета в файле XML.

 3 Нажмите кнопку Open. Определение отчета будет добавлено в указанную 
папку в дереве отчетов Excel.
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Часть VIII
Приложения





A
Работа сс VAPI-XP 

С помощью средства тестирования прикладного программного интерфейса 
открытой архитектуры VAPI-XP  можно создавать новые скрипты тестов 
или изменять уже существующие и интегрировать их в процесс 
тестирования. 

Глава содержит следующие разделы: На стр.

Сведения о работе с VAPI-XP 606

Разработка скриптов тестов VAPI-XP 607

Изменение скриптов тестов VAPI-XP 617

Использование VAPI-XP API 622

Прогон тестов VAPI-XP в режиме отладки 628

Прогон тестов VAPI-XP в режиме тестирования 629

Отладка скриптов тестов VAPI-X 631
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Сведения о работе с VAPI-XP
Средство тестирования VAPI-XP позволяет создавать новые скрипты 
тестов с помощью Microsoft VBScript, Microsoft JavaScript (версия JScript ), 
PerlScript и PythonScript и применять эти скрипты  в процессе тестирования. 
С помощью скриптов  тестов VAPI-XP можно тестировать серверы 
COM/DCOM, веб-службы на основе SOAP, API Java (такие, как классы Java 
и компоненты  EJB), а также консольные приложения. Средство 
тестирования VAPI-XP также можно использовать для создания 
виртуального пользователя LoadRunner. 

Кроме того, VAPI-XP полностью интегрировано с Quality Center, что 
позволяет разрабатывать скрипты тестов VAPI-XP,  вызывающие любой 
тест или набор тестов Quality Center и выполнять их в качестве части 
собственного скрипта пользователя. Это позволяет построить более 
современный поток выполнения набора тестов, где возможно 
отфильтровать каждый тест в наборе непосредственно в процессе 
исполнения с учетом его  статуса или типа.

VAPI-XP также полностью интегрирован с прикладным  программным  
интерфейсом  открытой архитектуры  среды Quality Center.  Все классы и 
методы прикладного программного интерфейса открытой архитектуры 
могут получать ссылочные имена от пользовательских интерфейсов VAPI-
XP, так что их можно включать в скрипты.  
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Разработка скриптов тестов VAPI-XP
Можно разрабатывать скрипты тестов VAPI-XP из дерева   плана 
тестирования модуля Test Plan.

Примечание. Кроме того, можно преобразовывать ручной тест в тест VAPI-
XP. На вкладке Design Steps нажмите кнопку Generate Script и выберите 
VAPI-XP-TEST. Quality Center создаст скрипт теста VAPI-XP, содержащий 
код для определенных ранее шагов. Такой скрипт также содержит код 
вызываемых тестов, которые содержал исходный ручной тест. Чтобы 
ознакомиться с подробными сведениями о ручных тестах,  см. главу 
Глава 19, "Разработка тестов"..

Чтобы создать скрипт теста VAPI-XP, выполните следующие 
действия:

 1 Выберите папку объектов в дереве плана тестирования.

 2 Нажмите кнопку New Test или выберите команду Tests > New Test. 
Откроется диалоговое окно Create New Test.

 3 В поле Test Type выберите VAPI-XP-TEST.

 4 В поле Test Name введите имя теста. Учтите, что имя теста не должно 
содержать следующие символы: \ / : " ? < > | * % ‘

Нажмите кнопку OK.
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Примечание. Если обязательные поля теста были определены в окне 
Project Customization, откроется диалоговое окно Required Test Fields. 
Выберите значения для обязательных полей и нажмите OK.

Откроется мастер HP VAPI-XP.

 5 В поле Script Language выберите язык для разработки скриптов. 
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Примечание. Для разработки скриптов тестов VAPI-XP на языке 
ActivePython или ActivePerl компании ActiveState эти языки должны быть 
установлены на данном компьютере. В меню Help на вкладке Test Script 
выберите ActivePython Home Page или ActivePerl Home Page и следуйте 
инструкциям по установке.

Обычно языки скриптов Microsoft VBScript и Microsoft JScript 
устанавливаются вместе с веб-обозревателем Internet Explorer. Если они 
не установлены, выберите VBScript Home Page или JScript Home Page в 
меню Help на вкладке Test Script и следуйте инструкциям по установке.

 6 В поле Script Name введите имя скрипта теста VAPI-XP.

 7 Если в качестве языка скрипта теста выбран VBScript или JavaScript, 
выберите Create HP LoadRunner Vuser, чтобы создать скрипт 
виртуального пользователя  LoadRunner, который можно будет выполнять 
в контроллере LoadRunner Controller. 

Примечание. Для выполнения виртуального пользователя в контроллере 
на клиентском компьютере, использующем LoadRunner, необходимо 
установить последнюю версию надстройки Connectivity среды  
HP Quality Center. Загрузить ее можно  со  страницы надстроек  
HP Quality Center. Дополнительные сведения см. в руководстве 
Руководство по установке HP Quality Center. 
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 8 Чтобы продолжить создание скрипта теста с использованием мастера HP 
VAPI-XP, нажмите кнопку Next. Откроется следующее диалоговое окно.

Примечание. Чтобы закрыть мастер и продолжить создание скрипта теста 
на вкладке Test Script, в любом окне можно нажать кнопку Finish.

 9 Выберите тип теста, который необходимо создать.

 10 Чтобы продолжить создание скрипта теста с использованием мастера HP 
VAPI-XP, нажмите кнопку Next. 
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➤ Если был выбран тип COM/DCOM Server Test, то в реестре своего 
компьютера выберите идентификаторы программ объектов 
COM/DCOM, которые необходимо протестировать, и нажмите кнопку +. 
Каждый выбранный объект COM/DCOM и его описание отобразятся в 
приведенном ниже окне.
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➤ Если был выбран тип Java Class Test, в поле Java Class Name введите 
полное имя класса Java, который необходимо протестировать, и 
нажмите кнопку +. Введенное имя класса Java отобразится в текстовом 
поле ниже.

Примечание. Можно использовать только тот класс Java, который имеет 
общий конструктор без аргументов.
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В разделе Java Virtual Machine выберите Other JVM, если не хотите 
использовать виртуальную машину Microsoft Java по умолчанию, и 
укажите следующее: 

➤ JVM Runtime. Исполняемый файл среды выполнения виртуальной 
машины Java (обычно java.exe).

➤ Java Compiler. Исполняемый файл, который перекомплирует байт-
код в конкретную платформу (обычно javac.exe).

➤ Classpath. Перечень дополнительных (нестандартных) библиотек 
Java, разделенных точкой с запятой (;), необходимых для 
выполнения заданного приложения Java. Учтите, что если путь к 
классу Java указан не был, Quality Center будет использовать 
переменную среды CLASSPATH.

➤ JVM Parameters. Параметры исполняемого файла 
среды-выполнения виртуальной машины Java.

Если виртуальная машина Microsoft Java, необходимая для отладки 
пользовательских скриптов тестов, на компьютере не установлена, 
запустите файл msjavx86.exe, находящийся в каталоге Redist на диске 
DVD HP Quality Center.

Чтобы можно было использовать другие виртуальные машины Java, 
установите пакет программного обеспечения Bean Scripting Framework 
(BSF) Java на клиентский компьютер. Распакуйте файл bsf-bin-22.zip, 
находящийся в каталоге Redist на диске DVD HP Quality Center. В 
распакованном файле найдите файл bsf.jar и добавьте путь к нему в 
поле CLASSPATH. Убедитесь, что переменная среды CLASSPATH 
содержит точку (.), указывающую на текущий каталог.

При работе с другими виртуальными машинами Java добавьте путь к 
библиотекам BSF в путь системы следующим образом: На панели 
управления выберите Система > Свойства системы, а затем 
перейдите на вкладку Дополнительно. Нажмите кнопку Переменные 
среды и в области Системные переменные измените параметр Путь, 
добавив в него путь к следующим библиотекам DLL: msvcp60.dll, 
bsfactivescriptengine.dll и bsfactivescriptengine_g.dll. Нажмите кнопку 
OK.
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➤ Если был выбран тест Web Service (SOAP) Test, из перечня SOAP 
Client Library выберите клиентскую библиотеку SOAP и в поле Web 
Service Definition введите или выберите URL-адрес , который 
необходимо протестировать. Нажмите кнопку +. Введенный URL-адрес 
отобразится в приведенном ниже текстовом поле.

Примечание. Поддерживаются две клиентские библиотеки SOAP: Microsoft 
SOAP SDK и PocketSOAP. Учтите, что при выборе работы с PocketSOAP 
для анализа веб-служб необходимо установить пакет Microsoft SOAP SDK. 
Если Microsoft SOAP SDK еще не установлен на компьютере, запустите 
файл SoapToolkit30.exe, расположенный в каталоге Redist на диске DVD 
HP Quality Center.

➤ Если был выбран тип Console Application Test, в поле Application 
Executable File введите имя файла приложения, которое необходимо 
протестировать, а его параметры – в поле Command Line Parameters. 
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Если нет необходимости заменять стандартный вывод окном вывода 
VAPI-XP, снимите флажок Use VAPI-XP Output instead of Standard 
Output.

В поле Application Timeout введите время в миллисекундах, в течение 
которого Quality Center будет ожидать завершения выполнения 
приложения. Учтите, что при установке времени ожидания -1 
Quality Center будет ожидать завершения выполнения приложения 
бесконечно.

Нажмите кнопку +. Введенный данные отобразятся в текстовом поле 
ниже.
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 11 Чтобы продолжить создание сценария тестирования с использованием 
мастера HP VAPI-XP, нажмите кнопку Next. Откроется следующее 
диалоговое окно.

 12 В списке Service выберите функции, которые необходимо добавить в 
сценарий тестирования. Дважды щелкните мышью на каждой функции или 
перетащите ее, чтобы добавить функцию в код сценария. Функция будет 
добавлена в поле под списком Service.

 13 Если необходимо, в нижней области данного окна введите 
дополнительные параметры или добавьте дополнительный код в скрипт.

 14 Нажмите кнопку Finish. Новый тест появится в дереве плана тестирования 
под выбранной папкой объектов.
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Примечание. К созданному тесту VAPI-XP можно добавить подробные 
сведения или вложения или определите покрытие требований тестами. 
Дополнительные сведения см. Глава 17, "Создание дерева плана 
тестирования". 

Изменение скриптов тестов VAPI-XP
После создания скрипта теста VAPI-XP с помощью мастера HP VAPI-XP в 
него можно внести изменения на вкладке Test Script.

Совет. Чтобы открыть вкладку Test Script в отдельном окне, выберите 
пункт меню View > Window Screen или нажмите кнопку Window Screen.
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Чтобы изменить скрипт теста VAPI-XP, выполните следующие 
действия:

 1 В дереве плана тестирования выберите тест VAPI-XP и перейдите на 
вкладку Test Script. Отобразится скрипт теста.

Примечание. Для просмотра или изменения свойств созданного 
пользователем скрипта теста выберите пункт меню Test > Properties.

 2 Для просмотра списка определений, методов и свойств объекта, которые 
можно добавить в сценарий, выберите один из следующих параметров.

➤ Test > References > COM Library References. Откроется диалоговое 
окно References , в котором можно выбрать определения, методы и 
свойства объекта СОМ, которые необходимо просмотреть.
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➤ Test > References > SOAP Web Service References. Откроется 
диалоговое окно Add Web Service Reference, в котором можно ввести 
определение или метод объекта веб-службы, которые необходимо 
просмотреть. 

➤ Test > References > Java Class References. Откроется диалоговое окно 
Add Java Class Reference, в котором можно ввести определение или 
метод класса Java, которые необходимо просмотреть.

 3 Выберите пункт меню View > Browsers или нажмите кнопку Show/Hide 
Browsers. Будут отображены следующие вкладки.

➤ Вкладка Library. Список определений, методов и свойств объектов 
VAPI-XP (SRunner), Quality Center (TDAPIOLELib) и COM/DCOM, которые 
можно добавить в сценарий пользователя. Разъяснение определений, 
методов и свойств объектов VAPI-XP см. в п. “Использование VAPI-XP 
API" на стр. 622. Пояснения относительно определений, методов и 
свойств объектов Quality Center приведены в документе 
HP Quality Center Справочная информация по интерфейсам API 
открытой архитектуры тестирования.

➤ Вкладка Soap. Список определений, методов и свойств объектов веб-
служб, которые можно добавить в сценарий пользователя. 

➤ Вкладка Java. Список определений, методов и свойств классов Java, 
которые можно добавить в скрипт пользователя. 

➤ Вкладка Function. Список функций, содержащихся в скрипте 
пользователя.

➤ Вкладка Object. Список объектов с определенными для них именами, 
которые можно добавить в скрипт пользователя.
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Примечание. Для получения пояснений относительно каждого 
определения, метода или свойства объектов выберите пункт меню View > 
Output и перейдите на вкладку Help.

 4 Чтобы добавить определение, метод или свойство в текущую функцию в 
сценарии пользователя, установите курсор в соответствующее место кода 
и дважды щелкните мышью определение, метод или свойство на вкладках 
Library, Soap или Java. 

 5 Для добавления объекта с определенным именем на вкладках Library, 
Soap или Java выберите определение, метод или свойство объекта, а 
затем выберите пункт меню Test > Add Object. В диалоговом окне Add 
Object введите имя, которое необходимо присвоить объекту, и нажмите 
кнопку OK. Объект будет добавлен на вкладку Object.
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Чтобы добавить объект в сценарий, дважды щелкните мышью объект или 
щелкните на объекте правой кнопкой мыши и выберите Insert into Script.

 6 Чтобы проверить синтаксис кода, выберите пункт меню Test > Check 
Syntax или нажмите кнопку Syntax Check. Для просмотра результатов 
проверки на вкладке Output выберите пункт меню View > Output.

Дополнительные функции изменения
На вкладке Test Script также можно выполнять следующие функции 
изменения.

➤ Чтобы отменить предыдущее действие, нажмите кнопку Undo. Чтобы 
восстановить отмененное действие, нажмите кнопку Redo.

➤ Чтобы удалить фрагмент кода из одной части сценария и вставить его в 
другую часть сценария, выберите фрагмент кода и нажмите кнопки Cut и 
Paste. 

➤ Чтобы скопировать фрагмент кода из одной части сценария и вставить его 
в другую часть сценария, выберите фрагмент кода и нажмите кнопки Copy 
и Paste. 

➤ Чтобы удалить фрагмент кода, выберите фрагмент и нажмите кнопку 
Delete.

➤ Чтобы найти определенный текст в скрипте, нажмите кнопку Find in Script. 
В диалоговом окне Find Text введите текст, который необходимо найти. 
Выберите параметры, направление, область и начало поиска и нажмите 
кнопку OK. 

Чтобы найти следующее вхождение данного текста в скрипте , выберите 
Search > Find Next.

➤ Чтобы найти определенный текст в скрипте и заменить его другим текстом, 
нажмите кнопку Replace. В поле Text to find диалогового окна Find Text 
введите текст, который необходимо найти. В поле Replace with введите 
текст, которым следует заменить заданный текст. Выберите параметры, 
направление, область и начало поиска и нажмите кнопку OK. Чтобы 
заменить все вхождения данного текста в скрипте, нажмите кнопку Replace 
All.
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➤ Чтобы перейти к определенной строке в скрипте , выберите пункт 
Search > Go to Line Number. В диалоговом окне Go to Line Number введите 
номер строки, которую необходимо найти, и нажмите кнопку OK.

➤ Чтобы изменить такие параметры редактора, как поля, шрифты и цвета 
текста или фона, нажмите кнопку Editor. На вкладках Editor, Display и 
Colors настройте необходимые свойства и нажмите кнопку OK.

После завершения внесения изменений в скрипт нажмите кнопку Save , 
чтобы сохранить внесенные изменения. 

Использование VAPI-XP API 
Инструмент VAPI-XP содержит встроенную библиотеку определений 
объектов VAPI-XP, к которым можно обращаться во время создания 
скрипта теста.

Использование объекта TDHelper
Объект TDHelper обеспечивает следующие функции, которые можно 
использовать для выполнения относящихся к Quality Center задач.

RunTestSet
Исполняет выбранный набор тестов и возвращает общий статус 
выполнения набора тестов.

RunTestSet([Name = "default"], [Filter = ""], [Locally = FALSE], [Host = ""], 
[HostGroup = ""])

Name. Имя набора тестов. Необязательный параметр. По умолчанию = 
"default".

Filter. Фильтр теста. Определяет, какие тесты следует выполнить. Если 
данные параметр не указан, дает указание Quality Center на выполнение 
всех тестов указанного набора. Необязательный параметр. По умолчанию 
= "".
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Locally. При выборе значения TRUE дает указание Quality Center на 
локальное выполнение теста. Необязательный параметр. По умолчанию = 
FALSE

Host. Узел, на котором будет выполняться набор тестов. Необязательный 
параметр. По умолчанию = "".

HostGroup. Группа узлов, в которой будет выполняться набор тестов. 
Необязательный параметр. По умолчанию = "".

RunTest
Выполняет выбранный тест и возвращает статус выполнения теста. 

RunTest(Name, Instance, TestSet, [Locally = FALSE], [Host = ""], [HostGroup = 
""])

Name. Имя теста.

Instance. Экземпляр теста.

TestSet. Имя набора тестов.

Locally. При выборе значения TRUE дает указание Quality Center на 
локальное выполнение теста. Необязательный параметр. По умолчанию = 
FALSE

Host. Узел, на котором будет выполняться набор тестов. Необязательный 
параметр. По умолчанию = "".

HostGroup. Группа узлов, в которой будет выполняться набор тестов. 
Необязательный параметр. По умолчанию = "".

AddDefect
Добавление нового дефекта в текущий тест, если тест выполняется в 
режиме отладки. Если тест выполняется в режиме тестирования, новый 
дефект добавляется в текущее выполнение экземпляра теста в текущем 
наборе тестов. Возвращает объект созданного дефекта.

AddDefect([Fields], [StepKey])

Fields. Двухмерный массив: первое измерение используется для имени 
поля, а второе – для значения поля. Необязательный параметр.
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StepKey. Идентификатор шага, связанного с новым дефектом. 
Необязательный параметр.

AddDefectUI
Добавление нового дефекта в текущий тест (в режиме отладки) или 
текущее выполнение (в режиме тестирования) с помощью диалогового 
окна Quality Center New Defect.

AddDefectUI([StepKey])

StepKey. Идентификатор шага, связанного с новым дефектом. 
Необязательный параметр.

AddStepToRun
Добавление нового шага к текущему выполнению. Возвращает объект 
созданного шага.

AddStepToRun(Name, [Desc], [Expected], [Actual], [Status])

Name. Имя шага.

Desc. Описание шага. Необязательный параметр.

Expected. Ожидаемый результат шага. Необязательный параметр.

Actual. Фактический результат шага. Необязательный параметр.

Status. Статус шага. Необязательный параметр.

DownLoadAttachment
Загрузка вложения, связанного с объектом тестирования. Возвращает 
локальный путь, по которому была выполнена загрузка.

DownLoadAttachment(Name, item)

Name. Имя вложения.

item. Ссылка на объект с вложением.

UpLoadAttachment
Отправка вложения и связывание его с объектом тестирования.
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UpLoadAttachment(path, item)

path. Локальный путь (полное имя файла) элемента, подлежащего 
отправке.

item. Ссылка на объект, с которым следует связать вложение.

Использование объекта TDInput
Объект TDInput предоставляет следующую функцию, которую можно 
использовать для получения входного значения от конечного 
пользователя.

GetInput
Вывод диалогового окна Input, с помощью которого можно получить 
входное значение от конечного пользователя.

GetInput([Caption],[Name])

Caption. Заголовок диалогового окна. Необязательный параметр.

Name. Имя входного значения. Необязательный параметр.

Использование объекта TDOutput
Объект TDOutput обеспечивает следующие функции, которые можно 
использовать для управления вкладкой Output VAPI-XP.

Метод Clear
Очистка вкладки Output

Clear

Метод Print
Печать текстового сообщения в новой строке на вкладке Output.

Print(Msg)

Свойство HookDebug
Установка или снятие обработчика функции API вкладки OutputDebugString.
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HookDebug

Свойство Text
Получение или установка текста вкладки Output.

String Text

Использование объекта XTools
Объект XTools обеспечивает следующие функции, которые можно 
использовать для выполнения общих задач.

run
Выполнение командной строки с переданными атрибутами.

run(Command, [Args = ""], [Timeout = -1], [UseOutput = TRUE])

Command. Исполняемый файл приложения.

Args. Аргументы приложения. Необязательный параметр. По умолчанию = 
"".

Timeout. Время ожидания в миллисекундах. При значении -1 Quality Center 
будет ожидать завершения выполнения приложения бесконечно.

UseOutput. При значении TRUE Quality Center заменяет стандартное окно 
вывода окном вывода VAPI-XP.

WrapArray
Создание массива значений переменного типа variant из массива объектов. 
Например, если вызванный объект возвращает в качестве результата 
метода массив строк, то ни один из поддерживаемых обработчиков 
скриптов не сможет прочитать такой массив. Вызвав функцию WrapArray и 
передав ей возвращенный массив в качестве параметра функции, можно 
получить массив типа variant, который может быть разобран обработчиком 
скриптов.

WrapArray (array)

array. Массив, который необходимо преобразовать. 
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Sleep
Приостановка исполнения скрипта на заданное время.

Sleep(interval)

interval. Время в миллисекундах, на которое приостанавливается 
исполнение скрипта.
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Прогон тестов VAPI-XP в режиме отладки
После создания и изменения скрипта теста VAPI-XP его можно выполнить в 
режиме отладки или в режиме тестирования. Выполнение теста VAPI-XP в 
режиме отладки позволяет выполнить тест без включения его в набор 
тестов и без создания данных выполнения теста в проекте Quality Center. В 
качестве общей рекомендации используйте режим отладки при разработке 
теста, а режим проверки – после завершения создания теста.

Чтобы выполнить тест VAPI-XP в режиме отладки, выполните 
следующие действия.

 1 В модуле Test Plan выберите тест VAPI-XP из дерева плана тестирования и 
перейдите на вкладку Test Script.

 2 Выберите пункт меню Test > Execute (Debug Mode) или нажмите кнопку 
Execute Script. Quality Center начнет выполнять выбранный скрипт теста.

 3 Для просмотра выходных данных, сформированных скриптом теста, 
выберите пункт меню View > Output.

➤ Для очистки вкладки Output нажмите кнопку Clear Output.

➤ Чтобы скопировать выведенный текст в буфер обмена, выберите текст 
и нажмите кнопку Copy Selected Text to Clipboard.

➤ Чтобы просмотреть текст вывода скрипта теста в веб-обозревателе, 
нажмите кнопку Open Output Text in Web Browser.

➤ Чтобы напечатать тест вывода скрипта теста, нажмите кнопку Print 
Output.

 4 Чтобы остановить выполнение теста VAPI-XP до его завершения, 
выберите пункт меню Test > Stop или нажмите кнопку Stop.
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Прогон тестов VAPI-XP в режиме тестирования
Выполнить тест VAPI-XP в режиме проверки можно после добавления 
теста в набор в модуле Test Lab. Дополнительные сведения о добавлении 
тестов в наборы тестов см. Глава 24, "Создание набора тестов".

Учтите, что при выполнении теста VAPI-XP в режиме тестирования данные 
выполнения теста создаются в проекте Quality Center.

Выполнить тест VAPI-XP в режиме тестирования можно либо из модуля 
Test Plan, либо из модуля Test Lab.

Примечание. Для дистанционного тестирования VAPI-XP на хосте, на 
котором будут выполняться тесты, необходимо установить 
дополнительное средство настройки клиента HP Quality Center Client Side 
Setup Add-in и дополнительное средство HP Quality Center Connectivity Add-
in. Подробные сведения о дополнительных средствах HP Quality Center 
приведены в документе Руководство по установке HP Quality Center.

Чтобы выполнить тест VAPI-XP в режиме тестирования из модуля 
Test Plan, выполните следующие действия.

 1 В дереве плана тестирования выберите тест VAPI-XP и откройте вкладку 
Test Script.

 2 Выберите пункт меню Test > Execute (Test Mode). Откроется диалоговое 
окно Select Test Set.
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 3 В поле Test Set выберите набор тестов, содержащий текущий тест VAPI-
XP. 

 4 В поле Instance выберите экземпляр теста, который необходимо 
выполнить. 

 5 В поле Run Name введите имя, которое необходимо присвоить запуску 
теста. 

 6 Нажмите кнопку OK. Quality Center начнет выполнять выбранный тест.

 7 Чтобы просмотреть вывод скрипта теста, выберите пункт меню View > 
Output. Сведения о вкладке Output см. в разделе “Прогон тестов VAPI-XP в 
режиме отладки" на стр. 628.

 8 Чтобы остановить выполнение теста VAPI-XP до его завершения, 
выберите пункт меню Test >  Stop или нажмите кнопку Stop.

Чтобы выполнить тест VAPI-XP в режиме тестирования из модуля 
Test Lab, выполните следующие действия.

 1 В списке Test Set выберите набор тестов, содержащий тест VAPI-XP, 
который необходимо выполнить.

 2 В таблице Execution Grid выберите тест, который необходимо выполнить, 
и нажмите кнопку Run. Откроется диалоговое окно Automatic Runner, в 
котором будет отображен выбранный тест.

 3 В столбце Run on Host выберите узел, на котором будет выполняться тест 
VAPI-XP, или установите флажок Run All Tests Locally, чтобы выполнить 
тест на локальном компьютере.
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 4 Нажмите кнопку Run. Когда Quality Center начнет выполнять выбранный 
тест VAPI-XP, откроется окно VAPI-XP Test Script Когда Quality Center 
закончит выполнять тест, в диалоговом окне Automatic Runner отобразится 
статус выполнения теста.

Отладка скриптов тестов VAPI-X
Если выполнение теста не было завершено успешно, воспользуйтесь 
встроенным отладчиком VAPI-XP, который поможет отладить скрипт теста 
VAPI-XP. 

Примечание. Встроенный отладчик не поддерживает отладку скриптов 
тестов PerlScript или PythonScript.

Чтобы отладить скрипт теста VAPI-XP, выполните следующие 
действия.

 1 На вкладке Test Script модуля Test Plan выберите Debug > Integrated 
Debugger. На панели инструментов будут отображены дополнительные 
кнопки управления процессом отладки.

 2 Для установки точки останова скрипта выберите строку в скрипте и 
выберите пункт меню Debug > Toggle Breakpoint или нажмите кнопку 
Toggle Breakpoint. Либо щелкните серое поле рядом со строкой скрипта. 
Выбранная строка будет выделена красным цветом.
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 3 Нажмите кнопку Execute Script. Quality Center начнет выполнять скрипт и 
остановится на заданной точке останова. На вкладке Output отобразится 
следующее сообщение. 

 4 Чтобы задать команду Quality Center на вход в скрипт после точки 
останова, выберите пункт меню Debug > Step Into или нажмите кнопку 
Step Into. Следующая за точкой останова строка скрипта будет выделена 
синим цветом.

 5 Чтобы задать команду Quality Center на пропуск строки скрипта, нажмите 
кнопку Step Over  или выберите пункт меню Debug > Step Over.
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 6 Чтобы задать команду Quality Center на выполнение скрипта, выберите 
пункт меню Debug > Step Out или нажмите кнопку Step Out. Вывод будет 
отображен на вкладке Output.

 7 Для просмотра или изменения каждой переменной скриптавыберите пункт 
менюDebug > Variables или нажмите кнопку Show Variables. Откроется 
диалоговое окно Variables, в котором будут приведены переменные, 
доступные в текущем скрипте. Выберите переменную, чтобы просмотреть 
ее свойства.

Чтобы изменить значение переменной в поле Value, введите новое 
значение, которое необходимо присвоить переменной, и нажмите кнопку 
Update. Нажмите кнопку OK, чтобы сохранить изменения и закрыть 
диалоговое окно Variables.
633



Приложение A • Работа сс VAPI-XP
 8 Для просмотра сведений о конкретной переменной во время отладки 
выберите пункт меню Debug > Watch или нажмите кнопку Show Watch 
Window  , чтобы отобразить вкладку Watch. 

Для добавления переменной на вкладку Watch нажмите кнопку +, введите 
имя переменной в поле Prompt и нажмите кнопку OK. Переменная и ее 
значения будут отображаться на вкладке Watch.

 9 Чтобы задать команду Quality Center на возобновление выполнения 
скрипта, выберите пункт меню Debug > Resume Execution или нажмите 
кнопку Resume Execution.

 10 Выберите пункт меню Debug > Stop Debugging или нажмите кнопку Stop 
Debugging , чтобы прекратить отладку скрипта встроенным отладчиком. 
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Quality Center - Комбинации клавиш

С помощью сочетаний клавиш можно перемещаться по центру качества 
Quality Center и выполнять многие его команды.

Глава содержит следующие разделы: На стр.

Переключение модулей центра качества Quality Center 636

Комбинации клавиш вызова общих команд 636

Комбинации клавиш, используемые для выполнения команд на 
вкладке Attachments или в диалоговом окне Attachments

638

Комбинации клавиш диалогового окна Send E-mail 639

Комбинации клавиш для модуля Releases 639

Комбинации клавиш для модуля Requirements 640

Комбинации клавиш модуля Business Components 640

Комбинации клавиш для модуля Test Plan 641

Комбинации клавиш для модуля Test Lab 642

Комбинации клавиш для модуля Defects 643
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Переключение модулей центра качества Quality Center
Можно переключать модули центра качества Quality Center с помощью 
сочетания клавиш CTRL+SHIFT+<число>. Число представляет собой 
порядковый номер модуля, отображаемого в боковой панели модулей. 
Например, если модуль Requirements является первым модулем, то для 
его выбора нажмите сочетание клавиш CTRL+SHIFT+1. Если модуль Business 
Components является вторым модулем – нажмите сочетание клавиш 
CTRL+SHIFT+2.

Комбинации клавиш вызова общих команд
Можно перемещаться по центру качества Quality Center и выполнять общие 
команды с помощью следующих сочетаний клавиш:

Комбинация 
клавиш Функция

СТРЕЛКА ВНИЗ или 
СТРЕЛКА ВВЕРХ

Выбор предыдущего или следующего элемента 
соответственно.

СТРЕЛКА ВЛЕВО 
или СТРЕЛКА 
ВПРАВО

Свертывание или развертывание папок соответственно 
в папках дерева.

В табличном представлении выбор соответственно 
предыдущего или следующего столбца таблицы.

TAB Выбор следующего поля на вкладке или в диалоговом 
окне.

SHIFT+TAB Выбор предыдущего поля на вкладке или в диалоговом 
окне.

CTRL+SHIFT+ 
<порядковый 
номер>

Переключение боковых панелей модулей в диалоговых 
окнах Requirement Details, Defect Details и Test Instance 
Properties.

CTRL+TAB Перемещение вперед по вкладкам.

CTRL+SHIFT+TAB Перемещение назад по вкладкам.
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F9 или ALT Выделение пунктов меню модуля. Для перемещения по 
меню используйте клавишиСТРЕЛКА ВЛЕВО, 
СТРЕЛКА ВПРАВО, СТРЕЛКА ВНИЗ,  и СТРЕЛКА 
ВВЕРХ.

ALT+DOWN Открытие раскрывающихся списков для формирования 
в окнах. Для выбора элемента списка используйте 
клавишиСТРЕЛКА ВНИЗ и СТРЕЛКА ВВЕРХ.

СТРЕЛКА ВЛЕВО Открытие папки (если она закрыта), содержащей 
вложенные папки дерева.

СТРЕЛКА ВПРАВО Закрытие папки (если она открыта), содержащей 
вложенные папки дерева.

ALT+G Переход к выбранному объекту.

ALT+HOME/END Отображение  соответственно первого или последнего 
объекта диалогового окна Requirement Details, Defect 
Details или Test Instance Properties. 

ALT+СТРЕЛКА 
ВЛЕВО/СТРЕЛКА 
ВПРАВО

Отображение соответственно предыдущего или 
следующего объекта диалогового окна Requirement 
Details, Defect Details или Test Instance Properties. 

F5 Обновление всех данных в выбранном дереве, таблице 
или папке.

CTRL+F Открытие диалогового окна Find, с помощью которого 
можно найти необходимый текст. 

CTRL+C Копирование выбранного элемента в буфер обмена.

CTRL+V Вставка содержимого буфера обмена в выбранное 
место.

CTRL+X Удаление выбранного элемента  в буфер обмена.

CTRL+Z Отмена последнего действия.

CTRL+A Выбор всех элементов.

DELETE Удаление выбранного элемента.

Комбинация 
клавиш Функция
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 Комбинации клавиш, используемые для выполнения 
команд на вкладке Attachments или в диалоговом окне 
Attachments 

С помощью соответствующих сочетаний клавиш на вкладке Attachments 
или в диалоговом окне Attachments  можно выполнять следующие 
команды:

F1 Отображение справки для выбранного диалогового 
окна.

F2 Переименование объекта.

F7 Проверка правописания выделенного слова или текста.

SHIFT+F7, 
SHIFT+CTRL+F7

Открытие диалогового окна Thesaurus и отображение 
синонимов, антонимов и связанных слов для 
выделенного слова.

CTRL+ALT+T ИЛИ 
CTRL+T

Создание вкладки (для полей MEMO).

Комбинация 
клавиш Функция

CTRL+F Вложение файла.

CTRL+W Вложение URL-адреса.

CTRL+P Вложение снимка.

CTRL+I Вложение сведений о системе.

CTRL+B Вложение содержимого буфера обмена.

ПРОБЕЛ Открытие вложения.

CTRL+U Отправка вложения.

Комбинация 
клавиш Функция
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Комбинации клавиш диалогового окна Send E-mail
С помощью соответствующих сочетаний клавиш можно выполнить 
следующие команды диалогового окна Send E-mail:

Комбинации клавиш для модуля Releases
С помощью соответствующих сочетаний клавиш в модуле Releases можно 
выполнять следующие команды:

CTRL+S Сохранение вложения.

CTRL+DELETE Удаление вложения.

Комбинация клавиш Функция

ALT+C ИЛИ ALT+T Открытие диалогового окна Select Recipients.

ALT+S Отправка сообщения электронной почты.

CTRL+ALT+O Открытие диалогового окна Spelling Options.

Комбинация 
клавиш Функция

CTRL+N Создание папки новых выпусков.

CTRL+R Создание нового выпуска.

CTRL+Y Создание нового этапа.

CTRL+D Создание копии этапа.

CTRL+DELETE Удаление выпуска, папки выпусков или этапа. 

Комбинация 
клавиш Функция
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Комбинации клавиш для модуля Requirements
С помощью соответствующих сочетаний клавиш в модуле Requirements 
можно выполнять следующие команды:

Комбинации клавиш модуля Business Components
С помощью соответствующих сочетаний клавиш в модуле Business 
Components можно выполнять следующие команды:

Комбинация 
клавиш Функция

CTRL+ALT+N Создание новой папки.

ALT+N Создание нового требования.

CTRL+I Увеличение. 

CTRL+O Уменьшение на один уровень.

CTRL+A Добавление теста в покрытие.

CTRL+M Отправка требования по электронной почте из 
диалогового окна Requirement Details.

Комбинация 
клавиш Функция

CTRL+N Создание нового компонента.

CTRL+ALT+N Создание новой папки компонентов.

F8 Проверка выбранного компонента.

ALT+S  Получение снимка экрана приложения (на вкладке 
Snapshot).

ALT+L Загрузка изображения из файла (на вкладке Snapshot).

ALT+N Создание нового входного параметра (на вкладке 
Parameters).
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Комбинации клавиш для модуля Test Plan
С помощью соответствующих сочетаний клавиш в модуле Test Plan можно 
выполнять следующие команды:

ALT+D Удаление входного параметра (на вкладке 
Parameters).

ALT+W Создание нового выходного параметра (на вкладке 
Parameters).

ALT+L Удаление выходного параметра (на вкладке 
Parameters).

ALT+N Создание нового этапа (на вкладке Design Steps).

ALT+E Изменение этапа (на вкладке Design Steps).

CTRL+P Выбор параметра (на вкладке Design Steps).

CTRL+R Создание параметра (на вкладке Design Steps). 

CTRL+K Завершение создания имени параметра на основе 
первого символа (символов) имени параметра, 
введенных пользователем (на вкладке Design Steps).

CTRL+S Сохранение этапа (на вкладке Design Steps).

ALT+M Добавление комментариев (на вкладке Details).

Комбинация клавиш Функция

ALT+N Создание нового этапа (на вкладке Design Steps).

CTRL+P Добавление параметра (из  вкладки Design Steps).

SHIFT+ALT+A Добавление вложений (на вкладке Design Steps).

CTRL+L Добавление вызова теста, проводимого вручную 
(на вкладке Design Steps).

ALT+S Выбор требования (на вкладке Design Steps).

Комбинация 
клавиш Функция
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Комбинации клавиш для модуля Test Lab
С помощью соответствующих сочетаний клавиш в модуле Test Lab можно 
выполнять следующие команды:

С помощью соответствующих комбинаций клавиш в диалоговом окне 
Manual Runner можно выполнять следующие команды:

CTRL+S Сохранение этапа (на вкладке Design Steps).

ALT+S Добавление требования в покрытие (на вкладке 
Req Coverage).

ALT+R Удаление требования из покрытия (на вкладке 
Req Coverage).

Комбинация клавиш Функция

ALT+N Создание нового набора тестов.

CTRL+A Добавление теста в набор тестов.

CTRL+DELETE Удаление теста из набора тестов.

CTRL+F9 Запуск теста.

CTRL+ALT+F9 Запуск теста вручную.

CTRL+SHIFT+F9 Возобновление выполнения теста вручную.

ALT+F9 Выполнение набора тестов.

Комбинация клавиш Функция

CTRL+Q Завершение выполнения теста.

CTRL+R Запуск теста.

CTRL+K Отмена выполнения теста.

CTRL+U Добавление вложений при запуске теста.

Комбинация клавиш Функция
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Комбинации клавиш для модуля Defects
С помощью соответствующих комбинаций клавиш в модуле Defects можно 
выполнять следующие команды:

CTRL+B Добавление нового дефекта.

CTRL+S Добавление вложений на этапе тестирования.

CTRL+P Отсутствие дефектов в приложении при 
выполнении выбранных этапов тестирования.

CTRL+F Обнаружение дефектов в приложении при 
выполнении выбранных этапов тестирования.

CTRL+A Прохождение всех этапов тестирования.

CTRL+G Сбой прохождения всех этапов тестирования.

CTRL+СТРЕЛКА ВВЕРХ/
CTRL+СТРЕЛКА ВНИЗ

Выбор предыдущего или следующего этапа 
тестирования.

Комбинация клавиш Функция

ALT+N Добавление нового дефекта.

CTRL+DELETE Удаление выбранного дефекта.

CTRL+ALT+G Поиск аналогичных дефектов.

CTRL+ALT+F Поиск аналогичного текста.

CTRL+L Поиск следующего вхождения указанного текста.

CTRL+M Отправка дефекта по электронной почте (на 
вкладке Defect Details).

CTRL+N Очистка всех полей в диалоговом окне New Defect.

Комбинация клавиш Функция
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режим отладки, тесты VAPI-XP 628
разработка скриптов автоматизированных 

тестов 319
разработка шагов теста 299–??
результаты выполнения теста 415, 432
результаты выполнения тестов 415
расширенные фильтры 65–69
расширенный набор тестов 353
ручные тесты

преобразование в тест VAPI-XP 607
экземпляры теста

связывание с требованием 289
экземпляры теста, связывание с 

требованием 289–298
экспорт данных таблицы 78

A
Древо Excel Reports 588
время

таблица выполнения 346
группирование записей таблицы 72
группы пользователей 36
дерево релизов 119

добавление релизов 126
добавление циклов 127
дублирование циклов 138
изменение 137
корневая папка 126
просмотр дефектов 134
просмотр назначенных папок 

наборов тестов 128
просмотр назначенных требований 

128
просмотр хода выполнения покрытия 

130

переименование папок релизов, 
релизов и циклов 137

перемещение релизов и папок 
релизов 137

обзор 120
статистические данные 128
удаление папок релизов, релизов и 

циклов 138
дерево набора тестов

копирование URL 374
назначение папок наборов тестов 

циклам 355
дерево наборов тестов

покрытие требования тестами 289
дерево плана тестирования 255–279

развертывание и свертывание 265
добавление тестов 259
значки тестов 264
копирование URL-адреса 276
просмотр 265
переименование папок и тестов 278
обзор 256
обновление 265
покрытие требований 285–288
поиск папки или теста 270
отправка тестов по электронной 

почте 267
отображение в модуле Requirements 

291, 292
отображение модуля Test Lab 359, 

360
сортировка папок 276
создание 258
удаление папок и тестов 278

дерево требований 169–200
развертывание и свертывание 186
замена значений полей 182, 183
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копирование требований 191
копирование URL 192
просмотр истории требования 186
переименование требования 190
перемещение требований 192
обзор 170
назначение требований релизам и 

циклам 175
обновление 185
определения полей 162
определение 144
покрытие требования тестами 

289–??, 289, ??–298
поиск требований 180
отправка требований по электронной 

почте 187
отображение в модуле Test Plan 287
создание 171
создание тестов из 193–200
удаление требований 193
фильтрация 185
уменьшение 185

Вероятность отказа 217
версия теста, таблица выполнения 346
веб-страница, вложение 93
базы данных проекта 36
базы данных, которые поддерживаются 

центром качества Quality Center 36
Генератор отчетов Excel 587
Администратора сайта, просмотр 

сообщений 51
демонстрационный проект 43
дата, указание для выполнения теста 383
автоматические тесты

выполнение вручную 393–401
автоматизированные тесты

выполнение 403–414
какие тесты не следует 

автоматизировать 318
когда необходимо автоматизировать 

317
создание скрипта теста 319

Actual execution rate, вкладка Progress 132
Actual execution rate, Progress, вкладка 132
Actual Fix Time, Defects Grid, таблица 446
Add and Link Defect, кнопка 476

Add Comment, кнопка 459
Add Object, Диалоговое окно 620
Add Object, Команда 620
Add-ins Page, команда 19
Adobe Reader 17
Диаграмма Defect Opening Rate, вкладка 

Quality 134, 135
диаграмма покрытия 290
Диаграмма No. of Requirements per Risk 

Category 224
Диаграмма Outstanding Defects, вкладка 

Quality 134, 135
диаграмма Tests Coverage 296
Диаграмма Total Testing Time per Risk 

Category 224
диаграммы 493, 493–530

редактирование категорий 528
Диаграммы Live Analysis 531
Вкладка Bar Chart 515
Вкладка Data Grid 515
Вкладка Line Chart 515
Вкладка Pie Chart 515
Defects - Age Graph 511
Defects - Progress Graph 510
Defects - Summary Graph 509
Defects - Trend Graph 513
панель инструментов 525
пользовательская настройка 519
пользовательская настройка 

внешнего вида 527
пользовательская настройка 

внешнего вида диаграмм Live 
Analysis 543

пользовательская настройка 
описания 530

пользовательская настройка 
установочных параметров 525

Live Analysis, папка наборов 
тестирования 537

Live Analysis, папка объектов 
тестирования 533

создание 514
типы 494
Requirements - Coverage Graph 499
Requirements - Progress Graph 498
Requirements - Summary Graph 497
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Requirements - Trend Graph 501
Test Execution - Progress Graph (Cross 

Test Set) 508
Test Execution - Progress Graph 

(Current Test Set) 506
Test Execution - Summary Graph 

(Cross Test Set) 507
Test Execution - Summary Graph 

(Current Test Set) 505
Test Planning - Progress Graph 503
Test Planning - Summary Graph 502
Test Planning - Trend Graph 504

Диаграммы Live Analysis
пользовательская настройка 

внешнего вида 543
создание в папке наборов 

тестирования 537
создание в папке объектов 

тестирования 533
удаление 542

Диалоговое окно Add Favorite 103, 104
Диалоговое окно Alerts 86
Диалоговое окно Assign To Cycle 175
диалоговое окно Assign To Cycle 355
Диалоговое окно Assign To Release 175
диалоговое окно Attachments 92
диалоговое окно Automatic Runner 406
Диалоговое окно Change Password 49
диалоговое окно Choose Type of Purge 378
диалоговое окно Confirm Purge Request 379
диалоговое окно Confirm Reset Test Set 376
Диалоговое окно Coverage Analysis 559
диалоговое окно Coverage Analysis 293–298
Диалоговое окно Create New Requirement 

172
диалоговое окно Create New Test 260
диалоговое окно Create Test Instance 360, 

361
Диалоговое окно Cross Filter 68
диалоговое окно Current Test Parameters 305
диалоговое окно Custom Zoom 391
диалоговое окно Defect Details 458
Диалоговое окно Drill Down Results 516, 537, 

541
диалоговое окно Execution Condition 386, 

387

Диалоговое окно Export All Grid Data 78
Диалоговое окно Export Selected Grid Data 78
Диалоговое окно Filter

Вкладка Filter 60
Вкладка Group 73
Вкладка View Order 70
с расширенными фильтрами 67

диалоговое окно Find 181, 272
вкладка Design Steps 314
таблица выполнения 413

диалоговое окно Find Folder/Test 270
диалоговое окно Find Requirement 180
диалоговое окно Find Similar Text 456
диалоговое окно Find Test, схема 

выполнения 390
диалоговое окно Find/Replace 183, 273, 371

таблица выполнения 414
таблица Defects 183, 273, 371

Диалоговое окно Flag for Follow Up 89, 90
Диалоговое окно Generate Test 199
Диалоговое окно Graph Appearance 525, 527

Диаграммы Live Analysis 543
диалоговое окно Linked Defects

для выполнения теста 423
диалоговое окно Manual Runner 396
диалоговое окно Manual Runner - Step Details 

398
диалоговое окно New Execution Condition 

384
диалоговое окно New Folder 258, 354
диалоговое окно New Host 410
диалоговое окно New Host Group 411
Диалоговое окно New Requirement 173
диалоговое окно New Test Set 356
диалоговое окно On Test Failure 366
диалоговое окно Order Tests

схема выполнения 389
таблица выполнения 411

Диалоговое окно Organize Favorites 105
диалоговое окно Parameter Properties 304
диалоговое окно Parameters of Test 307
диалоговое окно Paste Design Steps to Target 

Project 313
диалоговое окно Paste Test Sets/Test Set 

Folders to Target Project 373
диалоговое окно Paste Tests/Subject Folders 
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to Target Project 275
диалоговое окно Properties 105
диалоговое окно Remove All Execution 

Conditions 389
диалоговое окно Replace 182, 315

дерево требований 182
Диалоговое окно Requirement Details 178
диалоговое окно Run Schedule of Test

вкладка Execution Conditions 384
вкладка Time Dependency 385

диалоговое окно Run Steps 423
Диалоговое окно Search Results

дерево требований 181
диалоговое окно Search Results

дерево набора тестов 369
дерево плана тестирования 271
схема выполнения 391

диалоговое окно Select a Test 306
диалоговое окно Select Cleanup Test 365, 

429
Диалоговое окно Select Columns 56
Диалоговое окно Select Destination Subject 

198
диалоговое окно Select Fields 190, 270
Диалоговое окно Select Filter Condition 61
диалоговое окно Select Host 406
диалоговое окно Select Recipients 189, 269
диалоговое окно Select Test Sets to Purge 

377
диалоговое окно Send E-mail

требования 187
тесты 268

диалоговое окно Snapshot, диалоговое окно 
Attachments 94

диалоговое окно Sort Folders in Test Plan 
Tree 276

Диалоговое окно System Information 96
диалоговое окно Test Instance Properties 

415–432
вкладка Automated 427
вкладка Linked Defects 430
вкладка Manual 426
представление All Runs 422
представление Configuration 425
представление Details 419
представление History 431

представление Linkage and Coverage 
430

представление Run Events 428
диалоговое окно Tests Coverage 297
диалоговое окно Time Dependency of Test 

387, 388
Диалоговое окно Trace Existing Requirement 

207
Бизнес-критичность 217
Вкладка Analysis Results 229
вкладка Automated, диалоговое окно Test 

Instance Properties 427
Вкладка Bar Chart, диаграммы 515
Вкладка Business Criticality 218
вкладка Comments, дерево плана 

тестирования 263
Вкладка Data Grid, диаграммы 515
вкладка Description

дерево плана тестирования 263
диаграммы 530
Requirements, модуль 149, 152, 155, 

158
вкладка Details

модуль Test Plan 245, 263
Requirements, модуль 152

вкладка Execution Conditions, диалоговое 
окно Run Schedule of Test 384

вкладка Execution Flow 337
вкладка Execution Grid 337
вкладка Failure Probability 219
Вкладка General. 588
Вкладка Generation Settings 588
Вкладка Group, диалоговое окно Filter 73
вкладка History

дерево требований 186
таблица тестов 250

Вкладка Impact Analysis, Requirements 
Traceability 210

Вкладка Line Chart, диаграммы 515
вкладка Linked Defects 337

диалоговое окно Test Instance 
Properties 430

модуль Test Plan 245
Вкладка Live Analysis 534, 538
вкладка Manual, диалоговое окно Test 

Instance Properties 426
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Вкладка Pie Chart, диаграммы 515
Вкладка Post-processing 588
Вкладка Quality, Releases, модуль 134
Вкладка Query 588
Вкладка Query Parameters. 592
Вкладка Query Results. 592
Вкладка Relationships, Requirements 

Traceability 208
вкладка Reqs Coverage, модуль Test Plan 

245
Вкладка Risk, представление Requirement 

Details 221
Вкладка Risk, окно Requirement Details 218, 

223, 226
вкладка Steps, модуль Test Plan 245, 300
вкладка Test Script 245, 320
вкладка Test Set Properties 337

Details 358
уведомления 362
On Failure 364

вкладка Time Dependency, диалоговое окно 
Run Schedule of Test 385

Вкладка View Order, диалоговое окно Filter 
70

вложения 91–99
вложение элементов буфера обмена 

97
вложение сведений о системе 96
вложение снимка 94
вложение файла 93
вложение URL-адреса 93
изменение 98
просмотр 97
сохранение 98
удаление 99

журнал выполнения 408
Age Grouping, диаграмма периода 

существования 524
анализ проектов

диаграммы 493, 493–530
Диаграммы Live Analysis 531
Document Generator 545–583
отчеты 481–492

анализ покрытия 293–??
документ Word, команда Export 298
Alerts, кнопка 459

вставка папок релизов, релизов и циклов 
138

вставка требований 192, 193
API VAPI-XP 622–627
Assigned requirements, Progress, вкладка 133
Assigned To, Defects Grid, таблица 446
Attachments, вкладка, Defects Grid, таблица 

442
Attachments, вкладка,Defect Details, 

диалоговое окно 459
выполнение наборов тестов 403–??, 

403–414, ??–414
выполнение тестов

вручную 393–??, 393–??, 393–401, 
??–401, ??–401

автоматически 403–??, 403–??, 
403–414, ??–414, ??–414

наборы тестов 403–414
выход из QualityCenter 43, 48
Author, Requirements, модуль 162
Auto Complete Children, флажок 197

B
Browsers, Команда 619
Business Process Testing 45
Business Process, определение типа теста 

261

C
Запросы SQL, создание 591
запуск приложения Quality Center 39
Check Spelling, кнопка

новый дефект 174, 452
Send Mail 190, 467

Значок стрелки Show Advanced Filter 67
значок фотоаппарата 94
значок Time Dependency 388
Clear Filter/Sort, вкладка Test Coverage 290
Clear Output, кнопка 628
Clear, кнопка,New Defect диалоговое окно 

452
Clear, VAPI-XP, метод 625
Closed in Version, Defects Grid, таблица 446
Closing Date, Defects Grid, таблица 446
Collapse, Команда
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дерево требований 186
Comments

таблица тестов 252
Comments, область, Defects Grid, таблица 

442, 446, 459
Convert all requirements to subjects 195
Convert lowest child requirements

to design steps 195
to tests 195

Copy Selected Text to Clipboard, кнопка 628
Copy URL, команда 468
Copy, Кнопка

VAPI-XP 621
Copy, кнопка

дерево требований 191
Coverage Analysis ??–298
Coverage Type

вкладка Req Coverage 285
вкладка Test Coverage 289

Create New Requirement Folder, Диалоговое 
окно 172

Create Report For This Defect, кнопка 459
Created By, окно Traceability Grid 208
Created By, Linked Defects, таблица 473
Creation Date

дерево плана тестирования 263
таблица тестов 252

Creation Date, окно Traceability Grid 208
Creation Date, Linked Defects, таблица 473
Creation Date, Requirements, модуль 162
Creation Time, Requirements, модуль 162
Cross filter by section 68
Custom, кнопка 190, 467
Cut, Кнопка, Releases, модуль 137

D
Data Type, диаграммы 521, 522, 523
Defect ID

Defects Grid, таблица s 446
таблица Linked Defects 473

Defects Grid, таблица
распечатка дефектов 468
добавление дефектов 451
обновление дефектов 458
определения столбцов 446
поиск и замена 460

сопоставление дефектов 453
сопоставление текста 453
удаление дефектов 469

Defects, кнопка 440
Defects, меню, Defects, модуль 443
Defects, модуль

главное окно 440
Defects Grid, таблица ??–469
краткий обзор 439–448
процесс 435–438
обзор 450
панель инструментов 444
определения столбцов 446
строка меню 443

Delete, команда
Defects Grid, таблица 469

Delete, кнопка
Releases, модуль 138
VAPI-XP 621

Description
Defects Grid, таблица 446

Description, вкладка
таблица Defects 442

Description, Команда 197
Design Step Editor 299–315
Designer

дерево плана тестирования 263
таблица тестов 252

Details, вкладка
диалоговое окно Defect Details 459
Releases, модуль 127, 128

Detected By, Defects Grid, таблица 446
Detected in Cycle, таблица Defects 446
Detected in Release, Defects, модуль 447
Detected in Version, Defects Grid, таблица 

447
Detected on Date, Defects Grid, таблица 447
Direct Cover Status, Requirements, модуль 

163
Display Options, диаграмма хода 

выполнения 522
Document Generator 545–583

Дерево Document Generator 556
данные проекта 556
запуск 549
конкретизация данных модуля 
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Defects 580–582
конкретизация данных модуля 

Requirements ??–561
конкретизация данных модуля Test 

Lab 570–579
конкретизация данных модуля Test 

Plan 561–566
конкретизация данных Test Grid 

566–570
обзор 547
описание данных модуля 

Requirements 558–??
создание и просмотр документов 

проекта 583
форматирование документов проекта 

550–555
Document Generator, диалоговое окно Page 

Setup 555
Document Generator, вкладка Customization 

554
Document Generator, вкладка Document 

Settings 550
Document Generator, вкладка Logo 553
Document Generator, вкладка Options 551
Document Generator, кнопка Load from File 

553
Document Generator, кнопка Load from Saved 

553
Document Generator, кнопка Page Setup 554
Document Generator, кнопка Preview 583
Document Generator, кнопка Remove Saved 

553
Document Generator, кнопка Requirements 

558
Document Generator, кнопка Save 553
Document Generator, кнопка Unload 553
Document Generator, переключатель Defects 

580
Document Generator, переключатель Runs 

576
Document Generator, переключатель Subject 

Tests 564
Document Generator, переключатель Subject 

Tree 562
Document Generator, переключатель Test 

Lab 571

Document Generator, переключатель Test 
List 567

Document Generator, переключатель Test 
Sets 572

Document Generator, переключатель Tests 
574

Document Generator, ссылка Defects 580
Document Generator, ссылка Requirements 

558
Document Generator, ссылка Runs 576
Document Generator, ссылка Subject Tests 

564
Document Generator, ссылка Subject Tree 562
Document Generator, ссылка Test Lab 571
Document Generator, ссылка Test List 567
Document Generator, ссылка Test Sets 572
Document Generator, ссылка Tests 574

E
категория рисков, определение 217
категории, редактирование 528
избранные представления 101–106

добавление 103
загрузка 104
изменение свойств 105
недавно использовавшиеся 104
папка private 101
папка public 101
обновление 104
определение 101
удаление 105

изображения, вложение 94
изменения с течением времени, диаграмма 

хода выполнения 522
изменение размеров столбцов таблицы 57
изменение порядка шагов теста 310
Editor, кнопка 622
имя планового узла

таблица выполнения 346
Индикатор выполнения Days, Progress, 

вкладка 132
Индикатор выполнения Test Instance Runs, 

Progress, вкладка 132
комбинации клавиш 635
Команда Add to Favorites 103, 104
Команда Add to Favorites, отчеты 488
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Команда Add, избранное 102
Команда By ID (Trace From) 207
Команда By ID (Trace To) 207
Команда Change Project 46
Команда Check Spelling 47
Команда Clear Test Sets Filter/Sort 75
Команда Clear Tests Filter/Sort 75
Команда Collapse

дерево плана тестирования 265
команда Continue Manual Run 401
Команда Convert to Tests 194
команда Copy to Clipboard, схема 

выполнения 392
команда Copy URL 192, 276, 374
команда Customer Support Web Site 19
Команда Customize 46, 48
Команда Dashboard 47
команда Delete

дерево требований 193
команда Enable Manual Test Run 

Confirmation 396
команда Expand, дерево плана 

тестирования 265
Команда Export 78
Команда Export to Microsoft Excel 488
команда Export Word Document 298
команда Fail All 399
Команда Favorite Bar 104
Команда Filter/Sort 60, 70, 75
команда Find

таблица выполнения 413
таблица тестов 272

команда Find Folder/Test Set 368
команда Find Next

Defects Grid, таблица 460, 461
таблица требований 181
таблица тестов 272

Команда Go To Requirement
Requirement Details, Окно 153

команда Go To Requirement
Requirements Grid, Окно 156

команда Go To Requirement in Requirements 
Tree 286

команда Go to Test
дерево плана тестирования 246
таблица тестов 251

команда Go to Test in Test 290
модуль Test Plan 246

команда Go to Test in Test Plan Tree 290
модуль Test Lab 337

Команда Grid Filters 64
команда Indicator Columns

таблица выполнения 342
таблица выполнения тестов 250

команда Information Panel
Requirements Grid 155
Requirements Tree, окно 149

команда Mark as Template Test 304
Команда New Defect 46
команда Order Tests 389
Команда Organize Favorites 105
Команда Organize, избранное (модуль Test 

Lab) 102
команда Pass All 399
Команда Paste, дерево требований 192, 193
команда Purge Runs 377
команда Refresh All

вкладка Req Coverage 288
Команда Refresh Test Sets Filter/Sort 75
Команда Refresh Tests Filter/Sort 75
команда Remove All Execution Conditions 388
команда Remove Execution Condition 387
команда Remove Test’s Execution Conditions 

387
команда Remove Time Dependency 388
команда Rename

набор тестов 375
команда Replace

таблица выполнения 371, 414
таблица Defects 183, 273, 371

Команда Report Selected 488
Команда Report Selected with Children 489
команда Reset Test Set 376
команда Select Columns, вкладка Design 

Steps 311
Команда Set Test Sets Filter/Sort 60, 70
команда Show Full Path 286
команда Show Full Test Names 392
команда Show Full Test Names, схема 

выполнения 392
команда Show Last Run Results 341
Команда Spelling and Grammar
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Check Spelling 47
Spelling Options 47
Thesaurus 47

Команда Spelling Options 47
команда Template Test 262
команда Test Run Schedule 384
команда Test Set Details 358
команда Test Sets Grid 357
команда Test Sets Tree 354, 356
Команда Tests Filter/Sort 60, 70
Команда Thesaurus 47
Команда View, избранное 102
Команда Welcome Page 43
Команды Favorites 102
копирование

дефекты 467
наборы тестов, в том же проекте 372
наборы тестов, из одного проекта в 

другой 373
папки наборов тестов, в том же 

проекте 372
папки наборов тестов, из одного 

проекта в другой 373
папки объектов, в одном проекте 274
папки объектов, из одного проекта в 

другой 274
требования 191
шаги теста, в том же проекте 311
шаги теста, из одного проекта в 

другой 312
тесты, в одном проекте 274
тесты, из одного проекта в другой 274
URL требования 192
URL-адрес дефекта 468
URL-адрес набора тестов 374
URL-адрес теста 276

импорт в Quality Center
из приложения Excel 37
из приложения Word 37

комментарии
Requirements, модуль 162

Кнопка ‘Редактировать категории’, панель 
инструментов диаграмм 528, 530

Кнопка ‘Копировать в буфер обмена’, панель 
инструментов диаграмм 526

Кнопка ‘Прокрутка влево’, панель 

инструментов диаграмм 525
Кнопка ‘Прокрутка вправо’, панель 

инструментов диаграмм 525
Кнопка ‘Печать диаграммы’, панель 

инструментов диаграмм 526
Кнопка ‘Настроить внешний вид диаграммы’ 

525, 527, 537, 541, 543
Кнопка ‘Показать все’, панель инструментов 

диаграмм 525
Кнопка ‘Показать итоговые значения’, 

панель инструментов диаграмм 525
Кнопка ‘Увеличить’

Панель инструментов диаграмм 525
Кнопка ‘Уменьшить’

Панель инструментов диаграмм 525
Кнопка Add Entity to Query 593
Кнопка Add Excel Report 589
кнопка Add Host to Host Group 411
Кнопка Add Parameter to Query 599
Кнопка Add Query 594
Кнопка Add Requirement Traceability 206, 207
кнопка Add Step, выполнение теста вручную 

400
Кнопка Add Sub-Report 492
кнопка Add Tests to Test Set 359, 360
кнопка Add Time Dependency To Flow, схема 

выполнения 386
кнопка Add to Coverage

вкладка Req Coverage 288
вкладка Test Coverage 292

Кнопка Add to Traceability, вкладка 
Requirements Traceability 206

кнопка Adjust Rows Height 311
кнопка Alerts 86
кнопка Arrange Layout, схема выполнения 

391
Кнопка Authenticate 43
кнопка Back 46
кнопка Back to Steps Grid, выполнение теста 

вручную 399
кнопка Begin Run, выполнение теста 

вручную 398
кнопка Call to Test 306
кнопка Cancel Run, выполнение теста 

вручную 398
кнопка Check Spelling
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Send Mail 270
Кнопка Clear All 87
Кнопка Clear Filter 75
кнопка Clear Filter/Sort 75, 423, 491
Кнопка Clear, диалоговое окно New 

Requirement 173
Кнопка Clipboard 97
кнопка Compact View, выполнение теста 

вручную 399
Кнопка Configure Reports and Sub-Reports 

487
кнопка Continue, представление All Runs 422
Кнопка Copy Filter Settings 75
кнопка Copy From 320
кнопка Copy Paste Test Settings 368
кнопка Copy Steps, вкладка Design Steps 

312, 313
кнопка Copy Test Settings 367
кнопка Coverage Analysis 295
кнопка Custom 270
кнопка Defects, представление All Runs 422
кнопка Delete

дерево плана тестирования 278
представление All Runs 422
наборы тестов в модуле Test Lab 376
папки в модуле Test Lab 375

Кнопка Delete Alert 87
кнопка Delete Host 410
кнопка Delete Host Group 411
Кнопка Delete Selected

вложения 99
кнопка Delete Selected

вкладка Design Steps 311
выполнение теста вручную 400

кнопка Delete Selected Tests, таблица тестов 
251

Кнопка Delete Sub-Report 492
Кнопка Duplicate Cycle 138
Кнопка Duplicate Excel Report 602
Кнопка Edit Parameter 599
кнопка Edit Step 309
кнопка End Run, выполнение теста вручную 

398, 400
Кнопка Entities View 592
Кнопка Excel Report 600
Кнопка Export Excel Report Definition 602

кнопка Fail Selected, выполнение теста 
вручную 399

Кнопка File 93
Кнопка Filter, диаграммы 521, 522, 524, 525
Кнопка Find

Вкладка Requirements Traceability 206
кнопка Find

вкладка Req Coverage 287
вкладка Test Coverage 292

кнопка Find Test на схеме 390
кнопка Find Text 314
кнопка Find/Replace Text 315
кнопка Fit Picture In Window, схема 

выполнения 391
кнопка Flag for Follow Up 89, 90
кнопка Forward 46
Кнопка Full Document 583
Кнопка Full Screen View 537
Кнопка Generate Report 226, 487
кнопка Generate Script 319
кнопка Get Hosts on the Network 410
кнопка Get Net 410
Кнопка Go To Entity 78
кнопка Go to Test in Test Plan Tree, таблица 

тестов 251
Кнопка Help 48
Кнопка Import Excel Report Definition 602
кнопка Insert Parameter 304
кнопка Launch 320
Кнопка Login 43
Кнопка Logout 43
кнопка Logout 48
Кнопка Mail Requirement 188
Кнопка Maximize Content 177
Кнопка Move Field Down, диалоговое окно 

Filter 71
Кнопка Move Field Up, диалоговое окно Filter 

71
кнопка New Defect, выполнение теста 

вручную 399
кнопка New Folder 354
кнопка New Host 410
кнопка New Host Group 411
Кнопка New Parameter 598
Кнопка New Release Folder 126
кнопка New Step 301
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кнопка New Test 260
кнопка New Test Set 356, 357
Кнопка уменьшения до корневых папок 185
Кнопка уменьшения на один уровень 185
Кнопка Open (Download and Open), 

вложения 98
кнопка Pass Selected, выполнение теста 

вручную 399
Кнопка Paste Filter Settings 75
кнопка Paste Steps, вкладка Design Steps 

312, 313
Кнопка Perform Risk Analysis 224
Кнопка Refresh

диаграммы 521, 522
кнопка Refresh

диаграммы 524, 525
вкладка Test Coverage 292

Кнопка Refresh All
Вкладка Test Coverage 206

кнопка Refresh All
дерево плана тестирования 265
диалоговое окно Select a Test 306
вкладка Req Coverage 288

Кнопка Refresh All, Releases, модуль 133
Кнопка Refresh Filter/Sort 75
кнопка Remove From Coverage, вкладка Test 

Coverage 292
Кнопка Remove from Traceability 212
Кнопка Remove Graph 542
кнопка Remove Host From Host Group 411
кнопка Remove Selected, вкладка Req 

Coverage 288
кнопка Remove Tests from Test Set 372
кнопка Renumber Steps 310
Кнопка Requirement Details 178
Кнопка Requirements 147
Кнопка Reset Titles 527, 543
кнопка Run

вкладка Execution Flow 395, 406
вкладка Execution Grid 395, 406

кнопка Run Manually
вкладка Execution Flow 396
вкладка Execution Grid 396

Кнопка Run Query 594
кнопка Run Test Set

вкладка Execution Flow 406

вкладка Execution Grid 406
Кнопка Save and Apply to Children 225
кнопка Save Steps 302
Кнопка Searchable Fields Information 78
кнопка Select Columns, вкладка Design Steps 

311
Кнопка Select Fields, отчеты 491
кнопка Select Req 287
кнопка Select Tests, дерево плана 

тестирования 359, 360
кнопка Select Tests, вкладка Test Coverage 

291
кнопка Send by E-mail

тесты 268
кнопка Set Filter/Sort 60, 70, 423, 491
кнопка Set to Default 367
кнопка Settings per test 366
кнопка Show Parameters 399
кнопка Show Run Steps, представление All 

Runs 422
кнопка Snapshot, диалоговое окно 

Attachments 94
Кнопка Sort Ascending, диалоговое окно 

Filter 71
Кнопка Sort Descending, диалоговое окно 

Filter 71
кнопка Sort Folders 276
кнопка Spelling Options

новый дефект 453
Send Mail 270

кнопка Stop
диалоговое окно Automatic Runner 

407
Document Generator 583

кнопка Stop Debugging 634
Кнопка System Info 96
кнопка Test Lab 336
кнопка Test Parameters 305
кнопка Test Plan 244
Кнопка Test Query 594
Кнопка Test Sets Filter/Sort 60, 70
Кнопка Tests Filter/Sort 60, 70
Кнопка Text Search 77
кнопка Thesaurus

новый дефект 453
Send Mail 270
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кнопка Toggle Breakpoint 631
Кнопка Tools 46

Команда Customize 46
Команда Document Generator 549
Команда New Defect 46

Кнопка Upload Selected, вложения 98
Кнопка URL 93
кнопка Zoom In

схема выполнения 391
кнопка Zoom Out

схема выполнения 391
Комплект документации 16
интерактивная поддержка 19
End Date

дерево релизов 127, 128
Releases, модуль 118

история изменения
удаление 50

Entity Name
вкладка Req Coverage 285
вкладка Test Coverage 289

Entity Status
вкладка Req Coverage 285
вкладка Test Coverage 289

Estimated DevTime, таблица тестов 252
Estimated Fix Time, Defects Grid, таблица 447
Excel

экспорт данных таблицы из Quality 
Center 78

экспортирование данных отчета из 
Quality Center 488

Exclude, команда 197
Exec Date

сведения о выполнении теста 420
таблица выполнения 345

Execute (Debug Mode), команда 628
Execute (Test Mode), команда 629
Execute Script, кнопка 628, 632
Executed coverage, Progress, вкладка 133
Execution Grid

краткий обзор 341
Execution Grid, таблица

просмотр результатов тестирования 
415–??

Execution Report, ссылка,Defect Details, 
диалоговое окно 459

Execution Status, Test Grid 252
Expand All, Команда , дерево требований 

186

F
Find in Script, Кнопка 621
Find Next, Команда

VAPI-XP 621
Find Similar Defects, кнопка 454, 456
Find, диалоговое окно 461

Defects Grid, таблица 461
Find, команда

дерево требований 180
Defects Grid, таблица 460, 461
таблица требований 181

Find/Replace, диалоговое окно
Defects Grid, таблица 462

Fixed Columns, диалоговое окно Select 
Columns 57

Flag for Follow Up, кнопка 459

G
Getting Started 17
Go To Defect, команда 442
Go To Defect, кнопка 459
Go to Line Number, команда, VAPI-XP 622
Go To Requirement Команда

Requirements Tree, Окно 150
Go To Requirement, Команда

Coverage Analysis, Окно 159

H
Help on this page, команда 16
History, вкладка

диалоговое окно Defect Details 460
таблица Defects 442
таблица Defects Grid 463

Host Manager 409
HP Software Web site, команда 19
HTML-документ, экспорт данных таблицы 78

I
представления, избранное ??–106
представления, избранные 101–??
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представление All Runs, диалоговое окно 
Test Instance Properties 422

Представление Attachments, диалоговое 
окно Requirement Details 179

представление Configuration, диалоговое 
окно Test Instance Properties 425

представление Details
Диалоговое окно Requirement Details 

179
диалоговое окно Test Instance 

Properties 419
представление History

диалоговое окно Test Instance 
Properties 431

Представление History, диалоговое окно 
Requirement Details 180

представление Linkage and Coverage, 
диалоговое окно Test Instance 
Properties 430

Представление Linked Defects, диалоговое 
окно Requirement Details 179

Представление Requirements Traceability, 
диалоговое окно Requirement Details 
179

Представление Risk, диалоговое окно 
Requirement Details 179

представление Run Events, диалоговое окно 
Test Instance Properties 428

Представление Test Coverage, диалоговое 
окно Requirement Details 179

Представление Trace From Tree 210
Представление Trace To Tree 210
привилегии 36
привилегии пользователей 36
Приложение Excel

импорт в Quality Center 37
Приложение Microsoft Excel

импорт в Quality Center 37
Приложение Word

импорт в Quality Center 37
Проект QualityCenter_Demo 43
прослеживаемость требований 201

добавление 205
просмотр 208, 210
связи trace from 202
связи trace to 202

удаление 212
прослеживаемость, требования 201

добавление 205
просмотр 208, 210
связи trace from 202
связи trace to 202
удаление 212

просмотр сообщений администратора сайта 
51

процесс управления тестированием 27
выполнение тестов 34
планирование тестов 32
определение требований 30
отслеживание дефектов 35

перекрестные фильтры 65–69
filtering tests not in any test set 68
filtering tests with no requirement 

coverage 68
Переключатель Hide On Run 598
Переключатель Open Report 600
переименование папки или теста в дереве 

плана тестирования 278
переименование требования 190
параметр Custom Sort, дерево плана 

тестирования 276
параметры

добавление в тест 304
добавление к запросам отчета Excel 

597
вызов теста 305
просмотр значений 305
обзор 303

параметры WinRunner 426
перенумерование шагов теста 310
пароль, изменение 48
Начальная страница 43
набор регрессивных тестов 352
набор тестов для проверки общей 

работоспособности 352
набор тестов для проверки функций 353
наборы тестов 351–379

добавление 356
добавление тестов в 359
выполнение тестов 403–414
копирование в том же проекте 372
копирование из одного проекта в 
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другой 373
правила при отрицательном 

результате тестирования 364
переименование 375
обзор 352
назначение папок наборов тестов 

циклам 355
настройка уведомлений 361
определение 351
покрытие 289–298
поиск в дереве 368
сброс 376
удаления тестов из 372
удаление результатов тестирования 

377
удаление наборов тестов 376
удаление папок 375
типы 352

область Last Run Results, таблица Execution 
Grid 341

пакетный тест WinRunner 264, 405
меню Edit

модуль Test Lab 338
модуль Test Plan 246

меню Test Sets, модуль Test Lab 338
меню Tests

модуль Test Lab 338
модуль Test Plan 246

меню View
модуль Test Lab 338
модуль Test Plan 246

панели инструментов
диаграммы 525
Defects, модуль 444
набор тестов 339
модуль Test Plan 247
схема выполнения 349
таблица выполнения 343
таблица тестов 251
Releases, модуль 117
Requirements, модуль 161
Select Tests 340

Панель инструментов Excel Reports 588
панель Entities 592
Панель SQL 592
папка private, в избранном 103, 106

папка public, в избранном 103, 106
папка Unattached, дерево плана 

тестирования 278
папки наборов тестов

копирование в том же проекте 372
копирование из одного проекта в 

другой 373
папки объектов

добавление в дерево плана 
тестирования 258

копирование в одном проекте 274
копирование из одного проекта в 

другой 274
переименование 278
определение 256
поиск в дереве плана тестирования 

270
сортировка в дереве плана 

тестирования 276
удаление 278

Настройки безопасности Excel 596
настройки безопасности, Excel 596
Мастер диаграмм 516
обычный уровень увеличения 391
план, таблица выполнения

разработчик 345
дата создания 345
изменен 345
имя теста 345
комментарии 345
Estimated DevTime 345
объект 345
описание 345
путь 345
статус 345
статус выполнения 345
шаблон 345
тип 346

планирование выполнения тестов ??–392
плановая дата выполнения

таблица выполнения 346
плановое время выполнения

таблица выполнения 346
Окно входа в Mercury Quality Center 42
Окно Coverage Analysis 157
Окно Mercury Quality Center Options 40
658



индекс
окно Traceability Grid 208
Окно User Properties 49
Порядок сортировки ASCII 69
модуль Business Components 45
модуль Defects

диаграммы 496
Defects Grid, таблица 449–??
отчеты 481–492
создание документов проекта 

580–582
модуль Releases

назначение папок наборов тестов 
циклам 355

назначение требований 175
Модуль Requirements

диаграммы 494
процесс 141–146
покрытие 289–??
отчеты 481–492
создание требований 171

модуль Requirements
анализ покрытия 293–??
Coverage Analysis ??–298
покрытие ??–298
создание документов проекта 

558–561
Модуль Test Lab

краткий обзор 335–350
процесс 331–334

модуль Test Lab
автоматическое выполнение тестов 

403–414
диаграммы 495
Диаграммы Live Analysis 537
главное окно 336
вкладка Execution Flow 337
вкладка Execution Grid 337
вкладка Linked Defects 337
вкладка Test Set Properties 337
выполнение тестов вручную 393–401
просмотр результатов тестирования 

415, 432
наборы тестов 351–379
назначение папок наборов тестов 

циклам 355
панель инструментов Select Tests 340

панель инструментов Test Set 339
отчеты 481–492
создание документов проекта 

570–579
строка меню 338

модуль Test Plan
разработка шагов теста 299–??
дерево плана тестирования 255–279
автоматизация тестов 317–320
диаграммы 495
Диаграммы Live Analysis 533
главное окно 244
краткий обзор 243–254
процесс 237–242
панель инструментов 247
покрытие требований 285–288
отчеты 481–492
создание документов проекта 

561–566
строка меню 246
шаги теста ??–315
таблица тестов 249–??
Test Grid ??–254

покрытие
экземпляры теста 289–298
анализ 293–298
требования 285–288
тесты 289–298

покрытие требования тестами
добавление экземпляров теста 291
добавление тестов 291
анализ 293–298
пример 284
обзор 281

покрытие требований ??–288
добавление требований 287
анализ 293–298
пример 283
просмотр 286
обзор 281
удаление требований 288

покрытие требований тестами 285–??
покрытие тестами 289–298

просмотр 290
удаление экземпляров теста из 292
удаление тестов из 292
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поля
изменение размеров 57
определение порядка отображения 

полей 55
поле Coverage calculation by cycle 294
Поле Description of Criterion 219
Поле Estimated development time 219
Поле Filter Condition 61
поле фильтра в таблице 64
поле фильтра таблицы 64
Поле Total allocated testing time 223
политика тестирования

задание параметров 219
окончательное оформление 222

Описание
дерево релизов 127, 128
таблица тестов 252
Releases, модуль 118

описание
Requirements, модуль 162

описание требований 141–146
описание, сведения о тесте 420
поиск текста 76
пользователей

группирование 58
поиск 58
сортировка 58

пользователи
выбор 58

пользовательская настройка установочных 
параметров диаграмм 525

оповещения 79
Indicator Columns, команда

Defects, модуль 441
Окно Requirements Grid 158
Таблица Requirements 152
Таблица Test 149
Requirements Grid 155

Information Pane, команда
таблица Defects Grid 463

Information Panel, команда
Окно Coverage Analysis 158
таблица Defects 442

отчет об управлении качеством на основе 
рисков 226

отчеты 481–492

обзор 481
пользовательская настройка 489
Отчеты Excel 585
Отчеты модуля Defects 484
Отчеты модуля Requirements 482
Отчеты модуля Test Lab 484
Отчеты модуля Test Plan 483
создание 486
создание документов проекта 

545–583
Отчеты Excel 585

экспорт определений 602
генерирование 600
добавление 589
копирование 601
импорт определений 602
переименование 601
создание 588
создание запросов 591
удаление 601

Отчеты Quality Center 481–492
обзор 481
пользовательская настройка 489
Отчеты модуля Defects 484
Отчеты модуля Requirements 482
Отчеты модуля Test Lab 484
Отчеты модуля Test Plan 483
создание 486

ответственный тестер
таблица выполнения 346

отслеживание дефектов
добавление дефектов 451
Defects Grid, таблица 446
краткий обзор 439–448
просмотр истории дефекта 463
процесс 435–438
обновление дефектов 458
поиск и замена 460
отправка дефектов по электронной 

почте 464
сопоставление дефектов 453
сопоставление текста 453
удаление дефектов 469

путь
таблица выполнения 345

ITG Request Id
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вкладка Test Set Properties 358

K
Knowledge Base, команда 19

L
Link Comment, Linked Defects, таблица 473
Link Entity Type, Linked Defects, таблица 474
Link Existing Defect, кнопка 476
Link ID, Linked Defects, таблица 473
Link Type, таблица Linked Defects 474
Linked By Status, Linked Defects, таблица 474
Linked Defects, диалоговое окно 473
Linked Defects, вкладка 473
Linked Entities, вкладка

диалоговое окно Defect Details 460
Linked Entity ID, Linked Defects, таблица 474
Linked Entity Name, Linked Defects, таблица 

474
LoadRunner Scenario, определение типа 

теста 260

M
Manual, определение типа теста 260
Mercury Dashboard 47
Microsoft Excel

экспорт данных отчета из Quality 
Center 488

экспорт данных таблицы из Quality 
Center 78

Microsoft Word
экспорт данных таблицы из Quality 

Center 78
импорт в Quality Center 37
создание документов проекта 583

Microsoft Word, содержимое 176
Modified

Defects Grid, таблица 447
окно Traceability Grid 208
таблица выполнения 345
таблица тестов 252
Requirements, модуль 163

N

сравнение дефектов 453
связи дефектов

добавление 475
косвенные 471
прямые 471
просмотр 474
обзор 471
удаление 477

связи trace from 202
связи trace to 202
связывание дефектов

добавление связей 475
косвенное 471
прямое 471
просмотр дефектов 474
обзор 471
удаление связей 477

свойства пользователя, изменение 48
свойства, изменение 48
свойство HookDebug, VAPI-XP 625
свойство Text, VAPI-XP 626
Name

Releases, модуль 118
Requirements, модуль 163

скрипт , создание 319
скрипт теста, создание 319
Системные тесты 321–327
New Cycle, Диалоговое окно 127
New Cycle, Кнопка 127
New Folder, Кнопка 172
New Release Folder, диалоговое окно 126
New Release, Диалоговое окно 126
New Release, Кнопка 126
New Requirement, Кнопка 172
соглашения о типографских обозначениях 

20
снимок, вложение 94
Список доменов, окно входа в систему 43
Список Available Columns 56
Список Available Fields 70
Список Count changes in field 525
Список Grouped By 520, 522, 523
Список проектов, окно входа в систему 43
список параметров 597
Список Sorted Fields 70
список Status Filter, вкладка Test Coverage 
661



индекс
290
список Test Type, модуль Test Plan 260
список View Runs, представление All Runs 

422
Список Visible Columns 56
Список X-Axis 520
сообщение о дефектах

добавление дефектов 451
Defects Grid, таблица 446
краткий обзор 439–448
просмотр истории дефекта 463
процесс 435–438
обновление дефектов 458
поиск и замена 460
отправка дефектов по электронной 

почте 464
сопоставление дефектов 453
сопоставление текста 453
удаление дефектов 469

сопоставление дефектов 453
Составление расписания запуска тестов 

381–??
состояние

таблица выполнения 346
Ссылка Add Graph 535
ссылка Details 358
ссылка excluded 224
ссылка missing assessment 224
ссылка Notifications 362
ссылка On Failure 364
Ссылка User Properties 49
Стрелка Add Entity to Query 593
Схема выполнения 381–392

наборы тестов 351–??
схема выполнения

автоматическое выполнение тестов 
403–414

добавление временной зависимости 
383

добавление временной зависимости 
в схему 386

добавление условия 384
выполнение тестов вручную 393–401
краткий обзор 348
изменение даты и времени 387
изменение уровня увеличения 391

изменение условий 387
изменение условий выполнения 386
просмотр результатов тестирования 

415, 432
просмотр журнала выполнения 408
просмотр тестов в иерархической 

компоновке 391
наборы тестов ??–379
обзор 381
панель инструментов 349
Определение последовательности 

тестов 389
поиск тестов 390
отображение полных имён тестов 392
удаление временной зависимости 

388
удаление всех условий и 

зависимостей 388
удаление условий 387
увеличение 391
уменьшение 391

сценарий post-processing
инструкции 596
создание 594

сценарий Visual Basic
инструкции 596
создание 594

Статус требования Failed 163
Статус требования No Run 163
Статус требования Not Completed 163
Статус требования Not Covered 163
Статус требования Passed 163
столбцы

изменение размеров 57
определение порядка отображения 

столбцов 55

O
требования

добавление прослеживаемости 205
замена значений полей в дереве 182
замена значений полей в таблице 183
просмотр прослеживаемости 208, 210
поиск 180
поиск в дереве 180
поиск в таблице 181
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связи trace from 202
связи trace to 202
удаление прослеживаемости 212

требования к тестированию, описание 
141–146

шаги теста
добавление 301
изменение 308
изменение размеров 310
изменение порядка 310
копирование в том же проекте 311
копирование из одного проекта в 

другой 312
перенумерование 310
определение 299
удаление 311
упорядочивание столбцов 311

шаги теста, изменение при тестировании 
400

шаги тестирования ??–315
поиск и замена 314

шаги, тест 299–315
удалённое выполнение 403–414
удалённые хосты, настройка 409
удаление истории изменения 50
таблица выполнения

автоматическое выполнение тестов 
403–414

выполнение тестов вручную 393–401
замена значений полей 371
просмотр результатов тестирования 

??–432
просмотр журнала выполнения 408
наборы тестов 351–379
панель инструментов 343
определения столбцов 345
упорядочивание тестов 411

таблица Defects Grid
копирование 467
просмотр истории дефекта 463
отправка дефектов по электронной 

почте 464
URL-адрес, копирование 468

таблица Execution Grid
поиск и замена 413

таблица наборов тестов, копирование URL-

адреса 374
таблица покрытия

вкладка Req Coverage 285
вкладка Test Coverage 289

таблица требований
копирование URL 192
определения полей 162
поиск требований 181

таблица тестов 249–??
главное окно 249
замена значений полей 273
копирование URL-адреса 276
панель инструментов 251
определения столбцов 252
поиск тестов 272
отправка тестов по электронной 

почте 267
создание документов проекта ??–570
удаление тестов 251

Таблица Testing Policy 221
целевой цикл

таблица выполнения 346
цели и задачи 143
цели и задачи тестирования 143
текст в формате RTF 176
текстовый поиск 76
Центр качества Quality Center

обзор 25
тестер

таблица выполнения 346
тестирование безопасности 238
тестирование производительности 238
тестирование нагрузки 238
тесты

разработка шагов теста 299–??
автоматическое выполнение 403–414
автоматизация 317–320
добавление в дерево плана 

тестирования 259
выполнение вручную 393–401
замена значений полей в таблице 371
локальное выполнение 406
копирование в одном проекте 274
копирование из одного проекта в 

другой 274
продолжение выполнения ручного 
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теста 401
просмотр результатов выполнения 

??–432
просмотр результатов выполнения 

тестов 415–??
просмотр всех 249
переименование в дереве плана 

тестирования 278
наборы тестов 351–379
планирование выполнения тестов 

??–392
поиск в дереве плана тестирования 

270
поиск в таблице тестов 272
связывание требований с тестом 

285–288
связывание тестов с требованием 

289–??, 289, ??–298
создание из дерева требований 

193–200
создание шагов теста ??–315
Составление расписания запуска 

тестов 381–??
удалённое выполнение 406
удаление из дерева плана 

тестирования 278
типы 260

тесты на стрессовые условия 238
тесты VAPI-XP 605, 605–??
тесты, выполняемые в ручном режиме

выполнение 393–401
флажки для отслеживания

изменение и удаление 89
обзор 88
создание 89

флажки отслеживания
изменение и удаление 89
создание 89

флажок Add report as attachment 227
Флажок Alerts 86
флажок Enable Log, диалоговое окно 

Automatic Runner 407, 408
флажок Exclude from Analysis 219
флажок Full Coverage, вкладка Test 

Coverage 290
Флажок Global Parameter 598

флажок Hide Risk-Based Quality Management 
Columns 60, 70, 73

флажок Include list of requirements in the 
report 227

флажок Override calculated value 219
флажок Restrict to current filter 77
флажок Run All Tests Locally 406
Флажок Run post-processing 595
флажок Show only Template Test 306
флажок Use these for the next calculation 230
флажок View By Group 59
циклы. См.  дерево релизов
фильтры

раскрывающийся список 
пользователей 58

расширенные/перекрестные 65–69
группирование пользователей 58
копирование 74
filtering tests not in any test set 68
filtering tests with no requirement 

coverage 68
просмотр групп пользователей 58
параметры 59–64
обновление 75
поиск пользователей 58
удаление 75

управление качеством на основе рисков 213
восстановление констант по 

умолчанию 222
задание параметров 219
пример 231
окончательное оформление 

политики тестирования 222
определение категории рисков 217

упорядочивание тестов
в таблице выполнения 411
на схеме выполнения 389

хосты 409
добавление в группу хостов 411
добавление группы хостов 411
определение 403
удаление группы хостов 411
удаление из группы хостов 411
удаление хостов 410

Old Type (obsolete), модуль Requirements 
163
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условия группирования
копирование 74
параметры 72

условия выполнения, настройка 383
условия сортировки

копирование 74
параметры 69–71
обновление 75
удаление 75

условие, настройка для выполнения теста 
383

установочные параметры диаграмм, 
пользовательская настройка 525

функция VAPI-XP AddDefectUI 624
Open Output Text in Web Browser, Кнопка 628
Output, вкладка 621
Output, команда 621

P
Passed coverage, Progress, вкладка 133
Paste, команда , дерево релизов 138
Paste, Кнопка, VAPI-XP 621
Path

таблица тестов 253
Percent of Similarity, поле 457
Period

диаграмма тенденций 525
диаграмма хода выполнения 522

Planned Closing Version, Defects Grid, 
таблица 447

Planned coverage, Progress, вкладка 133
Planned Exec Date

сведения о выполнении теста 420
Planned Exec Time

сведения о выполнении теста 420
Planned Host Name

сведения о выполнении теста 421
Print Output, кнопка 628
Print, команда, Defects Grid, таблица 468
Print, метод, VAPI-XP 625
Priority

Defects Grid, таблица 447
Requirements, модуль 163

Product, Requirements, модуль 163
Progress, вкладка, Releases, модуль 130
Project, Defects Grid, таблица 447

Q
Quality Center

главное окно 44
выход 43, 48
запуск 39
переход к другому проекту 46
Окно входа в систему 42
Окно ссылок 40
URL-адрес сервера Quality Center 39

Quality Center, Центр качества
комбинации клавиш 635

QuickTest Professional, определение типа 
теста 260

R
Readme 17
Refresh All, Кнопка

Модуль Requirements 185
Refresh All, Кнопка, Releases, модуль 136
Releases, кнопка 116
Releases, модуль

дерево релизов 119
Вкладка Quality 134
добавление релизов 126
добавление циклов 127
вставка папок, релизов и циклов 138
краткий обзор 115
изменение дерева 137
просмотр дефектов 134
просмотр назначенных папок 

наборов тестов 128
просмотр назначенных требований 

128
просмотр хода выполнения покрытия 

130
процесс 109
панель инструментов 117
определения полей 118
строка меню 117
статистические данные 128
Progress, вкладка 130

Remaining days in cycle, Progress, вкладка 
132

Remaining days in release, вкладка Progress 
131
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Remaining test instances to run, вкладка 
Progress 131

Remaining test instances to run, Progress, 
вкладка 132

Remove Link, кнопка 477
Rename, Команда

дерево требований 190
Rename, Команда , Releases, модуль 137
Replace All, Кнопка, VAPI-XP 621
Replace, команда

дерево требований 182
Defects Grid, таблица 462

Replace, Кнопка, VAPI-XP 621
Reproducible, Defects Grid, таблица 447
Req ID, Requirements, модуль 165
Req Parent, Requirements, модуль 165
Required execution rate, вкладка Progress 131
Required execution rate, Progress, вкладка 

132
Requirement Details, Окно 151
Requirement Trace ID, окно Traceability Grid 

209
Requirement Type, Requirements, модуль 166
Requirements Grid, Окно 154
Requirements Tree, Окно 148
Requirements, модуль

дерево требований 169–200
вставка требований 192, 193
краткий обзор 147–167
назначение требований релизам или 

циклам 175
панель инструментов 161
Окно Coverage Analysis 157
определения полей 162
отправка требований по электронной 

почте 187
строка меню 160
Requirement Details, Окно 151
Requirements Grid, Окно 154
Requirements Tree, Окно 148

Responsible Tester
сведения о выполнении теста 420

Resume Execution, кнопка , VAPI-XP 634
Reviewed, Requirements, модуль 166
Rich Text, вкладка, модуль Requirements 176
Run on Host, диалоговое окно Automatic 

Runner 406

S
Select Fields, диалоговое окно 467
Select Recipients, диалоговое окно 466
Select Test Set, диалоговое окно 629
Send by E-mail, кнопка

дефекты 465
Send E-mail, диалоговое окно

дефекты 464
Set Filter/Sort, вкладка Requirements 

Traceability 206
Set Filter/Sort, вкладка Test Coverage 290, 

292
Set Filter/Sort, кнопка

Requirements, модуль 185
Severity, Defects Grid, таблица 447
Show Requirements, Команда 129, 130
Show Test Set Folders, Команда 130
Show Variables, кнопка 633
Show/Hide Browsers, Кнопка 619
Similar Defects, диалоговое окно 455
Spelling Options, кнопка

новый дефект 174
Send Mail 190, 467

Start Date
дерево релизов 127, 128
Releases, модуль 118

Statistics, модуль Releases 118
Status

дерево плана тестирования 263
Defects Grid, таблица 447
сведения о выполнении теста 421
таблица тестов 253

Step Into, кнопка 632
Step Out, кнопка 633
Step Over, кнопка 632
Step, Команда 197
Stop, кнопка

VAPI-XP 628
Subject

Defects Grid, таблица 447
таблица тестов 253

Subject, Команда 196
Summary, Defects Grid, таблица 448
Summary, область , Defects Grid, таблица 
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442
Syntax Check, Команда 621
Syntax Check, Кнопка 621
System Test, определение типа теста 261

T
Target Cycle

Defects, модуль 448
Requirements, модуль 166

Target Release
Defects, модуль 448
Requirements, модуль 166

TDHelper объект, VAPI-XP 622
TDInput, VAPI-XP, объект 625
TDOutput, VAPI-XP, объект 625
Template, Test Grid 253
Test Grid ??–254

создание документов проекта 566–??
Test ID, Test Grid 253
Test Name, Test Grid 253
Test, Команда 197
TestDirector, см. Quality Center
Tester

сведения о выполнении теста 421
Testing Level 220
Testing Time 220
Thesaurus, кнопка

новый дефект 174
Send Mail 190, 467

Time
указание для выполнения теста 383

Time, сведения о тесте 421
Toggle Breakpoint, команда 631
Total days in cycle, Progress, вкладка 132
Total days in release, вкладка Progress 131
Total test instances for cycle, Progress, 

вкладка 132
Total test instances for release, вкладка 

Progress 131
Trace Comment, окно Traceability Grid 209
Type, Test Grid 253

U
URL, копирование 192, 374
URL-адрес сервера Quality Center 39

URL-адрес, копирование 276, 468

V
VAPI-XP AddDefect, функция 623
VAPI-XP AddStepToRun, функция 624
VAPI-XP DownLoadAttachment, функция 624
VAPI-XP GetInput, функция 625
VAPI-XP RunTest, функция 623
VAPI-XP RunTestSet, функция 622
VAPI-XP Sleep, функция 627
VAPI-XP UpLoadAttachment, функция 624
VAPI-XP WrapArray, функция 626
VAPI-XP, встроенный отладчик 631
VAPI-XP, выполнение функции 626
VAPI-XP, определение типа теста 261
VAPI-XP, Тесты

Разработка 607, 607–617
изменение 617, 617–??

VAPI-XP, тесты ??–634
выполнение в режиме отладки 628
выполнение в режиме тестирования 

629
изменение ??–622
отладка 631, 631–634

Variables, команда 633

W
What’s New, команда 17
Window Screen, Кнопка 617
WinRunner Automated, определение типа 

теста 260
Word

экспорт данных таблицы из Quality 
Center 78

экспорт анализа покрытия в 298
создание документов проекта 583

X
XML-документ, экспорт данных таблицы 78
XTools, объект , VAPI-XP 626
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